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Legal

Trademarks

* GPD Global® is a registered trademark of GPD Global, Inc.

*  FLOware® and MicroMax® are registered trademarks of GPD Global, Inc.

* ClearVu Vision™, Contour Mapping™, and NCM5000 Pump & Controller are trademarks
of GPD Global, Inc.

* Luer-Lok® is a registered trademark of Becton, Dickinson and Co.

*  Microsoft®, Excel®, and Windows® are registered trademarks of Microsoft Corporation

+ Sybase™ is a trademark of Sybase, Inc. or its subsidiaries

*+  QNX® is a registered trademark of QNX Software Systems Limited

*« UNIX® is a registered trademark of The Open Group

+  X-Windows™ is a trademark of MIT

Throughout this manual, trademarks are used. Rather than put a trademark symbol in every
occurrence of a trademarked name, we state that we are using the names in an editorial
fashion only and to the benefit of the trademark owner with no intention of infringement of the
trademark.

Disclaimers

GPD Global® dispense systems are intended for the stated functions at the time of sale. GPD
Global® is not liable for other uses.

i IMPORTANT: Operation of a damaged machine may cause personal injury and invalidate the

warranty.

IMPORTANT: WICHTIG IMPORTANTE IMPORTANTE
L'utilisation d’'une Die Bedienung einer Il funzionamento di La utilizacién de una
machine endom- beschadigten Maschine | un’apparecchiatura magquina averiada
magée kann zu Verletzungen danneggiata pud puede provocar
peut entrainer des des Bedieners sowie zur | causare lesioni personali | lesiones e invalidar
blessures person- Unguiltigkeit der Garantie | e invalidare la garanzia. la garantia.

nelles fihren.

et invalider la garantie.
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Safety Notices

The complete translation of notices used throughout this document may be referenced here.
Links to these translations are provided in the procedural text when applicable.

Translated versions of the following safety precautions are used throughout this document and
are listed together here:

Translations:

* Consignes de sécurité

+  Sicherheitsan weisungen

e Istruzioni di sicurezza

* Instrucciones de seguridad

Warnings

WARNING The content of this section is NOT recommended for use by anyone besides GPD Global person-

& nel or those working under the direct guidance of GPD Global personnel. Improper application of this informa-
tion can lead to serious complications in FLOware Software operations. Any non-GPD Global employee who
uses this information beyond the stated application specified by GPD Global Service Department personnel is
in danger of causing personal injury and invalidating their machine warranty.

WARNING GPD Global is NOT responsible for loss of configuration or programs if a current backup is not
& available.

WARNING Care must be taken if subtypes are moved from one machine to another since subtypes relate to
both the hardware and software..

Precautions

& CAUTION DO NOT override the safety package or else personal injury could result.

i CAUTION DO NOT open the safety shielding while a program is running or a safety violation message will
appear and the program will abort.

CAUTION The gantry moves IMMEDIATELY to the coordinates designated in the corresponding coordinate
fields. MOVE TO can be used to verify previously taught coordinates.

programs and thus require you to modify your patterns accordingly.

E IMPORTANT Making adjustments to camera focus or lighting conditions may affect all patterns used by your
& IMPORTANT Only program (or shape) lines with no feature ID or with selected feature ID will run.
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Precaution Translations

Consignes de sécurité

ATTENTION Le contenu de cette section N'est PAS recommandé pour une utilisation par d’autres per-

& sonnes en dehors du personnel de GPD Global ou des personnes travaillant sous les ordres directs du per-
sonnel de GPD Global. Une mauvaise application de ces informations peut aboutir a de sérieuses
complications dans le fonctionnement du logiciel FLOware. Toute personne qui n’est pas un/e employé/e de
GPD Global et qui utilise ces informations en dehors de I'application spécifiée ici par le personnel du service
d’entretien de GPD Global risque de se blesser et de vicier la garantie de leur machine. Bien que nos clients
souhaitent souvent utiliser cette fonction de leur logiciel, GPD Global n’est pas responsable de son utilisation.
Le contréle direct des fonctions peut endommager I'équipement et interrompre le fonctionnement du pro-
gramme si I'opérateur active ces contrdles au mauvais moment ou dans le désordre.

ADVERTISSEMENT GPD Global n'est PAS responsable de la perte de configuration ou de programmes si
une copie de sauvegarde tenue a jour n’est pas disponible.

ATTENTION Faire attention si les sous- types sont déplacés d’'une machine a I'autre car les sous-types
communiquent a la fois avec la machine et le logiciel.

ATTENTION NE PAS neutraliser le dispositifs de sécurité pour éviter des blessures corporelles.

message de violation de la sécurité apparaitra et le programme sera interrompu.

ATTENTION Le portique se déplace IMMEDIATEMENT lorsque le bouton MOVE TO (ALLER VERS) est
activé. Avant d'utiliser le bouton MOVE TO (ALLER VERS), vérifier que le passage est dégagé entre la posi-
tion courante du portique et les coordonnées de destination.

IMPORTANT Tout changement de la mise au point de la caméra ou des conditions d’éclairage peut affecter
tous les modeles utilisés par vos programmes. Vous devez donc modifier vos modeles en conséquences.

IMPORTANT Seules les lignes de programmation (ou de tragage de forme) sans code-objet ou avec code-
objet sélectionné seront exécutées.

E ATTENTION NE PAS ouvrir I'écran de protection quand un programme est en cours d’exécution, sinon un
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Sicherheitsan weisungen

A

> B B BB P P

WARNUNG Der Inhalt dieses Abschnitts ist NICHT zur Anwendung durch Dritte empfohlen, sondern auss-
chlieBlich fur Mitarbeiter von GPD Global bzw. fur geschultes Personal unmittelbar unter Anleitung von GPD
Global bestimmt. Eine unsachgemafe Ausflihrung dieser Anweisungen kann zu erheblichen Problemen beim
Betrieb der FLOware Software flihren. Jeder nicht von GPD Global autorisierte Mitarbeiter, der diese Anleitun-
gen auBerhalb der vom GPD Global Service Department Personal spezifizierten Applikationen anwendet,
setzt sich der Gefahr von Personenschaden aus; gleichzeitig erléschen dadurch samtliche Gewahrleistung-
sanspriiche fir die Maschine. Obwohl unsere Kunden oftmals Zugriff auf diesen Software-Zusatz verlangen,
Ubernimmt GPD Global keinerlei Haftung fiir deren Einsatz. Die direkte Steuerung der Features kann zu Bes-
chadigungen der Fertigungsausstattung und zur Stérung des Programmablaufs fihren, wenn die Bedienper-
son diese Steuerungen zum falschen Zeitpunkt oder in nicht korrekter Reihenfolge aktiviert.

ACHTUNG GPD Global haftet NICHT fiir den Verlust der Konfiguration oder von Programmen, wenn kein
Notstrom zur Verfliigung steht

VORSICHT! Vorsicht beim Transferieren von Teilen des Programms von einer Maschine auf die nachste;
diese Routinen sind sowohl an die Hardware als auch an die Software gekoppelt.

VORSICHT! Setzen Sie NIEMALS die Sicherheitseinrichtungen ausser Kraft, es koennte Personenschaden
entstehen.

VORSICHT! Bei laufendem Programm diirfen Sie die Schutzabdeckung NICHT 6ffnen. Andernfalls wird ein
Sicherheitsverstol gemeldet und das Programm abgebrochen.

VORSICHT! Die bewegliche Portal-Einheit wird durch Driicken des MOVE TO Knopfes SOFORT in Gang
gesetzt. Bevor der MOVE TO Knopf aktiviert wird, muss sichergestellt sein, dass ein klarer Pfad zwischen der
aktuellen Position des Portals und den spezifizierten Koordinaten gegeben ist.

WICHTIG! Jegliche Justierungen des Kamera-Fokus’ oder der Beleuchtungskonditionen kénnen Auswirkun-
gen auf samtliche im Programm verwendeten Modelle haben. Demzufolge miissen auch die betreffenden
Modelle entsprechend modifiziert werden.

WICHTIG! Nur Programmzeilen (oder Zustandszeilen) ohne Funktions-ID oder mit gewahltem Funktions-1D
kdénnen laufen.

5/18/18 FLOware Software Guide iX



GPD Global®

Istruzioni di sicurezza

ATTENZIONE |l contenuto di questa sezione NON & destinato all'utilizzo di altri al di fuori del personale GPD

& o del personale autorizzato da GPD stessa. Un’applicazione impropria di queste informazioni pué comportare
gravi problemi nella funzionalita del software FLOware. Nonostante i nostri clienti desiderino utilizzare questa
funzione software, GPD Global non assume alcuna responsabilita per il suo utilizzo. Il controllo diretto delle
funzioni software puo danneggiare il sistema e il programma di lavoro se I'operatore attiva questi controllo nel
momento sbagliato e in sequenza errata

AVVERTENZA La GPD Global Global NON & responsabile della perdita di configurazione o di programma
se non si dispone di un backup corrente

ATTENZIONE Prestare attenzione in caso di passaggio di un sottotipo da una macchina all’altra dato che
sono associati sia al software che all’hardware.

ATTENZIONE NON aggirate le disposizioni sulla sicurezza, potrebbero verificarsi danni alle persone.

ATTENZIONE NON aprire la protezione di sicurezza durante I'esecuzione di un programma altrimenti appa-
rira un messaggio di violazione di sicurezza ed il programma verra interrotto.

ATTENZIONE Il gantry si muove IMMEDIATAMENTE all’attivazione del pulsante MOVE TO. Prima di atti-
varlo verificare che il percorso tra la posizione attuale del gantry e la coordinate designate sia libero

IMPORTANTE Regolazioni al fuoco della telecamera o all'illuminazione possono influenzare tutti gli schemi
utilizzati da vostri programmi. E’ necessario quindi modificare anche gli stessi di conseguenza

IMPORTANTE Si eseguiranno solo righe di programmi (o di forma) senza caratteristica identificativa o con
caratteristica identificativa selezionata.

> B> B> b BB P
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Instrucciones de seguridad

> BB BB P

ADVERTENCIA NO SE RECOMIENDA la utilizacion del contenido de esta seccion a personal ajeno a GPD
Global o a aquéllos que trabajen bajo la supervision directa del personal de GPD Global. La aplicacién inade-
cuada de esta informacion puede comportar complicaciones serias en el funcionamiento del software FLO-
ware. El personal ajeno a GPD Global que utilice esta informacion mas all4 de la aplicacion indicada por el
personal del Departamento de asistencia al cliente de GPD Global corre el riesgo de causar dafios personales
y de anular la garantia de la compafiia. A pesar de que nuestros clientes a menudo quieren utilizar esta
funcién del software, GPD Global no se responsabiliza de su utilizaciéon. El control directo de las funciones
también puede dafar el equipo y puede detener el funcionamiento del programa si el operario activa estos
controles en mal momento o en la secuencia incorrecta.

ADVERTENCIA GPD Global NO ASUME ninguna responsabilidad por la pérdida de configuracion o pro-
gramas si no se dispone de una copia actualizada de seguridad

PRECAUCION Precaucion al mover subtipos de una maquina a otra ya que los subtipos estan relacionados
tanto con el hardware como con el software.

PRECAUCION NO saltarse el paquete de Seguridad, o alguna persona podria sufrirdafios.

PRECAUCION NO ABRA la proteccién de seguridad mientras se esté ejecutando un programa, si lo hace
aparecera un mensaje de violacién de seguridad y se abortara el programa.

PRECAUCION El pértico se desplaza INMEDIATAMENTE cuando se activa el botén MOVE TO (MOVER
HACIA). Antes de utilizar el boton MOVE TO (MOVER HACIA), compruebe que hay espacio libre entre la
posicion del poértico y las coordenadas designadas.

IMPORTANTE Los ajustes al enfoque de la camara o a las condiciones de iluminacion pueden afectar a
todos los patrones que utilizan sus programas. El resultado es que debe modificar sus patrones en conse-
cuencia

IMPORTANTE Solo se ejecutaran las lineas (o formas) del programa sin identificacion de funciones o con la
identificacion de funciones seleccionada
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1 Overview

This chapter provides an overview of the performance, programming, and data transfer
aspects of the FLOware control software and its related documentation.

* Introduction to FLOware Software (pg 1.1)
+  About the Documentation (pg 1.4)

Introduction to FLOware Software

FLOware software, used by GPD Global dispensers to perform high speed, precision
dispensing, part pick-up and placement, and many other operations on single or multiple
components on boards, boats, or pallets, is a programmable, real time, true multi-tasking
operating system with a graphical user interface.

Designed with the concepts of great flexibility and ease-of-use in mind, the FLOware software
system enables easy programming of dots, lines, fills, arcs, and other custom shapes.

»  Performance (pg 1.1)

*  Programming (pg 1.2)
» Data Transfer (pg 1.3)

Performance

Real Time Operation
All processes sent to the CPU are processed according to a system of priority levels. High
priority processes, such as safety issues and motor and motion control, are completed
immediately in real time.

Every 0.5 ms (2000 of a second) the CPU checks for incoming processes to complete. If a
process with a higher priority than the one currently being executed appears, the CPU stops
the low priority process and immediately begins completing the higher priority process. For
example, if a safety violation occurs or a motion control command is required, the CPU
immediately processes those commands even though the operator is currently editing a
program, thus maintaining safe and constant operations with accurate monitoring and greater
control.

True Multi-Tasking
Because the system computer can perform multiple tasks at the same time, the user can
perform tasks such as editing a program at the same time the dispenser is processing
products. At no time is the dispensing speed slowed or machine safety compromised.

Optimization
Three methods for optimizing dispense patterns are available:

e  point-to-point,
» fixed divisions, and
+ floating square.

5/18/18 FLOware Software Guide 1.1
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The point-to-point algorithm, the most basic of the methods and used as the foundation of the
other two methods - determines the nearest component centroid to the present needle
position.

The fixed divisions method divides the product into a number of divisions as specified by the
operator, and then utilizes the point-to-point method within each smaller division.

The floating square method is similar to the fixed divisions method except the operator
specifies the dimensions of the square used to divide the product into divisions.

Programming

FLOware software gives the user control over all dispensing parameters. Just a few examples
of dispensing parameters are material selection, valve on time, and dispense speed. Selection
lists and default values are supplied for many parameters to help the user with proper value
selection.

Manually teaching a program - one of the three methods of programming a new board (the
other two being ASCII Pick & Place Data and CAD/GERBER Data Translation) - is a straight
forward process:

1. Create a new program file and name.
2. Teach the data origin.

3. Teach fiducial locations and patterns. Standard fiducial patterns are supplied, however,
custom patterns can be taught.

4. Specify the material, valve, and needle to be used. If multiple valves are used, parameters
for each separate valve are specified.

5. Select the component shape from a component list.
6. Teach component locations using the Jog feature.

7. Atfter using Inspection Mode to verify all locations, production level dispensing can begin.

Programs
A program library lists all programs available to be run or edited. Programs may be grouped by
a Class designation. Preferences for each program are selected by the user. A virtually
endless number of subroutines can be generated for later recall.

Shapes
Shapes are the building blocks for most programs. Any shape can be defined. Shapes can
range from a simple dot pattern to a complex, convoluted fill pattern. Shapes are created using
simple commands (dot, line, arc, circle, move, etc.) in combination such that the desired
pattern shape is achieved.

Pattern Recognition
Any pattern can be taught as the fiducial. All standard fiducials are included with the system,
but the system can be taught to recognize custom fiducials, even those represented using
text.

Access
The passworded system of access rights can be used to limit the access of each user. The
system administrator can set a user name and the functions available to each operator. The
system tracks log-in activity and operations performed by individual.

5/18/18 FLOware Software Guide 1.2
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Data Transfer

Data Converter
Take CAD data from desk to dispenser using the system data converter. The system trans-
lates pick-and- place data and other ASCII formats compatible with many data translation
companies. An integrated part number library relates your part number to the system
component library with assistance for easy part type recognition, so you can edit at your
leisure.

Data Exporting
The user can export all data from any GPD Global dispenser as an ASCII formatted file using
the Data Exporting utility. Any program file is selectable for export. Exported data may be
transferred between any of the GPD Global dispensers. The data may also be sent via e-mail
to another facility or to GPD Global for programming assistance.

5/18/18 FLOware Software Guide 1.3
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About the Documentation

This manual, written for version 2.9 of the FLOware software, is intended to provide the user
with the concepts, instructions, and reference material needed to create and modify programs.

Intended Audience & Equipment

This manual is intended as a software guide for the Engineer assigned to the GPD Global
dispensing equipment. Use this document to create and modify dispenser programs. The
assumption is made here that you have read and are familiar with the contents of the
Dispenser Operator Guide.

Organization of Manual

This manual is organized as follows:

Overview. Describes the version of control software described in this document; describes
many general aspects of the FLOware software package; gives an overview of how
this document is organized; and lists the titles of associated documents.

Getting Started. System start up and power down instructions; descriptions of all interface
features and instructions on how to use them; and likewise for features that function
as system-wide commands.

Using FLOware Software. Operating instructions for how to use existing programs, how to
use basic programming features, how to create new programs, and how to achieve
successful programming results using specific features. Calibration and configuration
topics are also included.

References. Reference material and procedures for specific topics often used when creating
or modifying programs.

System Management. Describes administrative, account management, routine backup, trou-
bleshooting, and security level features and procedures.

Appendices. Describes engineer-level procedures that should only be used while under the
direct guidance of GPD Global personnel. Instructions for capturing screen grabs is
also included here.

Related Documents
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For additional information about the dispenser, refer to the following associated documents:

» Dispense System Operator Guide (p/n 22100079K)

» Dispense System Service Guide (p/n 22290008D)

*  Mechanical & Electrical Reference Documents (p/n custom)

*  FLOware Software Import/Export Data Reference Guide (p/n 22100024)
* FLOware Base Locations Reference Guide (p/n 22100025)

* FLOware Messages Reference Guide (p/n 22100026)

*  TCP/IP Communications for Dispenser and Windows or UNIX PC (p/n 22100056M)
+ CMOS Set Up (p/n 22100114-x)

*  Upgrading FLOware Software (p/n 22100086)

* Installing Data Converter (p/n 22100038DOC)

* Dispenser Software Recovery (p/n 22100109CD.29)

FLOware Software Guide 1.4
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2 Getting Started

This chapter discusses system start up and power down, and guides the user through an in-
depth description of the software interface features and how they function.

« Start Up, Home, Shutdown (pg 2.1)
* User Interface (pg 2.3)
+ System-wide Commands (pg 2.21)

Start Up, Home, Shutdown

Power On

The startup sequence initializes the computer, loads the operating system, and implements
FLOware software programming changes. Some FLOware software programming functions,
such as teaching base locations for example, require the system to be booted before changes
will take effect.

To start the system:

1. Read all safety and operating instructions prior to operating the machine.

2. If the machine is equipped with an optional, uninterrupted power supply control, then per-
form the UPS startup sequence. For details, refer to the Dispenser Operator Guide (see
UPS Control under Operating Detail).

Verify the black Power Off button is pulled out.

4. Turn on the machine by pressing the green Power On switch. The system will prompt you
to home the XYZ gantry when you turn on the power and the booting process has finished.
The system must complete the homing sequence before other operations are possible.

Home the System
Homing the system is a standard part of the power on procedure.

1. Wait until the system has completed the boot sequence. This may require waiting several
minutes while status information displays. The main window and a prompt to home the
system will display when the booting process is complete.

2. Click OK to home the system. Homing defines where the gantry is for the system and is
complete when all homing status messages disappear. When only the main window
remains, you may proceed with normal operations.

& CAUTION DO NOT override the safety package or else personal injury could result.

ATTENTION VORSICHT! ATTENZIONE PRECAUCION
NE PAS neutralizer | Setzen Sie NIEMALS | NON aggirate le NO saltarse el paquete

CAUTION DO NOT open the safety shielding while a program is running or a safety violation
message will appear and the program will abort.

ATTENTION VORSICHT! ATTENZIONE PRECAUCION
NE PAS ouvrir I'écran | Bei laufendem Pro- NON aprire la protezi- | NO ABRA la protec-
gramm one cion
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Power Off

Before powering off the machine, end any active program and perform a proper shutdown
described in the following procedure.

Prepare for Shutdown
Before you can perform the shutdown procedure, you must end any active program. It is also
recommended that you unload all product from the dispense area and remove and clean the
heads.

To prepare for shutdown:

1. Stop program execution with one of these methods:
— If the Mount Board prompt is displayed, click ABORT, or
— click CANCEL on the main button bar.

2. After the program has ended, remove all product from the dispenser area. For details,
refer to Unload Product under Set Up Instructions section of the Dispenser User Guide.

3. To begin the process of unloading all heads (valves and tools), click REFRESH on the
main button bar to move the gantry to the front of the machine where you can access the
heads.

4. Remove the heads. For details, refer to Mount Heads in Mount Heads & Materials in the
Set Up Instructions section of the Dispenser User Guide.

5. Clean the heads. For details, refer to head cleaning instructions detailed in CLEAN Valves
in the Periodic Operations section of the Dispenser Service Guide.

Shutdown
The machine can be left powered on as long as the safety system has not been bypassed;
however, GPD Global recommends that you power off equipment when it is not in use.

To shutdown and power off the machine:

1. Perform the Prepare for Shutdown (pg 2.2) procedure.

2. If the machine is equipped with an optional, uninterrupted power supply control, perform
the UPS shutdown sequence specified in UPS Control in the Operating Detail section of
the Dispenser User Guide.

3. From the main menu bar, click on Operations > Shutdown System. A shutdown verification
prompt displays.

4. Click YES to shutdown the system or CANCEL to abort the shutdown. Wait until a System
Stopped prompt displays.

5. Power off the machine by pressing the black Power Off button.
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User Interface

The dispenser system is controlled through the trackball, keyboard, and software windows.
The operator uses these to run processes; the engineer uses these to design processes. All
typed entries, except passwords, are insensitive to case. File selection windows are widely
available throughout the software, enabling you to select any file in the system.

+ Keyboard & Mouse/Trackball (pg 2.3)

+ Jogging the Gantry (pg 2.7)

* USB Port (pg 2.9)

» Screen, Window, Pane, & Panel (pg 2.10)
*  Menu Structure (pg 2.13)

« Buttons (pg 2.15)

+ Lists (pg 2.18)

+ Sliders: Scales & Scroll Bars (pg 2.20)

+  Faded Items (pg 2.20)

+  Passwords (pg 2.20)

Keyboard & Mouse/Trackball

Cursor
The cursor (pointer) can be moved anywhere on the monitor screen with the ball section of the
trackball.
Trackball
Use the trackball to position the cursor on the monitor screens and to move the gantry.
MEW Style OLD Style
Cursor achon Drag & Drop

Drag
| . Cursor action
Click - - PopUp Menu Drag
Click Paplp Menu
Drag & Drop

You can select all or part of the contents in a field. There are several ways to select field
contents, and each method obtains slightly different results. You can either click-and-drag or
multiple-click on a field.

1. If you single-click on a field, press the lower left trackball key, and drag the cursor, you
can be selective about the data selected.

2. If you double-click on a specific item within a field, you can select that single item (a sin-
gle word, a value, or a unit of measure).

3. By triple-clicking on a field, you can select the total contents (a value AND the unit of
measure or all text) of a field.

5/18/18 FLOware Software Guide 2.3
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The following conventions are used in this manual for trackball actions:

Table 1: Trackball Conventions

Term Action
click Press the Click trackball button and immediately release it.
double-click In rapid succession, click the Click trackball button for the applicable number of
triple-click times.
drag As you move the cursor down a menu with the trackball, each menu selection is

highlighted in turn. Frequently, you will select a menu item by dragging the cursor
down the menu until the item you want is highlighted, and then releasing (or some-
times clicking) the Click trackball button.

drag & drop Press and hold the Drag & Drop trackball button while moving the cursor, then
(move) release the button.

position cursor | Move the cursor by moving the Ball portion of the trackball.

open Pop-up Position the cursor at the appropriate screen location and press the Click trackball
menu button.

Keyboard

When used in reference to hardware, the term key is understood to refer to a control located
on the keyboard and button is understood to refer to a control located on the trackball.

Accelerator Keys
Various accelerator keys are provided to accommodate navigation by keyboard rather than by

trackball.
Table 2: Using Accelerator Keys
Item Affected Use These Keys Notes
select a menu item | ALT key + first letter A menu item that displays with an underlined first
letter may be selected by pressing the ALT key
and the underlined letter.
select a panel CTRL key + first letter A selection panel may be selected by pressing the

CTRL key and the first letter of the panel title
(rather than clicking the Panel Selection button).

For example, to select the Vision panel in the Pro-
gram Detail window, press the CTRL key and the
V key.

enter mount location | ALT key + 1, 2, 3, 4, or 5 key | Enter a value in any Mount Position field by press-
ing the ALT key and a number (1-5) key.

enter gantry ALT key + A, B, or C key Enter a value in any Gantry field by pressing the
ALT key and a letter (A-C) key.

Arrow Keys

Use the arrow keys to move the cursor sequentially up/down lists or forward/backward through
text and numeric values.
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Tab Key

Either move the cursor with the trackball and click on a field to select it or press the TAB key
repeatedly to move through the fields sequentially until the cursor has reached the destination
field.

Use the TAB key to move the cursor sequentially from field to field. Normally, the TAB key will
not tab through a text field; rather, use of the TAB key within a text field creates tab spaces.
However, pressing down the CTRL key while using the TAB key will move the cursor through
all fields, in sequence, without exception.

NOTE: The TAB key does not always work on the main window.

Text Entry

Use the keyboard to type text entries after positioning the cursor in the appropriate field. When
entering text or values:

Table 3: Field Text Entry

To Action
select desired field click on desired field
move forward from field to field <Tab> to desired field
move backward from field to field <Shift> + <Tab> to desired field
select all text/numbers in a field double-click OR click and drag

Numeric Entry

5/18/18

Select desired field and type a numeric value using the keyboard, or click the default box next
to the field to return the field to its default value. When entering a value, you may need to
erase (backspace key) the prior value before entering the new value.

Units of Measure

Units of measure can be included in entries and need not be the same as the displayed units.
The displayed value will be properly converted and displayed when an entry is applied; the
system reverts the entry to the default (displayed) units. For example, suppose you want to
enter a value of 1.5 millimeters in a field that is currently displaying a value in inches:

1. Let's say you intend to enter a value in a field already displaying a value of 0.658 in (refer
to item A).

A Y |0,658 i
B X

C i

HLE

D ¥|0.089 in

2. Select the field contents, including the units of measure (B).
3. Type in the new value and the new units (C).

4. Press ENTER. The newly entered value and units, 1.5 mm, is converted and displayed in
default units as 0.059 inches (D).
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Global Units of Measure
Units of measure can be displayed as English or metric. The global default for units of
measure is set up in the configuration file and can be changed from English to metric or vice
versa if needed. For instructions and a complete list of valid units, refer to Unit Abbreviations

(pg 7.2).
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Jogging the Gantry

Gantry movement in the X, Y, and Z axes can be directly controlled by the operator with the
trackball and keyboard. This manual control over the gantry, or jogging, is typically used to
position the camera and teach program coordinates, align offset points, and reposition the
gantry when necessary.

How to Jog
To jog the gantry:

1. ALWAYS observe ALL jog rules:

CAUTION: Observe all jog rules or else damage to the machine may occur as a result of mov-
ing the gantry too quickly in an unintentional direction.

— Rule #1 - Visually monitor the gantry response EVERY TIME you activate gantry
movement.

— Rule #2 - Prior to using the jog feature, verify that the gantry is raised up sufficiently to
clear all obstructions.

2. Click JOG in the main button bar of the main window or use the Jog window that displays
automatically during various procedures.

Move the gantry using the Jog Controls (pg 2.8).
4. When the gantry is positioned where you want it, click CLOSE to exit the Jog window.

About the Jog Window

n'l-I‘ s tha palnaar ta move th rabat ssaurd.
oy Wheishi it i whiira yoin wast i, click O,

Current
Coordinates

|n—mnm“ o 0 ET R DO e e DO i, WOEEES miim

1]

T

Alignment
Cross Hairs

§|=- ii! %‘H

l
i
H#

Spesd

Pkt ag Spies T Fbeied 4 Epiea T T Sliders

| o o |

i

Current camera coordinates relative to the active reference point display at the top of Jog.
The alignment cross hairs are guides for precise alignment.

The speed sliders are used to change the overall operating speed of the cursor and keyboard
controls.
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The lens and lighting controls located along the left side of Jog are only available when the
dispenser is equipped with the associated optional equipment. For further lens and lighting
controls information, refer to Vision Lighting & Focus (pg 3.73).

Jog Controls

Gantry movement is controlled with the trackball and keyboard, and directly relates to the
movement of the cursor in Jog.

WARNING: The gantry moves IMMEDIATELY when the jog controls are activated. Gantry
motion stops immediately upon release of the jog controls.

NEW Style OLD Style
Cursor action
Drag

Drag & Orop

F= : Curser action
/ \\ ‘l\ i Poplp Menu Drag
Lo DE. Click ‘ Foplp Menu
; )

i \ Drag & Drop
Clrl Buttan Arrow Keys
Table 4: Jog Controls - How They Work
To control: Do this:

X-Y movement

1 - Position the screen cursor in Jog.

2 - Press and hold the Click trackball button to activate jog control over the gan-
try, while simultaneously moving the trackball to correspond with desired direc-
tion.

3 - Release the Click trackball button when desired movement has occurred.

Z movement

1 - Position the screen cursor in Jog.

2 - Press and hold the Ctrl button and the Click trackball button to activate jog
control over the gantry, while simultaneously moving the trackball to correspond
with desired direction.

3 - Release the Ctrl button and the Click trackball button when desired move-
ment has occurred.

speed

Speed is dynamic with the distance between the cursor and the center of the
Jog cross hairs; that is, the greater the length of the line in the Jog window cre-
ated by trackball action, the greater the speed of the gantry.

To control jogging speed more precisely, use the speed sliders to change the
overall operating speed of the cursor and keyboard controls.

fine tuning

To move the gantry in smaller increments of motion, use the keyboard arrow
keys to control gantry motion.

5/18/18
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USB Port

When a USB (universal serial bus) device is plugged into the USB port, the computer
operating system recognizes the device as a removable drive and assigns it a drive of:

/dos/c.

A USB device can be used with the Import and Export features and all types of Backup and
Restore utilities except a full system backup.

Loading USB

A USB device can be plugged into the USB port any time the system is running. If a USB
device is loaded prior to starting an import, export, backup, or restore function, the system will
skip displaying the mount a USB device prompt.

Removing USB
To remove the USB device, either:

» wait until a system prompt tells you to remove the USB device, or
« click in the main control window menu bar on Utilities > Unmount USB and then remove
the USB device.

CAUTION: Do not remove a USB device unless the system prompts you to do so or unless you
have used the Unmount USB command; otherwise, the USB port will be unusable until the sys-
tem is rebooted and anything you may have written to the USB device may be lost.

Data Transfer Utilities

Using USB with Import & Export

The USB port works with the Import Data (pg 3.1) and Export Data (pg 3.9) functions
beginning with FLOware software version 2.6.

In the Import and Export windows, a drive letter of ¢ will be assigned:
/dos/c/filename

NOTE: Wait for the prompt before removing the USB device.

Using USB with Backup & Restore

A USB device can be used with all types of Backup and Restore utilities except a full system
backup due to issues of licensing preservation.

A prompt will display asking if the USB port is available. If you opt to use the USB port, the
USB path will display for directory and file.
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Screen, Window, Pane, & Panel

Screen vs. Window
The term screen is used to indicate the full monitor viewing area, whereas the term window
represents a section of the screen dedicated to displaying specific types of information.

Moving & Resizing Windows
Windows can be moved about on the screen in one of two ways:

* by positioning the cursor on the title bar, holding down the lower left trackball button and
dragging the window to its new position with the ball portion of the trackball.

« clicking on the upper left corner of the window, selecting Move, dragging the window to its
new position with the ball portion of the trackball, and then clicking to release the window.

Many of the main windows are static in size and cannot be resized. Secondary windows can
usually be resized using the typical Windows system of drag-and-release of a window side or
corner.

Active Window & Field
An active window has a blue border, whereas an inactive window has a beige border. When
multiple windows are displayed, clicking on a window you want to use makes it the active
window and changes its border color to indicate its active status.

Program Editor

File Ed’:

= View Motes

Avaifable

! Isor Motes

Program Mame _ |g1 agn e

Similarly, the border around each field indicates its selection status: selected/active or
unselected/inactive. A selected field is indicated by a heavy black line emphasizing its border.

selected unselected

Y] 0.858 in Y| 0,658 in
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Pane

5/18/18

A pane is an area within a window that contains a group of related data; all objects within a
pane apply to the same subject. Each pane has a title to indicate its purpose. Panes can be
grouped within a pane, as illustrated in the right hand half of the window shown below.

Figure 1: Pane - each shaded area indicates a different pane.
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Selectable Panels

Selectable panels are used to organize and present subsets of related fields when their

Getting Started

volume would otherwise exceed the limitations of a single window. A pull-down menu of the

panel choices displays when you click on the Panel Selection button.

For example, a set of selectable panels (refer to item D in the following image) is available
from the Program Detail window.

In the example shown below, clicking on the Panel Selection button (A) and selecting the

Dispense choice from the pull- down menu (B) has displayed the Dispense panel within the
Program Detail window. Clicking on the Panel Selection button again and selecting a different

panel choice would replace the Dispense panel with the newly selected panel (C).

® Panel Selection button
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000w | FEWIEH

# (260 GrapOfZ

AFET N
{ (L=
® (0% SmAl ¥ | 0000 verchy
T -+ BT et
- . Appiach = o000 3 i it
= |"""""'"" elechy = Dl Trve
# | 150 ansp | DEpETRE = loo0ny  Pinch Delay
w [onms (Ve Y . | A B Sesen
Fug teaa-of
LRl Star T Ll i ED::
® om0 s [OnTime - | w1 [P Daiay
-
| i | aa O
. | L 3;;:‘. B o e
" i shiczn Wiyl @ [oveen o0 FRIESE
. Amapipe acTgleraLon
w (om0  Waheod | = [100,08 | SceleFacter
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Menu Structure

There are only minor functional differences among the various types of menus used in the
FLOware software

Menu Convention
The > symbol is used to identify a sequence of menu selections. For example, the phrase
Utilities > Backup > Data Only replaces the instruction to click on Ultilities, and then from the
resulting menu click on Backup, and then from the resulting menu click on Data Only.

Pull-down Menu
Pull-down or drop-down menus make it easy to find and use program features. To display a
pull-down menu, click on a menu bar item. There may be several layers of pull-down menus.

Litilities |

Notes -
Import/Export -
Management Info -

Backup r Data Only
Restore Backup Application
Copy dbfile to Floppy Fult System
Copy Floppy to dbfila Delete
Darwtoad..
Install Update...

Option Menu
Option menus provide an additional level of menu choices. Option menus display whenever
you click on a button with a small embedded rectangle.

Tye of Tip Flat |
Flat
Conical
Found Tool
Square Tool

Pop-up Menu
Pop-up menus are usually hidden and only pop up when you click the lower right trackball
button at the appropriate screen location. Generally, the only pop-up menu used on the
system will be the |Oviewer menu.
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Tear-off Menu
A tear-off menu is a pull-down, pop-up, or option menu that can be posted as a sub-window
that displays until you close it. Tear-off menus are convenient for menus you use frequently. If
a menu can be torn off, a perforation (perforated line) will show at the top.

Perforation

canrtn) |- _Conyurston oot |

Dispenser Configuration Dispenser Configuration
Option Seltings -v Option Bettings
70 Definitions O Definitions
Custem [0 Definitisns Custom [Q Definltions
Base Locabioms Base Locations
Fixed Locations Fixed Locations

Sarve Configuration

Sarvo Configuration
Print Config Filas
Main Resource File
Editor Resource Fila
Mise Resource File
Tem perature P11

Print Config Files
Main Rasourea Fila
Editor Resourca Fila
Mizo Rasouroa Fila

Tem perature P

To tear off a menu, position the pointer (cursor) on the menu tear line, and then click the
trackball’s lower left button. Move the resulting tear-off window wherever you want on the
screen.

To close a tear-off window, double-click its upper left corner or press the ESC key.
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Buttons

Push Buttons
Push buttons perform a direct action. Each button has a text label corresponding to its
function. Clicking on a push button invokes that function. Both an OK and Cancel button are
typically included on most windows so you can either save changes or you can exit the
window without saving changes. Help buttons are not generally implemented yet.

oK || Cancwl]

Push buttons that appear as small triangles (see below at left) generate pull-down menus.
Push buttons with a small embedded rectangle (see below at right) generate option menus.

ImportExport & Type of Tip Flat
Management Info
. ak
Baak i
2 B:t:: — Conical
chup Round Tool
Copy dbfile toFloppy oy sycrem Square Tool

Copy Floppyto dbfile e,

Toggle Buttons
Clicking on a toggle button changes its state from on/used to off/unused and vice versa.
Toggle buttons appear in various shapes and colors, with each type having a different

function.
Table 5: Guide to Toggle Buttons
Shape Function On Off

square (small) default status Dark blue Gray

The default value is used. The displayed value is used.
square (large) selection Red, yellow, or green Gray

The corresponding item is The corresponding item is not
diamond option selection used. used.

Used Button - Diamond

A diamond (of any color) determines the active option within a group of options. A diamond-
shaped used button is always located to the left of the item it controls.

Option ON Options OFF

# Printte Disk o Data to Disk -~ Printto Printer
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Used Button - Square

A somewhat larger square of any color other than blue (usually
red, yellow, or green) controls whether or not an item is
selected for use. Except in rare cases, a used button is always Used OFF —s= | White Dat
located to the left of the item it controls.

Used OM —m= B hap On

Location Exception

A used button is usually located to the immediate left of the item it controls, however, in the
rare case when the used button is located to the right of an item, it will be labeled Used.

Lepgh | 2.425 in ™ uses =a— Used ON

Thick | 0,000 in o Used —— Usad OFF

Default Button

Typically, a small blue square controls whether or not the default value of an item is to be
used. A default button can be located either to the right or left of the item it controls.

Auger [ ' '
3m:r:ﬂ[lif'.l.ﬂl i B Default ON —=& | 0,75 nn Start 7
All'é?:r 0,000 = d=— Default OFF —#=d | 0,00 s End Z

*  Turning a default button ON (square turns blue), returns the item to its default value.
+ Entering a value in that same field (square turns gray) automatically changes the state of
the default button to OFF, overriding the default value.

Is it a Default or Used Button?

An item will oftentimes have both a default button and a used button associated with it. Since
both button types are represented by a square shape, note the differences: Default buttons
are smaller in size than Used buttons and are limited to the color blue (when on), whereas
Used buttons (when on) may be any color except blue.

Used button Default button Default button Used button

g

w I Liight on Crark

Light
Level

l/h’lar: val Calfbration W

. 0

Triangle Buttons
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A triangle button indicates that a drop-down list of items is available. You have the choice of
making a selection from this list. For more detail, refer to Iltem List Buttons (pg 2.18).

Foan Humaes | MCOSITXTRISIMIZ @\

Euninient Sonpe. ABR C2|

BNl B E‘O
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Buttons for Teaching Coordinates

Instead of manually entering coordinate values, they can be taught using the MOVE TO and
TEACH buttons. Use the MOVE TO button to move the gantry to the currently entered coordi-
nates and then use the TEACH button to fine tune and re-teach the coordinates.

Typically found in close proximity to each other, the TEACH and MOVE TO buttons appear in
the editor windows (e.g., Program Editor, Fixed Locations Editor, and SubBoard Editor).
Occasionally, the TEACH button appears without a corresponding MOVE TO button.

emfaldor T e eenon &y
| Examples of
- TEACH and MOVE TO Lovatlon Jpecits
e Tioas buttons and their Ko | ONE |:| ] -1 G
fo s
corresponding
. S W Suppress . Dascriptien
Version ALy B coordinate fields
1 Pré-Scai 1 PR | Pause on I Sugpress

Frobes LEge tad Mark: Hada=Lean
" it e el 1
jmmmmmmmmmmm === i 1. <l ' |
‘”“': Buferance Foint  Taach : -;-’;‘ Teach r ] .
- | ¥ i U EE T |._.
& g K| TED : e T T T T e |
— R — # Cown | L
amaal o[ 3,07 n i |"'
i ] Y Couen | n
e - \ _________________ .
X ¥ Gn '
= - oI o
Taach| 'f Space " |

NOTE: When teaching new coordinates, it is recommended that you first install the valve
or tool you will be using during the program run. Teaching coordinates using the actual
valve or tool and mount station position designated for use with the new coordinates will
ensure accuracy and help prevent equipment damage.

TEACH

Clicking on a TEACH button invokes a Jog window so you can locate and align the camera on
the desired visual references. Clicking OK enters the current camera coordinate values in the
coordinate fields that correspond to the TEACH button. Depending on the situation, the
TEACH button may have a set of coordinate fields (X,Y) or only a single coordinate field (X or
Angle) associated with it.

MOVE TO

MOVE TO buttons move the gantry IMMEDIATELY to the coordinates designated in the corre-
sponding coordinate fields. MOVE TO can be used to visually verify previously taught coordi-
nates.

CAUTION The gantry moves IMMEDIATELY to the coordinates designed in the correspond-
ing coordinate fields. MOVE TO can be used to verify previously taught coordinates.

ATTENTION VORSICHT! ATTENZIONE |PRECAUCION
Le portique se déplace | Die bewegliche Portal- | Il gantry si muove | El pértico se desplaza
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Lists

=

When needed, you can make a selection from the list of items presented in the form of a
Select List window. The appearance of each window and the type of control buttons used by
each window may vary somewhat but the basic window function remains the same.

Various features will generate a Select List window. For example, clicking SELECT on the
main button bar allows you to select from a list of program names, or clicking ADD LINE on
Program Detail allows you to select from a list of operation types. A list window will also
appear whenever you click on a triangle button (continue reading for further details).

Mo03: Salect a Frogram .. .
from this List I E44: Select an Operation

fead 1 Hapaat ASET i i & CITCIAD A0
Boad I Ropoat CALIBRATE Foroes a calibratlon during a procoss
Frobe Repeat Test CIRCLE Drasa a circle or an arcay of circles

™|

cur Howes the gantry in a straight line
ftark 2 Aocuracy Moead 2 BELAY Dalays precesding loer a epecilied meaber of mill is
Btart T Bocuracy Hoead ¥ DoT Draws a dot or an array of dots
X Exlis Repeat Test LINE Braws & 1ine or an arcay of 1ines
¥ Axin Repsat Test HOVE Howes the gantery in o stralght @ine
% hxis Rapsat Test HOE ey ontry for dafaults
OFERATE operrates a fisture
FPRETITION Introduces 4 progras and partition defaulta
RECTAMGLE Praws a reckangle or an arcay of rectangles |
BETUP Zats up pallets, standoffs, eote.
OHAPE Introdicos i ahapa
BSO0200 D Bimension: 0.060* X 0,030
AS0402 D Dincnsion: 0.060* X 0,030
ASOEDT D Dimansion: 6. 060" ¥ O.010%
BSOBOS D pimansion: 0,080 ¥ O,050"
B LOKIOHBGR  Dimension: O 080* X 0.0%0" J,
Selecton Selection
|5t.rtzﬁmihd1 | Im Hmmﬂlﬂilrﬂryinluﬁmﬂ.lrm I
| Accop

Class | Cancal| Find | Aegept Canoal Find

Item List Buttons
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A list of items is available to you whenever you see a triangle button. For example, clicking on
the upper triangle button in the window shown below opens a list of part numbers from which
you may make a selection to be entered in the Part Number field. The lower triangle button
opens a list of part numbers. Use the DELETE triangle button to select one or more part
numbers for deletion.

Fnhmincm:zmmuu @
Eruivalent Shape ABR C2 |
| (
T :
it
FLOware Software Guide 2.18



GPD Global® Getting Started

Select List and Multiple Select
The list windows that open as a result of a click on a triangle button come in two basic forms: a
Select List window (use to select a single item), and a Multiple Select window (use to select
any number of items). Note the visual features that will help you distinguish between the single
and multiple list windows - the icons in the upper left corner and the window titles.

3140003502
J14-00041-01
134-00042-35
3350001510
335-00035-12
IRE-000ET-15
J35-0006T-08
335-00083-01
S00--00 1 S0-00
S00-001 67 -00
S00-30157-01
G000 18 -00
TAT-00002 K4
TAT-00002-F%
TAT=p0002 <K l
i

Zelestme 050~ 00009 -0
m Head 1 I IBT-E5-4321

Iw; Class | Coamool]  Fimd | *‘“‘l"i Cancal| AN | Mona |

SHIFT and CTRL Key Usage
Multiple Select windows, in addition to letting you select one, all, or none of the items listed,
also let you select multiple items, either as a group or individually. To select a group of items,
press and hold down the SHIFT key while you click on the first and last items in the group (see
example below at left). To select a collection of individual items, press and hold down the
CTRL key while you click on each of the items you want to select (see example below at right).

Use SHIFT key to select a group Use CTRL key to select individuals

= EG2: Delete Part Mumbars = | EB2: Delate Part Numbers
‘o | b3
[330-00893-01 i ! T =T it
::I!I-IDII:II!-IH T14-00017-08 |
TR~ Q00T 6-0F
2F4-00041-01
134-00042-35
S00-002 48 -00
T4T-00002-F4
TP -00002 -Fd
TAY 000215 = =
T4T-e0002 -FE B 50— QOGN -0
|B50-00009-00 BRT-E5-4321 e
AT -E5-4321 i HOME
tes tesk boot .
MJ tﬂwil| Al | Mane | . -
l.nu-cpls Canoel All Mone
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Sliders: Scales & Scroll Bars

Scales change a value. You can either click and drag the slider bar until the value you want is
displayed or click on the slider bar and then use the left and right arrow keys to move it.

125
J 1
Camera Gain

Scroll bars lets you move through a list when the list is not completely visible due to its length.
Click and drag the Scroll Bar or click on the beginning or end of file buttons until the portion of
the list you wish to see is displayed.

1 PARTITION - ..
? OPERATE Beginning
1 Dot Doe preh  7.198 23,454 of file
4 OFERATE 0,229 1,806
5 rectangle 0,229 1.806
b rectangle 0,229 3,835
7 OPERATE 6.096 12.014 =—Bar
b 240 11.Hbd
9 OPERATE 2.896 12.164
10 pectangle 3,048 12.012
11 OPERATE §.111 373.455 End
12 pectangle #.111 23,455 Df ﬁ[e

" o

Faded Items

Buttons and field labels appear faded when they are unavailable or only partially implemented.
Sometimes these items are unavailable because they do not apply in the current context. They
will appear grayed out (the label will be displayed in a lighter typeface) when they are not
available for selection.

A label will appear faded

20005 PurgeCnTi s :
[ R when it is unavailable

If a button is unavailable,
it will also appear faded

| I Close I Apply | w'liihl P‘um] Sringe] Clean | Halp |

Passwords

5/18/18

The dispenser utilizes an access by function password system. To use the dispenser requires
the entry of a password and a user name. A user must be authorized to access each system
function with a unique, user-defined password before access is allowed. Any combination of
access rights can be assigned to any user name.

Whenever the dispenser is powered on, the default password in effect allows minimal access
(at the Operator level) to the system.
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System-wide Commands

File selection windows can select any file in the system and are widely available throughout
the FLOware software under various file-type-specific titles. VEdit is a text editor that can be
used to edit any file in the system.

* File Selection (pg 2.21)

+ Edit Any File (pg 2.23)
« File Editor (pg 2.24)

*  Online Help (pg 2.24)

File Selection

A file selection window serves to retrieve or send file data by providing a way to find a
particular file and its path. There are numerous file selection windows — they all function the
same way using a basic template of features while serving their various file selection purposes
(to import from, export to, convert to, save to, or load data from a file).

There are several choices to be made during the file selection process. You may choose to
enter the exact path and file name or use the filtering search function provided in the file
selection window. You will also choose the source of the file being selected — a floppy diskette
or the dispenser hard drive.

The window title for each of the file selection windows reflects the type of information the
window filters.

The windows shown below are only examples. The file selection window is entitled Sample
Window, and the Data Import window is used to represent the retrieval/sending window.

Figure 2: The windows shown here are examples only.

File Help |
File to Import The *..." filter button, used on
II various windows, opens a file
selection window.
- Duplicates
4+ Skip Duplicates v~ Replana Munirataz
Fiter | Filter
i . ‘_—- . .
[dosrar Directories

Directories o Flles
[

(S

KLy
HLog. tet

- Files
CHEesSUrces
Enter Program or Shape Hrescurces.b
Names Below (leave empty to .dstrt
imgort all) .kshre

IN'”'“ . licenses .

1

f = = A
|- Selection

e

Begiv import | | dos/d |_ Filter button
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To select afile:

1. Prior to beginning the actual file selection process, load the diskette if the file to be
selected resides on a floppy diskette; otherwise, skip this step if the file to be selected
resides on the dispenser hard drive.

2. Open the retrieval or sending window; that is, open the import, export, convert, save, or
load data window. For purposes of our example, we opened the Data Import window.

3. Click the ... button on the retrieval/sending window (Data Import). The file selection win-
dow (Sample Window) displays.

4. Choose one of the following file selection sources and follow the corresponding directions.
Table 6: Choose a File Selection Sources

Select a file from Additional Criteria Action

dispenser hard drive | Diskette may or may not be present | Click the FILTER button. The system will
in the floppy drive. If present, define | read and display the home/dispenser
file path as described in the follow- | directory.

ing step.
floppy diskettes A diskette was loaded in the floppy | Click the FILTER button. The system will
drive during step 1. read and display the /dos/a directory.

No diskette is present in the floppy | 1. Load the floppy diskette.

drive. 2. Type /dos/al* in the Filter field.

3. Click the FILTER button. The system
will read and display the /dos/a directory.

5. Choose one of the following scenarios and follow the corresponding directions.
Table 7: Path & File Name Scenarios

Path & File Name Action
known 1. Type desired path and file name in the Selection field.
2. Click OK.
unknown 1. Either use the path supplied in the Filter field or, using wild cards, type a partial

path in the Filter field of the general location of the files you want.

2. Click the FILTER button.

3. To change to a different directory, click a directory and click FILTER again.

4. Repeat these steps until you locate the file you want to select.

5. Click on the desired file name. The complete path and file name will display in
the Selection field.

6. Click OK.

The Sample Window closes and the selected path and file name should be displayed in the file
definition field of the retrieval/sending window (Data Import).

Filter Defaults
The default entered by the system when the FILTER button is activated on a file selection
window depends upon whether or not a diskette is present in the floppy drive.

« If adiskette is present in the floppy drive when you click the FILTER button, the system will
enter a default of /dos/a/* in the Filter field.

» If there is no diskette present in the floppy drive and /dos/a/ is specified in the Selection
field when you click the FILTER button, the system will enter a default of /home/dispenser
in the both the Filter and Selection fields.
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Edit Any File

5/18/18

Getting Started

The Edit Any File function, available from the main menu bar under System Functions > Edit
Any File, is used infrequently. For example, it is used if you want to delete a backup;

otherwise, you will not need to use this function unless you are directed to do so by GPD
Global Service personnel.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software opera-
tions. Any non-GPD Global employee who uses this information beyond the stated application
specified by GPD Global Service Department personnel is in danger of causing personal injury

and invalidating their machine warranty.

ATTENTION

Le contenu de cette

WARNUNG

Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA
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File Editor

A file editing utility, VEdit, is provided to edit files in a shell-style window environment. If you
inadvertently open a shell file, close it immediately by simultaneously pressing the ALT and X
keys and then exiting the window without saving.

You should never access the shell environment unless expressly directed to do so by GPD
Global Service personnel. Disregard for this directive can lead to serious complications in
control software operations and invalidate your warranty.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software opera-
tions. Any non-GPD Global employee who uses this information beyond the stated application
specified by GPD Global Service Department personnel is in danger of causing personal injury
and invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE | ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

Exit Shell-Style Windows
Figure 3: Sample of a Shell-style window

VEDIT OHX Ver. 3.2Z2 112606 Copyright (C) 199 Greenview Data, Inc.

033000 Series fApplication Conl iguration

Copyright 1996 (C) Gemweral Prodouction levices

Munplfglals = False

izh: weight & teap rewvert to

Places after the decimal point lFor Englizh lengths and Hetric weights

spengerTygpe = 0

To exit from a shell-style window:

1. Simultaneously press the ALT and X keys.

2. To exit without saving, answer NO to the prompt that appears.

Online Help

The only help button currently active is the one found in the main window menu bar. The
About button displays copyright information as well as the title and version number of the
currently installed control software.
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3  Using FLOware Software

»  Using Existing Programs (pg 3.1)

»  Programming - Basics (pg 3.16)

»  Programming - Keys to Success (pg 3.70)
»  Calibration (pg 3.124)

»  Configuration (pg 3.135)

Using Existing Programs
This section provides details about how to use existing programs.

* Import Data (pg 3.1)
« Convert Data (pg 3.4)

* Export Data (pg 3.9)

*  Optimize a Program (pg 3.11)

* Update a Program (pg 3.12)

« Alter Reference Point & Fiducial Points (pg 3.14)

Import Data

Data import provides the means for importing dispenser programs and operating information
from various external sources.

The import selection function has improved; it is now more flexible and presented in a window
format, it is now faster and provides more selection options for expanded data import results.
Data files used and created by previous versions of Import can be used with this newer
version.

Refer to the Import/Export Data Reference Guide for a complete discussion of data conversion
and related, in-depth details.

File Structure

Information automatically added to the file structure of an export file is added as comments
and can be viewed in an editor if desired.
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Using the Importer

Use the import data feature to import data from a dispenser, a network, or a floppy disk. To
import data:

1. At the main menu bar, click on Utilities > New Import. The Import window displays.
—_,_——

IMPORT SELECTION ‘
ExportFile I?dosﬂ‘a/‘gpdpmgs /
FormatFile [exform y
HName Al HNarme Al Al Al
v v Shapes ~ “# Programs + Management Info - SubTypes

Materials
~ Program Classes .. Operator Notes ~ Error Log
Valves/Tools

~
~ -~ Shape Classes + Material Defaults - Base Info
v

~ ‘ision Classes -+ Fixed Locations -« Base Locations

v v

v oV

<~ -~ Mision Patterns
~ ~ Needles
v v

Cross Reference ~ Universal Options
I Update Duplicate I Replace Duplicate
SelectAllTables|  Reset I R e e e
Import EditNames Deone

2. Inthe Export File field, enter the name of the file containing the data to be imported by
either of the following means:
— Type in the path and name, or
— Click the Export File Name triangle button to select the file path and name. For details
on how to make a selection, refer to File Selection (pg 2.21).

3. The format file is not usually needed, but if it is, it has to be created by the editor (e.g.,
VEdit). The format file lists only the fields (tables) you want to select in the order you want

them to appear in the import file. Refer to the Import/Export Data Reference Guide for fur-
ther details.

In the Format File field, enter the file name of the desired format by either of the following
means:

— Type in the path and name, or
— Click the Format File Name triangle button to select the file path and name.

4. Select any combination of options. Choose whether to import everything or limit selections
imported according to the following choices. Entries can be added to and subtracted from
the list of tables to be imported until you click the IMPORT button.

Table 8: Import Options

To: Do this:

import everything click on SELECT ALL TABLES. Every ALL button will be acti-
vated.

import everything for a particular click the ALL button for the desired table.

table

import some, but not all, available Not implemented yet. Click the NAME button for the desired

items from a table table to invoke a list, then choose names for import from the
list.
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Table 8: Import Options (Continued)

To: Do this:

add additional names Not implemented yet. Click the desired NAME button off and
then on. The complete list of currently selected names for that
table will reappear so additional selections can be made. To
verify that your additions have been added to the import format
file, click EDIT NAMES.

remove names Not implemented yet. Click EDIT NAMES to invoke the list of
currently selected names, then delete any number of names.

reset to the default setting click on RESET. Only the ALL button for Programs will be acti-
vated.

reset an individual ALL button click on the NAME or ALL button to turn it off. This cancels any

selections associated with the button from being included in the
import format file.

5. Click IMPORT to execute file import. A prompt will indicate when importation is complete.
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Convert Data

The data converter is used to import data from various external sources after converting it to a
specific format that meets dispenser requirements. External sources can include pick-and-
place programs, feeder files, and cross references.

NOTE: If import data is already in the proper dispenser format, use the directions for
Import Data (pg 3.1).

Data conversion consists of selecting the type of conversion (based on the machine that
produced the data) and entering information about where the data can be found. The
conversion is then performed and the converted file is imported.

A Generic Example (pg 3.6) is provided, as well as a complete discussion of data conversion
and related, in-depth details, in the Import/Export Data Reference Guide.

Format Requirements
All material to be imported directly into the dispenser must be in a specific format. This format
is very flexible and allows import of as much or as little information as desired.

Convert programs all have the same general command line. These programs create dispenser
data for a cross-reference file, shape names, and dispenser program data as appropriate. If
input data has a separate feeder or component file, this file must be first in the list of files to be
processed.

Formatted material can be created easily with a spreadsheet, by hand, or obtained through
any of several conversion programs. Material can reside in any of the following locations: the
dispenser, a floppy disk in either QNX/UNIX form, or another computer connected to the
dispenser through a network.

Using the Data Converter
Use the Convert Data feature to convert and import data from an 24external source into
dispenser form.

To convert and import data:

1. At the main menu bar, click on Utilities > Import/Export > Convert. The GPD Data Con-
verter window displays.

Incoming IG . l -
Data Type |~¥enerie I 8kip _IReplace _IShapes

Source File I j
Component/Feeder |: y
File (optional) :

Convert | Exit |

2. Click on the INCOMING DATA TYPE button and select the data type to be converted from
the pop-up menu that displays.
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3. Enter the source file path and name in Source File by either of the following means:
— Type in the path and name, or
— Click the Component/Feeder File triangle button to select the file path and name.

4. If applicable, enter the feeder file path and name in Component/Feeder File by either of
the following means:
— Type in the path and name, or
—  Click the Component/Feeder File triangle button to select the file path and name.

5. Select the preferred method of handling duplication by clicking either the Skip or Replace
toggle control.

6. Choose whether or not to generate shapes by enabling or disabling the Shapes toggle
control.

7. Click CONVERT to execute conversion. A prompt will indicate when conversion is com-
plete and the converted file is imported.

Converter Programs
Various conversion programs are available or can be developed for you based on a sample of
a particular format. The following pertains to the generic conversion program; for information
about customized programs, contact the GPD Global Service Department.

Generic Conversion Program Format

The generic conversion program converts special format files designed for easy construction
in a spread sheet, or even in an ordinary editor such as Microsoft editor EDIT. The following
rules apply:

1. The input file(s) consist of a sequence of lines for each dispenser program.
2. Lines are optional and in order of descriptor.

3. Fields in the line are separated by tabs or spaces as follows:

Descriptor XCoord YCoord Angle Text

4. Each line is one of the following:

0 X Y U Program name (U=0 metric, 1 English

1 X Y (Program/Pallet fiducial location)
2 X Y A Subboard name (SubBoard location)

3 X Y (SubBoard fiducial)

6 X Y A Operation (Program operation)
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Table 9: Conversion Lines Types Described

Type 0

Each program is initiated by a type 0 record containing the (X,Y) distances of the refer-
ence point from the lower right corner of the board/pallet, the conversion units, and the
program name. This record can be omitted for the first (or only) program in the file, or
the program name or units/name may be omitted in these circumstances. If data is not
available, (X,Y) is assumed at (0,0); units are assumed metric; and the program name
is the data file name.

Type 1

Type 1 records are optional. If present, they define the relative coordinates of board/
pallet fiducials. Only the first three type 1 records are used.

Type 2

Type 2 records define the position and orientation of sub-boards of a pallet, where the
angle is in degrees and the sub-board name or angle/name may be omitted. If the
angle is omitted, 0 is assumed.

Type 3

Type 3 records are optional. If present, they define the relative coordinates of sub-
board fiducials. They are recognized only if they follow the first type 2 record. Only the
first three type 3 records are used.

Type 6

Type 6 records define the operations to be performed and the position and orientation
of the operation, where the angle is in degrees and the Operation or angle/Operation
may be omitted. If the angle is omitted, 0 is assumed; if the Operation is omitted, DOT
is assumed. These records follow other records for the program and appear in the
order the operations occur. Typically, the operations are shapes. If Shapes are
requested, shape records are generated only for non-primitive operations.

5. CVT generic uses an optional file CVTgeneric.prim if it is present. This file may contain up
to 20 primitive. The first primitive is the default operation type when OpType is omitted.
This file is usually used only for a foreign language.

Generic Example

5/18/18

o oY o NN DNBER PO

1 1 SampleProg
0 Fidl

10 Fid2

10 Fid3

0 0 Subl
10 90 Sub?2

0 180 Sub3
10 270 Sub4

0 0 5/0805
0 90 S/1206
2 180 S/1210

Example Explained

The generic example of data converter shown above will create a program named
SampleProg using English measurements (inch) with a reference point which is ten (10)
inches left and one (1) inch behind the work-area origin. The program will also contain the
following elements:
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The program will have three (3) fiducials:

+ Fid1[0,0]
+ Fid2[0,10]
+ Fid3[10,10]

There will be four (4) sub-boards:

.+ Sub1]0,0,0°]

.+ Sub2[0,10,90°]

.+ Sub3[10,0,180°]
.+ Sub4[10,10,270°]

Each sub-board will dispense the following three shapes with rotation relative to the sub-
board rotation:

. S/0805 [0,0,0°]
. S/1206 [1,0,90°]
.« S/1210[1,2,180°]

Subsections Explained

The same example used on the previous page is shown again here. An explanation of each
subsection (set of lines) follows.

0 10 1 1 SampleProg | -— Program
1 0 Fid1l
1 0 10 Fid?2 ~— Fiducials
1 10 10 Fid3
2 0 0 0 Subl
2 0 10 90 Sub2
5 10 0 180 Sub3 ~§—— Sub-boards
2 10 10 270 Subi4
6 0 0 S/0805
6 0 90 S/1206 ~«—— Program Detail
6 2 180 S/1210
Program

The following portion of the above generic example defines the program to be converted:
0 10 1 1 SampleProg

Field 1: 0 defines a new program line
Field 2: X coordinate of reference point
Field 3: Y coordinate of reference point
Field 4: value 1: defines English units
Field 5: defines the program name
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Fiducials

The following portion defines the fiducials for the program:

0 0 Fidl
0 10 Fid2
10 10 Fid3

Field 1: 1 defines a fiducial line

Field 2: X coordinate of each fiducial point
Field 3: Y coordinate of each fiducial point
Field 4: declares the name of the pattern to use
Sub-boards

The following portion defines the sub-boards of the program:

2 0 0 0 Subl
2 0 10 90 Sub2
2 10 0 180 Sub3
2 10 10 270 Sub4

Field 1: 2 defines a sub-board line

Field 2: X coordinate of reference of each sub-board
Field 3: Y coordinate of reference of each sub-board
Field 4: theta rotation (in degrees) of each sub-board
Field 5: defines the name of the sub-board

Program Detail

The following portion defines the program detail for each sub-board:

6 0 0 0 S/0805
6 1 0 90 S/1206
6 1 2 180 S/1210

Field 1: 6 defines an operation line

Field 2: X coordinate of each operation

Field 3: Y coordinate of each operation

Field 4: theta rotation (in degrees) of each operation
Field 5: declares the name of the operation to use
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Export Data

Export Data exports dispenser programs and operating information in dispenser format,
commonly used for data base and spreadsheet data transfers, to any of the following: file on
the dispenser, network file, or floppy disk.

As of FLOware software version 2.6, the export selection function has been improved and is
now faster, more flexible, and provides more selection options for expanded data export
results. Data files used and created by previous versions of Export can be used with this
newer version.

Transferring Data between Dispensers. Exported files are very useful when transferring
data from one GPD Global dispenser to another. Export files for FLOware software versions
1.9 and earlier can be used to export data from one version of the dispenser software and
import it to another version. Versions 2.0 and later can also do this although some fields may
be lost in the transition.

Refer to the Import/Export Data Reference Guide for a complete discussion of data conversion
and related, in-depth details.

File Structure

As of FLOware software version 2.6, additional information is automatically added to the file
structure of an export file. Each time an export file is created, it will now contain the following
elements for identification purposes:

» the date and time the export was performed,
» the version of FLOware software used to perform the export, and
» the name of the machine where the export was performed.

Using the Exporter

Use the Export Data feature to export data to a dispenser file, a network, or a floppy disk.

To export data:
P E e ]

1. At the main menu bar, click on Utili- EXPORT SELECTION
ties > New Export. The Export win- Export File | /dos/a/gpaprogs A
dow displays. FormatFila [axform W
2. Inthe Export File field, enter the TreaHame 1 Name Al an i

w w - Shapes

name of the file to receive the export v v v Maters
by either of the following means: Vehies ook

~ % Programs « Management Info - SubTypes

~ = Program Classes .- Opesator Notes « Emor Log

: : : e Pt « w Shape Classes ~ Material Defauls -~ Base Inin
— Type in the path and name, or e [ v~ VislonCsses . Fiwdlocaons - Base Locations
— Clle the Export File Name trian- v  + CrossReference w Universal Options
gIe button to select the file path Saloat Al Tables | Sulat All Triss | Rasot| _i Faroo All Finlds
and name. For details on how to
. . Expo Edit Namus Dhone
make a selection, refer to File ] E L

Selection (pg 2.21).

3. The format file is normally created by an editor and lists only the fields (tables) you want to
select in the order you want them to appear in the export file. In the Format File field, enter
the file name of the desired format by either of the following means:

— Type in the path and name, or
— Click the Format File Name triangle button to select the file path and name.
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4. Select any combination of options. Choose whether to export everything or limit selections
exported according to the following choices. Entries can be added to and subtracted from
the list of tables to be exported until you click the EXPORT button.

Table 10: Export Options

To: Do this:

export everything click on SELECT ALL TABLES. Every ALL button will be
activated.

export everything for a particular table click the ALL button for the desired table.

force the creation of all fields click on FORCE ALL FIELDS.

export some, but not all, available items  click the NAME button for the desired table to invoke a list,
from a table then choose names for export.

add additional names click the desired NAME button off and on. The complete

list of currently selected names for that table will reappear
so additional selections an be made. To verify that your
additions have been added to the export format file, click
EDIT NAMES.

remove names click EDIT NAMES to invoke the list of currently selected
names, then delete any number of names.

reset to the default setting click on RESET. Only the ALL button for Programs will be
activated.

reset an individual NAME or ALL button  click on the NAME or ALL button to turn it off. This cancels
any selections associated with the button from being
included in the export format file.

5. Click EXPORT to execute file export. A prompt will indicate when exportation is complete.
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Optimize a Program

The Optimize feature reorganizes the current program to minimize execution time. Typically,
Optimize is used on programs originally optimized for pick-and-place machines.

NOTE: Optimize is not intended for use on programs containing drawing-type operations
such as Move and Arc.

From the Program Editor, click on Utilities > Optimize. The Optimize Current Program window
displays.

Choose optimization options
then click OK.

4 Point to Point ~» Fixed Divisions -~ Floating Square

’*lf)pahma'an Twpe

o

oK | Cancel |

Fastest Program
To obtain the best program execution time, try each optimization option on a copy of your
program and then compare the results.

Shape Optimization

To optimize a shape, create the shape as a program, optimize the program, and then convert
the program to a shape.
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Update a Program

Easily update a program by copying or renaming an existing program before making any
necessary changes to make the new program unique.

Copy Program
The copy program feature enables you to copy the currently selected program or shape and
assign a new name to the copy.

To copy a program or shape:

1. In the Program Editor, select the program to be copied.

2. In the Program Editor menu bar, click on Edit > Copy. An Input Request window displays.

E05: Name for the new Copy

|ﬁ\1ew 3597 |

oK | Cancel |

3. Type the new name to be assigned to the program or shape copy.

4. Click OK. A copy of the selected program or shape is created.

Rename Program
1. In the Program Editor, select the program to be renamed.

2. In the Program Editor menu bar, click on Edit > Rename Program. An Input Request win-
dow displays with the word “New” preceding the name of the selected program.

E01: New Name for the Program

oK | Cancel |

3. Type the new program name.

4. Click OK. The new name is assigned to the selected program.
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Convert Program

Use the Convert feature to perform any of the following conversions while leaving the original
program or shape unaffected:

» convert a shape to a program,
* convert a program to a shape, or
» convert a program to a subboard.

IMPORTANT: Limit your use of program-to-shape conversion to programs containing only a
single partition line because shapes cannot contain multiple partition lines.

To convert a program or shape:

1. From the Program Editor, select the program or shape to be converted.

2. From the Program Editor menu bar, click Edit > Convert... and then select the appropriate
choice:
— Program -> Shape
— Program -> SubBoard
— Shape -> Program

3. Enter a name for the new shape, program, or subboard at the prompt that displays.
Newly converted programs or shapes will display in the list of available programs or

shapes in the Program Editor. Newly converted subboards will display in the list of defined
boards in the SubBoard Editor (pg 5.101).

Refresh Program

5/18/18

Use the Refresh Program function when the list of programs or shapes displayed in the
Available Items panel of the Program Editor might not be accurate. For example, newly
imported programs will not display until Refresh Program is activated.
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Alter Reference Point & Fiducial Points

Changing reference points and making corrections to fiducial points requires an understanding
of the relationship between these two different types of coordinates.

CAUTION: Changing the reference point for an existing program WILL shift dispense place-
ment. Changing fiducial points for an existing program has the same potential; it MAY shift dis-
pense placement.

Relation of Reference Point to Fiducial Points
A reference point and from one to three fiducial points are both used to locate product in
relation to the gantry.

Reference point is measured in relation to the machine, while fiducial points are measured in
relation to the reference point. Other distinguishing characteristics are listed below to illustrate
how the reference point and fiducial points are used together but are, in fact, different.

Table 11: Comparing Characteristics of Reference Point & Fiducial Point

Reference Point Fiducial Point
The Reference Point associ- A Fiducial Point is measured in relation to the Refer-
ates the default with the work ence Point.
area origin point (0,0).
Fiducial points
(baard origing
Product Reference point
(machane origing
Z
(0,0) Fy
-y
The Reference Point is a A Fiducial Point is used to align product with all
product-related point. Every- other product features. Three-point fiducial correc-
thing on the product is mea- tion is used to compensate for product stretch and
sured from the Reference Product rotation. [Further details at Using Multiple Fiducials
Point. (pg 3.37)].
If Reference Point uses the (% +y)
default coordinates (0,0),
then all product values and (0,0)
defaults will have (-x, +y)
coordinates.
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Table 11: Comparing Characteristics of Reference Point & Fiducial Point (Continued)

Reference Point

Fiducial Point

The Reference point is typi-
cally located on the product,

but can be located anywhere Product
on or off the product.

, (-x,+y) | (+x+y)
If the Reference Point uses
coordinates other than the (%, y) (+%,-y)
default, then product value e d %y

and default coordinates will
be defined (as shown here)in
reference to the Reference
Point, wherever it may be
located.

(0,0)

Alternate coordinates are generally used when converting pick-
and-place data or CAD data; data coordinates are all measured
from somewhere; the somewhere coordinates become the Ref-
erence Point.

A Fiducial Point is a mark located on the product.

Fiducial points

(board grigin}
Reference point
(meschine origing

The Reference Point and Fiducial 1 frequently use the same location. This scenario requires Fiducial 1 coordinates of

0,0.
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Programming - Basics

This section provides details about how to use various program creation features. For insight
into how these features work together, refer to the Creating a Basic Program (pg 4.1).

» Dispense Parameters (pg 3.17)

* Main Window (pg 3.23)

*  Program Editor (pg 3.30)

*  Program Detail (pg 3.42)

»  Operator Instructions (pg 3.46)

*  Print a Program (pg 3.47)

*  Programming with Shapes (pg 3.49)
+ Teaching a Pattern (pg 3.61)

»  Setting Up Valves & Tools (pg 3.65)
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Dispense Parameters

This overview of the fundamental dispense parameters for gantry motion and valve control
illustrates how these parameters interrelate with the programming to produce desired
dispense results for a basic dot, rectangle, circle, line, or pillar.

* The terms used in the following samples of dispense operations are defined in Parameter
Definitions (pg 3.19).

* Anunderstanding of the basic Operation Stages (pg 3.20) is also helpful while reviewing
the following samples.

+ Sample Dispense Operations (pg 3.17)

+ What are the Differences between a Line and a Move? (pg 3.21)

Sample Dispense Operations
Each of the following graphics illustrates all of these concepts:

* acomplete dispense operation,

» the three basic stages that comprise each operation,

« the needle movement through time and space involved, and

» the interrelation of the dispense parameters applicable to each step of the operation.

Figure 4: Sample of basic Dot operation

START MIDDLE END
to dispense height dispense time from dispense height
[ 1T 1 1
[mowving to XY} {maving ta £}
.- ™
l I Approach Velocity | '*' l l Past Delay
Miaws Woloity | Settle 2 i Walve Prime i i i |
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1 ] 4

. ]

Mine Selncity

it i 1 ] o o i T

[0 T SeTiie £ diSRense poinT
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Figure 5: Sample of Pillar (tall dot) operation

START END
to dispense haight from di 56 ht
1
- (maving to XY) (meving to Z) e

_,.......----.-.......-..-.
F i ————— T

I|I""lll-uq ................................................ ...‘........._,..._,._..._..______,____.....--mtﬂ.----.--..-.-..-""
fo et Settie 2 dispense posnt
Figure 6: Sample of Connected Move (rectangle, circle, line) operation
START MIDDLE END
to dispense height dispense time from dispense height
I 1 T 1T 1
{moving to XY) {mawing to Z)
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.
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Parameter Definitions

This list of parameter definitions is only a starter kit of the most commonly used dispense
parameters. It is by no means a complete listing of all available dispense parameters.

Move Velocity
Coordinated XYZ axis movement to the next dispense location at Settle Z height.
Typically, the default for system velocity is used for increased production throughput
even though this is a programmable parameter.

Approach Velocity

Speed of needle movement from Settle Z height to Start Z height. Used to minimize
the Z axis from overshooting the Start Z value.

Settle Z

Distance from Start Z at which the needle/gantry settles and then only Z axis motion
begins moving toward the board surface at Approach Velocity. Used to avoid running
the needle into tall board elements. Can be used in conjunction with Snap Off Z to
maintain a high needle height during movement to the next dispense location.

Valve Prime

Time the valve turns on prior to reaching Start Z height. Used to prime the needle tip
with material so material is ready to flow from the tip when the needle reaches Start Z
height.

Start Z

Initial needle height above the substrate surface. This is the starting point for the
program.

Start Z Pause
When the system reaches Start Z height, the valve turns on and pauses for the set
time prior to needle movement. Used to wet material to the substrate surface in order
to prevent voids in the material at the beginning of the dispense.

On Time
(does not apply to Micro-Dot valve) Time the valve is on. Main control of dispensed
volume.

MicroValve Steps
(for Micro-Dot valve) The number of motor counts. Main control of dispensed volume.

Dispense Velocity

Speed at which the needle travels from one location to the next. Dispense Velocity is
the speed between segments of a coordinated move. The move between locations
(dot-to-dot) is controlled by the Move Velocity. Used to achieve smooth, consistent
material flow for line dispenses and area fills.

End Z

Upward dispense motion of only the Z axis above Start Z. Used to create taller dot
profiles (pillars). Also used with Start Delay for puddled or angled (ramped) lines.

Valve Off

The distance before reaching the end of the dispense (End Z) at which the valve turns
off. Used to prevent material tailing by turning the valve off before the dispense is
complete. The final portion of the dispense action relies on dissipation of material
pressure inside the needle.
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Snap Off Z

Distance the needle moves from the last dispense height after dispense is completed.
Used to separate the needle from the material.

Snap Off Velocity
Snap Off Acceleration

Speed at which the needle performs snap off. Used to control material tailing

Pre Snap-Off Delay

Delay time after the dispense that the needle remains at dispense height prior to
performing snap off. Used to allow material to fall away from the needle prior to
leaving the current position.

Post Delay

Delay after Snap Off Z is performed. Used to allow materials to cleanly separate from
the needle before proceeding to the next operation.

In effect as of FLOware software version 2.9.1. All operations using a PostDelay value
greater than zero will await completion of the SnapOffZ motion and then begin the
Post Delay delay. If Post Delay is less than or equal to zero, the wait for motion
complete will not occur.

For FLOware software versions PRIOR to 2.9.1. All operations using a Post Delay
value wait for SnapOffZ position to be achieved before beginning Post Delay time
ONLY when the head type is an Etch, Rout, Dirill, or Pickup tool. All other head types
do not wait for ShapOffZ to be achieved. The Post Delay is the sum of the Pinch Delay
value and the Post Delay value beginning near the beginning of the SnapOffZ motion.
Operation sequence is as follows:

1 - Move to SnapOffZ.

2 - If head type is Etch/Rout/Drill/Pickup, wait for motion complete.

3 - Operate SuckBack, if appropriate.

4 - Delay - PinchDelay (from Mount info).

5 - Delay by one of following (controlled by ValveControlFromDetail):
* PostDelay (from detail line).
* PostDelay (from mount info).

Operation Stages
A dispense operation is always composed of the following three basic stages. See illustrated
examples at Sample Dispense Operations (pg 3.17). For details, refer to Move Controls

(pg 3.45).

5/18/18

Start moving the needle into position and turning on the valve

Middle  performing the dispense function

End turning the valve off and moving the needle to achieve material snap off
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What are the Differences between a Line and a Move?

When it comes to creating a series of lines, is the best tool for the job lines or moves? How do
you choose? The following is a quick guide:

Line is the best tool for Mowve commands are typically the
creating a single line segment. best tool for connecting multiple
line segments in a continuous path.

If Line is used to create this
same path, the head will
ascend at the end of each
segment and descend at the
start of the next segment.

Multiple line segments can then
be grouped in an array.

» Lines (pg 3.21) are simpler to use when you want to create a single motion, single line
segment dispensed in a straight line from point A to point B.

*+ Move Commands (pg 3.22) are the better choice when you want to connect multiple line
segments in a continuous path without raising the head.

Lines

Aline dispense is a single complete dispense motion. A line begins at the coordinate point and
ends at a point you specify in the Size X, Size Y fields. A line automatically turns off the valve
at line completion; (you can override this timing and shut the valve off earlier using the Valve
Off field).

The following is what occurs during a line dispense:

1. The gantry moves over the line coordinates and lowers the head to Settle Z height.

2. At Approach Velocity, the gantry moves down to Start Z height, dispenses to the point
specified in Size X, Size Y, and also to End Z (pg 3.19) height if greater or less than 0.00.

3. Once the gantry reaches the point specified by Size X and Size Y, it shuts off the valve and
snaps off to Snap Off Z height at Snap Off Z Acceleration and Snap Off Velocity.

Figure 7: Sample of a Single Line Segment
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Move Commands

Move commands are used to perform a continuous dispensing motion. The valve can be
turned on and off at any time during any of the intermediate moves.

HINT: Each move command is a single-part operation (Start, Middle, End). When used in
sequence, you can build a connected motion. The sequence of move commands deter-
mines the path and valve behavior that occurs during the continuous motion.

Refer to Move Controls (pg 3.45) for a more in depth discussion of all of the move
operation parameters (Complete, Start, Middle, End, and No Operation).

The following Operation Stages (pg 3.20) help illustrate further differences between Lines
(pg 3.21) and the use of move commands:

1. The beginning - You specify a starting point (point A) set to START using the MOVE
CTRL button.

2. The middle - Then you can add a series of moves, arcs, rectangles, and circles for one
continuous motion that moves to all new coordinate points (point B, C, D, etc.). All of these
intermediate moves are set to MIDDLE using the MOVE CTRL button.

Start Z (pg 3.19) or End Z (pg 3.19) can be used to change Z height during these moves.
Start Z and End Z accomplish the same result when applied to an intermediate operation.

The valve can be set to turn on and off at any time during any of these intermediate
moves. Use the ON/OFF CTRL button to implement these actions.

3. The end - Set the final move to END using the MOVE CTRL button so it will snap off to
Snap Off height and proceed to the next command in the program.
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The main control window displays when the system is ready to run and is the site where all
user interaction with the FLOware control software begins. Whether or not all menu bar and
button bar choices are displayed depends on the current access rights. All choices are
displayed here.

Program Editor lcons
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Main Menu Bar
Each item in the main menu bar has a drop-down menu. Current access rights control which of
the main menu bar items are available for use. Typically, an operator will have access to
Operations and some or all of the Utilities drop-down menu items.

Operations

Utilities

5/18/18

Displays a drop-down menu of basic operations such as Enter a Password (pg 5.13),
Clear a Password (pg 5.13), Material Expiration (Pot Life) (pg 4.59), Shutdown

(pg 2.2) of the system, Boot with Reboot (pg 6.28), exiting the main control window,
and displaying the Icons (pg 3.28) that appear along the bottom edge of the main
control window.

Exit Main should not be used. If this operation is activated inadvertently, restart the
machine to re-display the main window.

Displays a drop-down menu of utility functions. For details about backups, see
Routine Backups (pg 6.13); for data import, export, and conversion topics, see Using
Existing Programs (pg 3.1); for installing and upgrading software, see Installing &
Upgrading Software (pg 6.12); for using a USB device, see USB Port (pg 2.9); and for
data management, see Account Management (pg 6.2).
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Machine Controls

Displays a drop-down menu of manual Machine Controls (pg 7.4) choices which are
not intended for typical customer use.

Calibration
Displays a drop-down menu of Calibration (pg 3.124) choices for conveyor speed and
width, mapping, camera vision, the precision scale, and more.

Configuration

Displays a drop-down menu of Configuration (pg 3.135) choices. Of particular interest
is the Option Settings (pg 3.135) choice; the other choices are not intended for typical
customer use.

System Functions

Displays a drop-down menu of various System Functions (pg 7.7) which are not
intended for typical customer use.

Help

Click on Help > About to determine which version of the FLOware software is currently
installed on the system.

Main Button Bar

CANCEL
Ends program execution. Once a program is canceled, it can only be restarted from
the beginning with the normal Run procedure. Occasionally, a program will not abort
immediately because the current operation has to execute fully.

GO HOME
Moves the gantry quickly out of the way (to coordinates taught during configuration of
base locations).

JOG
Enables manual control of camera/gantry movement and position. Refer to Jogging
the Gantry (pg 2.7).

MOUNT

Opens the Mounts Table (pg 5.57) window in preparation for product to be mounted in
the dispenser manually. On conveyor systems, the lift plate rises to support product.
On stand-alone systems, the board crowders will lock.

PAUSE

Stops the current operation at a convenient place in the program; that is, gantry
motion may not stop immediately after you click PAUSE. This is a non-destructive
command; the system will not stop in the middle of a dispense of any kind. Operations
may be resumed when convenient by clicking the RUN button.

REFRESH
Moves the gantry to the front of the machine (to coordinates taught during configura-
tion of base locations) for easy access to the valves.

RESTART

Functions the same as the RUN button except none of the setup parameters are
changed. RESTART will not prompt for the lifter pins to be repositioned, and, if pallets
or feeders are being used, the program will continue where it left off without resetting
the pallets or feeders (where using the RUN button will start the program at the begin-
ning of the pallet or feeder).
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RUN
Starts the currently selected program in the current program mode after prompting the
operator to calibrate the heads and load the product.

SELECT
Lets you choose a program to run. The dispenser will always run the currently
selected program.

TEST
This button is for software development purposes only.

TWEAKS

Opens the Live Program Adjustment (pg 5.46) window. Intended as an on-the-fly
program adjustment feature for use during program development, Tweaks for Valves/
Tools (pg 3.119) can be used during a program run to adjust machine parameters per
valve mount station. All listed parameters can be changed by a percentage based on
the original program.

Run Controls
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In addition to displaying the name of the currently selected program in Current Selected
Program, the Run Controls panel includes:

Operating Modes

The user can select one of two operating modes, Run mode or Inspect mode; each with a
variety of operation patterns. These modes determine whether the current program runs as
designed or allows for inspection of the program without executing its operations.

NOTE: Mode settings are independent of programs, with the default mode being the mode
of the previously selected program.

Run Mode

The run mode determines how the currently selected program will execute. Of the four
available operation patterns, the Continuous choice is generally used for normal
production patterns and Loop is typically used as a demonstration or test mode.

Table 12: Run Mode Operating Patterns

Pattern Description

Continuous Program execution continues without pause except for required operator
intervention.

Board Processes a subboard on a panel without pause, except for required operator
intervention, and then prompts the operator before processing the next
panel. The operator can either continue with the next subboard or skip it.

Step Processes a single program step and then prompts the operator to continue.

Loop Processes the same board repeatedly without pause except for required
operator intervention.
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The inspect mode determines how the currently selected program will be processed -
either in full or in one of the various inspection modes. This mode is typically used for
Testing & Inspecting (pg 3.117) and visually inspecting program execution.

Table 13: Inspection Mode Operation Patterns

Pattern

Description

Run

The program executes as designed; use for normal activities.

Dry Run

Same as the Run pattern except no head operation or material dispensing
occurs and no movement below the board surface (trace cutting) is made.

Use to research such concerns as whether or not the dispense needle
heights in a program are set properly, or to verify whether or not all pro-
gram locations have been taught.

Inspect

The camera, not the heads, moves to the coordinates of each program line
providing visual inspection of the program. The gantry pauses for a speci-
fied time at each location to allow inspection. To adjust pause duration, use
the Inspection Delay slider.

Use to show the first XY coordinate for the start of a primitive shape and
show that point, and to skip all calculated points and then go to the next
shape.

Full Inspect

Same as the Inspect pattern except the camera moves along the path
intended for the head(s), showing all calculated points.

Use to research such concerns as if the correct locations have been
taught, if the offset dot locations are repeatable, and if the valve moves to
the correct location. To adjust speed, use the Speed During Operations
slider.

Inspection Sliders

In addition to clicking on the desired inspection operation pattern, use the slider bars
(also located in the Inspection Mode panel) to set operation parameters:.

Table 14: Operation Parameters set with Sliders

Slider

Description

Inspection
Delay

Length of time the camera will wait over a coordinate.

Speed During
Operations

The relative speed, either faster or slower than the current setting, at which
the camera moves over moves, fills, lines, and arcs during a Full Inspect.
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Operation States

Operation States control conveyor and camera operations. One or more states can function at
a time. To select an operation state for the camera, alarm, conveyor, printer, etc., click on the
toggle box of each state you wish to activate/disable.

Operation states are independent of program modes, but like program modes, the previously
selected state is the default state; that is, operation states are independent of programs. One
or more states can function at a time. Click on the box of each state you wish to activate.

Vision Display
Displays the camera image whenever the camera is located over a significant feature.
Alarm Off
Toggle control for enabling or preventing the audible alarm from operating. When set
to ON, the alarm will sound under these conditions:

* ahead requires attention,
* amanually mounted item requires attention, or
+ the machine times out.

State Appearance & Behavior

On alarm is on when the Alarm Off toggle box appears gray and raised. When an
alarm condition occurs, the alarm continues beeping until the user either clicks
OK on the message prompt or turns the alarm off.

Off alarm is off when the Alarm Off toggle box appears red and recessed. The alarm
will not beep when an alarm condition occurs. There are no messages that over-
ride the Alarm Off condition.

Silencing the Alarm

To silence a beeping alarm, click Alarm Off and then click it once more to reactivate
the alarm in case an additional alarm condition occurs.

Printer On

Activate this toggle box to use a printer attached to the dispenser parallel port. For
details, refer to Print a Program (pg 3.47). Various other system print controls (such as
Print Scale Values) can also be set to print and then be globally controlled here.

Conveyor Off

Turns on the conveyor belt briefly in order to seat a board against the nest stop pin,
making this a convenient conveyor state control when developing or testing a
program. To use this operation state to emulate a manual dispenser with no conveyor,
see Emulate Stand-Alone Dispenser (pg 3.118).

Stand Alone

Causes the conveyor to ignore upstream and downstream signals, thus requiring
manual product placement and removal, providing a convenient method of conveyor
state control for program development and testing. To use this operation state to
emulate a stand-alone conveyor dispenser or a manual dispenser with no conveyor,
see Emulate Stand-Alone Dispenser (pg 3.118).

Pass Through

Inhibits all machine processes except that of passing product through the machine on
the conveyor. Use this in an inline environment when a product requires no functions
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Ilcons
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from the dispenser but you want to move boards from the upstream unit to the down-
stream unit.

The pass through state controls the program rather than the machine; you can select
and activate a program and the machine will still look for board information but will not
act on it. The board will not be processed but the machine will read SMEMA signals
and operate conveyor width, conveyor pins, board width, and stop pin timing.

To: Do this:

turn ON 1 - In the main button bar, click SELECT and select a program.
2 - Click the Pass Through toggle box to turn ON.
3 - In the main button bar, click RUN.

turn OFF 1 - In the main button bar, click CANCEL.
2 - Click the Pass Through toggle box to turn OFF.

Auto Program

(Also referred to informally as Auto Mode.) Enables a device outside the dispenser,
such as a matrix reader, to scan information, such as a barcode, from incoming
product and then dictate various instructions to the dispenser, such as which program
to run, the number of boards to run before the next program, etc.

Reset Valves
Provides a quick reset of the valve controller for a Micro-Dot valve, causing the
system to recognize the head in cases where the valve is installed on the system after
the system has already been powered on.

Dot Inspect
Not currently functional; it has no effect on anything in either the On or Off state.

Several icons are located in the bottom corners of the main menu window:

Calculator

Double-clicking the calculator icon displays a fully operational, standard X-Windows
feature calculator. Functions can be performed with the trackball or with the keyboard.
To remove the calculator, double-click the button in the upper left corner of the calcu-
lator. To restore the calculator, click on Operations > Calculator.

Clock

The clock icon displays the system date and time. To remove the clock, double-click
the button in the upper left corner of the clock. To restore the clock, click on Opera-
tions > Clock.

Program Editor Icons

The Program Editor icon is displayed as one of two variations. Either the Edit
Programs or Edit Shapes icon will display depending on which selection tool is active
in the Program Detail window. To restore a Program Editor icon, click on Operations >
Edit.
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Status
In addition to displaying the name of the current user and the names of the program, board,
and shape currently being processed, status fields also provide the following data:
Info

Displays information when a process is waiting, such as loading a program, operating
in pass-through mode, or waiting to release the exit board. When in Inspect Mode, the
operation being executed displays.

Pending Operation

Displays the pending operation when a pallet is a fixed location and the pallet needs
to be changed.

Monitor

Data is only displayed in the Monitor field while a program is active. When the
program ends, the Monitor field resets to empty. For details, refer to Monitoring
Program Details (pg 3.138).

Material

When the Material Expiration (Pot Life) (pg 4.59) feature is enabled, this status field
displays and presents either the time remaining for the current material or an indica-
tion that the material is expired. If this feature is disabled, the field does not display.

Cycle Info
Tracks cyclic aspects of a program run. All fields reset to zero when a program run is initiated.

Board Count

The number of boards processed through the dispenser during the current program
run. When applied to pallets, the complete board, not the individual pallets, are
counted.

Avg Board Time

The average time per board spent executing program commands. The first board in a
program typically takes longer to run due to the calibration process that occurs at the
beginning of a program run.

Avg Cycle Time

The average time per board to complete a cycle includes Avg Board Time plus all
other events that occur within the cycle, such as pausing for operator intervention,
waiting for upstream/downstream equipment, etc.

Boards per Hour

The number of boards processed during an hour based on the value of Avg Board
Time.

Elapsed Time
Time elapsed since the current program run began.

Counters
Various types of counters are available - those that increment or decrement, those that test
one counter against another, and those that test a counter against a fixed value. Counter
values display only during a program run when counters are used in the active program.
Counters are added to a program as an OPERATE line with a SubOp. For more details, refer
to Counter Usage (pg 4.55).
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Program Editor

Program Editor provides access to the creation, modification, and selection of programs in
addition to the libraries and tools that directly affect program characteristics.

Using FLOware Software

Elements key to program creation are administered within the Program Editor. While accurate
board information is critical for conveyor operations, using the class filter and shape version
features can simplify your programming efforts; understanding the reference and fiducial
points will help you avoid unexpected dispense results; the touch span feature is useful for
close tolerance dispensing; and bad mark expands your programming strategy options.

To access Program Editor, click on the Program Editor icon on the main control window.
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Menu Bar
Each item in the menu bar has a drop-down menu.
File
Displays a drop-down menu for Print and Exit.
The Print choice prints the currently selected program with the option of reducing
details by category if a printer is attached. Refer to Print a Program (pg 3.47).
The Exit choice, in addition to closing the Program Editor, also deletes the Program
Editor icon from the main control window. Refer to Program Editor Icons (pg 3.28).
Edit
Displays a drop-down menu of tools for copying or renaming an existing program
before making any necessary changes to make the new program unique. Refer to
Update a Program (pg 3.12). Several menu items (Cut, Paste, Clear) are not currently
functional.
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Libraries
Displays a drop-down menu of Libraries (pg 5.1) that pertain to the machine configu-
ration. Each library is accessible with the proper access rights via the Program Editor.
Utilities
Displays a drop-down menu for Optimize which reorganizes the current program to

minimize execution time with either point-to-point, fixed divisions (number of divi-
sions), or a floating square (size of square). Refer to Optimize a Program (pg 3.11).

Program Selection Tools

Edit Programs / Edit Shapes

This toggling selection tool determines whether the Edit Programs version or the Edit
Shapes version of the Program Editor displays. The difference is most noticeable by
which program names display in the Available Items panel.

Available Items panel

The names of the currently available program or shape names as determined by the
program selection tools (Edit Programs, Edit Shapes, and Class Filter) are displayed
here.

Classes
Classes are used to isolate programs for different product lines from each other.

EXAMPLE: For example, when working with product line ABC, you would create a
class of ABC and then assign every shape and vision pattern used in the program-
ming for this product line to the ABC class. One advantage to using classes is the
ability it provides to limit operator access to only those classes of program to which
they need access. Classes also enable program developers working with multiple
products to restrict the display of programs and shapes to only those with which they
are currently working.

CLASS FILTER

Opens the Classes window where you can select a class of program or shape to
display in the Program Editor list of programs. Use class filters to expand or restrict
the combination of program or shape names displayed in the lists of program (or
shape) names you see in the Available Programs window and the Available ltems
panel of the Program Editor window.

The class filter assigned to the current program is both displayed in and entered in the
Class (pg 3.34) field.
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Class filter follows these basic rules:

« Each program can have a single class.
+ Each shape can have a single class.
* A blank is a significant class.
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Class filter can be used to accomplish the following:

» Expand the list of names to include ALL programs (or shapes).

»  Expand or restrict the name list to ANY COMBINATION of programs (or shapes)
you want to display.

* Restrict the list of names to ONLY programs (or shapes) with no class filter.

Display by Class Filter
To determine which programs or shapes display in the Available Items pane:
1 - In Program Editor, click CLASS FILTER. The Classes window displays. lllustrated

here is the selection of only those programs with no class filter plus those with an
Adhesive or Solder paste class filter.

Selected Items Indicate
Classes That Are Displayed

A - component

Adhesive

C -component
GPD Demo

Solder

&I None

OK | Cancel | Help |
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2 - Select each class filter name of the programs or shapes you want displayed. The
selected items will be the ONLY items displayed on ANY list of programs or shapes.

Table 15: Selecting Class Filters

To Select: Do this:
All classes click ALL.
No class click the blank for none.
A single class click on the class you want to select.
A combination of classes hold down <Ctrl> and click each class you
want to select/deselect.
To accept displayed selection as is click CANCEL.

3 - Click OK. Only those programs with a selected class filter will now display.

Assign a Class Filter

To assign a class filter to a program or shape:

1 - In Program Editor, either click on Edit Programs or Edit Shapes (to display pro-
grams or shapes) or else create a program or shape.

2 - Position the cursor so it highlights the program or shape to which you want to
assign a class filter.

3 - Enter a class filter name in the Class field.

NOTE: When adding class names for Shapes only - When you click in the Class field
in the Shapes version of Program Editor, a blank character is automatically entered.
Use the BACKSPACE key to delete this blank character and then enter desired class
name text. Do not use the back arrow key; if you do, the blank character becomes the
last character in the new class name.

4 - Click APPLY EDITS to establish the entry.

5 - As needed, assign a class filter to more programs or shapes by repeating this pro-
cedure.
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Board Information

Board Information is a collection of board reference data and board processing options

located in the Program Editor. While the numerous board processing options are indeed
optional, Reference Point coordinates are essential data for all programs and the board
dimension values directly affect conveyor operations.

5/18/18
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Class
The class filter assigned to the current program is entered and displayed here.
Use class filters to expand or restrict the combination of program or shape names
displayed in the lists of program (or shape) names you see in the Available Programs
window and the Available Items panel of the Program Editor window. For details, refer
to CLASS FILTER (pg 3.31).
Version

Any single character or number value may be entered in the Version field to control
which version of a shape is used by a program. Version provides you with a quick way
to switch between one set of shapes and another, and eliminates having to set up
another program that is a duplicate except for the use of a different shape. Entering a
prefix code in the Version field tells the program to use the shape name with that
version prefix instead of using the shape name actually specified in the program.

For example, suppose you have two processes to run on an identical board. Create a
base program using a “generic” shape of 0805. Before running process A, enter an A
in Version so the system will look in the component library for an A/0805 shape and
use those parameters to complete the process. For the second process, enter an Sin
Version so the system will search the component library for an S/0805 shape and use
those parameters for the process. Using Version allows you to have one base
program and easily change between processes by selecting the process type, i.e., the
version prefix, such as A and S used in the preceding example.

Changing Versions

To change the shape version used by a program:
1 - In the Program Editor, position the cursor so it highlights the current program.
2 - Enter the shape prefix you want used by the program in the Version field.

3 - Click APPLY EDITS to save the entry.
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Board Options

A drop-down menu of options affecting how boards are processed. These options can
be toggled on/off in any combination as needed. When turned on, each option
performs as described in the following table.
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Table 16: Effect of Active Options

Option Results

Skip if No Fiducial | If a fiducial is missing, rather than stopping for operator intervention, the
program will skip the board, subboard, or shape.

Suppress Lifter Suppresses lifter plate operations.

Pre-scan Patterns | Requires a complete vision scan be performed before the program runs.

Pre-scan Probes Requires a complete probe be performed before the program runs.

Point Search Limits the search area for the vision system.

Pause on Bad Mark | Program will pause for operator intervention if a bad mark is detected.

Suppress Hold- Hold-down vacuum on the board will be suppressed.
Down
Double Scan Performs a second fiducial search (thus slowing the fiducial scanning

process). After the standard process of looking for a fiducial and moving
the gantry based on search results is performed, a second fiducial
search is performed and the gantry is again moved if a position correc-
tion is deemed necessary by the second search.

Board Dimensions

The product reference data in Width, Length, and Thick are required by SMEMA and
automatic adjust conveyor systems. Width may be used to set the width of an auto-
matic conveyor; Length is used to improve conveyor operations; and Thick may be
used to adjust camera calibration.

Successful conveyor operations require a value be entered in Length. Length works in
conjunction with conveyor speed to successfully transfer boards between conveyor
stop positions. If the boards have slots or holes, a Length value must be entered in the
currently selected program to successfully convey these types of boards.

* When a value is entered in Length, the software can calculate when to expect the
tail end of the board to pass the sensors.
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* If no value is entered in Length, board detection is limited to the sensors which, if
the boards have slots or holes, might lead to failure to detect board presence.

Reference Point

This is the point upon which all other points in the program are dependent, including
data points on the product and all values and defaults (except those defined as abso-
lute). The reference point is used in conjunction with fiducial points to locate product in
relation to the gantry. The reference point is measured in relation to the machine,
while fiducial points are measured in relation to the reference point.

E IMPORTANT: It is important to teach the reference point prior to teaching the fiducial points or
unexpected fiducial point positions will result.

If the same location is to be used for both the reference point and the first fiducial
point, then a zero value must be entered in the first fiducial coordinates. If you use the
same coordinate values in the first fiducial as are used for the reference point, the
location of the first fiducial will be offset from the reference point by the values entered
in the first fiducial coordinates. For further discussion, refer to Relation of Reference
Point to Fiducial Points (pg 3.14).

Reference point coordinate values are taught in the Program Editor by either entering
the X and Y values manually or using the TEACH button. The MOVE TO button can
then be used to visually verify the taught coordinates; it will move the gantry to the
coordinates designated in the X and Y fields. Refer to Buttons for Teaching Coordi-
nates (pg 2.17) for details.

Description
Up to 250 characters of optional text can be entered in the Description field to describe the
currently selected program or shape.
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Fiducial Points
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Fiducials are product orientation points and their use is optional but recommended for
accuracy. Fiducial point locations must be defined if you want program adjustments to
be made for product orientation. Three-point fiducial point correction is used to
compensate for product stretch and rotation.

Patterns are used to define fiducials on dispensers equipped with automatic vision.
Standard fiducial patterns are supplied, however, custom patterns can be taught. For
details, refer to Patterns Library (pg 5.16).

Current fiducial coordinates display next to the FIDUCIAL X button which, when
clicked, opens the Jog window for teaching fiducial coordinates. Editing fiducial values
is accomplished by clicking the fiducial field and manually entering a new value.
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Rules of Fiducial Use

» Fiducial points can be set up in any order, however, if at least a single fiducial is
defined and Fiducial 1 is left undefined, the program will default to the work area
origin point (0,0) resulting in the use of the same location by both the first fiducial
point and work area origin point.

+ If the first fiducial point is to use a location different than that of the work area ori-
gin point, most commonly referred to as Reference Point, be sure to teach the
Reference Point first; always teach the Reference Point before teaching fiducial
points. For more information about machine and product origin points, refer to
Relation of Reference Point to Fiducial Points (pg 3.14).

Using Multiple Fiducials

When teaching multiple fiducials, you are advised to use the CAD print data diagram
of the product. The XY data from the CAD print represents ideal orientation. Teaching
multiple fiducials with the camera and a sample product can easily lead to skewed
results.
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For the most consistently accurate results, use consecutive fiducial points. For
example, use Fiducial 1 only, or Fiducials 1 and 2, or Fiducials 1 and 2 and 3. Use the
following guide when deciding how many fiducials to define.

Table 17: Three-point Fiducial Point Correction

Define: To adjust for:

1 fiducial (x,y) position only

2 fiducials  (x,y) position, adjust for product rotation, and uniform stretch in (x,y) directions

For example, using 2 fiducials assumes that the product is square but will com-
pensate for rotation.

3 fiducials (x,y) position, adjust for product rotation, and independent stretch in (x,y)
directions

For example, using a 3rd fiducial will compensate for skew (out of parallelism).
If the product is supposed to be square but happens to be a parallelogram, the
system will adjust accordingly.

Bad Marks
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A bad mark is a pattern detected by the vision system at the board or shape level of a
program. When a program executes, the control software searches for the bad mark
pattern prior to searching for fiducials and performing dispense operations. Bad mark
coordinates are relative to the Reference Point (pg 3.36).

A bad mark can be detected at either the board or shape level of a program for a
board or subboard. When detected, a bad mark triggers one of three actions.

Using Bad Marks

When processing palletized (panelized) boards where the bad mark location may vary
from board to board, use shapes with bad marks instead of subboards with bad
marks.

Bad marks can be used during several different programming strategies:

+ To teach or select a pattern for a bad mark, refer to Patterns Library (pg 5.16).

» To teach or select a shape for a bad mark, refer to the step within 3. Teach Pro-
gram Parameters (pg 4.2) that addresses bad marks.

» To teach locations for a bad mark pattern, refer to Jogging the Gantry (pg 2.7).

* To teach the bad mark location on a subboard and select the bad mark pattern to
be used, refer to Subboard Bad Mark (pg 4.39).

» Bad marks can also be used as a process inspection tool. Refer to Inspecting with
Bad Marks (pg 3.104).
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Bad Marks for Programs & Shapes

To teach and edit bad marks for programs and shapes, use the bad mark controls
located in the Fiducial panel of the Program Editor to choose one of three actions:

* process board if a bad mark is present (enter 1 in Flag)

* process board if a bad mark is absent (enter 2 in Flag).

» process board whether or not a bad mark is present - the program ignores the
presence of bad marks (enter 0 in Flag).

Bad Mark contrals - use the
slider in the Fiducials panel
to locate Bad Mark fields
and buttons

Bad Marks for Subboards

To teach and edit a Subboard Bad Mark (pg 4.39), use the controls located in the Bad
Marks panel of the SubBoard Editor window to choose one of three actions:

» skip a board with a bad mark.
* process board if a bad mark is present.
+ process board if a bad mark is absent.
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Touch Span

This feature is particularly helpful when crucial close-tolerance dispensing requires
high precision on non-flat boards. The Touch Span values can change the frequency
of level detects performed on a board by establishing the XY boundary parameters
around the point of the last height sense beyond which the program will perform
another height sense. The Touch Span values then apply to the new height sense
point.

Touch Span for Programs & Shapes

To assign Touch Span boundary parameters:
1 - Select a program in the Program Editor.

2 - In the Fiducials pane, scroll down until the Touch Span parameters are visible.
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3 - Enter a value in X and Y. These values represent the distance you want the dis-
penser to travel in each axis before it performs a board height sense.

4 - Click APPLY EDITS.

Touch Span for Subboards

You can choose whether the touch probe touches down on every subboard or just the
first subboard. Refer to Subboard Touch Probe Frequency (pg 4.40).

Alignment Points

For a program that uses arrays, alignment points can be used as an aid for array-to-
board edge alignment. For details, refer Arrays & Alignment Points (pg 3.99).
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Command Buttons
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ADD ITEM
Begins the process for adding a new program or shape.
DELETE ITEM
Begins the process of deleting the program or shape currently selected.
CLOSE EDITOR
Closes the Program Editor to an icon on the main window.
EDIT DETAIL LINES
Opens Program Detail (pg 5.86). Modify, save, or delete program detail line(s).
VALVE/TOOL MOUNTS
Opens the MOUNT (pg 3.70) version of the Mounts/Material Editor. Used to define the
position and type of valve/tool, material, and needle gauge for each mount position to
be used in the current program (not applicable to shapes).
MODIFY SUB BOARDS

Opens the SubBoard Editor (pg 5.101). Define the location and orientation of each
subboard in a program (not applicable to shapes). Refer also to Creating Subboards
(pg 4.38).

APPLY EDITS

Implements any changes currently displayed in the Program Editor window and any
program line modifications made in the Program Detail window.

MISC PROGRAM SETTINGS

Opens Miscellaneous Program Settings (pg 5.55) for defining and refining program
settings for various purposes, e.g., vision calibration, temperature, pressure, or rota-
tion relative to bad marks.

OPERATOR INSTRUCTIONS

Opens Enter Operator Instructions (pg 5.29) where you can add, modify, or delete
instructions associated with the currently selected program (not applicable to shapes).
These instructions display in the Mounts Table window.
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Program Detail

The user can establish or modify operation parameters of any program line for the currently
selected program using elements in the Program Detail window.

Program detail records describe each operation performed for the program. One record is
required for each operation, although a record may generate multiple operations if it refers to a
shape or defines an array.

To access Program Detail, click on the EDIT DETAIL LINES button in the Program Editor.
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Curt & Copy Shape List Primitive Operations
Clicking the Cut icon or the Copy icon serves to delete or copy the currently selected program
line.

Clicking the ShList icon displays a list of all currently available (non-class filtered) shapes.

IMPORTANT: Use the ShList icon rather than the Shape icon to call a shape for a program.
Using ShList presents you with all the available shapes within the class you have selected. (The
Shape icon is reserved for future use and does not currently function properly.)

The remaining icons (Line, Dot, Move, Arc, Rectangle, Circle, Calibrate, Delay, Operate,

Partition, Shape, None, and Setup) represent primitive operations. Use these to insert a
preprogrammed primitive operation below the currently selected program line.
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Program Lines

Program
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Program
The name of the currently selected program displays here.

Gantry
The gantry identification code for the currently selected program displays here. When
clicked, a menu of gantry choices displays.

Partition
The name of a partition or shape displays here. This field is typically allowed to default
for program lines subsequent to a partition or shape line. For details, refer to Partition
Line (pg 3.90).

program lines
A sequential display of the partition and shape lines comprising the currently selected
program.

ADD LINE
Inserts a new program line below the currently selected one after opening a list of
operation types from which to select for the new program line.

DUP LINE
Duplicates a program line by copying the currently selected program line and then
pasting it directly below the original.

DELETE LINE
Deletes the currently selected program line.

Line Detail

Comment
Text describing the currently selected line for documentation purposes. Often used
when converting pick-and-place data to the dispenser input format.

Operation

Determines which operation is used to perform the current program or shape line.
When clicked, a list of all currently available (non-class filtered) Operations (Primi-
tives) (pg 5.108) displays (unless the currently selected line is a partition line).

Operation may be the name of one of the primitive operations or the name of a shape.
(Prior to using a shape in a program run, the shape must be created.)

Valve/Tool

Dictates which head (valve or tool) will be used during the operation for the current
program line. Typically, a selection for Valve/Tool is made in the partition line with the
Valve/Tool field in all subsequent program detail lines set to default to the partition
line; otherwise, either a head must be selected for each program line or else Valve/
Tool will default to NONE.

Clicking on Valve/Tool opens a list of currently available heads. The name in Valve/
Tool must match the name of the valve/tool in the Mounts/Material Editor-MOUNT
(pg 3.70) library; if it does not, the program will not run. (Prior to using a head in a
program, a valve or tool must be defined.)

Part Number

This is an optional part number of up to 36 characters. This field is usually filled in
when converting pick-and-place data to dispenser input format. The Import Data
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(pg 3.1) feature uses this field to determine the operation type from the cross refer-
ence library.

Clicking on Part Number opens a list of currently available part numbers from which to
choose.

FIND LINE

SubOp

Allows you to find a specific program detail line within the current program by first
jogging the camera over a physical location, and then when FIND LINE is clicked, the
system finds and highlights the program line associated with the point nearest to the
current camera coordinates.

When FIND LINE is used with a program containing subboards, an additional prompt
for subboard selection displays. You can position the camera over a location on ANY
one of the subboards, click FIND LINE, and select a particular subboard from a list of
all subboards in the program. Then the system finds and highlights the program detail
line associated with that particular location in the subboard you selected.

Clicking SubOp opens a list of currently available operation subtypes from which to
choose. The choices displayed are dependent upon the operation used in the Opera-
tion field.

Panel Selection

A pull-down menu of choices, each of which will display a different set of fields in the
Selected Panel (pg 3.45).

Standard Values

X
Y

Theta

Location where the current operation is to occur relative to the board reference point.

Rotation (radians) of the fourth axis for this head.

Object Rotation

Size X
Size Y

Object Rotation is the rotation of a single object about X, Y (as opposed to Rotation
which is used to rotate an entire array). Refer to Rotation Guidelines (pg 3.96).

The X-size and Y-size of a line or rectangle or the start diameters of a circle.

| SizeY @Eﬁandﬂrﬂ
Sze K

End diameter

(X

Fill Spacing
Fill Spacing

5/18/18

For filled features such as circles and rectangles, this field defines spacing between
successive lines of the fill in units of needle diameters. A typical value is 1.5 needle
diameters. The second Fill Spacing field in millimeters is an alternate value to the first
Fill Spacing field in needle diameters.
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Move Controls

Gantry motion and valve control can each be exercised independently for continuous
operation across several program lines with these two move control buttons:

MOVE CTRL enables gantry motion.
ON/OFF CTRL enables valve control.

Each of these buttons provides the ability to perform only a single part (Start, Middle,
or End) of the operation for the current program line. Refer to Move Commands

(pg 3.22) for additional details and Sample Dispense Operations (pg 3.17) for illus-
trated examples.

This control is particularly useful for continuous valve or tool operations. This single
part operation control also allows the preservation of Z coordinates (gantry motion)
through several lines of a program.

Table 18: Move Operation Parameters

Operation

Part Explanation

Complete all three stages of the operation (Start, Middle, and End) are performed.

Start only the start and middle stages are performed. The beginning of an operation
consists of moving to (X, Y) at Move Velocity, then moving downward at
Approach Velocity to Start Z, starting valve operation at the appropriate time.

Middle only the middle stage is performed. The middle stage (the heart of an operation)
is always performed. The middle of an operation consists of activities unique to
the operation, such as the delay for a dot or the fill motion for a rectangle or cir-
cle. Height is unaffected.

End only the middle and end stages are performed. The end of an operation can
ensure the valve is off and perform the snap-off motion to SnapOff Z at SnapOff
Velocity and SnapOff Acceleration.

No behaves the same as Middle.
Operation

Feature ID

Use the feature ID function as an alternative to the default of processing all program
lines. With feature ID, you can define and run a select subset of program lines. A
feature ID can be assigned to any program line; any program line without a feature ID
(a blank) will always run. For details, refer to Feature ID (pg 3.101).

FIND FEATURE

Used to easily locate previously assigned feature IDs within a program. For details,
refer to Finding a Feature ID (pg 3.102).

ENABLED / DISABLED

This toggle button indicates whether or not the currently selected program line will be
used or not. Any program line can be easily enabled or disabled.

Selected Panel
Numerous subsets of related fields are organized into a set of Selectable Panels (pg 2.12).
Click on the Panel Selection button to select and display each panel from a drop-down menu
of choices.
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Operator Instructions

Instructions may be associated with any program and then the system will automatically
present the operator with the instructions just prior to running that program. Optional text
entered in the Enter Operator Instructions pane of the Program Editor displays in the Mounts
Table for the operator to see during the initial step of a program run.

Modify Operator Instructions
To add, change, or delete operator instructions:

1. In the Program Editor, select the program to which you wish to associate operator instruc-

tions text.
2. While still in the Program Editor, click on the OPERATOR INSTRUCTIONS button. The
Enter Operator Instructions window displays.

Cancel| Dalete]

3. Click anywhere in the text pane to activate it and enter or change the text you want asso-
ciated with the currently selected program.

4. Click OK to save your entry or, to delete the text, click DELETE.

View Operator Instructions
Whenever the program to which you have added operator instruction text is run, the operator

instructions will display in the lower portion of the Mounts Table.

\}_‘\,If R35: Prepare and Mount lfems
dedouryt
Fosition ToatVve Aaserial o
[ Operator Instructions
r A velstamdoff Ambocm DEZSF F-] !
[ s | display here when a program
2 |wone [ wome = run is started
] [:-m:ﬂ: |.\'E-\'I‘. [11
Lot |l e ||

I Ealect Foature 102V afation I Sabect Foaturs |Ds 1 Use Trwpalcs

OPERATOR INSTRUCTIONS

Text entered in the Enter Operator Instructicns window for the cummently jcmd
pragram will dipslay here in the Mounts Table window when that same program i run.
'}

Comtinus Alsort
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Print a Program

A program may be printed in full or in part to a printer. The print options available in the Print
Selected Program window allow you to print the currently selected program, optionally
reducing detail with the use of one or more filters.

In order for reports to print, both of these conditions must be met:

* adot matrix printer must be connected to the dispenser via a serial port (on the machine
rear panel or on the dispenser computer) and
» the Printer On (pg 3.27) operation state must be turned on.

To print a selected program:

1. Connect a printer to the dispenser.
2. Open the Program Editor and select the program to be printed.

3. Open the Print Selected Program window by clicking on

File > Print Options. [ Print Selected Program ||

4. Activate one, all, none, or any combination of the reduc- I Reduced Header Info
tion filters. A yellow, pushed-in box indicates an active
(on) filter. A gray, pushed-out box indicates an inactive
(off) filter. An activated reduction filter will print only mini-

[~ Reduced rount Info
_| Reduced Board Info

mally identifiable detail for its section of the report. Com- I” Reduced Program/Shape Info
pare the following sample reports to see what each filter
generates when turned on and off. oK Cancel|  Help

5. Click OK to print the report, or CANCEL to exit without
printing the report.

Sample Reports - Reduced Detail
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The following sample report illustrates the minimally identifiable detail that prints for each print
filter (Header, Mount, Board, and Program/Shape) when Reduced is activated for each filter.
One, none, or any combination of the reduction filters can be activated when generating a
report.

Frogram Hester Typebt .00&85" 2004/11/730 12:21:32 Page 1
MName: Kester Type& .0065" Classet Solder FPaste Version:

Prior scan & probe used for paste @ 18,500 DRH.

Entered By: SERVICE 2002-10~15 12:34:356.458
Changed By: SERVICE 2004-11-30 12:18: 10.790
e e e e FOUINTS v e v e o o
Head AQ: Micro Walwe Material: Hester RZVE NC Typeb
——————————————— BOARDE ————mm—mmmm e
Array: O X O Spacing: ©.0000 in X 0.0000 in Frobe Suppress: N

——————— FARTITION (No Mame) e

Gan SeghNo Operation Coords Angle Array Rot
A I PARTITION ¢ Q.0000, G, 00000 L ]
A 2 OPERATE € 0.1772, 0.1772) 0.0
A 2 DPERATE ¢ 0.0000,  O,0000) O
) 4 DOT ¢ 0.0000, O,0000) Q.0 38 X 37 Q.0
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Sample Report - Full Detail
The following sample report illustrates the full detail that prints for each print filter (Header,
Mount, Board, and Program/Shape) when Reduced is left inactive for each filter. One, none, or
any combination of the reduction filters can be activated when generating a report.

Frogram Kester Typet .00&5" 200411730 13:04:41 Fage 1
Mame: Kester Type& .O0065" Class: Solder Faste Version:
Prior scan & probe used for paste @ 18,500 DPH.
Entered By: SERVICE 2002-10-15 12:34:356.458
Changed By: SERVICE 2004-11-30 13:03:43,018
Reference: ( 00,9265, 0.6205) Board Size: ¢ 32,2500, 5.5000, 0.2500)
Fiducial 1: ¢ 0.0000, 0,0000) Pattern: Setup @ 28X Focus
Fiducial 2: ¢ 0.3543, 0,0000) Pattern: Setup @ 2BY% Focus
Fiducial 3: i ©.3%943, 0.3543) Pattern: Setup @ 26X Focus
Bad Mark (0): ¢ 0.35943, 0.35943 Pattern: NONE
e MOUNTS s

Head a0: Micro VYalve

Feature ID:
#*Battle Z 0.0750 in
#*#Suckback Dead Time 2 ms
*Suckback Reverse Z ms
#Warning Count ZOO0O000000 dots
#Idle Warning 2000000000 secs
#*Standard Accel 130.0 inf=ec/sec
*Btart 7 0.008B0 in

Material: Kester R27E NC Typst

#*5Snap Off Velocity 10.00 in/sec
*Snap Off Acceleration i00.0 in/fs
#f4ir Fressure 17.0 1lb/fsg in
#*0nTime Warning 2000000000 secs
*#Total Time Limit 2000000000 seos

#Yalve Frime 15 ms

On Time 75 ms
#Snap OFff 2 0. 1100 in

#Move Velocity 10.00 infsec
#hpproach Velocity 10.00 infsec

—==—m—————————— BOARDS -—————————————m
Array: 0 X O Spacing: 0.4000 in X Q.0000 in Probe Suppress: N
Fiducial 1: € Q.1000, 0.1000) Fattern: Circle
Fiducial 2: 44,0250, 3.92507 Fattern: Circle
Fiducial 23 C 0.0000,  0,0000) Pattern: NONE
Bad Mark (O): ( 0.0000, O,0000) Pattern: NOME
Mumber: I Name: Board 1 FeraturelD:
Fosition Cin): 0. 0000, 0. Q0003 Angle: 0.0 deg
Number: 2 Name: Board =2 FeaturelD:
Position C(ind: ( =-4.1353, =-0.0042) Angle: 0.0 deg
—mmmeme PARTITION (No Mams) CEs e

Sequence Mumber: 1

Operation:

FARTITION ¢ 3

Coordinates (indz (  O.0000, O, 00001 Ob ject Rotation: 0.0 deg
Head: Micro Walwe 10k Feature ID: Gantry: A
Start I 0.0022 in #Fill Width 0.0000 in
End Z 0.0070 in #Fill Spacing 0.00 Neadle Dias
Valve Prime O ms *8ize X/Start Dia 0.0000 in
Start I Fause 5 ms #Fize Y/End Dia O0.0000 in
*0n Time 50 ms *Move Velocity 20.00 in/sec

Snap Off I 0.1000 in
Valve Off 0.0050 in

Approach Velocity 5.00 infsec
Dispense Velocity 2.00 in/sec

#5cale Factor 1.00 % Maves: MNONE DOnOffs: MONE
Sequence Number: 2 Opweration: OPERATE (PROBE)
Coordinates (in)s ¢ 0.1772, 0.1772) Ob ject Rotation: 0.0 deg
Head: Micra Valve 10k Feature ID: Fantry: A

#5tart I 0.0022 in
#End I L0070 in
#Yalve Prime O ms
#5tart I Pause 3 ms
*#0n Time 50 me

*Snap Off Z 0.1000 in
*alve Off 0.0050 in
#Scale Factor 1.00 %

5/18/18

#Fill Width ©0.0000 in
#Fill Spacing 0.00 Meedle Dias
#8ize X/Start Dia 0.0000 in
#Zize Y/End Dia 0.0000 in
*Mowve Velocity 20.00 in/sec
wapproach Velocity 59.00 indsec
#Digpense Velocity 2.00 in/sec
Moves: NONE OnOffs: NONE
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Programming with Shapes

A shape is a block of program lines that can be referenced with a single line in a program.
Shapes can be extremely useful for eliminating repetitive entry of program parameter defini-
tions and simplifying program creation by enabling you define a package just once as a shape.

Why Use Shapes?

5/18/18

Use shapes to your advantage by defining a package as a shape once, or defining often-used
dispensing properties once, and then using the new shape as often as needed.

Package as a Shape

Rather than recreating all the program lines used to generate a component package each time
it is needed in a program, simplify program creation by teaching a package as a shape and
then reusing the shape every time the package is to appear in a program.

Components may often look alike; they may be packaged the same way. When dispensing
adhesive or solder paste for such components, the component package determines the
pattern of dispensing. A robust library of shapes facilitates program creation.

The component package is also commonly referenced when converting pick-and-place data.
To easily convert pick-and- place data into dispensing data, it is more convenient to define a
package as a shape and use the shape in the dispense program. This replaces repeatedly
having to define the dispense information everywhere the component package is placed in the
program.

Often-Used Dispensing Properties

Rather than re-entering all parameter definitions each time they are needed in a program,
define a set of shapes once — one shape for each dispense pattern — and then refer to the
appropriate shape whenever it is to occur in the program.

Product frequently has multiple components requiring identical dispensing properties. When
manually teaching a program for such a product or when pick-and-place data is unavailable for
a product, use shapes.

Shapes versus Subboards

When dealing with complex programs, shapes are considered easier to work with than
subboards. When using shapes, you retain control over certain aspects of programming such
as defining feature IDs and process sequence. When using subboards, these aspects of
programming are automated and may become viewed less as a benefit and more of a disad-
vantage as the complexity of a program increases.

* Feature ID - shapes allow more control over the naming of a Feature ID. Subboards auto-
matically assign the Feature ID name. If a meaningful feature ID is preferred, such as
matching the Feature ID to a label on a pallet, use shapes rather than subboards.

* Sequence - the sequence in which shapes are processed can be user-defined when
using shapes. Alternatively, if you choose to array subboards, the sequence is automati-
cally generated according to the most efficient single pass; however, automatic sequenc-
ing can be overridden by teaching individual subboard locations.
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» Orientation - when shape orientation varies, either shapes or subboards can be used;
however, many users find it easier to use shapes, especially when shape orientation var-
ies by 180 degrees.

+ Complexity - for more complex programs, users tend toward using shapes since feature
ID and process sequence can be user-defined.

* Touch Probe Action - touch probe action must be programmed to occur when using
shapes. When using subboards, touch probe action occurs automatically for each pallet
unless suppressed.

Shape Library
Shapes are stored in the shape editor, effectively separating them from programs in the
program editor [refer to Edit Programs / Edit Shapes (pg 3.31) for details about editor
versions]. This allows any program to reference any defined shape.

Each shape has a name referenced in a program as if it were an operation type, the same way
as DOT, MOVE, or RECTANGLE are referenced.

Shape Guidelines

All shapes follow these basic guidelines:

* Any shape defined in the shape library can be referenced by any program.

* Any number of shapes can be used multiple times within the same program.

+ Shapes are created, modified, and deleted in the same manner as programs.

+  With the exception of a Partition Line (pg 3.90) and a Shape Partition Line (pg 3.55), any
type of program line, including other shapes and arrays, can be used to define a shape.

« Alist of all available shapes will display in a Select List (pg 5.98) window during program
creation and program editing.

Shape Reference Point
Each shape is an independent program that requires a shape reference point. Each time a
shape is added to a program or to another shape, the shape’s reference point must be taught;
this distinguishes the location of each shape from that of all other uses of the same shape.

Reference Points - Program versus Shape

Because the location of a shape can be relative to multiple programs or shapes, a shape
reference point must be identified (taught) each time a shape is created or edited.

A program reference point, on the other hand, is taught once and preserved by the system.
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Frame of Reference

There are three distinct types of reference point: the work area origin, a program (board)
reference point, and a shape reference point, with each referring to a different frame of

reference or world origin.

A shape reference point is measured in relation to either a parent shape or program, while a
program reference point is always measured in relation to the work area origin.

Figure 8: Each type of reference point has a different world origin.

work area (contains program)  Program (2 shapes) shape 2 simple shapes) shape simple)

work area origin (o4l program reference puint shape reference pu:nt shape reference point

A shape reference point can refer to either a parent shape reference paoint (as with
or a program reference point (as with k

A program reference point alwaysreferstoﬂremtmm‘fqh{asisﬂﬂasemmﬂl,

Figure 9: Relationship of the three different types of reference point.
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Types of Shape Reference Points

Only one type of reference point can be set at a time using the Set Shape Reference Point
(pg 5.100) window: a calculated center, a single point, or a fixed location. Activating any of
these choices deactivates the other two. (Currently, you have two choices: setting a single
point or calculating a center point; the fixed location option is not currently functional.)

Calculated Center
Often used for importing CAD data. Use the calculated center option when:

+ an exactly centered shape reference point is acceptable (calculated at the center
between two points), and

z®
S it o
-9 caleulated point

e
-'_.-'"‘T
A

-

» itis desirable for any rotation command from the program to cause the shape to
rotate about its center.

Retation about
Calculated Center Point

» Calculated Center is also a good choice if shape size exceeds the camera field of
view.

Single Point

Often used to indicate the corner of a shape. Use the single point option when (1) the
shape reference point is a known point or an approximate point is acceptable, and (2)
it is desirable for any rotation command in the program to cause the shape to rotate
about the shape reference point.

Rotation about
Single Point
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The system will prompt for a shape reference point each time a shape is added or edited.
Once taught, the system will maintain the shape reference point data until you exit the shape.

1. Set Shape Reference Point (pg 5.100) displays whenever the system recognizes that a

shape reference point needs to be established. This can occur while you are looking at a
point using a MOVE TO button, teaching a point using a TEACH button, or searching for
fiducials using the FIND FIDUCIALS button.

You must set the reference point
before teaching any points for this shape.

— Calculated Center

First Point

[~ Calculate Center Point

— Set Single Point

| et Point

| Set Reference Point

Seoond Point

Show Polnt

— Fixed Location

1 Use Fixed Location

None ﬂ
ShowPoint

{lons

Cancel

Help |

2. Identify a common feature within the shape that can be used as the shape reference point,

assuming a shape is to be used multiple times in a program.

NOTE: The feature you choose must be present at the same location within the shape for
each occurrence of the shape.

3. Decide which of the Types of Shape Reference Points (pg 3.52) you want to use to refer to
the chosen feature that is to become the reference point and follow the associated instruc-
tions:

Set Single Point

a.

b.
c.
d

been taught.

To set a Single Point (pg 3.52), click Set Reference Point.
Click SET POINT. Jog (J04) displays.

Jog the gantry to the desired location and click CLOSE.
Set Shape Reference Point re-displays. Click DONE. The shape reference point has

& CAUTION: The gantry may move when you click DONE.

e.

5/18/18

Jog re-displays, returning you to what you were doing (looking at or teaching a point,

or searching for a fiducial) prior to the process of teaching a shape reference point.

Click CLOSE.
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Calculated Center Point

a. To set a Calculated Center (pg 3.52) point, click Calculate Center Point.

b. Click FIRST POINT. Jog (JOO) displays.

c. Jog the gantry to the first desired location and then click CLOSE. Set Shape Refer-
ence Point re-displays.

d. Click SECOND POINT. Jog (J00) displays again.

e. Jog the gantry to the second desired location and then click CLOSE. Set Shape Ref-
erence Point re-displays.

f. Click SHOW POINT. The system calculates and moves to the center point between
the first and second points. Jog (J0O) displays again.

IMPORTANT: Do not skip the SHOW POINT step or else the final shape reference point will
use SECOND POINT coordinates.

g. Visually verify that the calculated center point meets expectations, and then click
CLOSE.

h. Set Shape Reference Point re-displays. Click DONE. The shape reference point has
been taught.

& CAUTION: The gantry may move when you click DONE.

i. Jog re-displays, returning you to what you were doing (looking at or teaching a point,
or searching for a fiducial) prior to the process of teaching a shape reference point.
Click CLOSE.

4. Enter either a description or the coordinates for the shape reference point in the Descrip-
tion (pg 3.36) field of the Program Editor.

IMPORTANT: Because the system prompts for the shape reference point each time a shape is

& added or edited, you should keep a record of the location. The Description field in Program Edi-
tor is the only place where this information is kept and you must enter it manually; it will not be
entered automatically for you.

Change a Shape Reference Point

A shape reference point can be changed at any time.
To change an established shape reference point:

1. In the Edit Shapes version of the Program Editor, highlight a random shape, then highlight
the shape to be modified.

2. In the Fiducials panel, click MOVE TO for Fiducial 1. Set Shape Reference Point
(pg 5.100) displays.

3. Perform Step 3 through Step 4 of Teach a Shape Reference Point (pg 3.53) to teach and
record new coordinates for the shape reference point.
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Shape Partition Line
The main difference between a shape partition line and a standard Partition Line (pg 3.90) is
that a shape partition line is used within a shape and can be used only once. It displays as
Shape and is the first line in the shape program.

All Gantries — | 4 I"-aI‘titiOl"II

1 SHAPE

2 DOT 0.00

Shape Name Default
Assuming all levels are fully defaulted, a shape partition defaults not to the 72 PARTITION line
of the ..Default.. Program (pg 3.92), but to the 13 SHAPE detail line (as illustrated in Figure 15
on page 3-92).

Pre-Programmed Shapes
In addition to any custom shapes created by the user, a set of unalterable, preprogrammed
shapes reside in the shape library for use as initial building blocks.

Icons (pg 3.42) across the top of the Program Detail window provide a shortcut to each of
these unalterable shapes.

cENCEREEEEEEEREEF

ol

Curt & Copy Shape List Primitive Operations

Custom Shapes
When you need a shape that differs from the Pre-Programmed Shapes (pg 3.55), you can
Create a Custom Shape (pg 3.55) and then Add a Custom Shape to a Program (pg 3.58).

Create a Custom Shape

The following instructions guide you through the process of creating a custom shape and
saving it to the shape library. A custom shape named Socket is used as an example and the
following assumptions are made:

Assumption 1
We will be creating a shape name of Socket.

Assumption 2

Socket represents a chip socket pattern with a form where x marks the center of the package
and the dots are dispense points spaced 0.3” vertically and 0.1” horizontally. It will look like
this figure:

X
L B N NN
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Assumption 3
The program lines that will define Socket can look like either of the following sets of defined

parameters:
METHOD A METHOD B
Operation X Y Operation X ¥: XCoumt YCount XSpace Y ipace
0oT -0.3 -0.15 T -0.3 -0.15 1 z
DoT -0.2 ~p.15
DoT -0.1 ~0.15
por 0.0 -0.15
DoT 0.1 -0.15
DoT 0.2 =.15
DoT .3 =0.15
DoT 0.3 0.15%
DoT 0.2 0.15%
DoT 0.1 0.15
ooT 0.0 0.15
DoT -0.1 0.15
poT -0.2 0.15%
DoT -0. 0.15

To create a shape (based on the above assumptions):

1. In the Program Editor, select the Edit Shapes option.

el

| Veskn|| Mﬂ

el 0,00 dag

:l"r.l-‘[' AT o - :-|: ALY |
el
‘Hﬂ| AT fn L 'r'| m L I

2. When creating a shape, you can either type in a shape program name or select a shape
from the shapes library. For purposes of this example, click ADD ITEM, type in the name
Socket, and click OK. The SOCKET name displays.

Fle o Libvarios Diitkes el |
Avwide b frmr Program i Thaye Havwiee
e —

L. o Dl Fillae |

¥ Programs  Shapes m:’ ik ﬂbﬂﬁ

o o |

'::‘...Iu:l:?. Vi A pprwwwen far | Taach Mo s
c:ﬂﬂ-ﬂ.  TETE | 0,00 deg
—— vEE mm |
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3. When creating a shape for a real program, you would now define the optional program
description in the Description pane and the optional fiducial point(s) in the Fiducials pane.

e R o s e | Rt
%.n’!-]],]._:-l_n lwl — :lr-w.-Tv-ﬁ A’ Toack | Y ‘.
R — '_-“"| o in .r.l' g ' Find

1 Hﬁaﬁ;::-:h-lﬁ-h For nutarial,

Fec 1 5[0, 0 | ¥ om0 - [T i
iner  Patem el I
TR | G e e

| Pﬂ.n-ﬂ

[Fcial 3 =} 0.0 10 | ¥ vam |

4. Create shape details by adding program lines and establishing the parameters for each

new line:
a. Click on EDIT DETAIL LINES to open the Program Detail window.

b. Click on ADD LINE.
Select an existing shape from Operation — use DOT for our example — and then click

* AGCEPT
IEI %!ﬂ!@@@'!@@'@'
-|r,.:r'“

Prwin-;l:-: |
o e
@ [ m_l mmm___l
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d. Modify the parameters, as needed, for the new program line. For our example, make
the appropriate entries in X, Y, etc., as shown in Assumption 3 (pg 3.56). To access
the X Count, Y Count, X Space, and Y Space fields, select the Array & Track option
from the Panel Selection option menu.

e. Continue adding new program lines and entering parameter values as needed. For
our example, this step is unnecessary if you chose to enter a single program line like
Method B shown in Assumption 3 (pg 3.56).

5. Save the program by clicking APPLY and then exit Program Detail by clicking DONE.

Add a Custom Shape to a Program

The following instructions guide you through the process of using an existing shape in a
program. For the following example, we will use the shape created in Create a Custom Shape
(pg 3.55) and the following assumptions:

Assumption 1
We will use a single shape to create several chip socket shapes on a board. It will look like this

LR NN N NN
X
LR N N BN N N

L B N N NN LI T T
x x

LR L N N LU R B

Assumption 2
The program lines will be based on the Socket program created in Create a Custom Shape
(pg 3.55). The program will look like this:

Chject
Operation X Y Rotation  Oin Time
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Assumption 3
The new program will dispense a set of shapes that looks like the figure below and where:

A = is the set of 14 dots centered at coordinates (1.0,1.0).

B = is another set of 14 dots centered (1.0,2.0) but rotated 90 degree, i.e. the socket image is
vertically oriented.

C =is a third set of 14 dots centered at (2.0,1.0). The dots in the first two socket shapes, A and
B, will be larger than those in socket shape C as a result of the different On Time values (35
ms for the first two shapes, and 25 ms for the third).
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To add an existing shape to a program (based on the above assumptions):

1. In the Program Editor, select the EDIT PROGRAMS option.
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2. Select the program to which you want to add a shape, then click EDIT DETAIL LINES to
open Program Detail.

3. To add new program lines using an established shape and then enter parameters for each
new program line:
a. Highlight the program line that will precede your new program line and then click ADD
LINE. A new program line is added to the program.
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Select an existing shape from Operation — choose SOCKET, the shape created in
Create a Custom Shape (pg 3.55) — and then click ACCEPT.
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Modify the parameters, as needed, for the new program line. For our example, enter
values for X, Y, Object Rotation (pg 3.44), and On Time as shown in Assumption 2

(pg 3.58).

Some fields will only display if you select the Dispense option from the Panel Selec-
tion option menu.line.
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NOTE: By overriding the On Time value for the third usage of Socket, the dot size is
changed to meet the description in Assumption 3 (pg 3.59).

d. Continue adding new program lines and entering parameter values as needed. For

our example, this means creating the second and third SOCKET program lines as
shown in Assumption 2 (pg 3.58).

4, Save the program and exit Program Detail by first clicking APPLY and then DONE.
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Teaching a Pattern

Create or modify vision patterns used during fiducial or bad mark pattern recognition by the
(optional) automatic vision system to locate a product and adjust for its orientation. For details
about pattern usage and management, refer to Patterns Library (pg 5.16).
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To create a new pattern:

Using FLOware Software

1. From the Program Editor menu bar, click on Libraries > Patterns. Pattern Trainer displays.

2. Either type a name of up to 36 characters in the Pattern Name field, or select an existing

pattern similar to the one you want to create by clicking the W button next to the Pattern
Name field and typing the new name in the Pattern Name field. When teaching a new pat-

tern, you must enter an original name.
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3. Class Filter

(Optional) To assign a class filter, either the name of a new or existing class filter in the
Class field. For details, refer to Assign a Class Filter (pg 3.33).

4. In most cases, you may use the default parameters that display. To do so, click OK and
skip to Set Camera Thresholds (pg 3.62); otherwise, continue with the following steps.

5. lllumination Color & Axis

If optional illumination hardware is installed, click the LIGHT COLOR button and select the

illumination color or axis that applies.

6. Multiple Cameras

If multiple cameras are installed, click the CAMERA button and select the number of the

camera that will be used to search for the new pattern.

FLOware Software Guide
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7. Adjust Camera Focus
If the camera is out of focus, adjust the focus per the following procedure; otherwise, skip
to the next step.

a.

If the dispenser is configured with a lifter plate, verify that the lifter plate is in the UP
position prior to performing the camera focusing steps. For instructions on how to
raise the lifter plate, refer to the Lifter Controls under Machine Controls in the Operat-
ing Detail section of the Dispenser Operator Guide.

Jog the camera so the cross hairs in the Pattern Window align over the image you
wish to teach as a pattern.

As necessary, adjust Focus, Zoom, f-stop, Lighting Level, and Lighting Color in the
Live Video Parameters window. For details about these elements, refer to Lens Focus

(pg 3.76).

8. Set Camera Thresholds
Set the Confusion Threshold and Acceptance Threshold as needed, or use the existing
threshold settings as a starting place. Both thresholds affect search speed and the suc-
cess rate of finding the trained pattern.

9. Pattern Parameters
To train pattern parameters:

a.

Define the Pattern Window area by clicking and dragging the horizontal and vertical

Pattern Window slider bars. Everything displayed inside the defined Pattern Window
is considered the pattern being taught. Include the complete image plus any distinc-
tive features in the vicinity. A more distinct pattern will be easier to find.

Capture the complete shape image and a generous area around it. Capturing approx-
imately 1/4 of the total Camera View panel will help decrease search time. A relatively
small pattern will require increased search time.

Pattern window

Vertical slider

Horizontal slider

b. Click the TRAIN button to teach the Pattern Window. Wait for the clock cursor to dis-
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appear.
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10. Examine the Pattern
Examine the pattern for distinctive details:

a. Click the DISPLAY button. The currently selected image is magnified (in a frozen
image mode). The position of the displayed image in the Camera View panel is arbi-
trary with respect to the cross hairs that cross at the midpoint of the trained pattern.

[ Camera.

Magnified image

b. Return to live video mode by clicking the LIVE toggle button or click within the Camera
View panel.

11. Test Pattern
To test the pattern:

a. Click the TEST button. The automatic vision system searches for the pattern and dis-
plays an Acceptance score. Acceptance% is the percentage of match between the
pattern taught and the pattern found. Times ms is the length of time the vision system
takes to find the pattern.

b. Jog the gantry away from the image coordinates while keeping the complete pattern
within the field of view of the Camera View panel.

c. Click TEST again and take note of the acceptance value test results.

d. Repeat the test process two or three times, moving the gantry to a different position
each time. Take note of the acceptance values each time you click TEST.

12. Adjust Threshold Settings
Adjust the threshold settings based on the test score results. The following settings are ini-
tial recommendations only.
a. Calculate the Acceptance Threshold (AT) setting:
ACCEPTANCE - 10 = AT

where ACCEPTANCE is the lowest score gathered during Adjust Threshold Set-
tings (pg 3.63) and AT is Acceptance Threshold.

b. Calculate the Confusion Threshold setting:
AT+10=CT

where AT is Acceptance Threshold and CT is Confusion Threshold.
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13. Save Pattern
To save the trained pattern parameters, click SAVE to save the parameters, and then click
CLOSE to exit the Pattern Trainer.
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Setting Up Valves & Tools

Even though the same basic process can be used to set up most valves and tools, some
specific parameter differences can impact the performance of each head.

Valve data must be defined before working with program lines or program parameters
because the program must know which valve or tool to use, plus these factors determine
some of the default values used by the program.

Micro-Dot Valve Setup
To set up a Micro-Dot valve in a program:

1. Install a Micro-Dot valve on the dispenser in the desired mount position.

2. Make selections and entries for the Micro-Dot valve in the Valve/Tool Editor:
a. In the Program Editor menu bar, click on Libraries > Head to open the Valve/Tool Edi-
tor window.
b. Either select an existing Micro-Dot valve from the Valve/Tool Name field or create a
new valve record.
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c. Select the MicroValve choice from the Type option menu.

d. Enter a value in the MicroValve Velocity field. Both the type of material and needle
gauge to be used will factor into the value you choose to enter here.

e. To save your entries, click APPLY and then CLOSE.

3. Add Micro-Dot valve parameters to a program or shape:
a. In the Program Editor, select the program to which you want to the Micro-Dot valve
added.
b. Click on EDIT DETAIL LINES to open the Program Detail window.
c. Ifthe Micro Valve Steps field is not already visible, select the Dispense choice from the
Panel Selection option menu.
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d. Enter a value in the Micro Valve Steps field based on one of the following choices:
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If dispensing: The value in Micro Valve Steps will control:
Dots Dispense shot size. This value determines how long the
valve will remain on during dot dispense.
Any shape other Length of time required by the program to dispense the
than dots shape.

e. To save entries, click APPLY and then click DONE to exit the window.

Auger Valve Setup
To set up a variable speed auger valve in a program:

1. Install a variable speed auger valve on the dispenser in the desired mount position.

2. Make selections and entries for the auger valve in the Valve/Tool Editor:
a. Inthe Program Editor menu bar, click on Libraries > Head to open the Valve/Tool Edi-

tor window.
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b. Select an existing auger valve from the Valve/Tool Name field or else create a new

e.

valve record.
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Select the Variable Auger choice from the Type option menu.

NOTE: Be sure to choose Variable Auger and not Auger or else the variable speed
auger valve will not function.

Enter a value in the Valve Speed and Valve Ramp fields. Both the type of material and
needle gauge to be used will factor into the value you choose to enter here. If these
values are set too low for the material being used, the valve will stall.

To save your entries, click APPLY and then CLOSE.

Pressure Sense Tool Setup
To set up a Pressure Sense tool in a program:

1.

Install a Pressure Sense tool on the dispenser.

2. Make selections and entries for the Pressure Sense tool in the Valve/Tool Editor:

5/18/18

a.

b.

In the Program Editor menu bar, click on Libraries > Head to open the Valve/Tool Edi-
tor window.

Select an existing Pressure Sense tool from the Valve/Tool Name field or else create a
new tool record.

SUGGESTION: Set up a new tool record (with tool name, pressure, etc.) for each dif-
ferent pressure value you will be using. This will help prevent damaging the tool as a
result of inadvertently running operations not meant for that particular tool. For exam-
ple, set up one tool named 2.5 kg Tool with an assigned value of 2500 grams seating
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C.

e.

a.

b.
c.

Using FLOware Software

pressure, and a different tool named 3.0 kg Tool with an assigned value of 3000

grams seating pressure.
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Select the Pickup choice from the Type option menu.
d. Enter a value in the Seating Force field.
To save your entries, click APPLY and then CLOSE.

3. Add Pressure Sense tool parameters to a program or shape:
In the Program Editor, select the program to which you want the Pressure Sense tool

added.

Click on EDIT DETAIL LINES to open the Program Detail window.

Create an OPERATE program line to seat a part by first highlighting the program line
that will precede your new program line and clicking ADD LINE. A new program line is
added to the program. Then select the OPERATE choice from the Operation option

menu.
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d. Select the PRESS choice from the SubOp option menu.

e. Ifthe Operation Time field is not already visible, select the Operate choice from the
Panel Selection option menu.

f.  Enter a value in the Operation Time field for the desired length of press time. Press

time begins when the Pressure Sense tool achieves the Seating Force value (previ-

ously entered in the Valve/Tool Editor). Tool descent time is not factored into press

time and the tool will retract automatically (Snap Off Z in the Dispense panel) when

the Operation Time value expires.

Teach the X and Y coordinates for the new program line.

To save your entries, click APPLY and then DONE to exit the window.

J@

Monitoring Pressure Data

The amount of pressure exerted by the Pressure Sense tool can be monitored as it continu-
ously displays in the Monitor field on the main window. For details, refer to Monitoring Program

Details (pg 3.138).
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Programming - Keys to Success

Topics important to your programming success are included in this section.

+  MOUNT (pg 3.70)

+ Material Parameters (pg 3.72)

» Vision Lighting & Focus (pg 3.73)

*  Operations (pg 3.85)

+ Defaults (pg 3.88)

+ Arrays & Alignment Points (pg 3.99)
» Feature ID (pg 3.101)

+  Process Inspection Tools (pg 3.104)
+ Testing & Inspecting (pg 3.117)

+  Tweaks for Valves/Tools (pg 3.119)
+  Conveyor Auto-Width (pg 3.123)

MOUNT

Values displayed in Mounts/Material Editor - MOUNT are program specific. They define the
following to be used by the selected program:

* head station position,
» type of head (valve or tool), and
* type of material.

MOUNT also performs the critical function of defining the following for a program:

* needle gauge,

» setup parameters for the calibration dot,

»  process parameters (air pressure, etc.)

» settings for vision parameters for inspection mode,
* limit parameters,

+ material weight for scale (if present),

+ valve settings, and

* gantry.
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MOUNT Rules

The following rules apply to all uses of Mount/Material - MOUNT:

* Head and material data must be defined before working with program lines or program
parameters because these factors determine some of the default values used by the pro-
gram.

» Ifa program uses valve/tools in multiple mount positions (for example: Head 1 to dispense
material A and Head 2 to dispense material B), the name for each valve/tool must be
unique.

MOUNT & Defaults

Location

5/18/18

Parameters set to default in Mount/Material Editor - MOUNT are operating at the program
level and default to Mount/Material Editor - MATERIAL. So, when a material is selected using
Mount/Material - MOUNT, all the parameter, setup, and valve information associated with that
material will display in the MOUNT window.

For complete details about the defaulting hierarchy of the Mount/Material Editor windows, refer
to Mounts & Material Defaults (pg 3.93).

of Valve Parameters
Valve control and valve speed parameters are typically controlled from the detail lines of the
program. Alternatively, the level of control can be relocated to Mount/Material - MOUNT.

The valve parameters usually display in the Dispense and Extra Control Selectable Panels
(pg 2.12) of Program Detail, but can be re-configured by GPD Global Service personnel to
display instead in Mount/Material - MOUNT.
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Material Parameters

Material data must be defined before working with program lines or program parameters
because these factors determine some of the default values used by the program.

Using FLOware Software

A set of standard materials and associated parameters are included in the control software.
The material parameters for each material are stored in the Materials Library (pg 5.7).

To view the default parameters associated with any of these materials, open the Mount/
Material Editor MATERIAL window by selecting Libraries > Material from the Program Editor
menu bar, and then select the desired Material ID from the Material field.

Table 19: Examples from Material Library

Material Group

Material ID

Material
Color

Recommended
Valve

Material Info

2-Part

3-M DP 190

Black

MV-50

2-Part / 1-to-1 mix ratio in duo-pack
design cartridge. Very high snap-off
required.

Adhesive

Amicon D124F

Pale Yellow

Auger Valve

Dots have a very rounded profile. For
high speed surface mount adhesive.

Loctite 3106 UV

Clear

Auger Valve @ 75%

UV cure adhesive. Stringy material
requiring higher snap-off heights.

Conductive
Adhesive/Epoxy

Namics H9628D

Silver

Micro Valve 50K

Conductive material that must be kept
at -40 degrees C/F. Excellent material
for small, low profile dots @ high
speed dispense rates.

Dielectric Epoxy

MS (Ablestik 84-3)

White

LX Auger Valve with
Delrin cartridge

Ablestik 84-3. Non-conductive mate-
rial that must be kept at -40 degrees
C/F. Material is discolored with car-
bide; use Delrin/plastic cartridge
assembly.

Damming Mate-
rial

Hysol FP4451

Black

LX Valve

Damming material for use with Hysol
FP4450. Viscosity is too thick for 8-
pitch deep auger. Recommend using
0.125” 16-pitch w/19:1 motor ratio.

Fill Material

Hysol FP4450

Black

Auger Valve with
shutoff

Fill material for use with Hysol
FP4451. Requires shut-off to prevent
needle drip.

RTV Silicone

NuSil MED-2000

Clear

Spool Valve

RTV silicone adhesive. Requires a
high snap-off, slow dispense rate, and
a longer Start Z pause.

Solder Paste

Indium NC-SMQ90

Grey

Micro Valve 20K

Solder paste Type 4 mesh. 86% Metal
Content and No-Clean flux.

None

Vacuum Material

None

Vacuum Tool

This is used to define running parame-
ters for the vacuum tool only; it is not
to be used with dispensing valves.
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Vision Lighting & Focus

Adjust vision lighting and focus as necessary to heighten camera capabilities.

* Lighting Controls
e Lens Focus
*  Automatic Vision System Set Up

Lighting Controls

5/18/18

Defining various elements for the camera such as the level of light intensity, lighting color, and
the type of illumination can heighten camera vision capabilities.

Software lighting controls, available when the dispenser is equipped with the applicable
options, can be found on the following windows: Jog, Lens Adjust, and Pattern Trainer.

Parameters for light level, light color, and type of illumination can be set up for specific
materials in the materials library.

Lighting controls available in the Program Detail window provide the ability to change lighting
parameters either globally (by modifying the partition line) or for a single program line.

Intensity

NOTE: The optional Light Intensity hardware has been discontinued,; the same functions can
now be accomplished using the gain and offset lighting features discussed in Program Set Up

(pg 3.81).

When a machine is equipped with the llluminator Intensity Control option, the intensity of the
light illuminating the camera field of view can be controlled either manually by the operator or
automatically through the software. A specific light level can be defined to enhance fiducial
and pattern identification.

To enter a value for intensity control:

1. From the Program Editor menu bar, click on Libraries > Materials. The Mounts/Material
Editor- MATERIAL window displays.

2. Select the material to which you wish to assign a light level parameter. The material name
should be displayed in the Material field.

3. From the Panel Selector pull-down menu, select XY Calibration. The XY Calibration panel
displays in the right-hand side of the window.

4. Enter desired value in the Light Level field.
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5. Click APPLY to save your entry. You have completed setting a light level for the selected

material.
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Color & Type

You may select the Camera Light Color (pg 3.76) and type of illumination best suited for your

process provided the applicable options are installed on your machine. The selected lighting
elements become associated with a specific fiducial or pattern image within a program.

To enhance fiducial or pattern identification when vision is affected by surface colors or
textures, you may define a specific color (typically red or blue) with the llluminator Intensity
Control option, and a choice of ring light or diffuse on-axis light is available with the Multi-Axis

lllumination option.

To select a color or type of light:

1. From the Program Editor menu bar, click on Libraries > Materials. The Mounts/Material

Editor- MATERIAL window displays.

2. Select the material for which you wish to select a color or type of light. The material name
should be displayed in the Material field.

3. From the Panel Selector pull-down menu, select XY Calibration. The XY Calibration panel
displays in the right-hand side of the window.

4. Click the Light Color DEFAULT button and make desired selection from the pop-up menu.
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5. Click APPLY to save your selection. You have now completed selecting a color and/or

type of light for the selected material.
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Camera Light Color

Use the Dark Field camera light colors with the low angle ring light for improved edge
detection. The Dark Field options (DF Left, DF Right, DF Both) can be used alone or in
conjunction with the overhead lighting options (Red, Blue).

Figure 10: Relative locations of DF Left & DF Right areas of illumination

DF Right

DF Left

To turn off the overhead lighting options, be sure the Light Level field (or slider in the Jog
window) is set to 0%.

Figure 11: Location of camera light color controls
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Lens Focus
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The camera lens focusing instructions differ depending on whether your system uses a fixed,
manually adjusted camera or an automatic, programmable focus camera.

i IMPORTANT Making adjustments to camera focus or lighting conditions may affect all patterns
used by your programs and thus require you to modify your patterns accordingly.

IMPORTANT WICHTIG IMPORTANTE IMPORTANTE
Tout changement de | Jegliche Justierungen Regolazioni al fuoco | Los ajustes al enfoque

Fixed Camera

If your dispenser is configured with a fixed (passive) vision system, use these steps to adjust
the aperture and focus for a manually adjusted camera lens:

1. Jog the camera to a position over the calibration dot on the calibration station.

2. Manually adjust the aperture (f-stop) to wash out unimportant features (paper grain) and
increase contrast. The background should be as white as possible while maintaining dot
blackness. Be sure not to introduce distortion such as blooming (indicates the f-stop is
open too far).
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3. Manually adjust the focus ring so the dot is distinct (black versus white). There should be
no shades of gray between the dot and the background.

Programmable Focus Camera

If your dispenser is configured with an Automatic Vision System, the camera (mounted next to
the heads) works with the vision system to verify product alignment and the XY location of the
valve tip prior to the dispensing process. An automatic vision system locates images automat-
ically as opposed to requiring an operator to manually align the camera over parts. More
specifically, the automatic ClearVu Vision™ system uses a video camera and a programmable
zoom/focus lens.

NOTE: The programmable zoom and focus is specific to a fiducial/pattern image and
program.

The Programmable Focus Lens Camera is a part of the ClearVu
Vision™ option. This automatic vision alignment system
automatically performs the functions of alignment, locating, and
pattern-recognition training with a software-controlled, program-
mable focus lens camera.

This camera must be adjusted through the software - it cannot
be manually adjusted. Lens focus, zoom, and f-stop (camera
iris) adjustments are controlled through the software rather than
by means of mechanical adjustments - refer to Automatic Vision
System Set Up (pg 3.77). Live video provides immediate
feedback as these software camera control adjustments are
made.

ClearViu Vision
Frogrammable Optem Lens

Automatic Vision System Set Up

5/18/18

NOTE: This section applies only to dispensers configured with a ClearVu Vision™
programmable focus camera.

With the (optional) automatic vision feature, there is no need to manually align the camera
during calibration or during a program run. Alignment is performed automatically with no
operator intervention.

The automatic vision feature locates fiducial points by means of a pattern search. The user
teaches a fiducial pattern (model) and stores the pattern for later use in a program (where the
system looks for the fiducial).

During the needle calibration procedure, a dot of material is dispensed on the calibration
station at the dispense pad. In place of manually aligning the camera over the dot, the
automatic vision locates the roundest object on the pad and makes positional adjustments
based on what it finds.

Camera calibration looks at the calibration dot (on the calibration station) from two different
positions. The difference in positions is used to (1) calculate the size and aspect ratio (width to
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height) of the camera pixels, and (2) determine the ratio transformation of the camera pixels to
encode counts.

The following topics are discussed in this section:

+ ClearVu Vision™ Sequence of Operation (pg 3.78)

+ Material Set Up (pg 3.79)

* Program Set Up (pg 3.81)
+ Calibration Chip Use (pg 3.82)

+ Parameters & 1/0Os (pg 3.82)

» Adjust Lens Focus Settings (pg 3.83)

ClearVu Vision™ Sequence of Operation

The following is a typical sequence of events for the ClearVu Vision™ system:

1. The surface sensor probe moves to the touch pad to establish pad height.

2. The camera adjusts to the values set in the Vision Calibration panel [refer to Vision Cali-
bration (pg 3.128)]. If defaulted, the camera uses the settings from the ..Default.. program

[refer to Program Set Up (pg 3.81)].

— Vision Calibration
Gain | 100 E
Offset | 21 L
Tuning | O
30,000 2
Focus|20.000 8 W
f=stop | 0,000 L s
Light Ii
Level| © * g
I Light on Dark =

Light Color Red ~

Teach| FEiiiiE

Vision Jog
o L1

w
Zoom LS

— Temperatures
_I Pre—Heat Heater On m

Pre-Heat
Temperature
Pre—Heat

Range

Pre-Heat PID! el

-

1]

_| Post-Heat Heater On &
Post-Heat
Temperature
Post-Heat
Range

Post-Heat PID -

1]

| Work Area Heater On &
YWaork Area
Temperature
Work Area
Range

Work Area PID Lt

il

-

— Other
Bad hark
Count
Post Press
Post Press
Range

Post Press
Time

o
0000y W
0000y W
00ms W

Done |

Apply |

3. The camera moves to a dot on the calibration station glass chip. The dot selected
depends on the Zoom value and the settings for CamCalZoom1 and CamCalZoom2 [refer
to Configuration Parameters (pg 3.82)].

Example

If CamCalZoom1 = 30 and Zoom < 30, the camera moves to the largest dot for cali-

bration.

If CamCalZoom2 = 60 and Zoom > 30 but < 60, the camera moves to the medium
sized dot for calibration.
If Zoom > 60, the camera moves to the smallest dot for calibration.
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For additional details about proper set up of the camera calibration locations, refer to
Teaching Base Locations in the Dispenser Service Guide.

4. The surface sensor probe touches either the ceramic chip or the paper pad on the calibra-
tion station.

The valve needle moves to the touch pad to establish needle tip height.

The valve purges.

The valve dispenses a dot on the ceramic chip or paper pad.

© N o o

The camera adjusts to the Zoom value of XY_Calibration only if it is different than the
value set in the Vision Calibration panel, and then moves to the glass chip to re-calibrate.

9. The camera adjusts to the focus and light settings of the XY_Calibration and centers on
the dispensed calibration dot to establish the XY coordinate relationship between the cam-
era and needle.

10. The gantry moves to park location for program start.

11. The gantry adjusts to the Zoom value of the pattern used at the first fiducial point, adjusts
the focus and light settings to those defined in the Vision Calibration panel of the Miscella-
neous Program Settings window, and moves to the glass calibration chip to re-calibrate
(only if Zoom value differs).

12. After calibrating, the camera now adjusts to the focus and light settings of the pattern used
at the first fiducial point and finds the point.

13. After finding fiducials and if in Full Inspect mode or Inspect mode, the camera will adjust to
the settings defined in the Observation panel section of the Mounts/Materials Editor win-
dow. IF the zoom is different, it will re-calibrate once again.

Material Set Up

Process cycle time can be greatly reduced if consistent zoom settings are used. To keep
process cycle time to a minimum, use the same zoom and focus settings in all areas where
vision is used:

+ patterns used at fiducial points
* in the program Vision Calibration panel
* in the Materials Library in XY_Calibration settings and Observation settings

The XY_Calibration settings establish the XY relationship between the needle and camera.

The camera uses these settings to view and automatically center on the dispensed calibration
dot located on the ceramic chip or paper pad.
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To set up the material you will be
using in your program in the material
library, set up the XY_Calibration and
Observation settings:

1. From the Program Editor, click on
Libraries > Materials. From the
Panel Selection button, select
XY_Calibration.

2. Click the JOG button, move the
camera over the ceramic chip or
paper pad, and view a dot of the
material that will be used by the
program.

3. Adjust the lighting for a dark dot
on a light background. If the cali-

Using FLOware Software

o) MATERIAL
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bration station back light is used, turn off the top light and turn on the back light before

adjusting Gain and Offset.

IMPORTANT: As much as possible, always teach Zoom and Focus values equal to the Zoom
and Focus Settings used in the Vision Calibration panel.

4. Close the Jog window and click TEACH. This updates the data field settings in the XY_-

Calibration window.

5. In the Observation panel selection area of the Mounts/Material Editor - MATERIALS win-
dow, adjust the camera settings for use when in Inspect mode or Full Inspect mode. Adjust
the camera settings with the camera positioned over the dispense area of your component
and verify that the lifter plate is in its raised position.

IMPORTANT: As much as possible, always teach Zoom and Focus values equal to the Zoom
and Focus Settings used in the Vision Calibration panel.
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Program Set Up

To set up the vision calibration settings properly in the Misc Program Settings panel of the
..Default.. program:

1. Open the Program Editor and highlight the ..Default.. Program (pg 3.92).
2. Click on MISC PROGRAM SETTINGS> JOG.

3. Move the camera over a calibration dot on the glass calibration chip and adjust the zoom
to 100%.

4. Adjust the focus until the image is sharp and clear.

Move the zoom back to 0% and verify that the focus is good throughout the full range of
the zoom. If the zoom is out of focus at 0%, refer to the ADJUST Camera/Lens Alignment
section of the Dispenser Service Guide for setting the camera-to-focus height adjustment.

CRITICAL: Sharp focus throughout the zoom range is critical. When a new zoom value is

& called for, either from the XY _Calibration of the Mounts/Material Editor - MOUNT window or from
a pattern being used at a fiducial point, the camera needs to re-calibrate the pixel-to-gantry
transformation. When doing so, it only adjusts the zoom. The focus, gain, and offset are gath-
ered from the Vision Calibration panel of the Miscellaneous Program Settings window.

6. Adjust the Gain and offset lighting to a level that will maintain a dark dot with a light back-
ground throughout the zoom range. If this is not possible, manually adjust the Iris (f-stop).

Typically, the Iris will need to be opened slightly to allow more light for a brighter image at
100% zoom. This is also critical for the same reason as stated in the prior step. When the
camera comes to calibrate at the glass chip at a new zoom level as called for from either
the XY_Calibration settings or a pattern used at a fiducial point, the Gain, Offset, and
Focus information will be gathered from the Vision Calibration panel. Only the
Zoom will adjust to the new values as called.
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7. When the above-mentioned conditions are met, set the following:
a. SetZoom to 50%
b. Adjust the Gain and Offset for a clear black dot and white background.
c. Set Zoom back to 0%.

8. Close the Jog window and click the TEACH button. This action updates the vision calibra-
tion settings.

IMPORTANT: Zoom is typically taught at 0% or at the typical zoom values used by the pat-
terns; however, it can be taught at a different value of engineer’s preference. Keep in mind that
any new program and any existing program that is defaulted will use the vision settings of the
..Default.. program to calibrate at the glass chip. Again, keeping zoom values consistent is
the key to minimizing re-calibration.

Calibration Chip Use

As the value of zoom increases, the viewing area decreases and the dot size will grow larger.
For this reason, the camera must be able to calibrate on smaller dots at higher zoom levels.
To properly teach the locations of the different calibration dots at higher zoom values, refer to
Teaching Base Locations in the Dispenser Service Guide.

Keep in mind that there are Configuration Parameters (pg 3.82), CamCalZoom1 and
CamCalZoom2, used in the Dispenser Configuration file that determine at what zoom level
each dot is used.

Parameters & I/0s

The parameters and inputs/outputs (I/Os) listed below are used by the ClearVu programmable
vision system and are located in the Edit Configuration file (for details, refer to Dispenser

Configuration (pg 3.135)).

Configuration Parameters

Unless otherwise noted below, the following displayed values may be changed as needed.

— CamCalZoom1 = 30

— CamCalZoom2 = 60

— GantrySettleDelay = 150

— HasVision = True < never change this value
— LensType =2 < never change this value
— LensPort = dev/ser3

— Reduce Flash = True

— DotCalibDIg = 1

Inputs/Outputs (I/0)

— 1O/Vision/LightBlue - 10003 - Hard Wired
— 10O/Vision/LightRed - 10002 - Hard Wired
— |O/Vision/BackLight -10017 - Configurable
— 10/Vision/LensAdjust - Configurable
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Adjust Lens Focus Settings

Obsolete as of FLOware Software version 2.1. The software tools described in this section
can be used in subsequent software versions, however, all changes to vision values
made using the Lens Adjust window are temporary and overridden by the newer
vision tools described in ClearVu Vision™ Sequence of Operation (pg 3.78).

Prior to adjusting the lens focus settings for an automatic vision system, it is important to first
understand the contents of Automatic Vision System Set Up (pg 3.77).

i IMPORTANT: Programmable zoom and focus values are specific to a fiducial/pattern image

and program. Therefore, adjusting the camera and/or lighting may require changing all patterns
used by your programs.

To adjust the lens focus settings:

1.

4.

If the dispenser is configured with a lifter plate, verify that the lifter plate is in its raised
position prior to performing the following camera focusing steps.

Jog the camera to the point where it is to focus.

In the menu bar of the Main Control Panel, click on Machine Controls > Lens Adjust. Two
different types of windows display — the lens adjust controls and a live camera video dis-

play.

Live Video
B15: Live Camera.

Focus | 0.000 ¥ a v
Zoom | 0,000 £ AT
=tmog ’— al v .

Lightimg

Level | 100 % Al ¥

Color  Default ~

Adjust camera focus as needed using the arrows in the Lens Adjust window to obtain a
clear picture in the Live Video window. The contrast should be black and white, not shades
of gray. If the contrast is gray, adjust the aperture and focus of the camera lens.

NOTE: Typically, you'll use the Focus and Zoom controls the most often. For camera

lenses for which the f-stop field is active, set the desired level of brightness with the f-stop
arrows. (Units can not be converted in the Lens Adjust window.)
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As needed, adjust Lighting Level to obtain the optimum intensity for the current viewing sit-
uation. Also as needed, switch the Lighting Color for optimum contrast results. For further
details about controlling light intensity and color, refer to Lighting Controls (pg 3.73).

NOTE: Lens and lighting controls are available in both the Jog window and the Lens
Adjust window. Coarse adjustments can be made in the Jog window, while finer adjust-
ments are more easily made using the controls in the Lens Adjust window.

If you will want to view dispense heights at a later time while in Inspection Mode, record
the Focus and Zoom values displayed now; otherwise, skip to the next step.

Click DONE in Lens Adjust.
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Operations

Operations define how the dispenser is to perform. Basic software operations can be
combined into a package called a shape.

Operation Categories

Different types of operations are used to define the processes performed by program lines. All
types of operations fall into one of two categories: they either function as an operation or as a

shape.
Operation .
Category Explanation
operation a preprogrammed, primitive shape provided by the control software. Each operation
defines an often-used shape or action; e.g., dot, line, move, arc, delay, etc.
shape a subroutine created by the user, incorporating primitive operations and other

shapes.

All operations, or primitives, are always available. They can be accessed from the top of the
Program Detail window where each operation appears as an icon, from the Select List window
(discussed below), or with the Program Detail OPERATION button.

EEREEEEEEERREE

B Une Dot Fart Shape

Operation icons

| Program Line Detuil

Comment |

OPERATION button

Valve/Tn~!

All shapes are also always available unless filtered by class. A list of all currently available
(non-class filtered) shapes can be accessed with the ShList icon located at the left of the icon
group (shown above), from the Select List window (shown below), or with the Program Detail
OPERATION button.
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All operations from both category types — operation and shape — are listed in the Select List
window that displays when you click on the ADD LINE button in the Program Detail window.
Primitives are always listed first.

I E44: Select an Operation

ARC Moves the gantry in a circular arc
CALIBRATE Forces a calibration during a process
CIRCLE Draws a circle or an array of circles
cuT Moves the gantry in a straight line
DELAY Delays processing for a specified mummber of mill
Draws a dob or an array o |
Operatigns | LINE Draws a line or an array of lines
(Primitives} HOVE Moves the gantry in a straight line
NONE Dummy entry for defaults
OPERATE oOperates a fixture
PARTITION Introduces a program and partition defaults
RECTANGLE Draws a rectangle or an array of rectangles
SETUP Sets up pallets, standoffs, etec.
SHRAPE Introduces a shape
0805-07 Component used by program “3AGL2370ABAA L NT 2A
Full Logo Draws the GPD logo.
Shapes - H3528-19 Component used by the program "3AG12370ABAA L NT
M7343-28 Component used by the program "3AG12370ABAR L NT
HINIMELF Component used by the program "3AG12370ABAA L NT
[} -
Selection

Examples from both operation categories — operation and shape — are shown below in a

‘ DOT Draws a dotor an array of doﬂ

| Aocert| Cancll

sample program (in the Program Detail window).

Operations <
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|
EEREESE]

[~ Program Lin

Prugram| Sample Program

All Gantries — | 4 Pamuun[ESm:.p}eP

000¢
HOVE 250
1515-13 500

‘_r_avil

T~

% B Component
7 HOVE
L]
9
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Summary of Operations (Primitives)
The table below lists and briefly explains the preprogrammed, primitive operations available in
the dispenser control software. For further, detailed information about each operation/
primitive, refer to Operations (Primitives) (pg 5.108).

(%F:;?ttii‘?:) Brief Explanation

Arc moves the gantry in a circular arc

Calibrate forces a calibration during a process

Circle draws a circle or an array of circles.

Cut synonym for the Move operation; moves the gantry from point to point.
Delay delays processing for a specified number of milliseconds.

Dot draws a dot or an array of dots.

Line draws a line or an array of lines.

Move moves the gantry from point to point.

None dummy entry for defaults or comments.

Operate operates a fixture; performs special functions not included in other primitives.
Partition introduces a program and partition defaults.

Rectangle draws a rectangle or an array of rectangles.

Setup performs setup of pallets, standoffs, etc. prior to program execution.

Shape introduces a shape and shape defaults.
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Defaults

The proper use of default and override values can save both programming time and program
run time. Increased efficiency in both areas results from understanding and effectively using
these toggling value controls.

Default Values & Override Values

All value fields with a square blue or gray Default Button (pg 2.16) next to them can use the
default value supplied by the system or an override value entered by the user.

You control whether a field uses the default value or an override value by turning the default
button on or off. The displayed button color indicates which value is active for that field:

blue = ON, default value is used gray = OFF, override value is used

0,075 in Settle g 1,000 in Settle £

Hierarchy of Defaults for Programs & Shapes

An understanding of default hierarchy is very important to the effective and proper use of
default and override values.

Key to lllustrations

For simplicity, the illustrations used to explain default hierarchy in Hierarchy of Programs &
Shapes (pg 3.89) show only window snippets (program name, program/shape detail lines, and
a representative value field) to convey the hierarchical relationship between elements in both
versions [Edit Programs / Edit Shapes (pg 3.31)] of the Program Editor.

Figure 12: Key to illustration format used to explain default hierarchy

__» shape level « Indicates level of Program Editor:
__— Edit Programs or Edit Shapes
» Program J Rice « Program/Shape name
- 1 SHAPE
2 LINE _____ .« Program/Shape detail lines
- \\* 4 HOVE
—: -..--.:-—- T 4 -..:- - |C|.0?5 in Settle 7 « Field parameter with
= —1— default button ON
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If all program and shape levels are defaulted — if all Default buttons are blue as shown in
Figure 13, the primitives used in a shape (like LINE, DOT, MOVE) follow the default hierarchy
relationship shown here to the root ..Default.. Program (pg 3.92) level where the most

commonly used values are defined.

The example in Figure 13 shows a simple program named Beans that consists of a shape
named Rice that consists of a line, dot, and move. This example follows the DOT shape detail

line through the full hierarchy of defaults.

Figure 13: Hierarchy of defaults: all program & shape levels are defaulted for DOT.

root default level

Progeem | Daefanlt..

1 FPARTITION
P T
1 HE -

program level

HOVE %
6 ARC =
7 RECTANGLE Pragram | Boans
§ CIRCLE | |
D e | ST
10 DELKY 1 ¢ Rioce
11 ~{pafault) program level
17 PARTITION C. pyr— .
11 EHAFE 007 1 Program | Beans
14 HOME e T
o With program partition 1 PARTITION
line difaulted, the -
o primitives used in the
A 0.075 Sefite £ Shape cetail lines (LINE, T 7
DOT, MOVE) default to L o
eI Sapename (i)
i defaults to the program
¥ e DRI, progrm, partition line,

Additional Fully-Defaulted Hierarchy Tips

shape level
Program | Rice
2 LIHE | shape level
3 DoT
s Program | Rice
B 0OTE r Seme £ - G R
| 1  SHAPE
; |- 7 LIME
Shape partition line L. ENNC SR—
defauits to the shaps L 1 HOVE
name a5 calked from the ;
program (shown here as - |._:_.,..¢_ in

Rice),

Shape details lines
[LINE, DOT, MOVE) default
to thie shape partition e,

Assuming all levels are defaulted, a shape in a program will default to the 2

shapename detail line in the ..Default.. program.

Assuming all levels are defaulted, any value inside any shape, even when nested,

comes from the corresponding primitive in the ..Default.. program.

When a shape is embedded in a program, the shape values override the program val-

ues. In other words, a non-default value entered at the shape level will override a non-

default value entered at the program level.
Also see Shape Partition Line (pg 3.55).
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How Overriding a Default Value Affects Hierarchy

When a field value is entered by the user, the default value is overridden, the default hierarchy
is no longer observed by this field, and the corresponding Default button turn gray.

The example in Figure 14 shows how an override value entered in the DOT shape detail line
breaks the defaulting progression.

Figure 14: Overriding the default hierarchy for DOT.

shape level

Program uﬁiw
X 1 SHAPE
? LINE
When a value is entered by the user to gverride a
default value, the default hierarchy is no longer observed by
this field and the corresponding Default button turns gray, B 1000 i [Getied

Using Overrides

Overriding default values can, if done at the proper level in the default hierarchy, impact
program efficiency.

RECOMMENDATION: Overriding a value at the lowest level of defaults, as illustrated in
Figure 14 on page 3-90, is the best choice in most cases.

Partition Line

5/18/18

A partition line is a type of program line that appears automatically at the beginning of every
new program and defines the default values for all program detail lines that follow it. A partition
line saves you from having to enter the bulk of the values in each program line.

Multiple partition lines can be used in a program. (A Shape Partition Line (pg 3.55) is a
different matter; it can be used only once in a shape).

Using Partition Lines

Additional partition lines can be added to divide a program into discrete sections. Each new
partition line defines the default values for all program lines that follow it until overridden by a
subsequent partition line.
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For example, in the sample program shown below, the initial partition line defines values for all
of the DOT program lines, and the second partition line defines the values for the LINE

program line.

Partition #1

The default values for\\

these lines are defined
by Partition #1 |
Partition #2 <

The default values for
this line are defined

£ = o O 3

Arc Fect Circle

by Partition #2

Program ‘ Sample Program

All Gantries — | o Partlﬁonl_'_

DoT .1 .1
3 Dot -19.349 -7.1527
4 DOT 0.0000 0.0000
5 DOT 0.5000 0.1000
6 PARTITION
7 LINE 0.7000 0.3000

Partition Line Parameters

FProgram Line Detuil -

Comment |

Operation PARTITION |.|

Part
Mumber

SubOp

- Stardard Values

The initial default parameters for a partition line are automatically set to a reasonable value by
the system; these parameters can be modified as needed. If an additional set of default
parameters with different values are needed in a program [as discussed in Using Partition
Lines (pg 3.90)], the use of additional partition lines is suggested.

For example, all DOT program lines in the sample program shown below use a Micro-Dot
valve and a Start Z value of 0.0030 inches, but when the program arrives at the LINE program
line, it needs to use an Auger valve and a Start Z value of 0.0100 inches.
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Frogram| Sampie Progam
AN Gy~
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..Default.. Program

5/18/18

..Default.. is the name of the foundation program in the FLOware software. Access to the
..Default.. program requires appropriate access rights plus class filtering for the blank filter.
Modification of the ..Default.. program is limited to changing parameter values. This program
cannot be deleted.

If the ..Default.. program is not visible at the top of the available programs list in the
Program Editor, it will reappear if you click in the menu bar on Edit > Refresh Programs List
(assuming the appropriate access rights are active).

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software opera-
tions. Any non-GPD Global employee who uses this information beyond the stated application
specified by GPD Global Service Department personnel is in danger of causing personal injury
and invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

Modification of the ..Default.. program is limited to changing parameter values. This program
cannot be deleted.

The ..Default.. program consists of a program detail line for each of the often-used primitive
operations [Operations (Primitives) (pg 5.108)], each of which are already populated with
reasonable starting values.

Figure 15: Program detail lines in the ..Default.. program.

Program | .Default.

0. 000

ARE 0. oo
BECTMGLE Q. 000
CIRCLE 0. Doo

5 CALIBRATE 0. 000
10 DELRY 0. 000
11 ~(pafault) 0. 000
12 PRRTITION 0. 000
13 SHAPE 0. 000
14 HONE 0. 000
15 SETUP 0. 000
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Table 20: Purpose of each detail line in ..Default.. program

Program

Detail Line Purpose

1 PARTITION This is merely a partition line for the ..Default.. program, as is the rule for all pro-
grams — the first program detail line in every program must be a partition.

12 PARTITION  This is the primitive partition operation used by all programs. The first program
detail line in every program must be a partition line - one is automatically inserted
whenever a program is created and populated using the values in this partition.

This is the partition that populates any newly created program.

2 shapename All newly created shapes are given a name of the programming engineer's prefer-
ence. When writing a program, the engineer will call out these shapes to run in the
process.

This is the line that populates the parameters for the shape when called out from
the program, assuming all program and shape levels are defaulted.

13 SHAPE This is a shape partition line. Just as PARTITION defines parameters for subse-
quent detail lines in a program, the shape partition line defines parameters for sub-
sequent detail lines in the shape.

This is the shape line that populates any newly created shape.

11 ~(Default) Defines the parameter values for any Operate (pg 5.112) operation in programs or
shapes, assuming all program levels are defaulted.

remaining lines  The remaining program detail lines in the ..Default.. program (LINE, DOT, MOVE,
3-10, 14-15 etc) populate any newly created program line using a corresponding primitive
operation, assuming all program levels are defaulted.

Mounts & Material Defaults
There are three versions of the Mounts/Material Editor (pg 5.59), each with a different purpose
directly affected by the hierarchy of defaults.

Purpose of Each Editor

In addition to representing different levels of the default hierarchy, the different purpose of
each Mounts/Material Editor window is affected by the default hierarchy.

Parameter definitions remain the same across all three versions of the editor, although not all
fields are active in all three windows.
+ DEFAULTS

Library of material parameter (needle, valve speed, head type, etc.) values affecting
the most commonly used materials. Define the defaults for materials with the Mate-
rial Defaults Library (pg 5.9) according to head mount position.

+  MATERIAL

Library of material parameter values affecting a particular material. Details at Mate-
rials Library (pg 5.7).
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+  MOUNT
Table of values affecting a specific program. Details at MOUNT (pg 3.70).

Editor Versions & Hierarchy of Defaults

Each version of the Mounts/Material Editor has a distinct heading and icon to help identify it
from the others and follows a straightforward hierarchy of defaults:

*  MOUNT operates at the program level and defaults to MATERIAL.
* MATERIAL operates at the library level and defaults to DEFAULTS.
+ DEFAULTS operates at the root default level.

Figure 16: Basic default hierarchy of the three Mounts/Material Editors

root default level

library level

: :
rogram level
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x
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Using Overrides
For increased efficiency, values are most commonly overridden at the library level
because any change made here apply to all programs using the selected material.

Overriding a value at the program level is typically done only if the value applies to a single
program.

Additional Info You Probably Won’t Need

Confusion can occur when library level MATERIAL is defaulted and the user happens to
notice an unexpected value displayed in program level MOUNTS. Although rarely
observed because it deals with defaults at the level of the various Mount Position choices
(1 through 6), this situation bears some explanation.

Everything displays normally when there is an override in library level MATERIAL because
program level MOUNTS defaults to library level MATERIAL and the defaulting cascade
stops there due to the override.

If, however, library level MATERIAL is defaulted, then an additional detail about the default
hierarchy involving the Mount Position becomes involved. Assuming all levels are
defaulted, values at Mount Position X at program level default to the corresponding Mount
Position X at root default level.

For example, defaulted values in program level MOUNTS for Mount Position 2 actually

default to the corresponding Mount Position, which in this case would be Mount Position 2,
in the root default level DEFAULTS.
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Miscellaneous Program Settings Defaults
Values in the Miscellaneous Program Settings (pg 5.55) window default from the ..Default..
Program (pg 3.92).

RECOMMENDATION: All default buttons in the Vision Calibration (pg 3.128) pane of the
Miscellaneous Program Settings window should be turned ON (they should appear blue).
This forces the program to use the default vision values established in the ..Default..
program.

Offline Head Defaults

All parameters in the Offline Operations (pg 5.67) window, except valve type, default from the
Materials Library (pg 5.7).
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Rotation

Two types of items (in a program or shape line) can be rotated: a single object and an array.
Because both an entire array and an individual item within an array can be treated as a single
object, there are two different ways to implement rotation:

Object Rotation
Used for Single Object Rotation (pg 3.97).

Rotation
Used for Array Rotation (pg 3.97).

Rotation Guidelines
Either parameter will rotate a single object a specified number of degrees about a coordinates-
defined point, however, these parameters behave differently when applied to an array. For this
reason, it is strongly recommended that you consistently follow these guidelines:

* Use Rotation to rotate an entire array, and Object Rotation to rotate a single object.

» All rotation occurs about the point defined in the X,Y fields (located in Program Detail in
close proximity to the rotation parameter fields).

+ The entry of positive rotation values results in counterclockwise rotation for both Rotation
and Object Rotation. Clockwise rotation requires the entry of negative values.

* Rotation is independent of Object Rotation, so both parameters may be applied to the
same item if necessary.

* Rotation is applied by entering a value in Program Detalil in either the Rotation parameter
or the Object Rotation parameter.
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Single Object Rotation

A sample of how Object Rotation influences a single object (line, rectangle, or created shape)
is shown in Figure 17. The sample line in the X axis is shown rotated +90 degrees and -90
degrees to become a line in the Y axis. The point of rotation is always the starting XY
coordinate for the line. Counterclockwise rotation results from a positive value. Refer to
Rotation Guidelines (pg 3.96). An array can also be rotated as a single object. See example

shown in Array Rotation (pg 3.97).

Figure 17: Example of using Object Rotation to rotate a single object (line)

Rotation of a line occurs at
+90° the starting XY coordinates.
“\ Positive rotation values
XY o cause counterclockwise

J rotation.
-90° Negative rotation values

cause clockwise rotation.

Array Rotation

5/18/18

To illustrate how the different rotation parameters (Rotation and Object Rotation) influence an
array, a sample array of five vertical lines is shown in Figure 18, before and after each rotation
parameter is applied. Note how applying both rotation parameters (Rotation and Object
Rotation) to the array affects the resulting pattern. Refer to Rotation Guidelines (pg 3.96).

Figure 18: Different Rotation Parameters Can Produce Dramatically Different Array Patterns

Initial Pattern Add Rotation Value(s) Resulting Pattern

Object Rotation = 30 degrees

Rotation = 30 degrees

Object Rotation =-30
&

Rotation = 30 degrees

The following values were used to produce the initial pattern in Figure 18.

OpType XCoord YCoord SizeX SizeY XCount YCount XSpace
LINE 0 0 0.0 1.0 5 1 1.0
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Theta Rotation
Not currently functional. Theta rotation acts on the valve/tool head, rotating the head around
the component. Theta rotation is used in conjunction with an upward-looking camera for pick-
and-place applications or for applications utilizing a pre-formed needle where the end is
angled to dispense on the side of a component.
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Arrays & Alignment Points

Alignment points are used to remedy situations in which arrays do not stay properly aligned
(otherwise, using alignment points is unnecessary). When programming with arrays, consider
using alignment points when any of the following scenarios exist:

* horizontal (0 degrees) is not parallel to the board edge,

* aconstant board feature indicating 0 degrees is unavailable,
* inconsistent board positioning is common, or

* no fiducials or manually taught fiducials are present.

Using Alignment Points
Alignment points are used to remedy situations in which arrays do not stay properly aligned;
otherwise, using alignment points is unnecessary. Alignment points define horizontal (0
degrees) and vertical (90 degrees) on a board. These angles, which are not established by
fiducials alone, become the reference points upon which array rotation is based.

Alignment points apply only to arrays and are typically used when arrays have been
programmed along an absolute x or y path but actually dispense at an unexpected angle.
Teaching an alignment point at either end of a array pattern establishes a straight path along
which the arrays will align. Accuracy increases with an increased distance between the two
alignment points.

ries Liniiies
- Progrise or Peige Neader
S s | om0 Varsian| [l | Getans

Alignment Points - use
the slider in the Fiducials
panel to locate the
Alignment Point

para meters.

To use alignment points:

1. Locate the Alignment Point fields in the Fiducials pane of the Program Editor.
2. Enter coordinates in Alignment Point 1 for a point on the product.

3. Enter coordinates in Alignment Point 2 for the other end of the horizontal or vertical path.
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Creating Arrays

When creating arrays using particular operations, namely Circle, Dot, Line, and Rectangle,
apply the following rules:

1. Assign values to the array parameters.

2. The array is formed by X Count items in the x-direction spaced X Space apart with Y
Count items in the y-direction spaced Y Space apart for a total of (X Count x Y Count)
items. Items equate to circles, dots, lines, and rectangles.

3. The entire array is then rotated about the first reference point Rotation degrees.
For details about rotating arrays, refer to Array Rotation (pg 3.97).
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Feature ID

The feature ID function provides an alternative to the default of processing all program lines by
enabling you to define and run a select subset of program lines. A feature ID can be assigned
to any program line. Any program line without a feature ID (blank) will always run.

Using Feature ID

One way to use feature ID is to choose to run all program lines except those applicable to pick-
and-place. Another way to use this function would be to limit a program run to only the lines
applicable to a particular type of component location on a board.

Feature IDs are typically created during program development as names for product features
and may be used to represent any feature on a product. Typically they are used to designate
component board locations (e.g., C15, R23, etc.).

When you activate the feature ID function for a program run, you will be prompted to select the
feature IDs you want recognized during the program run. You may choose any combination of
feature IDs ranging from none to all or any combination in between.

A program will run only the set of program lines containing the feature IDs you select and that
set is only in effect while the program is running. If the program is stopped and restarted, the
system reverts to the default of processing all IDs unless you reselect a subset of feature IDs.

Assigning a Feature ID
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If you want to execute only select program (shape) lines, assign a Feature ID to the program
(shape) lines you want to include when the program runs.
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To assign a feature ID to a program (or shape) line:

1. Select or create a program (or shape) and open the Program Detail window.
2. Highlight the program line to which you want to assign a feature ID.

3. Type a name in the Feature ID field.
4

Click the APPLY button. This assigns the feature ID name to the selected program line.
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Finding a Feature ID
Previously assigned feature IDs can be easily located within a program. The FIND FEATURE
button helps you locate the first occurrence of a Feature ID in a program by highlighting the
program line in which the feature ID was found.

To find a specific feature ID within a program:

1.
2.

Type the name of the feature ID you want to locate.

Activating Feature ID Function

To activate and select feature IDs for a program run:

1.

Select and start a program.

Using FLOware Software

In the Program Detail window, click the FIND FEATURE button. An input request displays.

Click OK. The system finds and highlights the first program line assigned using the speci-
fied feature ID.

2. When the Mounts Table window displays, be sure to click the Select Feature IDs box

before clicking CONTINUE.
7 |
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3. The Feature IDs window will display unless the selected program contains no feature IDs.
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From this window select any combination of the feature IDs listed and then click ACCEPT.

The <Ctrl> button acts as a toggle button, allowing you to quickly change the selection
state of a feature ID. For example, you can easily select the majority of feature I1Ds by first
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Using FLOware Software

clicking on the ALL button and then, while holding down the <Ctrl> button, clicking just
those feature IDs you wish to deselect.

5/18/18

Feature IDs |
R34: Select Features
to be Processed.
c11
R16
All None
Accept. Cancel
To select: Do this:
All names Click ALL.
No names Click NONE.

A single name

Click the name you want to select.

A combination of

Hold down <Ctrl> and click each name you want to
names select.

OR

Click ALL and then, while holding down <Ctrl>, click

each name you want to deselect.

To accept the dis-
played selection
asitis

Click ACCEPT.

After making any other pertinent entries to the Mounts Table window, click CONTINUE. The
program will run only those lines with an enabled and selected feature ID.

IMPORTANT Only program (or shape) lines with no feature ID or with selected feature ID will

run.

IMPORTANT WICHTIG IMPORTANTE IMPORTANTE

Seules les lignes Nur Programmzeilen Si esequiranno solo Solo se ejecutaran
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Process Inspection Tools

The process inspection tools, Bad Marks and Dot Inspection, are integral to a program and
perform process quality inspection during every production run process in contrast to the
Testing & Inspecting (pg 3.117) choices that are typically used only during program devel-
opment.

While Dot Inspection (pg 3.105) is limited to the inspection of dots, Inspecting with Bad Marks
(pg 3.104) is a more flexible process inspection tool that can inspect a broad spectrum of
shapes and primitive operations.

Inspecting with Bad Marks

5/18/18

When applied to process inspection, bad marks can be set up to verify process conformity
and/or material presence (a shape dispense actually occurred). The sole purpose of the bad
mark in this scenario is to display a user message as needed informing the operator of the
problem.

NOTE: When not used for inspection, Bad Marks (pg 3.38) are typically used in
conjunction with fiducials.

After a pattern is dispensed in a program run, a bad mark shape in the program evaluates the
pattern. If the process fails (the pattern is missing), the bad mark shape causes a custom user
message to display. If the process is passes (the pattern is good), the program skips the bad
mark shape so no message is generated and continues on with the rest of the program.

Some of the advantages to using bad marks for process inspection are:

+ Bad marks can be used to inspect a process at any point in a program.

« Bad marks find a pattern and then evaluate the pattern against an acceptance threshold:
— If the pattern passes evaluation, the program continues.
— If the pattern fails evaluation, the system displays a message.

+ The text and buttons displayed in the message (that displays if the pattern fails evaluation)
are determined by the user.

Using Bad Marks with Custom User Message

Create a user message that will display if a pattern fails process inspection. You can
customize the text content and the buttons (Ignore, Retry, Abort, etc.) displayed in the
message.

To create a customized user message:

EXAMPLE: For the purposes of this procedure, we’ll create a user message for a program
of dispensed lines that we want inspected to verify that each line is actually dispensed.

1. Train the part of your process that you want inspected as a vision pattern. For example,
teach a dispensed line in Pattern Trainer.

2. Create a custom user message:

a. From the Program Editor menu bar, click Library > SubTypes.

b. In SubType Editor [refer to SubTypes Library (pg 5.18)], create a subtype using Mes-
sage Type that will display a user message edited to convey to the operator the fact
that the process failed (material not present, dispense pattern missing, etc.).

c. From the main window menu bar, click System Functions > Edit Any File.
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d. User messages are edited in /appl/etc/config/ds.user.msgs

e. Inthe Subtype, test a pseudolO to force the message to display.

f.  Type the text you want to display on the message.

g. Select the buttons you want to display on the message using Edit Misc Resource.

3. Create the shape in your program that will inspect the process. For example, in a program
of Shape (partition), add a program detail line using the InspectTest created during the
prior step.

The shape is what contains both the bad mark pattern and the InspectTest program line. If
it passes the bad mark it skips the execution of the InspectTest. If it fails the bad mark, it
executes the Inspect test and displays a message.

4. Use the vision pattern created in step 1 in the Bad Mark Pattern, teach the location, and
select Process if Absent.

5. In the detail lines of the shape, add the SubType that you created.

Dot Inspection
Dot Inspection can be used when inspection needs are limited to the inspection of dots
created with opaque material. After the initial setup, this inspection method is easier to
implement in a program and can be used to inspect individual dots or arrays of dots.

Dot inspection is a process during which the camera compares a dispensed dot to a
calibration dot for the purpose of identifying whether or not the dispensed dot falls within
chosen parameters. Dot inspection can be set up to inspect any arrangement of dots:

» all dots on all parts,

« all dots on every nth part,

« particular dot(s) on all or every nth part, or

+ only those dots which are specifically programmed to be inspected.

The user must configure the software to use one of two calibration dot modes. One mode
measures the dispensed dot and then compares it to a user-defined dot size within a user-
defined range; the other mode compares the dispensed dot to a set of dots of predefined
sizes. While setting up a mode of dot inspection, the user may choose a time interval at which
dot inspection occurs: inspect dots every n seconds or inspect dots on all parts. Further refine-
ments to inspection location and timing are made during the creation of dot inspect program
lines.

1. Work Area Set Up

Physically set the height of the work area to match the height of the calibration chip (located
on the calibration station). Because the same vision settings for zoom and focal length will be
used at both of these locations, a common physical height must exist.
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2. Software Configuration

Using FLOware Software

Choosing a mode of dot inspection determines which calibration dot will be used during the
inspection process. Two modes are available:

* A - Measure dispensed dot and then compare it to a user-defined dot size within a user-
defined range.

+ B - Compare the dispensed dot to a set of dots of predefined sizes. (These dot sizes are
typically defined by, but are not limited to, the preprinted, precision, calibration dot chip
available from GPD Global.)

To implement the desired mode of dot inspection, select the mode appropriate for your
process from the chart below and then proceed to the indicated page for detailed procedural

instructions:
Table 21: Modes of Dot Inspection
Mode Theory of Operation Advantages Go to:
-A- Camera measures dispensed dot and Time saving aspect - Mode A: User-

Verifies dispensed dot
size based on values

then compares it to Target Size and Tar-
get Range:

only a single calibration
operation is performed,

Defined Calibra-
tion Dot Size

entered by the user. 1. System dispenses a dot. even if the program dis- (pg 3.107)
2. Camera calibrates at the calibration penses a range of dot
chip dot size determined by the zoom sizes.
value set in the program Vision Calibra- Any size target may be
tion panel (Miscellaneous Program Set- set.
tings window) using the dot size value
from the middle Cal Dot Sizes field
(Option Settings window).
3. Camera looks at dispensed dot and
decides pass/fail based on Target Size
and Target Range set in Blobs panel
(Program Detail window).
-B- Camera uses pre-established calibration ~ Can be used as a dot Mode B: Fixed

Verifies dispensed dot
size based on the
fixed size range of the
calibration chip dots.

chip dots to establish acceptable range
of dot sizes:

1. System dispenses a dot.

2. Camera views the three calibration
chip dots using particular base locations
(Camera to Camera Calibration A1, A2,
B1, B2, C1, and C2).

3. Camera calibrates to the values set in
Cal Dot Sizes fields (Option Settings win-
dow) and establishes the acceptable
minimum/maximum size range for dis-
pensed dots.

4. Camera looks at dispensed dot and
decides pass/fail based on the accept-
able range established during the prior
step.

presence test (assuming
the sizes of the calibra-
tion chip dots establish a
wide size range when
compared to the dis-
pensed dot size).

Calibration Dot
Size (pg 3.111)
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Mode A: User-Defined Calibration Dot Size
To select a calibration dot that verifies dispensed dot size based on values entered by the

user:

1. Open the Edit Configuration screen [Configuration > Dispenser Configuration (pg 3.135)]
and enter a value of True for both Dot Inspection and UseTargSize.

,JE

GPD - Configuration Definftions

#1 ds.options.cfgLINE: 2?4 COL:
[PriorScan = True
False to suppress prior scan even if the program calls for it

ipeForTouch = False
True for message to operator before needle touchdown on the touch pad

umPartsReady = 0
i Number of PartsReady sensors (0, 1, 2, or 3) to be tested

PotInspection = True

tt True to enable dot inspect

seTargSize = True

it True to use the values of the dot size and range

pEREH R R R R R R R R R R R R R R R R R R
it

it Conveyor

DunpCfgVals = False

2. If the values noted in the prior step were already set to True, skip to the next step; other-
wise, reboot the system to implement the changed values before continuing.

3. Now that Dot Inspection has been configured to True:
a. Open Program Detail.
b. Turn on the Inspect box.
c. Select the Blobs panel.
d. Enter desired dot size and tolerance values in Target Size and Target Range.
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4. In the Blobs panel, enter a value of 1 in the Blob Count field. (For purposes of the current
procedure, only a 1 will work.) Establishing the correct value for blob parameters is critical
to the success of finding dots dispensed by the dot program.

A

Blob Count
must be set
toa value of 1

Sl

5

HRLGEE
ARG
HORNNN

5. Be sure identical values exist in the vision fields common to both the Vision panel (in Pro-
gram Detail) and the Vision Calibration panel (in Miscellaneous Program Settings).

NOTE: The same value for Zoom MUST be used in both vision panels. The value for
Focus will be the same if the work area surface is at the correct height. Gain and Offset
values may need to be changed depending on the work surface, material, and lighting.

CRITICAL: vision ZOOM values in
both windows must match each other
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6. Inthe Option Settings window, set the middle Cal Dot Sizes field to the diameter of calibra-
tion dot you want used.
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The value used in this step to represent calibration dot size, along with the value entered
in Zoom during the prior step, will affect which base locations are used for the calibration
dot, thereby affecting the location of the calibration dot - refer to the chart below.

Table 22: Relating Calibration Dot Size and Base Location

If Zoom value in then the system will automatically Abbreviation for Base
Vision Calibration is: use these Base Locations: Location Name:
less than 30 Camera to Camera Calibration A1 (XY) A1
Camera to Camera Calibration A2 (XY) A2
more than 30, but less than 60 Camera to Camera Calibration B1 (XY) B1
Camera to Camera Calibration B2 (XY) B2
more than 60 Camera to Camera Calibration C1 (XY) C1
Camera to Camera Calibration C2 (XY) C2
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7. Enter a value in Time Interval for the amount of time to elapse between dot inspection ses-
sions. Time Interval tracks process time, disabling dot inspection for the duration entered.
For example, if a program can process 10 parts per minute and Time Interval is set to 1
minute, the system will inspect every tenth part.

Use the following chart when determining the value to enter in Time Interval.

Table 23: Controlling Frequency of Dot Inspection

To inspect: enter this value in Time Interval:
dots on all parts 0
dots on every nth part Multiply the process time per single part by the number of parts for

which inspection is to be skipped.
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8. Go to 3. Programming for Dot Inspection (pg 3.113).
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Mode B: Fixed Calibration Dot Size
To select a calibration dot that verifies dispensed dot size based on a fixed size range
controlled by predefined calibration chip dots:

1. Open the Edit Configuration screen [Configuration > Dispenser Configuration (pg 3.135)]
and enter these values:
a. Enter a value of True for Dot Inspection.
b. Enter a value of False for UseTargSize. An entry of False directs the system to cali-
brate using the three official calibration chip dot sizes established in base locations.

dJE

GPD - Configuration Definitions

ds.options.cfgLINE: 274 COL: 1
False to suppress prior scan even if the program calls for it

ipeForTouch = False
True for message to operator before needle touchdoun on the touch pad

unPartsReady = @
Number of PartsReady sensors (0, 1, Z, or 3) to be tested

Dot Inspection = True

it True to enable dot inspect

seTargSize = False

it True to use the values of the dot size and range

JOO S48 B SR NI R U TS U UL B R T U S B B R M B T R
i

ittt Conveyor

2. If the values noted in the prior step were already set, skip to the next step; otherwise,
reboot the system to implement the changed values before continuing.

3. Verify the location taught for each base location shown below (A1, A2, B1, B2, C1, C2)
correlates with the correct dot size (A, B, or C) on the calibration chip as indicated here:

Precision Glass Calibration Chip

(p/m 22205215)
(008 in) (040 in)
Camera to Camera Calibration C1 (XY) ' . A Camera to Camera Calibration A1 (XY)
Camera to Camera Calibration C2 (XY) Camera to Camera Calibration A2 (XY)

011 im)

Camera to Camera Calibration B1 (XY)
Camera to Camera Calibration B2 (XY)
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4. In the Option Settings window, set the Cal Dot Sizes fields to match the base location val-
ues noted in the prior step.

s (o0 | G
3,80 10 |20t 5| ot |
e ki 1 When calibration dot
E (= & sizes are controlled
. = — by fixed calibration
r ; chip dot sizes:
o oiom s | =3
= D08 for dot €
o == ne 8
= ; 011 for dot B
cmm L 040 for dot A
rE ¢ ] 0.6 in |
] t |

5. Be sure identical values exist in the vision fields common to both the Vision panel (Pro-
gram Detail) and the Vision Calibration panel (Miscellaneous Program Settings).

NOTE The same value for Zoom MUST be used in both vision panels. The value for
Focus will be the same if the work area surface is at the correct height. Gain and Offset
values may need to be changed depending on the work surface, material, and lighting.

CRITICAL: vision ZOOM values in
both windows must match each other

6. Go to 3. Programming for Dot Inspection (pg 3.113).
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3. Programming for Dot Inspection

Dot inspection program lines must now be created or modified to incorporate dot inspection
into a program. At the same time, further refinement can be made as to which dots will be
inspected.

Add Dot Inspection to Program
1 - Select the program to be modified and open Program Detail.
2 - Choose one:

+ Toinspect one or more new or existing dots of your choosing, go to Inspect as

Programmed (pg 3.113).
+ Toinspect each new dot after it is dispensed, go to Inspect After Every Dot

(pg 3.115).
Inspect as Programmed

Consider the following guidelines when programming one or more new or existing
dots to be inspected with a Dot Inspect operate:

+ Typically, a DOT program line does not have to precede a Dot Inspect program
line.

* The coordinates of a Dot Inspect program line determine both where the first dot
in an array is dispensed and where dot inspection occurs.

* Any value greater than 0 in Time Interval (in Option Settings) will be overridden by
a Dot Inspect program line when the Inspect box is turned on. If, however, the
Inspect box is turned off, the Time Interval value becomes active.

1 - Prepare a DOT program line:

1A - Create or select a DOT program line for which you want a dot inspected.

1B - Verify the Inspect box is turned OFF (gray).

1C - Verify the default button next to the Inspect box is turned ON (blue).
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1C - Verify array values are entered in the X Count and Y Count fields of the Array &
Track panel.

Array value
fields

Settings for
Inspect box and
default box

2 - Create a Dot Inspect program line:

2A - With the DOT program line from the previous step still selected, create a DOT
program line by either clicking the Operation icon or clicking the Operation button and
selecting OPERATE.

2B - With the new Dot Inspect program line selected, click the SubOp button and
select DOTINSPECT. This subop will cause inspection for dot size and/or dot pres-
ence to happen unconditionally regardless of dispenser configuration condition.

2C - Teach coordinates for the Dot Inspect program line - dot inspection will occur at
these coordinates.

3 - Save and test the modified program. Any dot that does not meet the designated
criteria will generate an error message indicating that dot size is out of range.
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Inspect After Every Dot

Inspection occurs after each new dot is dispensed as long as Inspect (on Program
Detail) is turned on in a program line.

1 - Create or select a DOT program line.

2 - If desired, enter values in the array fields of the Array & Track panel.

2 L LTRHa s e ol ) G )
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3 - Turn on the Inspect box (it should be red). If array values were entered in the previ-
ous step, all dots in the array will now be set to be inspected.

4 - Repeat the above steps for each additional dot or dot array to be dispensed and
inspected. All dot program lines with the Inspect button turned on will enable inspec-
tion as long as the value of Dot Inspection was set to True in the Dispenser Configura-
tion (pg 3.135) file during Dot Inspection Set Up.

OPTION: Dot inspection can be set globally by turning on the Inspect button in the
Partition line.

5 - Save and test the modified program. Any dot that does not meet the designated
criteria will generate an error message indicating that dot size is out of range.
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Additional Notes

NOTE: The following items are currently inactive.

Dot Inspect box on Main Window
Not currently functional. The Dot Inspect box located in the Operation States pane of
the main window is currently not functional; it has no effect on anything in either the on
or off state.

OPERATE subops

Dot Size - Not currently functional. Computes dot size but does not currently display
results.

Dot Test - Not currently functional. Compares dot with limits and if dot is found to be
outside limits, an error message will display. If UseTargSize [Dispenser Configuration
(pg 3.135) file] is set to TRUE, dot limits are based on the values in the Cal Dot Sizes
fields (Options Settings). If UseTargSize is set to FALSE, dot limits are based on
Target Size and Target Range (Program Detail - Blobs).
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Testing & Inspecting

The following test and inspection choices are typically used only during the process of
program development, in contrast to Process Inspection Tools (pg 3.104) which are integral to
a program and perform process quality inspection every time the program runs.

Program development testing and inspection can be handled in a variety of ways depending
on your needs:..

Testing Choices Instructions

Test an entire program without dispensing mate-  Dry Run Test (pg 3.117)
rial

Visually inspect an entire program with the cam-  Full Inspection (pg 3.117)
era

Visually inspect only the general coordinates of General Inspection (pg 3.118)
a program with the camera, i.e., only the starting
point of each shape or primitive in a program

Test or run programs on a conveyorized dis- Emulate Stand-Alone Dispenser (pg 3.118)
penser as if it was a stand-alone machine, with
or without the conveyor being operational

Dry Run Test
During a program dry run, the needle performs the exact process it normally would during a
program run except no material is dispensed.

To test a program using a dry run:

1. Select the program you want to test.

2. Click the Dry Run button located in the Inspection Mode (pg 3.26) panel of the main win-
dow.

Select one of the Run Mode (pg 3.25) options.

4. Click RUN in the main button bar. A dry run of the selected program executes.

Full Inspection
During a full visual inspection of a program, the entire program is executed with the camera
emulating the needle. (Obviously, no material is dispensed.)

To visually inspect an entire program:

1. Select the program you want to inspect.

2. Click the Full Inspect button located in the Inspection Mode (pg 3.26) panel of the main
window.

Use the Inspection Sliders (pg 3.26) as needed.

4. Select one of the Run Mode (pg 3.25) options.

Click RUN in the main button bar. A full visual inspection of the selected program exe-
cutes.
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General Inspection
During a general visual inspection of a program, an abbreviated version of the program is
executed with the camera emulating the needle. The camera proceeds only to the starting
point of each shape and/or primitive operation before skipping on to the next one in sequence.

To visually inspect only the general layout of a program:

1. Select the program you want to inspect.

2. Click the Inspect button located in the Inspection Mode (pg 3.26) panel of the main win-
dow.

Use the Inspection Sliders (pg 3.26) as needed.

4. Select one of the Run Mode (pg 3.25) options.

Click RUN in the main button bar. A general visual inspection of the selected program exe-
cutes.

Emulate Stand-Alone Dispenser
A dispenser with a conveyor can be made to emulate a stand-alone (manual) dispenser with
or without the conveyor depending on which Operation States are selected.

Stand-Alone Dispenser - with Conveyor

A conveyor unit can be made to emulate a stand-alone conveyor dispenser by bypassing the
SMEMA controls:

1. Install SMEMA plugs in the SMEMA connector ports.

2. Click the Stand Alone (pg 3.27) operation state toggle box so it is turned ON. The con-
veyor will function normally except it will not communicate with upstream or downstream
units.

3. Manually load product in the conveyor entry area and unload it from the conveyor exit
area.

4. To return to normal conveyor operations, remove the SMEMA plugs and click the Stand
Alone toggle box to turn it OFF.

Stand-Alone Dispenser - as if No Conveyor

Turn the conveyor belt off to make a conveyor unit emulate a stand-alone (manual) dispenser
with no conveyor:

1. Click both the Conveyor Off (pg 3.27) and Stand Alone (pg 3.27) operation state toggle
boxes so they are turned ON. The conveyor will cease to function.

2. Manually load and unload product from the dispenser area.

3. To return to normal conveyor operations, click the Conveyor Off and Stand Alone opera-
tion state toggle boxes again so they are turned OFF.
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Tweaks for Valves/Tools

Tweaks is an on-the-fly program development tool for discovering program adjustment values
for a designated valve mount position. Tweaks (fine tuning adjustments) are implemented as

soon as any tweak parameter is changed, providing you with immediate feedback.

Using FLOware Software

IMPORTANT: Changes are only temporary percentage changes based on the original pro-
gram and are only in effect while the program is actively running. Tweaks are multipliers, not
actual values; they temporarily alter a parameter by a percentage. When desired adjustments
are achieved, you must then calculate the new value by multiplying the original value by the
tweak percentage and then manually entering the results in the corresponding field of the appro-

priate program detail line.
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Clicking TWEAKS on the main menu button bar displays Live Program Adjustment (pg 5.46)
which functions as the tweaks panel for making temporary adjustments to valve program
parameters.

5/18/18

NOTE: Not all values listed in Live Program Adjustment apply to all valves.
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Tweak Controls

RESET

All parameters in Live Program Adjustment can be reset to the default (100%) at any
time using the RESET button.

LOAD

The LOAD button loads previously saved tweak parameters to Live Program Adjust-
ment.

SAVE
The SAVE button saves tweak parameter values ONLY to Live Program Adjustment.
Only one set of tweak values can be saved as each new save overwrites the previ-
ously saved values.
i IMPORTANT: Tweak parameter values are NOT saved to the program being tweaked.

Tweaks does not permanently change parameters - it only implements value changes temporar-
ily while the program is running and while Live Program Adjustment is open.
Save after Program Cancel

If the running program is canceled at any time while Live Program Adjustment is open,
a prompt displays giving you the option to save the current tweak parameters.

R43: Pregram tweaks data has changed
Save changes?

_Save | Dissard |

Use Tweaks

The values displayed when the tweaks panel opens depends on whether or not Use
Tweaks in Mounts Table is set to use tweak values in place of the program values:

* If Use Tweaks is ON, previously saved parameters will display in the tweaks
panel.
* If Use Tweaks is OFF, the default parameter of 100% will display in all fields.
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Using Tweaks
Following are the two methods for applying tweaks.

On-the-Fly Tweaks

To repeatedly adjust tweak parameters while observing how the program is affected:

1.

From the main window button bar, click TWEAKS to open the tweaks panel, Live Program
Adjust.

If previously used tweak values have been saved, they can be loaded now by clicking
LOAD.

Run the program to be adjusted:

a. Select the program to be adjusted.

b. From the main window button bar, click RUN. Mounts Table displays.
c. Click CONTINUE to accept Mounts Table as is.

While the program runs:

a. In Live Program Adjust, select the applicable head from the Position option menu.

b. Adjust desired tweak parameters and observe how the program is affected. Continue
making adjustments until desired results are observed.

When you are happy with the adjusted process and done using the tweaks feature:

a. Make a note of the tweak percentage for each field.

b. Click either SAVE to save the displayed multipliers or DONE to exit Live Program
Adjust without saving them.

Implement the tweak adjustments in the program:

a. Navigate to Program Detail and the program detail line where the adjustments need to
be implemented.

b. Based on the existing field values in Program Detail and the final tweak percentages,
calculate the new values. You can use the on-screen Calculator (pg 3.28) to do the
computing.

For example, if the program currently displays an original On Time of 0.010 and the
final On Time in Live Program Adjust displayed 200%, then the program On Time
value should be changed to 0.020.

c. Manually enter the new values.

Applying Saved Tweaks

To run a program with previously saved tweak values applied to it:

1.
2.
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Select a program.

From the main window button bar, click RUN. Mounts Table displays.
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3. In Mounts Table, activate Use Tweaks and then click CONTINUE.

4. Answer the various prompts that display; be sure to answer OKtothe Cl1ick OK to
continue? prompt.

The program runs with tweaks applied.
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Conveyor Auto-Width

In effect as of FLOware software version 2.9

Dispensers configured at the factory with the automatic-width conveyor, will automatically
adjust conveyor rail width to accommodate the current program. After the user enters a value
in a program for board width and initiates a run for that program, a prompt to clear hardware
from the lifter plate displays. As soon as the user responds to the prompt, the conveyor quickly
opens or closes to the specified width.

The conveyor remains at the current width until either the width value is changed in the current
program and the program is run again, or a different program with a different value is run.

Programming for Auto-Width

5/18/18

For dispensers configured for the auto-width conveyor function:

1. Calibrate the conveyor if needed. The dispenser conveyor was calibrated at the factory,
however, if you feel it should be re-calibrated, refer to Conveyor Width Calibration
(pg 3.126).

2. Program the width of the conveyor:
a. Select the program for which you want to set a conveyor width.
b. Enter the desired width value in the Width field. Value must be greater than 1.00 inch
(25.4 mm) or else manual width adjustment is assumed.

Frogram or Skape Header
Shoa i oo
Class Version | 5| options
.
Trugl, Angie

e G = [ S TR
dauid Lest '
Temic ilig Rivet Lengthj 0,000 & [ llsed R 0,000 G0
Tenic Saall Rivet Find I
ubale lstta dete Thigkl 6,000 in | lesd % 0000 i m Fiduslals

c. Turn on the corresponding Used box (green indicates on).
Save the program.
4. Start a program run.

5. Apromptto Clear Standoffs from Lifter Plate will display. Remove
any hardware from the work area that would otherwise be in the path of conveyor rail
movement during the next step.

CAUTION: Prior to running a program on a dispenser configured with the automatic-width con-

& veyor adjustment feature, always verify that all boards, fixtures, and other hardware within
the work area envelope have been removed or repositioned to prevent damage to and by the
conveyor rails. Potentially, every program can be set to a different conveyor width. The conveyor
width setting for the program you want to run may not be set in accordance with current hard-
ware positions.

6. Press CONTINUE. The conveyor rails will immediately adjust to the width set in the cur-
rent program.
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Calibration

Calibration is important for keeping systems within specifications. Several dispenser features
may need occasional attention:

« Calibration Menu (pg 3.124)

« Conveyor Calibration (pg 3.126)

* Vision Calibration (pg 3.128)

+ Scale Set Up within Software (pg 3.129)

For shape calibration, refer to Weight Calibrated Shapes (pg 4.91).

Calibration Menu

A drop-down menu of calibration choices is available by clicking on Calibration in the menu
bar of the main window.

A brief explanation of each configuration choice follows:

Calibrate Conveyor Speed

The conveyor must be calibrated any time a conveyor speed control is changed. Refer
to Conveyor Speed Calibration (pg 3.126).

Calibrate Conveyor Width

A conveyor equipped with automatic width adjust requires calibration to achieve
proper processing results. Refer to Conveyor Width Calibration (pg 3.126).

Map X-Y Surface

Mapping the dispenser work area for precise movement reduces the errors in posi-
tioning/placement caused by mechanical imperfections. For precision of less than
0.003” (0.076 mm), mapping is required. For high accuracy applications, mapping
should be performed at least every six months (more often depending on usage) and
every time the dispenser is moved.

Mapping is currently performed offline. Do not use the Calibration > Map XY
Surface sequence from the main menu bar. Instead, follow the detailed instructions
on how to map the system offline provided in the Precision Contour Mapping Calibra-
tion procedure (request the most current version of document part number
221MAPDOC).

Plot X-Y Surface

DSplot provides a two dimensional graphical representation of the mapping data. A
visual representation of the Delta X and Delta Y offsets, normalized values, differ-
ences, and gantry coordinates of the mapping data are possible.

Plotting of the X-Y dispenser work area surface is currently performed offline. Do not
use the Calibration > Plot XY Surface sequence from the main menu bar. Instead,
refer to the DSplot instructions in the Precision Contour Mapping Calibration proce-
dure (request the most current version of document part number 221MAPDOC).

Live Video Parameters

Used to align Cognex cross-hair generator with video capture. There is no reason for
the typical user to use this feature.

Test Serial ports
This function is for software development purposes only.
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Calibrate VCI Tilt
Adjust VCI Z

Tilt Adjust Fixture Controls

Several styles of mechanical tilt adjust fixtures are available from GPD Global. Estab-
lished operation sequences are used to calibrate and adjust a fixture tilt position. Use
only the established setup sequence described in the document(s) listed below that
are specific to the control fixture functions for your system. Using any other means
can lead to damaged equipment and will void your warranty.

*  Vacuum Tilt Fixture Calibration (Part No. 22150613CALIB) details calibration pro-
cess instructions.

*  Vacuum Tilt Station (Part No. 22150613) includes instructions for setup, position
adjustment, and maintenance.

* Dual Rotation Fixture Operations & Adjustments (Part No. 22150250M) includes
instructions for setup, adjustments, installation, and maintenance.
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Conveyor Calibration

To achieve the best operating results, systems equipped with a conveyor must be calibrated
any time a conveyor speed control is changed. Systems equipped with the slow transit speed
option and/or the automatic width adjust option require additional calibration procedures be
performed.

Conveyor Speed Calibration

In order to ensure the conveyor operates at the correct rate of speed, both single and three
stop-pin conveyors must be calibrated any time a conveyor speed control is changed. Failure
to calibrate changes to conveyor speeds is likely to result in time-out messages and improper
stop-pin firing times.

Conveyor speed calibration uses the main menu bar Calibration > Calibrate Conveyor Speeds
sequence. For complete, detailed instructions on how to calibrate both board transit speed
and the optional slow transit speed, refer to CALIBRATE Conveyor Speeds in the Dispenser
Service Guide.

Conveyor Width Calibration

5/18/18

Calibrating the conveyor establishes the width between the conveyor rails for successful
results when Programming for Auto-Width (pg 3.123). A conveyor equipped with automatic
width adjust requires calibration to achieve proper processing results.

Typically, auto-width conveyor calibration is a one-time process performed at the factory. If,
however, you want to re-calibrate the conveyor width, use the following procedure appropriate
for your system.

Select the procedure appropriate for your system based on the version of operating software
installed on your system.

+  Auto-width Conveyor Calibration - as of FLOware Software version 2.9 (pg 3.126)
+  Auto-width Conveyor Calibration - for FLOware Software PRIOR to version 2.9 (pg 3.127)

Auto-width Conveyor Calibration - as of FLOware Software version 2.9

Conveyor calibration is performed using a calibration tool (part number 22121463) and the
following procedure. FLOware software version 2.9 is required to operate the calibration
function as described in this procedure.

NOTE: The following calibration procedure supersedes earlier calibration procedures.

To calibrate an auto-width conveyor:

1. \Verify that all boards are removed from the conveyor system.

2. From the main window menu bar, click on Calibration > Calibrate Conveyor Width. Cali-
bration Conveyor Width displays.

futn Cosveyor Width Calibration

Encoder Type :MEE 5508520

det the cosveyor width to Jis (P.Zme) amd press ENTER:
wait...

Get the coseypos to Fis (177.8Ben) asd pross ENTER:g
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Place the calibration plate in the conveyor at the nest position so it is seated against the
nest stop pin. The conveyor should be snug against the calibration tool at a 3” (7.6 cm)
opening.

i T
k LN
= CALEEATION

MWD
P

Press ENTER.

Place the calibration tool in the conveyor at the nest position so it is seated against the
nest stop pin. The conveyor should be snug against the calibration tool at a 7” (17.8 cm)
opening.

Press ENTER.

Remove the calibration plate. Calibration is complete.

Auto-width Conveyor Calibration - for FLOware Software PRIOR to version 2.9

To calibrate for auto conveyor width adjust:

1.
2.

Verify that all boards are removed from the conveyor system.

Position the Calibration Block on the conveyor by adjusting the conveyor rails to the
approximate width of 1.50” (38.10 mm) using either the Conveyor Open/Close button (for
MAX Series dispenser systems) or the Conveyor manual hand crank (for DS Series dis-
penser systems).

1.800% (32,40 mm)

[
[ CALIERATION BLOCK
| Block PIN 22901137

NOTE: For conveyor control locations, refer to ADJUST Conveyor Width in the Periodic
Operations section of the Dispenser Service Guide.

Slide the Calibration Block into the conveyor nest position and seat it against the nest stop
pin.

Adjust conveyor width so the Calibration Block is almost snug between the rails but will
slide freely on the conveyor belts.

Calibration the conveyor:
a. From the main menu bar, click Calibration > Calibrate Conveyor Width.
b. Follow the directions that display:

Auto Conveyor Width Calibration
Set the conveyor width to 28.1 mm (1.5 inches) and press
ENTER.

Conveyor width calibration occurs.

Calibration Complete - remove setup tool and then press
ENTER.

Remove the Calibration Block from the conveyor. Calibration is complete.
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Vision Calibration
To verify that the vision system is properly calibrated:

1. In the Program Editor, click on the MISC PROGRAM SETTINGS button to open the Mis-
cellaneous Program Settings window.

2. All default boxes in the Vision Calibration pane should be turned on (they should appear
blue). If any of these boxes appear gray, click them to turn them on. Turning on the default
boxes forces the program to use the default vision values established in the ..Default.. pro-
gram.

The default vision values from
the ..default.. program are used
when these default boxes are
turned on.

Click on APPLY and then DONE.

4. Run your new program in Inspect mode to verify that the vision system is calibrated cor-
rectly — it should be able to locate the calibration dot on the calibration station. (If the
camera cannot find the calibration dot, go to the ..Default.. program and examine the val-
ues in the vision calibration pane of the Miscellaneous Program Settings window.

Your new program should now be ready to use in Run mode.
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Scale Set Up within Software

The first step in scale setup is to determine the flow rate of your valve material by using weight
volume data. The next step is to apply the results as either material default values or as
material values used by a single program.

After the initial power-up, depending on the model, the scale requires a minimum of 30 to 60
minutes to reach its required operating temperature. For further operating specifics, refer to
SETUP Scale in the Periodic Operations section of the Dispenser Service Guide.

The following applies to all scale models.

» Scale Software Operation Theory (pg 3.129)

+ Determine Valve Flow Rate Using Weight Volume (pg 3.129)

*  Scale Set Up Within Program (pg 3.132)

» Sustain Scale Adjustment Across Multiple Programs (pg 3.133)

Scale Software Operation Theory

Scale values can be set up as defaults for any program using a particular material by entering
them in Mounts/Material Editor for the Material Library (Program Editor > Libraries >
Materials). Another option is to apply scale values to a single program by entering them in
Mounts/Material Editor for that program (Program Editor > Valve/Tool Mounts).

When the time value entered in Weight On Time expires, the system looks for Target Weight
for On Time. If the actual weight is within Tolerance for Weight, the program runs. If the actual
weight is outside Tolerance for Weight, the system displays the percentage of error in the
Monitor field on the main window.

The system automatically increases/decreases Weight On Time by the percentage of error
and then performs a weighing operation at the scale. The system repeats this cycle either until
it reaches a value within Tolerance for Weight or until it exceeds Maximum Scale Retry.

The resulting percentage of change that the system used to increase/decrease Weight On
Time is automatically used to compensate for actual material flow during program execution.

Determine Valve Flow Rate Using Weight Volume

Use this procedure to determine the material weight volume values you will need later for
scale setup within a program. Once you determine a weight volume value, you may alter the
percentage error, but the most important aspect of the following procedure is to obtain
consistent results. If you use a weight volume value from inconsistent results, you risk slowing
down program runs due to scale retries for out of tolerance weight volumes.

To determine valve flow rate using weight volume:

1. Prepare a valve for dispensing with a clean needle and fresh material at room tempera-
ture.
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2. From the main menu bar, click Machine Controls > Offline Operations. The Offline Opera-
tions window (ltem 1 in graphic below) displays.
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Enter preliminary value, if desired, in the Expected Weight field (Item 4).

Click on the WEIGH button (Item 5). The system will move to the scale and dispense for

After the dispense completes, verify that the needle snapped away cleanly leaving no
material tail trailing from the needle tip. If needed, make adjustments to encourage the
material to break away cleanly, i.e., to eliminate material trailing from the needle tip:

Hardware — to make adjustments so the material tail adheres to the side of the purge cup
as the needle moves away, either adjust the position of the purge cup so the needle is
positioned along the cup edge or adjust the dispense height at the cup. The dispense
height at the purge cup is set up in Base Locations. A full discussion of Base Locations is

Software — to adjust dispensing values such as Snap-off Velocity, Pre-Snap Delay, Post
Snap Delay, or Auger Reverse, keep in mind that valve speed and syringe air pressure

Closn | Apply Waigh Purgs | Srviugs| Clean Halp |
3. Select the Mount Position (Item 2) to be used during this procedure.
4. Enter preliminary value in the top Weight On Time field (Item 3).
5.
6.
the length of time set in the Weight On Time field.
7.
located in the appendices of the Dispenser Service Guide.
can drastically affect dispense accuracy.
8.

If you entered a value in the Expected Weight field, the scale weight value displays in an
Information window (Item 6) with an error percentage. Note the values displayed. (During
an actual program run, these values will display in the Monitor field (Item 7) of the main
window instead of in the information window.) As needed, increase the Weight On Time
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value to achieve enough volume for accurate results. A 3-position scale should be 15 mg
or greater; a 4-position scale should be 10 mg or greater.

Table 24: EXAMPLE - Changing the Percentage of Error

Let’s assume the desired shot weighs 0.0572 g (Expected
Weight) and it takes 60 seconds (Weight On Time(s)) to dispense.
When you test for the valve flow rate, the results display in the
Information window as shown in the graphic below. Now, let’s say
you want to change the percentage error from -5% to 0%.

1. Add 5% of Weight On Times to Weight On Times: (.05 X
60.000) + 60.000 = 63.000

2. Enter 63.000 in Weight On Times.

3. Click the WEIGHT button.

4. Note the new values displayed in the Information window.

- Line Operations
; The amount of time the
CREvy ) ek m“m.,;, —  valveis on at the scale
fo create a shot
Ve Microlat Vake |
Material Traelinarn - 635 | [om0s | | Actual scale WEighT

MOME | [ o000 ‘

| 0,0072 ¢ Expechsd Weight

@
Purge Qn Tiee e l Value — Expecied Change
mninlls 0.0543 | 0.0572 -5.0000%

Close | Apply | Welgh | Pumge || Sndoge] Clean | Halp |

Percentage of emor; the difference between
actual weight and expected weight. If actual
weight is short of expected weight, a negative
value results; if actual weight is greater than
expected weight, the value will be positve.

Weight expected from the given On Times

9. To verify dispense accuracy, run the test several times using the same values, repeating
steps Step 4 through Step 8 until verification is complete.

10. Record the final weight results and the Weight On Time value for use in Scale Set Up
within Software (pg 3.129).
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Scale Set Up Within Program

During a program run, the system will automatically compensate for actual material flow when
you set up the scale values resulting from the Determine Valve Flow Rate Using Weight
Volume (pg 3.129) procedure. You can set up these values in either the material library or in a
specific program. We suggest entering them in the material library to simplify future
programming.

To set up scale values in the material library:

1. Access the Scale Parameters in the material library:
a. a. Double click on the Program Editor icon. The Program Editor window displays.
b. From the Program Editor menu bar, click on Libraries > Materials. The Mounts/Mate-
rial Editor - MATERIAL window displays.

2. Click on the Panel Selection button (ltem 3 in the graphic below), scroll down the pop up
menu, and select Weight. The Scale Parameters panel (Item 1) will display in the right-
hand side of the Mounts/Material Editor - MATERIAL window.

MATERIAL

I =] PanelSelection

Material | Ablestik $380

Group | Conductive Adhesive/Epoxy '7
Color | Silver Neede 20 | = 0.000 5 4
Target Wesight [, —
Valve/Tool Auger Valve | Gantzy A = | :?En nfng' If'-'-'r'3i |
Tolerance - [—
Deseription for wathl”""" § el
Conductive matarial that must ba kapt at -20 deg C/F Scﬂ-ﬁm [b.= 0 5 4
Mudmum [
scale Agust| 7 el 6§
Macdmum [ .
SatteT Harns NONE Sca.je ﬁml “'---..___ ?
N Auto Clean i _I o Toar
J Marual Calibration W I Skip Calioration i o g
_ - Skip Weighing 4
Feature 10 Inspect Delay | 2,000
Close Apply Delata| | Copy

3. Using the values recorded during Step 10 (pg 3-131), input values in Weighing On Time
(Item 2) and Target Weight for On Time (ltem 4).

4. Enter an allowable Tolerance for Weight (Item 5) value that will supply adequate coverage
for the desired results without exceeding your coverage limit.
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5. Typically, you will want to enter a value in Maximum Scale Adjust (Item 6) between 50%
and 70%.

NOTE: If you are mixing 2-part material on the machine, enter a value in Maximum Scale
Adjust based on the following choices for handling material conditions:

Automatic operations — set the maximum scale adjust to 50% or greater.

System attempts to make a single correction before flagging the operator that scale
adjustment has failed — set the maximum scale adjust to less than 50%. The smaller the
tolerance value, the longer the scale compensation routine will take.

6. If you want the system to keep adjusting until the set value is achieved, enter a value in
Maximum Scale Retry (Item 7). Results depend upon whether or not the scale adjusts
within the maximum number of scale retries:

If the scale adjusts to the value set in Maximum Scale, adjust before reaching the maxi-
mum number of retries. Then the program On-Times and Dispense Velocity will be
adjusted according to the percentage that was required to match your Weighing On-Time
to Target Weight.

The scale fails to adjust to the value set in Maximum Scale Adjust by the maximum num-
ber of retries. Then the system will flag the operator with the following options:

— Continue = continue with last correction attempt.

— Retry = start scale adjust over.

— Abort = abort program.

7. Click APPLY to save your entries or click CLOSE to exit the window without saving the
entries.

Sustain Scale Adjustment Across Multiple Programs
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If you set up material volume values using the Material Library, any adjustments you make to
scale On- Time values in one program will carry across to all other programs using the same
material for as long as the Stale Calibration function is active.

Table 25: EXAMPLE - Automatic Adjustment Across Multiple Programs

Let’'s assume you have set up material volume values in the Material Library for a
particular material. Now let’s also assume that Program A and Program B both use that
same material. During machine calibration for Program A, material flow is calculated to be
30% less than the Target Weight for On Time; the system automatically corrects for this
difference.

When machine calibration runs for Program B, the system will automatically apply
the additional 30% of On Time at the start of the weigh routine to minimize calibra-
tion time. The system will continue to automatically apply an additional 30% of On
Time to all programs run with this same material until the Stale Calibration value
expires.
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To sustain a scale adjustment setting across all programs using the same material:

1. Click on Configuration > Option Settings. Option Settings displays.
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2. Verify that “Reset Scale when Calibrating” box (Item 1) is turned OFF.

Status of Reset Scale

When Calibrating How Weight Calibration is Affected

Turned Off (gray) Begins with the value at the last calibration.

Turned On (red) Begins with initial scale adjustment.

3. Verify that Stale Calibration (ltem 2) is active. The scale adjustment setting remains valid
until the Stale Calibration value expires.

4. Click OK to save your entries and exit the window.

Reboot the system.
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Configuration

Various configuration topics are included here. Because your machine is configured at the
factory, re-configuration is typically only required if hardware is added or changed.

»  Configuration Menu (pg 3.135)

*  Monitoring Program Details (pg 3.138)

«  Temperature Control & Monitoring (pg 3.141)
* Needle Cleaner Setup (pg 3.142)

Configuration Menu

To create a custom dispenser system, certain selections are made at the factory to configure
the machine before it ships. As needed, additional local changes can be made to the machine;
a machine reboot is required for a configuration change to take effect.
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A drop-down menu of configuration choices is available by clicking
on Configuration in the menu bar of the main window. Of particular
interest is the Option Settings choice; the other choices are not
intended for typical customer use.

A brief explanation of each configuration choice follows:

Dispenser Configuration

Brings up two panels, one to edit the current hardware
configuration and one to display a fully detailed description
of the current machine hardware configuration. Text is
divided into categories such as General, Main, and
Run_Engine and resembles the *.INI form used for Micro-
soft configuration files. Entries in this file are normally
changed only if the machine hardware is changed.

For directions on how to change the global default settings
for units, refer to Global Default for Units (pg 7.1).

Using FLOware Software

Dispenser Configuration

Option Settings
[/Q Definitions
Custom [0 Definitions

Base Locations
TCP/IP Configuration

Servo Configuration
Print Config Files
Main Resource File
Editor Resource File
Mise Resource File

Temperature PIE

For directions on how to configure the Monitor field to display program data on the
main control window, refer to Monitor Configuration Setup (pg 3.138).

Option Settings

Options Settings establish machine configuration for hardware on the dispenser. You
can set parameters for the values that (may) affect your overall operation. For further

details, refer to Option Settings Features (pg 3.136).
1/0 Definitions

Brings up two panels, one to edit the current I/O (input/output) configuration and one
to display a fully detailed description of the current I/Os, the configuration file contents,
and the associated text for how to add I/Os into the file. Entries in this file are manually

changed only if machine wiring is changed.

Custom 1/O Definitions

Defines which items are displayed on the Custom Controls menu. Custom I/O names

are defined here.

Base Locations

Configuring the base locations enables the user to verify and teach all base locations
and positions around the table for automatic adjustments. All base locations are
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initially established at the factory, however, if any of the following conditions arise, a
qualified engineer or maintenance person may use base locations to:

+ teach the location of a newly installed device,

* change a location to increase process speed,

» verify the current coordinates of an existing location, or

* re-teach an existing location. For example, the camera calibration locations
should be re-taught after adding a new calibration dot sticker to the calibration sta-
tion.

A full discussion of base locations is located in Base Locations in the appendices of
the Dispenser Service Guide.

TCPI/IP Configuration

For procedural details on how to set up TCP/IP communications between a GPD
Global dispenser and a customer-supplied PC in order to establish the necessary
communication to transfer data between the two systems, refer to Interfacility Commu-
nications (pg 7.15).

Servo Configuration

CAUTION: DO NOT USE. This is a factory set calibration and is for GPD Global use only. Mis-
use of this file can cause the loss of all motor tuning, etc.

Print Config Files
Used to print all configuration files to a printer hooked up to the back of the dispenser.
Main Resource File

Editor Resource File
Misc Resource File

These files access X-Windows Resource Files which control all window displays and
all window functions. Familiarity with X-Windows is required to work with these files.
Changes installed at the site are removed with any software update.

Temp PID

Not yet implemented. Determines PID loop parameters for temperature control (or
anything else controlled by a PID loop).

Option Settings Features
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Options Settings are used to establish the machine configuration for hardware on the
dispenser. You can set parameters for the values that (may) affect your overall operation. For
a list of individual parameter descriptions, refer to Option Settings (pg 5.70).

A few of the Option Settings features are discussed below:

Logging Files
Logging is an engineering tool that collects various types of system and user
messages for purposes of analyzing machine performance, process results, failure
rates, etc. Instructions on how to set up, retrieve, and format logging data can be
found under Message Logs (pg 6.5).

Monitor Temperature

The temperature ready signals from each temperature controller can be monitored.
For instructions on how to set up temperature monitoring, refer to Temperature
Control & Monitoring (pg 3.141).
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Needle Cleaner

When the dispenser includes needle cleaner hardware, the system must be config-
ured for the type of cleaner installed, various operational parameters must be estab-
lished, and the coordinates for each point in the cleaning path must be taught. This set
up has probably been done for you at the factory, however, most setup parameters
may be modified, as needed, for process purposes. Instructions on how to configure a
needle cleaner and set up its cleaning path can be found under Needle Cleaner Setup
(pg 3.142).

Scale Adjustment

With material volume values set up for a particular material, any adjustment to scale
On-Time values in one program can be made to carry across to all other programs
using the same material (as long as certain conditions are met). Find detailed instruc-
tions under Sustain Scale Adjustment Across Multiple Programs (pg 3.133).

5/18/18 FLOware Software Guide 3.137



GPD Global® Using FLOware Software

Monitoring Program Details

The Monitor (pg 3.29) field, in the main window, displays a continually updated account of
some program details only while a program is active.

This field can be configured to display several types of values: subboard count, board count (if
subboards are not used), touch probe height, and tool foot pressure.

The rules that govern the monitor field:

* Subboard and board count represent the number of subboards (boards) processed by a
program. This value increments by one when a subboard (board) has completed process-
ing.

« Surface sensor height can be displayed in millimeters (with three decimal places) or in
inches (with four decimal places).

*  Pressure exerted by the Pressure Pick-up Tool is represented in grams. If the Monitor field
is configured for the Pressure Pick-up Tool and the tool is not installed on the dispenser,
then the Pressure value remains zero.

Monitor Configuration Setup
When the Monitor field is configured to display on the main window, the real-time status of
certain program data can be monitored by viewing this field.

There are several choices of display content from which to choose during configuration setup.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel.
Improper application of this information can lead to serious complications in FLOware Software
operations. Any non-GPD Global employee who uses this information beyond the stated appli-
cation specified by GPD Global Service Department personnel is in danger of causing personal
injury and invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

To configure the dispenser to display the Monitor field:

1. From the main window menu bar, click on Configuration > Dispenser Configuration
(pg 3.135).

2. In the Edit Configuration window that displays, locate the [Run_Engine] section and then
set MonitorDisp to the appropriate value using the following choices:

MonitorDisp = n
where n defines whether or not the Monitor field displays on the main window.
0 = field content is not displayed (default setting)

1 = displays subboard count and tool foot pressure in grams (requires installation of Pres-
sure Pick-up Tool hardware or else the pressure value will remain zero)

2 = displays subboard or board count and surface sensor height value (mm with 3 decimal
places)

3 = displays subboard or board count and surface sensor height value (inches with 4 dec-
imal places)
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3. Press ESC to exit the Edit Configuration window, choose X to exit, and then choose Y for
Yes to save the change.

4. Reboot the dispenser.

Z Probe Limits
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In effect as of FLOware software version 2.9.3P

The PROBE operation (Z height detection) will test the measured elevation against a set of
limits and if the elevation is found to be outside of those limits, an error message indicating the
Z Probe is out of range is presented, and the process is paused.

The limits are defined in the program PROBE step using the Minimum Z Value and Maximum
Z Value fields.

» If both of these values are non-zero, then they define the range of the limits.
* If one or both these values are zero (0.000) then no limits checking is performed.

NOTE: The PROBE operation operates as expected in both pre and post scan modes.
NOTE: This testing/validation is not designed to be used to ensure a surface is within a
very small tolerance for process precision. The purpose of this testing is to ensure that the

measurements taken are not grossly outside the expected range which can happen if a
height sensor is dirty, bent, or otherwise not operating properly.

Z Probe Limits Operation

The Touch Pad surface elevation is used as a reference elevation. When a Z Probe operation
is performed, the difference between the detected surface and the Touch Pad surface is calcu-
lated. This difference is checked against the range specified by the Minimum Z Value and
Maximum Z Value values. If the difference between the detected surface and the Touch Pad
surface falls within the defined limits, the operation is successful and the process continues.

If the difference is outside the defined limits, the process is paused with a warning dialog
presented to the operator (plus, yellow light turns on and alarm sounds). The operator may at
this point:

* ignore the warning and continue the process,

« retry the ZProbe (this will again measure the elevation of the surface and test it against the
limits), or

* abort the process altogether.

Example:

Assume the following:

Touch Pad Elevation 10.550 mm
Minimum Z Value -0.1 mm
Maximum Z Value 0.1 mm

A PROBE operation is performed which measures a surface at 10.503 mm. The difference
between the measured surface and the Touch Pad elevation is 0.047 mm. This falls within the
range -0.1 mm,0.1 mm and so the operation succeeds and the process continues.
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A different PROBE operation is performed which measures a surface at 11.184 mm. The
difference between the measured surface and the Touch Pad elevation is -0.634 mm which is
well outside the defined range of -0.1 mm,0.1 mm. In this case, the process immediately stops
and the operator is alerted with a message indicating the Z Probe is out of range. The operator
may ignore the message, retry the measurement, or abort the process.
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Temperature Control & Monitoring

The FLOware software temperature control function is currently limited to monitoring the
temperature ready signals from each temperature controller. Temperature control for each
heated device on the dispenser is maintained mechanically by a CAL 9900 temperature
controller.

When temperature monitoring is set up in Option Settings, a program will test the temperature
ready signal from each heated device prior to processing each product (board). If the
temperature is within the set deviation range of the set temperature, the program continues. If
the temperature falls outside this range, the program will wait until set temperature is achieved
before proceeding.

Monitoring Temperature
To set up temperature monitoring:

1. From the main menu bar, click Configuration > Option Settings. Option Settings displays.

2. Turn ON the Test Temp Ready default box. This activates the temperature monitoring
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Needle Cleaner Setup

The optional, software-controlled needle cleaner can be used to
clean the needle on up to three heads, one at a time. This process is
software controlled and can be used within a program to clean a
needle during the calibration process or any time during a program
run, or offline when the dispenser is not busy.

Needle cleaner setup involves these topics:

* Cleaning Path (pg 3.142)
+ Cleaner Setup Overview (pg 3.142)

+  Configuring Cleaner (pg 3.143)
+ Setting Cleaner Parameters (pg 3.144)
»  Teaching Cleaning Path (pg 3.146)

Cleaning Path

Initially, coordinates for the start and end points of the needle cleaning path have to be taught.
Then values for the number of increments the needle is to move and the distance the needle is
to move from the last cleaning point need to be entered.

For example, the cleaning path for a standard grip-type needle cleaner typically starts with the
needle positioned between the set of pneumatically operated grip jaws. After the jaws clamp
on the needle simultaneously, the gantry typically raises the needle upward to the ending
point, wiping the needle clean on the soft jaws in the process.

Cleaner Setup Overview
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Before needle cleaning operations can be used, some set up may be required. The set up
required by the needle cleaner has probably already been done for you at the factory,
however, most setup parameters may be modified, as needed, for process purposes. The
system must be configured for the type of cleaner installed, various operational parameters
must be established, and the coordinates for each point in the cleaning path must be taught.

The basic steps involved in setting up a needle cleaner are as follows:

1. Establish Configuration & Operational Parameters. Needle cleaner configuration is
typically done at the factory - see the Configuring Cleaner (pg 3.143) discussion - how-
ever, you may modify various operational parameters, such as needle velocity during
cleaning, the incremental distance moved between successive cleaning dispenses, and
the number of increments made before operator intervention is required. To modify these
configuration parameters, refer to the Setting Cleaner Parameters (pg 3.144) discussion.

2. Teach Locations. The cleaning path locations (coordinates) through which each head
moves during the needle cleaning process are typically taught at the factory, however, you
may re-teach these cleaning path locations if desired. To modify the locations at which
needle cleaning operations begin and end, refer to Teaching Cleaning Path (pg 3.146).

3. For instructions on how to use the needle cleaner after set up is complete, refer to the fol-
lowing procedures in the Dispenser Service Guide:
— Needle Cleaner in the SETUP section
— Needle Online with Needle Cleaner in the CLEAN section
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Configuring Cleaner
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Your system has already been configured for the type of automatic needle cleaner(s) installed,
each cleaner has been assigned to a head, and unless it is replaced by a different type of
hardware, this configuration information should not change. However, various other opera-
tional parameters within the configuration may be modified, such as needle velocity during
cleaning, the incremental distance moved between successive cleaning dispenses, and the
number of increments made before operator intervention is required.

The locations at which needle cleaner operations occur, i.e. the points in the cleaning path
used during a program, may also be modified. The coordinates at which needle cleaning
operations begin and end, the type of valve motion used, and the velocity at which it occurs
are all variables you may change as needed.

Other Configuration Choices

GPD Global offers different needle cleaner types and configurations to meet a variety of
needs. A single needle cleaner can be scale-mounted or one or more needle cleaners can be
table-mounted. Whenever needle cleaner hardware is installed or moved, the needle cleaner
must be re-configured.

Assigning Cleaner to a Head

As previously noted, the cleaner(s) on your system have probably already been assigned to a
head. If circumstances dictate a change, then know that:

* A head must be assigned for each grip type needle cleaner.

+ Head assignment is unnecessary for brush type needle cleaners.

*  Multiple cleaners may be assigned to the same head.

« Typically, a maximum of three heads and three needle cleaners can be installed on a dis-
penser.

To assign a grip type needle cleaner to a head:

1. In the main menu bar of the Main Control Panel, click on Configuration > Dispenser Con-
figuration (pg 3.135). The Edit Configuration and Configuration Definition windows display.

2. In Edit Configuration, set the Clean1X, Clean2X, and Clean3X fields to an appropriate
value. The value you enter in each determines which head is assigned to that particular
needle cleaner hardware. Needle Cleaner Field Needle cleaner hardware is identified by
the field used in Edit Configuration:

Needle Cleaner Field Head Value
Needle cleaner hardware is identified by the Head hardware is identified by the value
field used in Edit Configuration: used in Edit Configuration:
Needle Cleaner Field Head Value
first Clean1X 1 0
second Clean2X 2 1
third Clean3X 3 2
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EXAMPLE 1
In the following example, the first cleaner has been assigned to Head 1, the second
cleaner to Head 2, and the third cleaner to Head 3.

Field Value
Clean1X 0
Clean2X 1
Clean3X 2

EXAMPLE 2

In the following example, both the first and second cleaners have been assigned to Head
1, and the third cleaner has been assigned to Head 2.

Field Value
Clean1X 0
Clean2X 0
Clean3X 1

3. Close the Edit Configuration and Configuration Definition windows. You have completed
assigning a head to the grip type needle cleaner.

Setting Cleaner Parameters
To establish or modify the needle cleaner configuration parameters:

1. In the main menu bar of the Main Control Panel, click on Configuration > Option Settings.
Locate the needle cleaner parameter fields in the Option Setting window that displays.

NOTE: Beginning with version 2.4 of the FLOware software, a selection from the pop-up
menu of needle cleaner types replaces the numerical entry previously required in the Type
of Needle Cleaner field.
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2. Ifthe type of needle cleaner hardware has been changed, set the Type of Needle Cleaner
field to the new needle cleaner code appropriate for the type, quantity, and location of
hardware, and the type of motion or number of moves to be used in the cleaning path.

Table 26: Relating Needle Cleaner Codes and Characteristics

Type of | Number of | Installed Type of Motlop or # Code for
. of Moves in Notes Type of
Cleaner Cleaners Location .
Cleaning Path Cleaner
Varies with the val-
. ues input for Clean- | The coordinates for each move are
Grip Al Table ing Velocity and taught using Base Locations. 7
Cleaning Increment.
2 inch move in X direction from a point
1 . . 1
taught using Base Locations.
2 2
Table ]
. 3 The coordinates for each move are 3
Single - .
4 taught using Base Locations. 4
Brush o S
The coordinates for each move are
Scale 2 - . 11
taught using Base Locations.
2 inch move in X direction from a point
1 . . 21
) taught using Base Locations.
Multiple Table
The coordinates for each move are
2 - . 22
taught using Base Locations.
Ignore All All 0 Cleaning is suppressed.
None None None None No needle cleaner is present. (Default) |0

3. Cleaning Velocity. To change the velocity at which the needle moves through the auto-
matic needle cleaner, change the value in Cleaning Velocity. If no needle cleaner is pres-
ent, the default is a 0.0 value.

4. Cleaning Increment. If the machine is equipped with either a scale-integrated needle
cleaner or one to three grip-type needle cleaners, a value must be entered in Cleaning
Increment for the incremental distance (mm) moved between successive cleaning dis-
penses.

5. Cleaning Count. If the machine is equipped with either a scale-integrated needle cleaner
or one to three grip-type needle cleaners, a value must be entered in Cleaning Count to
indicate the maximum number of increments the needle will move through a needle
cleaner before the operator is notified for purposes of operator intervention.

NOTE: As of FLOware software version 2.3, Cleaning Count is retained between
programs, including offline operations; thus, the user cannot reset the count.
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Teaching Cleaning Path

The cleaning path locations through which a head moves during the needle cleaning process
are typically taught at the factory, however, you may re-teach these locations as needed. You
may modify the coordinates at which needle cleaning operations begin and end.

Teaching a location is a matter of selecting the name of the location you wish to teach, jogging
the gantry to the coordinates you want to establish for the selected name, and then clicking
several on-screen buttons.

The XY and Z coordinates for each needle cleaning location are taught in a two step process.
Be sure to first teach the XY coordinates using the camera over the desired location, and then
teach the Z coordinate using the head mount position at the desired location.

To establish or modify needle cleaning coordinates:

1. Take the following steps to access the scrolling list from which you will choose base loca-
tions for the cleaning path:

a. Sign onto the system with a password with Configuration authority.

b. In the main menu bar of the main window, click on Configuration > Base Locations.
The Check/Set Base Locations window displays.

NOTE: The normal multi-tasking capability of the system is unavailable while the Check/
Set Base Locations window is open.

c. Scroll down through the list of base locations until the series of locations labeled Cam-
era to NeedleCleanx (XY): Head1 to Z displays.

Heads to Target (XVZ) ¥: 001.560 " V¥:-000.580 * 2Z: 1.438 "

0072 e Specah ocsons P List of base

locations

move

arvpuhiare im MUY with £ ot the £ position

muduzuv.&mucnu
CTRL to meve

Sehcl @ lecalbon and click Meve Cumira

N & Lghtl ot

[a]  tom] | | & Em)

2. To determine which base location(s) need to be taught in order to create the desired
cleaning path, answer the following questions:

a. Which code is entered in the Type of Needle Cleaner field on the Option Settings win-
dow? (Refer to steps 1 and 2 of Setting Cleaner Parameters (pg 3.144). Find that
same code, in the column marked Code for Type of Needle Cleaner, in Base Loca-
tions Used by Needle Cleaner Codes 1-11 (pg 3.147) or Base Locations Used by Nee-
dle Cleaner Codes 17-22 (pg 3.148).

b. To which head position (1, 2, or 3) is the needle cleaner assigned? Find that same
head number in the column marked Head Assignment.
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c. If you answered question 2.a with:

« 1,2, 3,4, orb5, then answer the question How many base location points are
needed in the cleaning path?
* 11 or greater, then continue with the following step.

d. The name of one or more base locations is listed in the column marked Base Loca-
tion(s) to be Taught. When multiple base locations are to be taught, the initial location
or starting point is typically positioned at one end or the other of the needle cleaner at
the elevation at which the cleaning action will begin. The final location or ending point
is typically positioned at the opposite end of the needle cleaner at an elevation clear of
the needle cleaner.

Table 27: Base Locations Used by Needle Cleaner Codes 1-11

Codes 1-11
Code for Number of
Type of Head Moves in Base Location(s) to be .
Needle Assignment Cleaning Taught Move that will Occur
Cleaner Path

Starts at the location taught for Camera
1 1 to NeedleClean1 and then moves 2 inch
in the X direction. Refer to note below.t

Starts at the location taught for Camera
to NeedleClean1 and then moves to the
location taught for Camera to Needle-
Clean2. Refer to note below.t

Starts at the location taught for Camera
to NeedleClean1 and then moves in

3 3 sequence to the locations taught for
Camera to NeedleCleant Camera to NeedleClean2 and Camera to

Camera to NeedleClean2
Camera to NeedleClean3 NeedleClean3. Refer to note below.t

1.2,0r3 Camera to NeedleClean4 Starts at the location taught for Camera

Camera to NeedleClean5 to NeedleClean1 and then moves in

4 4 Camera to NeedleClean6 sequence to the locations taught for
Camera to NeedleClean2, Camera to
NeedleClean3, and Camera to Needle-
Clean4. Refer to note below.t

Starts at the location taught for Camera
to NeedleClean1 and then moves in
sequence to the locations taught for

5 5 Camera to NeedleClean2, Camera to
NeedleClean3, Camera to Needle-
Clean4, and Camera to NeedleClean5.
Refer to note below.t

Start at the edge of the brushes with the
Camera to NeedleClean4 corresponding Z coordinate at the dis-
pense elevation.

11 1,2,0r3 2
End at the opposite end of the brushes

Camera to NeedleClean5 with the corresponding Z coordinate at an
elevation above the brushes.

+ To prevent inadvertent equipment damage, teach all six locations even though they may not all currently
be used in the needle cleaning path. GPD Global suggests teaching any unused Camera to NeedleClean
n base locates to the (XYZ) to Refresh Location coordinates. A full discussion of Base Locations is
located in the appendices of the Dispenser Service Guide.
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Table 28: Base Locations Used by Needle Cleaner Codes 17-22
Codes 17-22

Code for
Type of Head Base Location(s) to be .
Needle Assignment Taught Move that will Occur
Cleaner
tStart down between the jaws with the corresponding Z
Camera to NeedleClean1 coordinate at an elevation where the needle wipe action
1 is to occur.
Camera to NeedleClean2 T End of cleaning path with the corresponding Z coordi-
nate at an elevation above the grip jaw surface.
1 Start down between the jaws with the corresponding Z
Camera to NeedleClean3 coordinate at an elevation where the needle wipe action
2 is to occur.
17 Camera to NeedleClean4 T End of cleaning path with the corresponding Z coordi-
nate at an elevation above the grip jaw surface.
1 Start down between the jaws with the corresponding Z
Camera to NeedleClean5 coordinate at an elevation where the needle wipe action
3 is to occur.
T End of cleaning path with the corresponding Z coordi-
Camera to NeedleClean6 nate at an elevation above the grip jaw surface.
Camera to NeedleClean1
1 OR
Camera to NeedleClean2
Camera to NeedleClean3 ] ) o ] )
21 2 OR 2 inch move in X direction starting at taught location.
Camera to NeedleClean4
3 Camera to NeedleClean5
- Camera to NeedleClean6
Tor2 Camera to NeedleClean1 Start at wipe elevation.
or

Camera to NeedleClean2

End clear of jaw or brushes.

1 Typically, the start location is taught at one end or the other of the needle cleaner.
i Typically, the end location is taught at the opposite end from the start location on the needle cleaner.
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Now that you have identified which base location(s) to teach, make a selection from the
scrolling list in the Check/Set Base Locations window.

Teach the X and Y coordinates by jogging the camera to the coordinates you want to
teach for the selected base location and then click the XYZ button.

To teach the Z coordinate:
a. Mount the Head Calibration Tool in head 1 to emulate a valve.

NOTE: Always mount the Head Calibration Tool in the head 1 mount position regard-
less of the head assignment for the currently selected base location. For mounting
details, refer to Head Calibration Tool procedure under Tools & Equipment in the Rou-
tine Maintenance section of the Dispenser Service Guide.

b. Jog head 1 to the desired elevation at the needle cleaner and then click the Z ONLY
button.

NOTE: ltis critical to teach a Z height that will not transfer material from the needle
cleaner to the optional Rigid Needle StandOff if it is being used, nor damage the touch
probe if a short needle is being cleaned.

To save the newly taught values, click SAVE. To cancel your input, exit the window without
clicking SAVE.

Repeat steps 3 through 6 for any additional base locations to be used in the cleaning path.
Click DONE to close the Check/Set Base Locations window.

Boot the system so all changes take effect.
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4 Tips & Tricks

*  Program Creation (pg 4.1)
*  Program Enhancement (pg 4.52)
»  Procedures for Custom Hardware (pg 4.76)

Program Creation

+ Creating a Basic Program (pg 4.1)

+  Tutorials - How to Program Basic Shapes (pg 4.7)
* Creating a SubBoard Program (pg 4.37)

» Creating a Pick & Place Program (pg 4.44)

Creating a Basic Program

Use the following guidelines when creating a program from the beginning (scratch) instead of
importing or converting existing program data.

All of these basic steps are required to manually create a new program - perform all steps in
the order listed:

* 1. Create Program Header (pg 4.1)

» 2. Add Program Description (pg 4.2)

+ 3. Teach Program Parameters (pg 4.2)

* 4. Select Material, Head, Needle (pg 4.3)
+ 5. Create Program Lines (pg 4.4)

* 6. Define Subboards (pg 4.5)

« 7. Add Options (pg 4.6)
« 8. Verify Vision Calibration (pg 4.6)

1. Create Program Header
To create a program header:

1. Open the Program Editor by double-clicking the Program Editor icon located on the main
window. Verify that Edit Programs is selected.

2. Program Name - Create a name for the new program by clicking on ADD ITEM. Then in
the prompt that displays, type a new program name and click OK. The new name will dis-
play alphabetically in the Available Items pane of the Program Editor. The new program
name should remain selected (highlighted) so subsequent input is applied to it rather than
some other program.

3. Class - Enter a name in Class (pg 3.34) if you want the ability to filter (include/exclude) the
new program along with other programs with the same class name.

4. \Version - Enter a prefix code in Version (pg 3.34) if you want the program to have the abil-
ity to use the shape name with a version prefix instead of using the shape name specified
in the program.

5. Board Dimensions - If the dispenser is equipped with a conveyor, enter Board Dimen-
sions (pg 3.35); otherwise, skip to the next step.

NOTE: Entry of the length dimension is critical for timing conveyor operations, especially if
there are slots or holes in the board.
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Conveyor timing is also dependent on the board transit speed entered in the Options
window; this value is determined during conveyor calibration. If conveyor timing problems
are encountered when you run your new program, perhaps the conveyor needs to be re-
calibrated per Calibrate Conveyor Speed (pg 3.124).

Reference Point - Establish the board origin point (upon which all other points in the pro-

gram depend) by entering coordinates for Reference Point (pg 3.36). If the Reference

Point X and Y fields are:

— known values, enter them manually.

— unknown, use the TEACH button and the resulting Jog window to teach the coordi-
nates.

In either case, if the same location is to be used by both the Reference Point and the first
fiducial point, first teach the reference point coordinates and then immediately enter zero
in both coordinate fields for the first fiducial point.

Click APPLY EDITS to save your entries.

2. Add Program Description
Enter a program Description (pg 3.36) of descriptive text to record product and/or processing
information about the new program:

1
2
3.
4

If it is not still open, reopen the Program Editor and verify that Edit Programs is selected.
Also verify that the name for your new program is selected in the Available ltems list.
Enter desired text In the Description pane.

Click APPLY EDITS to save your entry.

3. Teach Program Parameters
Teach program parameters:
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1.

If it is not still open, reopen the Program Editor and verify that Edit Programs and the
name for your new program are selected.

Patterns - If you will be using existing patterns from the pattern library, skip to the next
step; otherwise, create any new patterns you will need for defining fiducials and bad
marks, especially if your dispenser is equipped with automatic vision. For details, refer to
Teaching a Pattern (pg 3.61).

Fiducial Points - Teach as many fiducial points (from 0 to 3) as needed for product orien-
tation. Teach these points as accurately as possible as they are used to align the board in
X, Y, and theta in relation to the Reference Point. The Reference Point should be taught
prior to teaching Fiducial Points (pg 3.37).

a. Inthe Fiducials pane of the Program Editor, click on the button of the fiducial you want
to teach (FIDUCIAL 1 X, FIDUCIAL 2 X, or FIDUCIAL 3 X). The Jog window displays.

b. Use Jog to move the camera to the desired fiducial coordinates and then click
CLOSE. This action teaches the fiducial coordinates. Click MOVE TO only to visually
verify the coordinates once they have been taught.

c. If the dispenser is equipped with an Automatic Vision System, assign a pattern to the
fiducial point. The vision system will search for the pattern at the fiducial point coordi-
nates during the program run. To assign a pattern from the Patterns Library (pg 5.16)
to the fiducial point:

1 - Click the PATTERN button associated with the selected fiducial point.
2 - Select an existing pattern from the list that displays and click ACCEPT.
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d. Click APPLY EDITS to save your input.
e. Repeat the above steps to teach up to two additional fiducial points.

4. Touch Span - If the program will be performing high precision operations, use the touch
span feature. The touch span coordinates represent the distance you want the dispenser
to travel in each axis before it performs a board height sense. To teach the touch span
parameters:

a. Inthe Fiducials pane of the Program Editor, manually enter the desiredTouch Span
(pg 3.40) coordinate values.
b. Click APPLY EDITS to save your input.

5. Bad Mark - If the program is to trigger a particular action based on whether or not a Bad
Marks (pg 3.38) pattern is detected, teach the appropriate coordinates, pattern, and flag
value for a bad mark. Bad marks can be used for several different programming strate-
gies.

a. Inthe Fiducials pane of the Program Editor, click on the BAD MARK X button. The Jog
window displays.

b. Use Jog to move the camera to the desired coordinates and then click CLOSE.

c. If the dispenser is equipped with an Automatic Vision System, assign a pattern to the
bad mark. The vision system will search for the pattern at the bad mark coordinates
during the program run.

To assign a pattern to the bad mark, click the PATTERN button associated with Bad
Mark. Then either select an existing pattern from the list that displays and click OK, or
teach a new pattern.

d. Click APPLY EDITS to save your input.

6. Alignment Points - If the program is going to use arrays:
a. Teach the alignment points as an aid for array-to-board edge alignment. For details,
refer to Arrays & Alignment Points (pg 3.99).
b. Click APPLY EDITS to save your input.

4. Select Material, Head, Needle
Select the type of head to be used, its mount position, and the material and gauge of needle to
be used. You may also need to modify the material default parameters

1. Ifitis not still open, reopen the Program Editor and verify that Edit Programs and the
name for your new program are selected.

2. Head Position - Define the station position for the valve or tool to be used in the program.
a. Inthe Program Editor, click the VALVE/TOOL MOUNTS button.
b. In the Mounts/Material Editor - MOUNT (pg 3.70) window that displays, select the
appropriate head mount station position from the Mount Position drop-down menu.
c. Click APPLY to save your input.

3. Material Type - Define the type of material to be used by the head position selected in the

prior step.
a. Inthe Mounts/Material Editor - MOUNT (pg 3.70) window, click the Material field but-
ton.

b. From the list of available materials that displays, select the name of the material to be
used, and click ACCEPT. Typically, selection of a material will automatically enter a
valve or tool name in the Valve/Tool field; a head type is usually assigned to a material
when it is set up in the Material library.

c. Click APPLY to save your input.
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4. Head Type - You may override the type of head automatically assigned during the prior
step or assign one if none was automatically selected.
a. In the Mounts/Material Editor - MOUNT (pg 3.70) window, click the Valve/Tool field.
b. From the list of available heads that displays, select the name of the valve or tool to be
used, and click ACCEPT.
c. Click APPLY to save your input.

5. Material Parameters - Any modifications you make to the material parameters here do
not affect the material parameter values set up in the material library. If the material will be
used repeatedly, it is more efficient to set up the material and make material parameter
changes in the Materials Library (pg 5.7) rather than repeating the material setup steps
every time you want to use the material in a program.

On the other hand, if you are only using the material or material parameters changes in
this one program, define the material in this manner:

a. Make any necessary changes to the default parameters for the selected material. In
addition to all the parameter fields available via the Panel Selection drop-down menu,
make any needed entries to the following fields and options: Group, Color, Descrip-
tion, Pattern Name, Auto Clean, Manual calibration, Skip Calibration, Feature ID, and
Inspect Delay.

b. Click APPLY to save your input.

6. Needle Gauge - Define the needle gauge, if any, to be used by the selected head.
a. In the Mounts/Material Editor - MOUNT (pg 3.70) window, click the Needle field but-
ton.
b. From the list of available needle gauge sizes that displays, select the gauge to be
used, and click ACCEPT.
c. Click APPLY to save your input.

7. Additional Heads - repeat Step 1 through Step 6 for each additional head to be used by
the current program.

8. Return to the Program Editor by clicking CLOSE in the Mounts/Material Editor MOUNT
window.

5. Create Program Lines
A program usually consists of multiple program lines, each of which has a set of parameters
associated with it. Program lines and parameters can be created or modified in any order. The
Program Detail window is the source of all program line creation and modification.

1. Ifitis not already open, reopen the Program Editor and verify that Edit Programs and the
name for your new program are selected.

2. Add Program Line - Define the position of the program line within the program.

a. Open Program Detail (pg 3.42) by clicking on EDIT DETAIL LINES in the Program
Editor.

b. To establish the position of the new program line within the program, highlight the pro-
gram line that will precede the new line. For example, if you highlight the second pro-
gram line, the new program line will be added into the program as the third program
line.

c. Click on either the LINE icon (located at the top of the window) or the ADD LINE but-
ton. A list of operations displays.

3. Select Operation - From the list of operations that you opened in the previous step, select
an operation type to define the type of action or shape the new program line will define.
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For a listing of operation types and their definitions, refer to Summary of Operations (Prim-

itives) (pg 3.87).

a. Highlight a selection in the operations list and click ACCEPT. If the operation you want
to select is not listed, a class filter may have suppressed it.

b. Click APPLY to save your input.

Define Program Line Parameters - Consider the benefits of making the bulk of any com-
mon parameter modifications in a partition program line. Partition program lines use the
default hierarchy inherent in the software for faster, more efficient programming.

For example, instead of repeatedly assigning parameter values in numerous program
lines, define them once in a Partition Line (pg 3.90); the partition line defines the default
values for all subsequent program lines.

Additional Program Lines - repeat Step 2 through Step 4 for each additional head to be
used by the current program.

Click APPLY to save your input and then click DONE to return to the Program Editor.

6. Define Subboards
If your program will be using subboards, define them now; otherwise, skip to 7. Add Options
(pg 4.6).

Subboards must be defined for palletized (panelized) boards. By defining subboards, you will
be converting an existing program for an individual board into a subboard program of multiple
boards with different origins.

5/18/18

NOTE: A subboard cannot be defined until a program line is established. For further
details, refer to Creating a SubBoard Program (pg 4.37).

Verify that Edit Programs and the name for your new program are selected in Program
Editor.

Click on the MODIFY SUBBOARDS button to open SubBoard Editor.

Subboard Name - The subboard name is a reference used to identify an individual board
within the pallet; the program name will not be affected. Sequence numbers (first, second,
third) are typically used as subboard names.

a. As desired, type a name in the Name field.

b. Click APPLY to save your input.

Subboard Parameters - If you want subboard parameters to differ from those already

defined for the pallet (refer to 3. Teach Program Parameters (pg 4.2)), enter them now.

a. As needed, alter the subboard fiducial point coordinates. If you do not turn off the fidu-
cials by clicking the fiducial Used buttons, the system will locate them twice on the first
board — once as the pallet fiducial and again as the board fiducial.

b. Bad Marks - As desired, teach Bad Marks (pg 3.38) for subboards. To access the Bad
Mark Location panel in the Sub Board Editor window, click MODIFY SUB BOARDS in
the Program Editor window.

c. Suppress Auto Height Probe - Activate this setting if you want the touch probe to
touch down on only the first subboard rather than on each subboard within a pallet
prior to processing. For details, refer to Subboard Touch Probe Frequency (pg 4.40).

d. Click APPLY to save your input.

Subboard Orientation - Teach new coordinates for each subboard origin (reference
point) that differs from the origin of the pallet. For details, refer to Teach Origin for New
Subboard (pg 4.41).
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a. Ifthe X and Y coordinates of a subboard reference point are known values, enter
them manually. If the values are unknown, use the TEACH button and the resulting
Jog window to teach the coordinates.

b. Click APPLY to save your input.

Add the Subboard - Assign the subboard information you've entered during the last sev-

eral steps to a defined subboard:

a. Click the ADD button in the SubBoard Editor.

b. As desired, type the subboard name in the resulting query and click OK. Notice the
entry that now appears in the Defined Boards pane.

c. Click APPLY to save your input.

Additional Subboards - repeat Step 3 through Step 6 for each additional subboard to be
defined.

Add Subboards to Program - Save the subboard program:

a. Click APPLY to add the completed subboard subroutine to your program.
b. Click DONE to exit to the Program Editor.

c. Click APPLY EDITS to save the changes to the program.

Test Subboard Program - After adding subboards to a program and prior to running the
program live, first run the program in Inspect Mode to verify that all points are in their cor-
rect location.

7. Add Options
Add options as needed. Options include such choices as Skip if No Fiducial, Suppress Lifter,
Pause on Bad Mark, Pre-scan Patterns, Pre-scan Probes, and Suppress Hold-Down.

To activate options for the currently selected program:

1.

2.

In the Program Editor, turn on any of the Board Options (pg 3.35) that apply to the new
program.

Click APPLY EDITS to save your input.

8. Verify Vision Calibration
Verify that the vision system is properly calibrated:

1.

In the Program Editor, click on the MISC PROGRAM SETTINGS button to open the Mis-
cellaneous Program Settings window.

All default boxes in the Vision Calibration pane should be turned on (blue). This includes
the default boxes for Gain, Offset, Tuning, Zoom, Focus, f-stop, Light Level, and Light on
Dark. If any of the boxes appear gray, click on them now to turn them ON. (Your program
will now use the default vision values established in the ..Default.. program.

Click on APPLY and then DONE.

Run your new program per Testing & Inspecting (pg 3.117) to verify that the vision system
is calibrated correctly — it should be able to locate the calibration dot on the calibration sta-
tion.

NOTE: If the camera cannot find the calibration dot, go to the ..Default.. Program (pg 3.92)
and examine the values in the vision calibration pane of the Miscellaneous Program
Settings window.

Your new program should now be ready to use in Run mode.
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Tutorials - How to Program Basic Shapes

Use the tutorials in this section as a guide to creating a basic shape and adding it to a
program.

* How to Program a Single Dot (pg 4.7)

+ How to Program a Single Line Segment (pg 4.12)
+ How to Program an Area Fill (Rectangle) (pg 4.17)
* How to Program a Circle (pg 4.25)

* How to Program an Arc (pg 4.30)

How to Program a Single Dot
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DOT is a primitive (preprogrammed routine) shape for which you may modify various param-
eters. DOT moves the valve to a height above the board and turns the valve on for a specified
amount of time, then moves the valve to a safe height above the board before moving to the

next operation point.

A DOT is the most basic type of dispense. A DOT program detail line can dispense a single
dot or an array of dots.

To create a program detail line for a single dot in a program or shape:

1. Open a program:
a. From the Program Editor, select either an existing program (or shape) or create a new
program (or shape).
b. Select the appropriate choice: Edit Programs or Edit Shapes.
c. Open Program Detail by clicking on EDIT DETAIL LINES.

2. Add a DOT program detail line:
a. Position the cursor so it highlights the program line that will precede your new DOT
program line.
b. Click on either the DOT icon (located at the top of the window) or the ADD LINE but-
ton. If you choose to click ADD LINE, the Select List of operation choices displays;
select DOT and then click ACCEPT.

In both cases, a new DOT program detail line displays in the Program Lines pane with
a designation of NEW next to it.
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Add Line l Select DOT Icon

Voo
=]

c. Click APPLY to save your input.

3. Enter a value in Auger Speed or Microvalve Speed, and then click APPLY to save your
input.

NOTE: This procedure and the Single Dot Guide (pg 4.10) apply to all valve types,
however, the guide focuses on building a dot using an auger type of valve. The param-
eters specific to a particular valve are Auger Speed for the LX Auger valve, and Micro-
Valve Speed and Micro Valve Steps for the Micro-Dot valve.

I Add Line ’ Select DOT lcon
I 3
l Sets the rotational
"'-UEEL'-;‘P’-’-N | __gspeedofeither the
MicroValve Speed LX Auger valve or
I the Micre-Dot valve.

4. Teach coordinates for the new dot:
a. Click TEACH COORDS. The Jog window displays.
b. Jog the camera to the point where the dot is to be dispensed.
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c. Click OK in the Jog window. The resulting coordinates display in the new DOT pro-

gram detail line.

Add Line Select DOT lcon
v
DOT
¥ Sets the rotational
Msa-:nfmﬁ | ____Jspeedof either the
Microvalve Speed LX Auger valve or
- the Micre-Dot valve,
s 4
Defines the operation
location with respect L | TEACH
to the Board Origin or COORDS
Shape reference.

5. Change any default parameter values not suitable for the new dot; parameters pertinent to
a dot are located in the Dispense and Extra Controls Selectable Panels (pg 2.12). Use the
Single Dot Guide (pg 4.10) to decide which parameter values to change for your new dot.

NOTE: For help deciding the value of End Z, refer to End Z equals zero and End Z is not
equal to zero under Dot (pg 5.111).
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Figure 19: Single Dot Guide
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6. Click APPLY to save your input, and then click DONE to return to the Program Editor.

This completes the creation of your new program detail line for a single dot.
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How to Program a Single Line Segment

5/18/18

_IUI

LINE is a primitive (preprogrammed routine) shape for which you may modify various param-
eters. LINE is used to move the valve to a specified height and keep the valve at that height for
a specified x, y distance.

A LINE program detail line can dispense a single line or an array of lines.

To create a program detail line for a single line in a program or shape:

1. Open a program:
a. From the Program Editor, select either an existing program (or shape) or create a new
program (or shape).
b. Select the appropriate choice: Edit Programs or Edit Shapes.
c. Open Program Detail by clicking on EDIT DETAIL LINES.

2. Add a LINE program detail line:
a. Position the cursor so it highlights the program line that will precede your new LINE
program line.
b. Click on either the LINE icon (located at the top of the window) or the ADD LINE but-
ton. If you choose to click ADD LINE, the Select List of operation choices displays;
select LINE and then click ACCEPT.

In both cases, a new LINE program detail line displays in the Program Lines pane with
a designation of NEW next to it.

ist Lire: Circle Caliby Drelay Olper

SREN RN =NERCRORGRHED

Cut Copy
— Program Lines — Program Line Detuil
Program | sereen Grabs Cormment I

All Gantries _.| - Partition | Ciperation LINE 4 Valve/Too

1 PARTITION B
HEH LINE

swop | Panel Sele

2 LIHE

Add Line J Sedect LINE kcon
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c. Click APPLY to save your input.

3. Enter a value in Auger Speed or Microvalve Speed, and then click APPLY to save your
input.

NOTE: This procedure and the Single Line Segment Guide (pg 4.15) apply to all valve
types, however, the guide focuses on building a line using an auger type of valve. The
parameters specific to a particular valve are Auger Speed for the LX Auger valve, and
MicroValve Speed and Micro Valve Steps for the Micro-Dot valve.

Select LINE lcon |

Add Line

Sets the retational

Auger Spaed — g cpeed of either the

or
MicraValve Speed L Auger valve or
I the Micro-Daot valve

4. Teach coordinates for the new line:
a. Click TEACH COORDS. The Jog window displays.
b. Jog the camera to the point where the start of the rectangle is to be dispensed.
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c. Click OK in the Jog window. The resulting coordinates display in the new LINE pro-

gram detail line.

] = @
ShList Lire: Dot Maove: Are Rect Circle Caliby Drelay
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Ackd Line

| Select LINE lcom

h 4 | Sets the rotational
MQHWM = o _.‘:ls-peedaferiherthe
MicraValve Speed ;: L¥ Awger valve or
| the Micro-Dot valve
v
RS TEACH
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r _

Change any default parameter values not suitable for the new line; parameters pertinent to
a line are located in the Dispense and Extra Controls Selectable Panels (pg 2.12). Use the
Single Line Segment Guide (pg 4.15) to decide which parameter values to change for your

new line.

NOTE: For an explanation of what happens during a single line dispense motion, refer to

Lines (pg 3.21).
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Figure 20: Single Line Segment Guide
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6. Click APPLY to save your input, and then click DONE to return to the Program Editor.

This completes the creation of your new program detail line for a single line.
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How to Program an Area Fill (Rectangle)

RECTANGLE is typically used as the area fill operation. RECTANGLE is a primitive (prepro-
grammed routine) shape for which you may modify various parameters. A RECTANGLE
program detail line can dispense a single area fill or an array of area fills.

RECTANGLE is used to move the valve to a specified height and keep the valve at that height
while conducting a fill over a specified x, y size. RECTANGLE may have a hollow, concentric,
or zigzad fill.

| ||

—

NOTE: For a detailed explanation of what happens during a RECTANGLE dispense
motion, refer to Rectangle (pg 5.113).

To create a program detail line for an area fill:

1. Open a program:
a. From the Program Editor, select either an existing program (or shape) or create a new
program (or shape).
b. Select the appropriate choice: Edit Programs or Edit Shapes.
c. Open Program Detail by clicking on EDIT DETAIL LINES.

2. Add a RECTANGLE program detail line:
a. Position the cursor so it highlights the program line that will precede your new RECT-
ANGLE program line.
b. Click on either the RECTANGLE icon (located at the top of the window) or the ADD
LINE button. If you choose to click ADD LINE, the Select List of operation choices dis-
plays; select RECTANGLE and then click ACCEPT.
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In both cases, a new RECTANGLE program detail line displays in the Program Lines
pane with a designation of NEW next to it.

S AP = e O x][ F

screen Grabs -

| - A | g
1 PARTITION L
U RECTANGLE
RECTANGLE |
Add Line Select RECT kon
L -
RECTANGLE

c. Click APPLY to save your input.

3. Choose an area fill sub-operation:
a. Click the SUBOP button.

E L2 A= e O X[

screen Grabs
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1 PARTITION
HEH RECTANGLE
RECTANGLE

5/18/18 FLOware Software Guide 418



GPD Global® Tips & Tricks

b. Select a subop from the list of RECTANGLE subops that displays and then click
ACCEPT.

% E47: Select a new Operation SubType

Locate by center
CENTER Locate by center
CEHTER/ in Center, spiral in
CEHNTER/ out Center, spiral out
CORHNER Locate by lower left corner
CORHERY in Lower left corner, spiral in
CORHER/ out Lower left corner, spiral out

l Add Line J Select RECT lcon
¥ '1

RECTAMGLE
Defines rectangle origin as . l .
CENTER or CORNER. W
COANER, then bower left o SUBOP
cormer is defined. If CENTER,

then cenfer i defined I
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4. Teach coordinates for the new area fill:
a. Click TEACH COORDS. The Jog window displays.
b. Jog the camera to the point where the rectangle is to be dispensed.
c. Click OK in the Jog window. The resulting coordinates display in the new RECTAN-
GLE program detail line.
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5. Enter a value in Auger Speed or Microvalve Speed and then click APPLY to save your
input.

NOTE: This procedure and the Area Fill Guide (pg 4.22) apply to all valve types, however,
the guide focuses on building an area fill using an auger type of valve. The parameters
specific to a particular valve are Auger Speed for the LX Auger valve, and MicroValve
Speed and Micro Valve Steps for the Micro-Dot valve.

A Line | Select RECT lcon
= A

L l KEY
“ —_—
| eruwcisl
RECTANGLE e
significant
Defines rectangle orlgin as ¥
CENTER or CORMER. M
COAMER, then kewer loft Pt SUB0oP
corner is defined. IFCENTER,
then center is defined.
t
Defines the start point of
TEACH — — @ the rectangle with respect
AN o the Baard Origin or Shape

l reference,

Sets thi rotational spead of k A Speed

vither the LY Asger valvear T
the Micro-Dof vabve,

6. Change any default parameter values not suitable for the new area fill; parameters perti-
nent to an area fill are located in the Dispense and Extra Controls Selectable Panels
(pg 2.12). Use the Area Fill Guide (pg 4.22) to decide which parameter values to change
for your new area fill.

NOTE: Many variables affect the outcome of an area fill dispense. For additional insights,
refer to Helpful Hints for Area Fills (pg 4.23).
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Figure 21: Area Fill Guide
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7. Click APPLY to save your input, and then click DONE to return to the Program Editor.

This completes the creation of your new program detail line for an area fill.

Helpful Hints for Area Fills

Continuous Moves

Rectangles, circles, and arcs can all be specified as Middle moves and can be used both in
conjunction with each other and with other Moves for continuous dispensing.

Rotation

CENTER/in and CENTER/out are the preferred RECTANGLE subops when rotation is to be
used.

Valve Off

When using a Needle valve to dispense an area fill, the Valve Off parameter shuts off the
valve at the Valve Off distance prior to finishing the final line of the rectangle. Alternatively,
when used with any other type of valve, Valve Off shuts off the valve at the Valve Off distance
prior to finishing every line segment in the rectangle.

Undersized or Shifting Area Fill

Using the CENTER/out RECTANGLE subop may generate a smaller than expected area fill
or an area fill that appears to have shifted. Making adjustments to Size X,Y and Fill Spacing
will remedy these problems.

If the final dispense pass would exceed the area fill boundaries then either the final pass is not
dispensed, resulting in an undersized rectangle or only half of the final pass is dispensed,
resulting in a rectangle that is both undersized and appears to have shifted as well.

Avoid Voids

Using a CORNER/in or CENTER/in RECTANGLE subop may generate an area fill with a void
in the center. Slight adjustments to either Size X,Y or Fill Spacing will remedy this problem in
most cases.

Gantry Motion

»  Dampen the intensity of the gantry movement created during rectangle dispenses by
using the Standard Acceleration parameter [located in the Mounts/Material Editor
(pg 5.59) window under the Process selectable panel].

«  Erratic gantry motion may occur if an End move control command is missing. An End com-
mand must be used after the use of a Middle move control command, especially with rect-
angles. Refer to Move Controls (pg 3.45).

FLOware Software Guide 4.23



GPD Global® Tips & Tricks

Seldom Used Parameters

End Z is used only for the last line segment of an area fill. Alas, you cannot use this field to
build pyramids.

Start Z Pause is not used with area fills since the pause would be applied to the start point of
every line segment in the rectangle.
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How to Program a Circle

CIRCLE is a primitive (preprogrammed routine) shape for which you may modify various

parameters. A CIRCLE program detail line can dispense a circle, ring, or an array of circles or
rings.

CIRCLE is used to move the valve to a specified height and keep the valve at that height while
dispensing a ring or filled circle over a specified x, y diameter.

You have the choice of tracing a figure from either minor-to-major diameter (spiral outward) or
from major-to-minor diameter (spiral inward). Spiral direction is based on the relationship of
start and end diameter values entered in the Start Dia and End Dia fields.

@0 © O

Minor to Major Major to Minor

To create a program detail line for a circle:

1. Open a program:
a. From the Program Editor, select either an existing program (or shape) or create a new
program (or shape).
b. Select the appropriate choice: Edit Programs or Edit Shapes.
c. Open Program Detail by clicking on EDIT DETAIL LINES.

2. Add a CIRCLE program detail line:
a. Position the cursor so it highlights the program line that will precede your new CIRCLE

program line.

b. Click on either the CIRCLE icon (located at the top of the window) or the ADD LINE
button. If you choose to click ADD LINE, the Select List of operation choices displays;
select CIRCLE and then click ACCEPT.
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In both cases, a new CIRCLE program detail line displays in the Program Lines pane
with a designation of NEW next to it.
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1 PARTITION

[T=mw _ CIRCLE
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A Lime Select CIRCLE loon

c. Click APPLY to save your input.

3. Teach coordinates for the new circle:
a. Click TEACH COORDS. The Jog window displays.
b. Jog the camera to the point where the center of the circle is to be located.
c. Click OK in the Jog window. The resulting coordinates display in the new CIRCLE pro-
gram detail line.
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4. Enter a value in Auger Speed or Microvalve Speed and then click APPLY to save your
input.

NOTE: This procedure and the Circle Guide (pg 4.28) apply to all valve types, however,
the guide focuses on building a circle using an auger type of valve. The parameters
specific to a particular valve are Auger Speed for the LX Auger valve, and MicroValve
Speed and Micro Valve Steps for the Micro-Dot valve.

Add Line Select RECT lcon

l KEY
w

T erucial
RECTAMGLE J

significant
Defines rectangle arigin as l
CEMTER or CORNER. If
CORMER, then lower left e '] SUBOP

corner is defined. If CENTER,
then center is defined,

Y
Defines the start point of
TEACH — —g the rectangle with respect
COORDS |
to the Board Origin or Shape
reference.
I Y
Sets the rotational speed of | Auger Speed

either the LX Auger valve or L
the Micro-Dot valve,

or
MicroValve Speed

5. Change any default parameter values not suitable for the new circle; parameters pertinent
to a circle are located in the Dispense and Extra Controls Selectable Panels (pg 2.12).
Use the Circle Guide (pg 4.28) to decide which parameter values to change for your new
circle.

NOTE: Many variables affect the outcome of a circle dispense. For additional insights,
refer to Helpful Hints for Circles (pg 4.29).
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Figure 22: Circle Guide

Add Line Select CIRCLE Icon

KEY

l l |:| crucial
CIRCLE |:| significant

Y
Defines the center point of
TEACH | __ __g thecircle with respect
COORDS to the Board Origin or Shape
reference.
A4 Defines the start diameter
Sets the rotational speed of Auger Speed — ~® for the circle where dispensing
either the LX Auger valve or p— — — . or | will oceur.
the Micro-Dot valve. Miciolalvelpeed | I
|
A hd "
I / start diameter end dla'meten
Start Dia L end diameter start diameter
If start diameter (Start Dia) | If start diameter (Start Dia)
Y . "
< end diameter (End Dia), | >end diameter (End Dia),
gDl | e ears.| (el imward) il occurs
Defines the fixed distance | (spiral outward) fill occurs. | SP 2
or the number of needle |
diameters the system will Y | @
increment on each pass
of the CIRCLE fil, p— ——{ Fill Spacing AN e
depending on machine | T
configuration. | |
Y I Defines the end diameter
Velocity the z axis b— — | Aproach Velocit I_ —0 foAr the circle where dispensing
approaches the board pp 4 will occur.
surface from Settle Z.
A
Turns the tool on Valve Prime
Valve Prime — — —@ seconds before reaching the
operation height or Start Z.

Height above the A
board §urfa§e the [ | Start Z
operation will be
conducted. Velocity at which the gantry
v moves while dispensing in the
X, y, zdirections. The
Dispense Velocity [—— —® amount of material dispensed
for a line is directly proportional
to changes in dispense velocity.
Defines the distance from the end Y

of the fill at which point the valve
will shut off while gantry motion
continues.

— — — Valve Off

Used to reverse the rotational
direction of the auger valve

Valve Reverse/ | and create a “suck back” effect
MicroValve Reverse that pulls the material back
up into the needle.

Time delay to allow material
Pre-Snap Delay | — — —® 5 wet and finish flow from
needle before snap.

ALWAYS the relative height above N

End Z. Relative height above

StartZ/ Enfl Z the Z axis will move b— — —| Snap Off Height

before moving the xy axes to the

coordinates of a new dispense

feature (dot, line, etc.)
Post Delay allows material to
detach from needle tip prior

Post Delay % to next move location to

prevent tailing.

5/18/18 FLOware Software Guide 4.28



GPD Global® Tips & Tricks

5/18/18

6. Click APPLY to save your input, and then click DONE to return to the Program Editor.

This completes the creation of your new program detail line for a circle.

Helpful Hints for Circles

Continuous Moves

Circles, rectangles, and arcs can all be specified as Middle moves and can be used both in
conjunction with each other and with other Moves for continuous dispensing.

Rotation

The start point of an inward spiraling circle or the end point of an outward spiraling circle can
be rotated using the Object Rotation parameter.

Avoid Voids

Using minor-to-major circle fills with higher viscosity materials may help reduce voids.

Avoid Excess Material

Using major-to-minor circle fills with lower viscosity materials will reduce the chance of
material flowing over the top of the die during placement.

Gantry Motion

Dampen the intensity of the gantry movement created while dispensing circles by using the
Standard Acceleration parameter [located in the Mounts/Material Editor (pg 5.59) window
under the Process selectable panel].
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How to Program an Arc

ARC is a primitive (preprogrammed routine) shape for which you may modify various param-
eters. An ARC program detail line can dispense a single circular arc or an array of arcs. ARC

is used to move the valve to a specified height and keep the valve at that height while
dispensing an arc over a specified x, y diameter.

There are two types of arcs from which to chose: a 3-point arc and a relative arc. The 3-point
arc is the most commonly used type of arc and is created by defining start, middle, and end
points. The relative type of arc is rarely used; it uses a center, angle, and start point.

To create a program detail line for a 3-point arc:

1. Open a program:
a. From the Program Editor, select either an existing program (or shape) or create a new
program (or shape).
b. Select the appropriate choice: Edit Programs or Edit Shapes.
c. Open Program Detail by clicking on EDIT DETAIL LINES.

2. Add an ARC program detail line:
a. Position the cursor so it highlights the program line that will precede your new ARC
program line.
b. Click on either the ARC icon (located at the top of the window) or the ADD LINE but-
ton. If you choose to click ADD LINE, the Select List of operation choices displays;
select ARC and then click ACCEPT.

5/18/18 FLOware Software Guide 4.30



GPD Global® Tips & Tricks

In both cases, a new ARC program detail line displays in the Program Lines pane with
a designation of NEW next to it.
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SubOp | Panel Selection

Add Line [ Select ARC lcon

AR

c. Click APPLY to save your input.
3. Click on the SubOp button and select 3-Point Arc.

NOTE: This procedure focuses on the more commonly used 3-Point Arc. The rarely used
Relative Arc is not addressed here.

Add Line [ Select ARC lcon

AR

v

SUBOR
{3-Point Arc)

4. Enter a value in Auger Speed or Microvalve Speed and then click APPLY to save your
input.

NOTE: This procedure and the 3-Point Arc Guide (pg 4.35) apply to all valve types,
however, the guide focuses on building an arc using an auger type of valve. The param-
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eters specific to a particular valve are Auger Speed for the LX Auger valve, and Micro-

Valve Speed and Micro Valve Steps for the Micro-Dot valve.
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5. Teach coordinates for the new arc:

a. Click TEACH COORDS. The Arc Editor displays. You will use this window to teach the
three points of the arc. Keep in mind that the arc must pass through each of the three

points you will teach.
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Together, these parameters determine
the three points of the arc. An arcis
abways a small segment of a circle with
the center of the anc being the X

coordinate.
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Start XY End XY

Stark XY
Middle X

End X7Y
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b. Click the TEACH button next to Start Point, jog the camera to the coordinates where
you want the beginning of the arc to be located, and then click OK.
c. Repeat the same process for both Mid Point and End Point.

& IMPORTANT: The location you choose for the Mid Point is key to obtaining expected results.

Middle ;
m Mlddlfm MiddleO
Start End Ctart End Start Enicl
Start Start
-y Middle Middle
End End

NOTE: Arc acceleration and deceleration will be affected slightly by the interpolation
of the arc angle. Velocity is not constant throughout an arc dispense. Velocity will slow
slightly at each end of the arc.

d. After all three points have been taught, click OK in the Arc Editor window. Coordinates
display in the new ARC program detail line.

SRER A =a RO RS R

Cut Copy Delay Oper Part
— Program Lines — Program Line Detuil
Program | screen grabs Commentl_@_
All Gantries — | o Partition Operation ARC r Yalve/Toal 7 |

=

1 PARTITION

-446. 62

14.856 :
Panel Selection

Sturncard | Selected P

* I -446,62 mm L I 1,80
Y|14‘86 nm A L IO‘QE
L -
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e. Notice that the actual XY coordinates for the arc that display in the XY fields are
located midway between the Start Point and the End Point, in what would be the cen-
ter of the circle if you were to make the arc into a complete circle.

Middle

SIaHm End
N

XY coordinates

SRER RN E AL RORSRHEO R

Cut Copy Lire Dot Circle Drelay Olper
— Prograin Lines — Program Line Detail
Program | screen grabs Commentl_@_
All Gantries — | 4 Partition I Ciperation ARC 4 Valve/Tool ?
1 PARTITIOH 5
HEH ARC -446.62 14.856 .
2 ARC SubOp Panel Selection
Streclard Vakies Selected F
1| Teach " I -446.62 nm ] 4 I 1.3
L Coordls \r’I 14,5 " Io‘zs
Fhetal 0 des ® oo

6. Change any default parameter values not suitable for the new arc; parameters pertinent to
an arc are located in the Dispense and Extra Controls Selectable Panels (pg 2.12). Use
the 3-Point Arc Guide (pg 4.35) to decide which parameter values to change for your new
arc.

NOTE: For tips about arc dispensing, refer to Helpful Hints for Arcs (pg 4.36).
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Figure 23: 3-Point Arc Guide

Tips & Tricks
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to wet and finish flow from
needle before snap.

Post Delay allows material to
detach from needle tip prior
to next move location to
prevent tailing.
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7. Click APPLY to save your input, and then click DONE to return to the Program Editor.

This completes the creation of your new program detail line for an arc.

Helpful Hints for Arcs

Continuous Moves

Arcs, circles, and rectangles can all be specified as Middle moves and can be used both in
conjunction with each other and with other Moves for continuous dispensing.

Rotation

The Start or End point positions of an arc can be rotated around its center point using the
Object Rotation parameter.
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Creating a SubBoard Program

A subboard is one of a set of identical boards arranged into a single panel. All subboards
within the set are identical except for position and possibly orientation.

A program describing a single board, with its own defined values for fiducial and origin
location is converted into a program describing a set of subboards in a panel.

Examples of Subboards in a Panel

Panel of three boards in various positions and
same orientation.

Panel
Panels showing various orientations and positions.

*  Why Subboards? (pg 4.37)
* Creating Subboards (pg 4.38)
»  Teach Origin for New Subboard (pg 4.41)

Why Subboards?
Why use subboards when the same end result can be accomplished using shapes?

Subboards are more descriptive of a panel of multiple boards and can be generated more
efficiently in a single pass. Also, a touch probe action occurs automatically for each subboard
(unless suppressed); if using shapes, touch probe action does not occur unless programmed
to do so.

Refer also to Shapes versus Subboards (pg 3.49).
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Creating Subboards

5/18/18

By defining subboards for palletized or panelized boards, you will be converting an existing
program for an individual board into a program for multiple subboards, each with a different
origin. Before a subboard can be defined, a program line must be established.

To create a subboard program:

1. In Program Editor, select or create a program for a single board. All aspects to be used to
perform program operations should be defined because all program data defined now will
be replicated later in each subboard program line during the conversion step.

The first step in subboard creation is selecting or creating a single
board program complete with fiducials, dispense points, and reference point,
Fiducial 2

Dispensed Point

Fiducial 1

Reference Point (Origin)

2. Test the program to verify it produces expected results before using it as the basis for a
subboards program.

3. Conversion transforms the original single board program into a panel of subboards pro-
gram. To convert the program to subboards:

a. Verify the single board program is selected in Program Editor.

b. From the Program Editor menu bar, click Edit > Convert > Program-->Subboard.

c. Enter a name that will represent the new subboards. As you will see in the following
step, a subboard program line with this new name is generated and displayed in Sub-
board Editor. (For example purposes, a name of SUBBRD X is used in the screen
shot illustration.

4. Teach the origin of each new subboard. Details are listed here: Teach Origin for New Sub-

board (pg 4.41).
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5. The origin coordinates for each newly added line is (0,0). To teach the actual location
coordinates, select a subboard line, click the TEACH button, and teach the location of the
origin for that subboard. Repeat for each subboard.

Teach the location
of the origin for
each subboard
using the TEACH
button.

6. Optional: Set subboard bad marks.

Subboard Bad Mark

The value you enter in the bad mark process field applies to all subboards, so it only needs to
be entered once.

Bad Mark setting
is entered here

Choose and enter one of three values:

» To skip a board with a bad mark (process ignores bad mark), enter 0.
+ To process board if a bad mark is present, enter 1.
+ To process board if a bad mark is absent, enter 2.
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7. Optional: Change frequency of touch probe.

Subboard Touch Probe Frequency

The choice you select for Suppress Auto Height Probe applies to all subboards, so it only
needs to be entered once.
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el e
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Fitecial 1 -
e -
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frequencyis Qo oex s Lot )
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Arrur Dimrmyisnr
Sewnd| Lm0 i Lo in
i cam¥: |
S Autn B Prate

Choose whether the touch probe touches down on every subboard or just the first subboard.

+ To activate the touch probe on each subboard prior to processing, turn OFF the Suppress
Auto Height Probe box.

» To activate the touch probe only on the first subboard, turn ON the Suppress Auto Height
Probe box.

8. Click APPLY to save the information and then click DONE to exit the SubBoard Editor.

9. OPTIONAL - Panel Origin: If the origin (reference point) coordinates of the actual panel
differ from the (0,0) origin of the first subboard, go to the Program Editor and turn off or
redefine the fiducials for the panel; otherwise, the system will locate the fiducials twice
in sequence on the first subboard at the same coordinates - once as panel fiducials and
again as subboard fiducials.

To avoid running the fiducials twice, either change the fiducials at the main level to true
Panel fiducials or turn them off. When the program runs it will then only do the sub board
fiducials.

Optional: Turn off or reteach panel fiducials. Subboard conversion assigns
the fiducial coordinates used by the original program to the first subboard.

Panel Fiducial 2
at new coordinates

Panel Fiducial 1
at new coardinates

10. Click APPLY EDITS on Program Editor to save all changes made in Program Editor and
any program line modifications made in Program Detail.

11. Run the new subboard program to verify it operates as intended:
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Teach Origin for New Subboard
To teach the origin for a new subboard:

1. In the Program Editor, click the MODIFY SUB BOARDS button to open the SubBoard Edi-
tor.

The first subboard line
appears here using the
narme assigned in the
prior step.

2. Choose one of the following alternatives for generating the origin coordinates of each sub-
board. Ultimately, orientation of each subboard will be defined in the subboard program
line created for each subboard.

To Generate Subboard Lines: Go to:

automatically using array Generate Subboard Lines Automatically
dimensions (pg 4.42)

manually one at a time Generate Subboard Lines Manually (pg 4.43)
using a combination of the Perform Generate Subboard Lines Automatically
above methods (pg 4.42) before proceeding to Generate Sub-

board Lines Manually (pg 4.43).

When a program is converted to subboards, fiducials are automatically
generated with the subboards,

Original board

Subboards generated
by conversion

Teach the reference point (origin) for all but the original subboard.

Ornginal board

The reference point (entered
in the Board Information panel
of the Program Editor) for the
ariginal subboard is derived
from the original program.

Subboard Reference Points

WHEN ROTATED: If a board
is presented in a rotated
orientation {like the middle
board shown at right), teach
the rotated reference point
in its rotated state.
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Generate Subboard Lines Automatically

Subboard lines can be generated automatically using Array Dimensions.
Rules for Subboard Arrays

» Array creation erases and replaces all content within the Defined Boards panel of the Sub-
board Editor; therefore, only a single array can be generated at a time.

» After array creation, any single line can be modified, and single lines can be added one at
a time at any point in the subboard program.

To generate subboard lines automatically using Array Dimensions:

1. Enter values in Span X and Y for the distance between a recognizable point on the board
to another position; select positions that remain consistent from board to board. Then
enter values in Count X and Y for the number of subboards in both directions.

First, measure actual distance from the Then enter array data here

same position in both X and Y directions
from board-to-board, Negative values

B iy
may be used. G ——
i o (W i i —u-—u--_..._...—._.___________
| e Pl | HONE /
N 00 W 000 i |

'mad Pammen | S |

S | co— Subboard line detail
o o I (o 172 3 lowe 1ees 8o generated by entry of
oorm oorm o R i array data.

s s P

3. Choose one:
— If no additional subboards need to be added, click DONE to exit SubBoard Editor and

either resume with Step 5 (pg 4-39) or
— If manually taught subboard lines are needed, continue with Step (pg 4-43).
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Generate Subboard Lines Manually

To manually teach the name, position, and angle of each subboard within the pallet:

1. In the Subboard Editor (opened by clicking MODIFY SUB BOARDS in Program Editor),
click the ADD button once for each subboard in the pallet. This action creates a subboard
program line for each subboard.

For example, if there are five subboards in the pallet, click ADD five times to create five
new lines in the Defined Boards panel.

A line of subboard
detailis

with each click of
the ADD button,

2. Select one of the subboard lines, enter a name for it, and click APPLY. The name will be
applied to the highlighted line and all lines listed below it. The same name can be used for
all the subboards. For example purposes, a name of SUB MANUAL is used in the screen
shot.

~. Name is applied to
all lines at and below
the highlighted line.
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Creating a Pick & Place Program

In effect as of FLOware software version 2.8

To program for component pick and place applications, you will use two preprogrammed
SubOps (PICK and PLACE) with either a vacuum tool or a pick tool with either vacuum or a

gripper.

* Requirements (pg 4.44)
+ PICK & PLACE SubOps (pg 4.45)

+  Programming Pick & Place (pg 4.46)

Requirements

5/18/18

The following tools and program elements are required when programming for pick and place
applications:

Physical Tools

« Pick Tool equipped with either a gripper and/or vacuum and release blow-off and/or eject
+ (Optional) Force Feedback tool (with load cell) for component placement

Program Elements

* Shapes

* Fixed Locations

e PICK & PLACE SubOps
* Vision Patterns

Inputs & Outputs (1/0)

* |O/Head1/PickCtrl Used for gripper and/or vacuum generator
* l0/Head1/PickSense Senses vacuum when component is picked
* |O/Head1/ReleaseCtrl Turns on component blow-off air solenoid and/or a

component eject tool

ds.io.cfy LINE: 313 CoOL:
I0/Head2AugerSloRev: Output 343 Normal False PseudolODriver
I0/Head2-ShutOff : Output 344 Normal False PseudolODriver
ID/HeadZ2-AirTurbine: Dynamic 345 Normal False PseudolODriver

Dynamic 346 Normal False PseudolODriver

Output 347 Normal False PseudolODriver
ID/Head2-Needle: Output 10030  Normal False FieldBusDriver
ID/HeadZ2-PumpDetectCt]l: Dynamic 319 Normal False PseudolODriver
I0/Head2-PUMONT ime : Dynamic 350 Normal False PseudolODriver
I0/Head2-PUMOLf Time : Dynamic 351 Normal False PseudolODriver
ID/Head2-PUMF irstDotTime : Dynamic 352 Normal False PseudolODriver
I0/Head2-EtchMotor: Output 353 Normal False PseudolODriver
I0/Head2-NeedleTemp: Input 11016  Normal False FieldBusDriver
ID/Head2-Mat1Temnp: Input 355 Normal False PseudolODriver
ID/HeadZ2-NeedleTemnpCtl: Output 10031 Normal False FieldBusDriver
ID/Head2-Mat1TempCtl: Output 357 Normal False PseudolODriver
I0/Head2-PiggyBack: Output 10007  Normal False FieldBusDriver
I0/Head2-DebrisVac: Output 359 Normal False PseudolODriver
I0/Head2-PickupCtl: Output 360 Normal False PseudolODriver
ID/Head2-PickupSense: Input 361 Normal False PseudolODriver
ID/Head2-ReleaseCtl: Output 362 Normal False PseudolODriver
ID/HeadZ2-LevelDetect : Input 363 Invert False PseudolODriver
10-feadZ-LouSense: Input 364 Normal False PseudolODriver
ID/Head2-AltSense: Input 365 Normal False PseudolODriver
LoHe o h o o - - Moo h = Pooudo Ol d o

CAUTION: Only qualified service personnel or advanced programmers should access inputs
and outputs. If inputs and outputs are set incorrectly, the dispenser will not function properly.
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PICK & PLACE SubOps

5/18/18

PICK SubOp Routine

The PICK SubOp uses a fixed location that can be set up to pick components from either a
single feed, pallet array, or array of pallet arrays. Fiducials for the fixed location can be defined
using patterns trained to the component intended to be picked. Fixed locations are
independent of the location information for the board reference point.

A typical PICK SubOp routine:

1.

If set up to do so, the pick tool moves to the programmed fixed location (XYZ) using fidu-
cials and patterns.

From this position, the pick tool piggyback extends and indexes downward in the Z axis at
Approach Velocity (set in Dispense panel of Program Detail) to the actual component in
increments based on the values in Maximum Z Value and Retries.

After each index, the gripper and/or vacuum is turned on.

The system waits for the amount of time set in Operation Time (set in the Operate panel of
Program Detail).

The system tests for vacuum pressure. Sufficient vacuum indicates a component is pres-
ent or picked.

The pick tool retracts to End Z position at Dispense Velocity (set in Dispense panel).

The pick tool piggyback retracts while leaving the vacuum on, thus completing the PICK
SubOp.

PLACE SubOp routine

The PLACE SubOp places a picked component at a user-defined location based on fiducials
and patterns that can be set in a shape.

A typical PLACE SubOp routine:

1.

The touch probe activates to probe the work surface and then the gantry moves the pick
tool to Settle Z.

The Pick tool releases the component at Start Z using Approach Velocity (set in Dispense
panel of Program Detail).

If a Force Feedback tool is present, the gantry continues moving downward until the Force
Feedback tool reaches Pressure Value (set in Operate panel).

Before releasing the component, the system performs a vacuum test to verify the compo-
nent is indeed still present.

If the component is present, the pick tool places the component and disengages the grip-
per/vacuum by activating a vacuum release/blow-off for the amount of time set in Blow-Off
Time (set in Operate panel).

The pick tool retracts, thus completing the PLACE SubOp routine.
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Programming Pick & Place

Creating a component pick and place program involves all of the following steps.

1 - Create a Shape for Pick Operation

Tips & Tricks

To create a shape for the pick operation:

1.

Create a shape that will use the PICK SubOp:
In the Program Editor, select Edit Shapes.
b. Click the ADD ITEM button.
Enter a name of your choice. (For instructional purposes, we have used the name

a.

C.

PIC.)

2. Create a valve/tool called Pickup:
In the Program Editor, select Libraries > Heads, and then select Pickup from the Type

a.

drop-down menu.

b. Open Program Detail by clicking the EDIT DETAIL LINES button, and then select
Pickup Tool from the Valve/Tool drop-down menu.
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e == o 5 5 - -
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T — oo | —
" 0. 000 [ i[i] sm o Fanel Befectin o
- Stndard - Selected Panel
Move 'ramh :ﬁom in |4 af o Mexe Repeat
L ¥|0.000 In 4 il s Fetries
‘|'l1ataJ 000 dey | W - | 1 Skip Lines
nﬁﬂgﬁ_- A - * |'_l pissssor
ITaach| Sice | o o0 i W K o
Teach| s il win - | : .f::?!
Fill Spaging | 1 - " | ¥ Head Pressure
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3. Create an operate line with a PICK SubOp.

5/18/18

a.

Choose one:

« with the Shape partition selected, click the OPER icon, or
« with the newly created line selected, click the OPERATION button and select

OPERATE.

b. From the SUBOP button, select PICK, and then click APPLY.

FLOware Software Guide
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4. Enter desired values in the Operate and Dispense panel fields (see fields listed in chart
below):

1
weaton | OPERATE |+ Vabe/Teal?)
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Table 29: Operate & Dispense panel fields pertinent to Pick Operation

Panel Location of Fields Fields Field Description
Dispense panel End Z distance above StartZ were pick ends.
Approach Velocity  velocity at which tool approaches component (velocity from Set-

tleZ to StartZ).

Dispense Velocity

velocity at which tool moves to End Z.

Operate panel

Max Repeat

number of times the system attempts to pick up the component
at the current Z location.

Retries

number of Z axis increments used to move the tool downward,
testing for component presence after each index. (If no compo-
nent is detected, an error message will display.

Divide Maximum Z Value by Retries (total distance divided by
number of increments) to figure out the distance per increment.
For example, to make the Z axis index downward a total of 0.500
inches in five 0.100 inch increments:

* set Minimum Z Value to 0.0 inches

» set Maximum Z Value to 0.500 inches

» set Retries to 5

Maximum Z Value

maximum Z coordinate value allowed; the total distance Z axis
will travel downward.

Minimum Z Value

minimum Z coordinate values allowed.

Operation Time

amount of delay after turning on vacuum/gripper and before test-
ing vacuum/proximity sensor.
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Create a new fixed location:

a. From the Program Editor, select Libraries > Fixed Locations.

b. Create a fixed location with desired name. (For instructional purposes, we have used
the name PickLoc). For further detail about fixed location creation, refer to Fixed Loca-

tions Library (pg 5.3).

Fixed Location Editor
Location Specific [ Featmres
Name PickLo({ / %\Inucrﬁgg;‘ 1 i 1] Start Index
o - 32000 End Index
escription
= Y
| 0.000 in Uit X Adjust
i
0.000 in  Multi Y Adjust
Move - B X 18,161 in 0,000 in  StartZ | MUt % Count
To (S (¥ ey i
2= o 000 B 1 WUt ¥ Count
K Count| L
oun 0,00 deg  Angle Teach Il bt bl Index
¥ Count| 1 0,000 = Operate Time
Teach| x Space|0.000 in 0,000 = Operate Delay ° Girigp FeuEst
EI ¥ Space | 0.000 in 0,000 = Change Time ° Elapoed
Change
4]
Acknowlege
“# Mo Pallet ~ Request New -~ Use |/O Fiducials 0 Changed Flag
~ Mulii Loop ~ Multi Request - Muli Use /O
Close | Apply | Delete j

Teach the actual fixed location (typically, the center of a component):
a. Click the TEACH button.

b. Teach X/Y with the camera.

c. Teach Z with the pick up head touching the component surface.

NOTE: The PICK routine has the ability to compensate for variations in component height
by using an indexing approach as described in PICK SubOp Routine (pg 4.45). The PICK
routine will adjust to XY location using the fiducials and patterns set in the Fixed Location
Editor (pg 5.35).

Teach the fiducials for the fixed location:
a. Click the FIDUCIALS button to open the Fiducials & Bad Marks (pg 5.33) window. The
current coordinates at which the gantry is positioned should be displayed.

Ml Fixed Location Fiducials/BadMarks

- Fiductad 1
%|18,161 in  ¥|-3,958 in = Teach
Pattern Fid1 |  Usea ~|
— Futucted 2

%|18.161 in | ¥[-3.958 in  Teach
Pattern Fid 2 | Im

[ PRl ;

Teach “

| Unused ~ |

— Bad Mark

| 18,161 in  v|-3,958 in = Teach

Pattern | Unused |

Close Apply
b. Click APPLY.
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2 - Create a Shape for Place Operation

To create a shape for the place operation:

1. Create a second shape, this time using the PLACE SubOp:
a. In the Program Editor, verify Edit Shapes is still selected.
b. Click the ADD ITEM button.
c. Enter a name of your choice. (For instructional purposes, we have used the name
PLC.)

HAFl B0 0Ee0REEEHE

£ 1 I
Spacingl 1 5 cis: (N

e

2. Create an operate line with a PLACE SubOp:
a. Click the EDIT DETAIL LINES button to open Program Detail.
b. With the Shape partition selected, click the OPER icon.
c. With the newly created line selected, click the SUBOP button and select PLACE. The
program will use the fiducials and patterns for the shape to establish the desired
PLACE location.

e
T

s

:

:

= =
@ 3
2 5
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3. Enter desired values in the following Operate and Dispense panel fields of Program Detail:

Table 30: Operate & Dispense panel fields pertinent to Place Operation

Panel
Location of Fields
Fields

Field Description

Dispense panel StartZ

height of Z axis for placement.

End Z

location of Z axis after place operation.

Approach Veloc-
ity

velocity at which tool approaches component (velocity from
SettleZ to StartZ).

Dispense Velocity

velocity at which tool moves to End Z.

Operate panel Max Repeat

number of times the system attempts to pick up the compo-
nent at the current Z location.

Retries

number of Z axis increments used to move the tool downward,
testing for component presence after each index. (If no com-
ponent is detected, an error message will display.

Divide Maximum Z Value by Retries (total distance divided by
number of increments) to figure out the distance per incre-
ment. For example, to make the Z axis index downward a total
of 0.500 inches in five 0.100 inch increments:

* set Minimum Z Value to 0.0 inches

» set Maximum Z Value to 0.500 inches

» set Retriesto 5

Head Pressure

target operating pressure for the Force Feedback tool.

Operation Time

amount of delay before turning off vacuum/gripper.

Blow Off Time

amount of time for blow off/eject operation.
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3 - Create a Program for Pick & Place Shapes

Tips & Tricks

To create a program that incorporates the pick and place shapes generated from 1 - Create a
Shape for Pick Operation (pg 4.46) and 2 - Create a Shape for Place Operation (pg 4.49):

1. Incorporate both the new pick shape and place shape into a new program:

a. Create a new program and name it as desired (Pick&Place, for example).

b. With the new program selected, click EDIT DETAIL LINES to open Program Detail.

c. Below the first partition line of the program, add the two shapes you created earlier in
this procedure (PIC and PLC in the examples).

2. Assign a fixed location to the pick shape:
a. Highlight the pick shape line (shown in the screen illustration as the PIC line).

b. Click the SUBOP button to open a list of fixed locations.

c. Select the fixed location set up in Step 4 of 1 - Create a Shape for Pick Operation

(pg 4.46) to pick the component.
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3. Assign a fixed location to the place shape:

a. Highlight the place shape line (shown here as the PLC line).

b. Click the TEACH COORDS button in Program Detail and teach the location where the
part should be placed.

c. Click APPLY and DONE.

4. In the Program Editor, teach a reference point for the pick and place program.

From the Valve/Tool drop-down menu in Program Detail, select Pickup Tool.

6. Test your new pick and place program to verify results are as expected.
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Program Enhancement

* Pre-Scan (pg 4.52)

»  Automatic Calibration Limits (pg 4.53)

*  Counter Usage (pg 4.55)

«  Material Expiration (Pot Life) (pg 4.59)

+ Resumption Points for Underfill - UltiPath™ (pg 4.62)
+ Indexing Calibration Dots (pg 4.70)

+ Material Purge Options (pg 4.73)

Pre-Scan

Activating the pre-scan options in a program can help reduce processing time by reducing
gantry movement. When the pre-scan options are activated for a program, the gantry moves
first to all camera- related (fiducial and bad mark) locations, and then to all programmed height
sense (probe) locations before continuing with the regular program steps. In contrast, each
visual verification and probe operation is performed in its programmed sequence when pre-
scan options are not used.

One or the other or both of the Pre-Scan options can be used in a program. Both options, Pre-
Scan Patterns and Pre-Scan Probes, can be activated from the Program Editor when Edit
Programs is selected.

SUGGESTION: Use Pre-Scan Patterns with Pre-Scan Probes so visual verifications
precede probe operations, thereby ensuring that height sense operations are performed at
the proper coordinates and to verify the need for height sense.
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Pre-Scan Patterns

Pre-Scan Patterns will cause a program to find all fiducials and bad marks throughout the
program before performing any other operation such as dispensing, probing, etc.

Pre-Scan Probes

5/18/18

Activating Pre-Scan Probes will cause a program to perform all height sense-type operations
before performing any other operation (such as dispensing) with one exception. Board orien-
tation-type fiducials (global fiducials) and bad marks are always checked before Pre-Scan
Probes height sensing occurs to ensure a board is present.
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Automatic Calibration Limits

Program

5/18/18

Establish automatic program limits to prevent the Calibrate operation from executing every
time it is encountered in a program. Program limits are examined by the Calibrate operation
upon execution to determine:

+ if any limit is enabled and
« if the threshold for that limit has been exceeded.

If a limit is enabled and its threshold is exceeded, the Calibrate operation is performed. If a
limit is enabled and its threshold is not exceeded, the Calibrate operation is not performed.

Any number of limits may be enabled simultaneously. If any of the enabled limits is exceeded,
a single Calibrate is performed and thresholds for all enabled limits are reset [see Preventing
Over Calibration (pg 4.54)].

Limits
All program limits are located in the Limits panel of the program Mounts/Material Editor -
MOUNT window:
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To set limits for re-calibrating operation, board count, and/or time in the selected program,
enter a value in any/all of these limit fields:

Re-Calibrate Operation Limit

To enable this limit, set a value greater than 0.0 and less than 1000000 (1 million).
When the number of operations (dots, lines, etc.) exceeds this value, the Calibrate
operation is performed.

Re-Calibrate Board Count Limit

To enable this limit, set a value greater than 0.0 and less than 1000000 (1 million).
When the number of boards processed exceeds this value, the Calibrate operation is
performed.

Re-Calibrate Time Limit

To enable this limit, set a value greater than 0.0 and less than 1000000 (1 million).
When the total amount of processing time exceeds this value, the Calibrate operation
is performed.
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Preventing Over Calibration
All limit values are accumulated from the beginning of program execution. Times, board
counts, operation counts, etc. do not span multiple program invocations.

The execution of a Calibrate operation resets all limit timers and counters to prevent
calibration being performed too frequently.

Example

Assume:
Time Limits = 100 seconds
Board Count Limit = 7 boards

If 7 boards process in 140 seconds (20 seconds per board), then we expect a calibration
to be performed at 100 seconds AND 140 seconds (7 boards). This is 60 seconds before
the Time Limit expires the second time.

To prevent this issue, the calibration performed at 100 seconds causes the board count
threshold to reset so an additional 7 boards require processing before causing a calibra-
tion. Because the board threshold is greater than the time threshold, the board count
threshold will never cause a calibration.

No Program Limits
If no program limits are enabled (values are within valid ranges), the Calibrate operation is
performed every time it is encountered.
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Counter Usage

Tips & Tricks

Various types of counters are available - those that increment or decrement, those that test
one counter against another, and those that test a counter against a fixed value.

The values for selected Counters (pg 3.29) display on the main window only during a program

run when counters are used in the active program. Counters are added to a program as an
OPERATE line with a SubOp.

Counter Rules

These rules apply to standard counters:

»  Counters are numbered and can be assigned any number from 1 to 32,767.
* Any counter assigned a number less than 100 always starts at zero (0) with a program run

and disappears when the program run ends.

Any counter assigned a number of 100 or greater always starts with the value the last pro-
gram left it at and keeps its value in the database.

The panel of counter values displays on the main window only when a program asks for a

display of one or more counters and only while the program is running.
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Adding a Counter to a Program
All counter identities and values are established in the Operate selectable panel of Program

Detail.

To assign a counter:

1. In Program Detail, add an OPERATE program line and then click SubOp.
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2. From the list that displays, select a counter subop. For details about each counter subop,
refer to Counter Functions (pg 4.56).

=
=

Counter Functions

Ctr Set

Ctr Set sets or resets a counter. Assigns a value to a specific counter. Negative
values may be used. In the example shown here, counter 3 is assigned a value of 10.
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Ctr Inc
Ctr Inc increments or decrements a counter. The designated counter will be
increased/decreased by the amount specified. Negative values may be used. In the
example shown here, counter 3 will be decreased by 4.

Ctr Show

Ctr Show selects a counter to display. Designates which counter displays in the
counter panel on the main window and in which of the three counter boxes in that
panel it will display. In the example shown here, counter 15 will display in box Ctr 2 on
the main window.
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Ctr TestG

Ctr TestG tests a counter greater than another counter. In the example shown here, if
counter 3 is greater than counter 15, the program will skip two program lines back-
ward and resume with program line #3.
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Ctr TestLE
CtrTestLE test a counter less than or equal to another counter.

CtrValueG

Ctr ValueG tests a counter greater than a fixed value. Negative values may be used.
In the example shown here, if counter 3 is greater than 125, the program will skip a
single program line and resume with program line #5.
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Ctr ValueLE

Ctr ValueLE tests a counter less than or equal to a fixed value. Negative values may
be used
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Material Expiration (Pot Life)

In effect as of FLOware software version 2.9.3P

The Material Expiration features allows setting a material start date/time and a pot life. When
the combined start time and pot life has expired, messages are displayed indicating the
material has expired.

When the material expires, the dispenser continues dispensing expired material normally but
requires an operator to override the Material Expired condition.

Using Material Expiration
To activate Material Expiration:

5/18/18

1. From the main menu bar, click on Operations > Material Expiration (pg 5.54). The Material
Expiry dialog will display.

Material Expiry

Enter Start Date/Time and Pot Life

Begin Date/Time I 2018-05-09 08304 J

Pot Life | 8.00 hr

Warn Time I 30,00 min

Material Expiry Setup

Expires: 20153-05-09 16:02

_I0k|

Cancel | |

2. Enter an appropriate Start Date/Time and Pot Life.

If the entered values are valid, the actual expiration time/date is displayed and the OK but-
ton is enabled.

If the data is invalid (badly formed, in the past, etc.) the OK button is disabled.

Enter an appropriate Warn Time.

4. Set the Active/lnactive toggle.

NOTE: The Date/Time must be entered in this format: YYYY-MM-DD hh :mm

YYYY A 4 digit year, example: 2018

MM A 2 digit month (01-12), example: 04 is the month April

DD A 2 digit day of month (01-31), example: 14 is the 14th day of the month

hh A 2 digit hour in 24hr form (00-23), example: 13 is the 13th hour (1 o'clock PM)
mm A 2 digit minute (00-59), example: 05
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Tips & Tricks

Examples:
2018-05-09 10:00 May 9, 2018 10AM
2019-11-29 16:30 November 29, 2019 4:30PM
2018/05/12 14:20 Bad Format - date elements must be separated by hyphens (-)
2018-10-14 8 Bad Format - no minutes specified
May 14, 2018 12:00 Bad Format

Status Monitor

When the feature is enabled, an additional Monitor field displays on the main screen and is
active at all times. This monitor field displays either the time remaining for the current material
or an indication that the material is expired.

Figure 24: Material Not Expired

Pending Operationl

Monitorl

Materia'|§E><p1‘res in: 01:29:03

@Ccfe.(,}lfu
’7 Countl 0

Figure 25: Material Expired

Board

Pending Operation |
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hdaterial

I** Material Expired **

Chvele Iefor

Baoard
Count

n

If the feature is disabled, this monitor field is removed from the screen entirely.

Warning Dialogs

There are two cases in which a Material About To Expire warning dialog will display:

*  When no process is running, a warning is displayed if the material expires within Warn
Time minutes. This dialog is persistent; it displays until the material is updated or a pro-
cess is executed (Run button).

R59: Warning!!

A Material is about to expire
15:16

Close |
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* When a process is running and the material expires within Warn Time minutes, a warning
displays before processing the next unit.

/I\

[e=]

Expired Dialog

When a process is running and the material becomes expired, the following dialog is displayed
before processing the next unit.

Continue Dispenser will process the next unit; it will run one time.

Abort Dispenser aborts the current process allowing the operator to change the material and
update the expiration data.

Disabling Material Expiration
If the Active toggle button is not enabled, the Date/Time, Pot Life, and Warn Time fields are
disabled and the entire feature is deactivated. When deactivated, no warnings or messages
display.
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Resumption Points for Underfill - UltiPath™
In effect as of FLOware software version 2.9.2.

UltiPath™ Benefits Underfill
UltiPath™ underfill optimization increases throughput and reduces program setup time by
automatically determining the fastest, optimized dispense path and eliminating the need for
the operator to guess at the best route. This optimization is done on-the-fly so that changes to
the program are automatically handled.

FLOware software optimizes the best gantry path for the end-user by using resumption points.
The optimization ensures the quickest cycle times for complex underfill processes. The result
is reduced setup times, as well as quick updates for product changes and the addition or
deletion of components.

+ UltiPath™ Uses Resumption Points (pg 4.63)

+  Theory of Operation (pg 4.65)

* Resumption Point Rules (pg 4.66)

* Adding Resumption Points to a Shape (pg 4.69)
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UltiPath™ Uses Resumption Points
A resumption point is a standard call/return sequence with a closure, e.g., a point within a

FLOware software underfill program at which execution will be suspended and then resumed
at a later point in time, i.e., a resumption point allows you to design a program in a manner that

5/18/18

allows for the interweaving of operations with significant, inherent process delays.

Figure 26: How Program Flow changes when a Resumption Point is added into Program

Tips & Tricks

Flow of a “normal” program {without Resumption Paint)

narmal program flow end of program

top level program

Symbraf

Y
NS

——  flow of program

Explanation

program step

Flow of same program with a Resumption Point added
~ The program must finish before resuming execution of the interrupted shape,

program flaw with RP
top level program

p end of program

Explanation

program step flow of program
RP {resumption point) step subwverts normal program execution

resumption point
program steg when last step of top level program executes, system examines all P timers.
When an RP timer expires, program resumes at program detail step immedi-
ately follpwing the RP step and continues normal program execution,
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5/18/18

Figure 27: How Program Flow changes when Partition Lines are used with Resumption Points

Same program with Resumption Points AND Partition Lines
~ The program must finish before resuming execution of the interrupted shape,

Progran floww with RP m
Partition Line A |— T— -.- . . .

;’I- -M-Qvl end of program

Program continues
at line immediately
fallewsing Partition

Line B

Symmbod Explanatian | Symibol Explarnarion

- program step —— flow of program

resumption paint RF {resumption point) step subverts normal program execution

program step ——p= when a PL (Partition Line) or the last step of top level program executes, system
examines all RP {resumption point) timers. When an RP timer expires,
FL —=  Partition Line program resumes at program detail step immediotely following the RP step

and continues normal program execution,

For example, assume several underfill operations are required on a board. Each operation is
composed of a number of fill passes with a delay of several seconds required between each fill
pass. One way to approach this scenario is to make your program execute the first fill pass,
delay for some seconds, perform the second fill pass, delay for some seconds, and then
repeat this sequence until the first component is completed and then move to the next
component and repeat all these steps.

Resumption Points allow you to capitalize on the delay time between fill passes by performing
(in this example) a fill pass on another component and returning to the original component to
complete the next fill pass after some amount of time has expired. In other words:

1. A resumption point halts execution of a shape at the point at which the resumption point
command is encountered.

2. Execution of the interrupted shape is resumed after and only after:
a. the program encounters either a Partition Line or the end of the program (see
Figure 26 on page 4-63), and
b. the expiration time of the resumption point has expired (see Figure 28 on page 4-65).
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3. When the resumption point is resumed, execution picks up at the line immediately follow-
ing the resumption point command and continues until:
— another resumption point command is encountered (see Figure 29 on page 4-67) or
— the end of the shape is encountered.

Figure 28: Each Resumption Point can have a different Operation Time Value
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2 Operation Time is the minimum amount of
time that must pass before the Resume Pt
can be reactivated,

A different value can be assigned (o
Oyperation Time for each Resume Pt For
example, the first Resume Pt (see detail

line 3) has been assigned a value of 5.000
seconds, but the second Resume Pt (see
detail line 5) could be 7750 seconds.

Theory of Operation
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When a resumption point is encountered in normal program execution flow, its location in the
program is noted (saved) for later restoration and the time after which the resumption point
may be restored is calculated. At that point, execution of the shape is aborted and program
execution continues at the point at which the shape was invoked.

When the entire program has been executed, i.e. every line of the main program has been
visited or a Partition line is encountered, then and only then is the collection of resumption
points examined to determine which is to be resumed first. FLOware will continually examine
the collection of available resumption points until there are none left to perform. If a Partition
line was encountered, program operation will continue after all resumption points have been
executed. Refer to Figure 29.

A resumption point is performed when 1) its Operation Time number of seconds has passed
since the resumption point was first encountered, and 2) the particular resumption point has
been ready and waiting longer than any other resumption point. The resumption point which
has been ready to execute longer than any other resumption point will be performed first.
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Resumption Point Rules
These rules apply to resumption points:

* Resumption points are designed for use in underfill processes. Forcing them to work in
scenarios fundamentally different from underfill will probably result in failure.

»  The program will continue either to the end of the program (and all that entails) or to a Par-
tition line in the program. See Figure 29 on page 4-67.

*  There is no maximum time within which a resumption point will be performed. If your pro-
cess is waiting too long to return to a partially completed operation, then rearrange your
process.

* DO place resumption points within shapes (see Figure 29 on page 4-67).

DO NOT place resumption points:
— in the top level of a program sequence; this will result in undefined behavior.
— in the last step of a shape; this accomplishes nothing while slowing machine opera-

tions.

— next to each other in a shape; this also accomplishes nothing.

*  Resumption points can be used in up to 5 levels of nested shapes.

+ A Partition Line (pg 3.90) can be used to separate a program into smaller segments (see
following example). Partition lines should only be used in the program (not in a shape) and
cannot be the /ast line of the program (or undesirable results will occur).

Example of Partition Use: In this scenario, a program that dispenses multiple materials is
separated into subsections by using multiple partition lines: the first partition line begins
the section of the program that masks off an area with a UV mask. A second partition line
begins the section that cures the mask with a UV wand. A third partition line begins section
that dispenses UV curable underfill material. A fourth partition line begins the section that
cures UV underfill to prevent bleed-out. And a fifth partition line begins final program sec-
tion that dispenses regular underfill material.

Plays Well with Others

Resumption points work with these FLOware software features:

« fiducials on shapes

*  pre-scan controls

« array of shape

* nested shapes (to a depth level of 5)
* nested array of shape
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Figure 29: How Program Flow changes with Multiple Resumption Points

Tips & Tricks
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Figure 30: How Flow changes when Partition Lines are used with Multiple Resumption Points
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Adding Resumption Points to a Shape
To insert a resumption point in a shape:

1. In the Edit Shapes version of Program Detail, insert an Operation of OPERATE into a pro-
gram at an appropriate position.

NOTE: Do not position a resumption point in the top level of a program sequence, in the
last step of a shape, or next to another resumption point within a shape.
2. Select a SubOp of SetResumePt.

Enter a value in Operation Time (see Figure 28 on page 4-65) to represent the minimum
number of seconds that must pass before the resumption point may be reactivated. This is
the only parameter used by a resumption point.

4. Click APPLY.
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Indexing Calibration Dots

Set Up

5/18/18

Use this procedure when setting up calibration dot indexing at the ceramic chip on a
calibration station with chip backlighting (and no paper pad).

The changes described in the following procedure will cause the dispenser gantry to index to a
new position at the calibration station chip each time a dot is dispensed in the calibration
sequence.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software opera-
tions. Any non-GPD Global employee who uses this information beyond the stated application
specified by GPD Global Service Department personnel is in danger of causing personal injury
and invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses 1l contenuto NO SE RECOMIENDA

To set up the dispenser so it dispenses indexing calibration dots on the ceramic chip at the
calibration station, follow and complete all of the following steps in the order listed.

1 - Edit Configuration

To configure the basic calibration dot pattern at the calibration station:

1. From the main menu bar, click on Configuration > Dispenser Configuration (pg 3.135).
The Edit Configuration and Configuration Definitions windows will display.

2. In the Edit Configuration window, scroll down until you locate lines of text similar to the fol-
lowing:

DrillPadType = n
DrillPadHeight =
DrillPadWidth = n

n

3. Change the values to match the following:
DrillPadType = 1
DrillPadHeight = 20
DrillPadwWwidth = 20

NOTE: Height and width values are equal to half the physical length and width of the
ceramic chip.

4. To save changes and exit the Edit Configuration window, press and hold down the ALT
key and then type X and then S.

5. To exit the Configuration Definitions window, press and hold down the ALT key and then
type X.
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Edit Option Settings

To define a single line, calibration dot pattern at the calibration station chip:

1.

4.

From the main menu bar, click on Configuration > Option Settings. The Option Settings
window displays.

Enter a value of 30 in the Max Chip Index field. The number of times the dispenser
indexes (Max Chip Index) is limited by chip width and the minimum Drill Spacing value.

EXAMPLE: The Max Chip Index value must be less than 40 for a 40 mm wide chip with a
Drill Spacing of 1 mm. A value equal to or greater than the 40 mm chip width will cause
dots to be dispensed beyond the chip surface.

Enter a value of 1 mm in the Drill Spacing field. It is important to set the distance between
the calibration dots (Drill Spacing) at a value large enough to ensure that only a single dot
at a time is visible in the camera field of view.

To save new settings and exit the window, click OK.

3 - Set Base Locations

To teach camera base locations pertinent to indexing dots at the calibration chip:

1.

© N o a &

From the main menu bar, click on Configuration > Base Locations. The Check/Set Base
Locations window displays.

Jog the camera so it is centered over the calibration station ceramic chip. It is important to
center the Jog alignment cross hairs over the center of the ceramic chip because the chip
center point is the origin point for the dot dispense pattern.

In the upper left-hand panel of the Check/Set Base Locations window, select Camera to
Paper Pad (XY).

Save new base location coordinates by clicking the XYZ button and then SAVE.
Without changing camera position, select Camera to Drill Pad (XY).

Save new base location coordinates by clicking the XYZ button, and then SAVE.
Exit the window by clicking DONE.

Boot the system, using the standard Shutdown procedure, so the new base locations will
take effect.

4 - Edit Material Library

To turn on the Dot on Chip function in the pertinent material record(s):

1.

In the Program Editor menu bar, click on Libraries > Materials. The Mounts/Material Editor
window displays.

Click on the Material button and select the material to be modified — select the material to
be used when dispensing indexed calibration dots at the calibration station.

Click on the PANEL SELECTION button and select Calib Dot from the pop-up menu.
Fields specific to Calibration Dot Parameters should display in the right-hand panel of the
Mounts/Material Editor window.

Turn on the Dot on Chip default box.
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To save the change, click on APPLY and then CLOSE.

Repeat steps 2 through 5 for any additional material(s) that should also generate indexed
calibration dots.

To apply changes to the Program Editor, click on APPLY EDITS.

This completes the process of setting up for indexing calibration dots on the calibration station
chip.
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Material Purge Options

Material can be purged from a needle or nozzle while the system is idle or automatically as
part of a program run. The location at which purging occurs can be varied automatically to
prevent needle contamination.

Needle Clean & Purge

5/18/18

A valve needle or nozzle can be cleaned and purged automatically as part of the program run.
Using Auto Purge in a SETUP line enables the valve to purge while boards are moving on the
conveyor.

To set up this scenario:

1. Create a SETUP program line in the Program Detail window by clicking the Setup icon in
the upper right-hand corner.

o [ [ 1= IEEETE

2. Select AutoPurge from the SubOp option menu.
Enter a purge time value in On Time.

4. Be sure to activate the Auto Clean function.
IMPORTANT: The Auto Clean box must be selected in the Mounts/Material Editor window
in order for the needle to be cleaned online automatically as part of the program run;

otherwise, the purge operation will consist of a purge only with a message to the operator
to manually clean the needle.
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Auto Purge
When it is important to keep material flowing while the system is idle, as in the case of heated
material or a material that sets up quickly, use the Auto Purge feature.

Auto Purge can be selected for Head 1, Head 2, or both head positions. When your system is

configured for Auto Purge (DisplayAutoPurge must be set to True), these fields display on the
main window.
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To use Auto Purge:

1. Select one or both heads from the Auto Purge panel in the main window.

IMPORTANT: The Auto Purge head position you select must match the Mount Position
and Head of the library record for the material you want to automatically purge.

2. Set the duration of the automatic purge by entering a value in the Purge On Time field in
the Offline Operations window.

3. Set the duration of the automatic purge pause (the amount of time between automatic
purges) by entering a value in Purge Interval When Idle in the Option Settings window.
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Shifting Purge Location
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In effect as of FLOware software version 2.8v

The location at which the valve needle automatically purges material into the purge cup
(located on the calibration station) during a program run can be varied automatically. A shifting
purge location prevents the needle from contacting previously purged material.

To set up an automatically shifting purge location:

1.

Teach the following base locations at the center of the purge cup:
— Camera to Purge Cup 1 (XY); Head1 to Z
— Camera to Purge Cup 2 (XY); Head1 to Z
— Camera to Purge Cup 2 (XY); Head1 to Z

Refer to Appendix A - Base Locations in the Dispenser Service Guide for further details.

Open Option Settings (pg 5.70) by clicking Configuration > Option Settings.
Locate the Cup Location Count and Cup Radius fields in the Calibration panel.

Enter a value in Cup Radius that is less than the actual radius of the purge cup. This
defines the purge path (the circumference of the purge area within the purge cup).

Enter a value in Cup Location Count to represent the number of purge locations you want
available for use around the circumference of the purge path.
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Procedures for Custom Hardware

*  Auto Mode (pg 4.76)

» Barcode Scan Program Select (pg 4.80)
+ Board Flip Control (pg 4.83)

+ Dynamic Load Program (pg 4.84)

+ Material Weigh Module (pg 4.85)

*  Weight Calibrated Shapes (pg 4.91)

+ UV Wand Curing Light (pg 4.97)

Auto Mode

Tips & Tricks

In effect as of FLOware software version 2.9.1. Previous title: Barcode Program Selection.

The Auto Mode feature is complex and not always suitable for simple conveyorized applica-
tions. Use Auto Mode for a conveyorized system with an upstream barcode reader and board
flipper; otherwise, consider using this simpler option: Dynamic Load Program (pg 4.84).

Overview

When the operator selects the barcode program selection mode, the dispenser automatically
clears the nest, if a board is present, by moving the board downstream. A board is then

requested from upstream.

When a board passes the system barcode reader, a file is generated to indicate the program
to be used to process the board. When the board reaches the dispenser nest, the dispenser

retrieves the file and executes the designated program.

When the program is complete, the board is sent downstream and a new board is requested.

Details
The barcode program selection feature puts the dispenser into an endless loop mode where,
after emptying the dispenser nest to downstream if necessary, the dispenser waits for a board
(or pallet) to travel down the conveyor and trigger a barcode reader mounted upstream from
the dispenser. The dispenser loads and executes a program applicable to the current board
based on information received from the barcode reader.
After the barcode reader is configured at the factory, it functions transparently and conforms
with Auto Program, the FLOware control software feature that enables barcode-driven
program selection.
A board present sensor mounted at the barcode reader is triggered by the presence of a PCB
on the conveyor when Auto Program is selected (turned on) and Conveyor Off is unselected
(turned off).
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The barcode reader scans the PCB barcode and runs the program associated with the data
received from the barcode or, if the program specific to the scanned data is not available, the
dispenser prompts the operator to make a selection:

+ alter the ERROR-NO_READ program to sound an alarm, display a message, etc., or
« react to a display when the condition occurs by choosing either (A) to click OPERATOR
and then select a program to run, or (B) click RETRY.

The Auto Program mode and the RUN operation (triggered by the RUN button) are mutually
exclusive operations. While Auto Program mode is selected, the RUN button becomes
inoperable because board entry into the system and the reading of the barcode initiate a run.

Best Practices
In order for Auto Program mode to operate properly, observe these requirements:

Clear the System

Clear all boards from the system before selecting Auto Program. Any board arriving in
the system while the system is powered off can cause an Qut-of-Sequence Condition
(pg 4.79).

NOTE: For the discussion of this barcode feature, the term “system” refers to the dis-
penser AND all devices including and between the device into which the barcode
reader hardware is integrated. For example, if the barcode reader is mounted to a pre-
heater upstream from the dispenser, the preheater and any other device inline
between the preheater and the dispenser is considered part of the “system”.

Auto Program

Turn on Auto Program mode BEFORE a board arrives at the barcode reader. See
Controlling Barcode Selection (pg 4.77).

Board Delay

Maintain a board feed delay that will allow the dispenser to begin processing the
current board before the next board is allowed to trigger the barcode reader; other-
wise, a Lost Label (pg 4.79) condition could result.

Resumption Points

The Resumption Points for Underfill - UltiPath™ (pg 4.62) feature can be used in a
program that processes boards using a board flip device AND a barcode reader. If the
barcode reader is not present, however, resumption points are incompatible with a
board flip device.

Controlling Barcode Selection
Turning the Auto Program mode on and off turns the barcode selection feature on and off.

Turning On Auto Program

To turn on the Auto Program mode:

1. The dispenser uses its last known XYZ calibration during Auto Program mode, so before
entering Auto Program mode, calibrate the valve:

NOTE: It is presumed that a "family" of boards is run with the barcode reader, i.e., all the
boards in a run can be processed successfully using the same calibration template).
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a. Mount the valve that will be used during Auto Program mode.
b. Begin a calibrate program for the valve and then cancel the program after the calibra-
tion sequence part of the program is complete.

2. Clear the System (pg 4.77) of all boards.

3. Select the Auto Program button. The button turns red when the option is turned on.

f DANGER: The dispenser becomes active as soon as Auto Program is turned on. Automatic
operations now control gantry movement.
4. \Verify that both the Conveyor Off and Stand-Alone buttons are turned off.

5. Optional. To re-calibrate material dispense weight for each board as it enters the dis-
penser, add a Calibrate operation with a SubOp of Weight at the beginning of the program
to be initiated by the barcode reader.

The barcode program begins its endless cycle until an error occurs or Auto Program is turned
off.

Turning Off Auto Program

To turn off the Auto Program mode, deselect the Auto Program used button located on the
main window. The button turns gray when the option is turned off.

NOTE: If you turn off Auto Program while the dispenser is still in the process of running a
program, the program will finish running and the system will return to the standard run
mode.

Stop Operations

Emergency Stop

If either the Emergency Stop or Motion Stop buttons is pressed or a safety shield is
opened while the dispenser is in Auto Program mode, Auto Program mode and the
currently selected program are both canceled.

Cancel

If the CANCEL button is pressed while the dispenser is in Auto Program mode, Auto
Program mode and the currently selected program are both canceled. Occasionally a
program will not abort immediately as the current operation has to execute fully.

Pause

If the PAUSE button is pressed while the dispenser is in Auto Program mode, the
current operation is stopped at a convenient place in the program and operations can
be resumed by clicking the RUN button.

Troubleshooting

5/18/18

Waiting for Instructions

A Waiting for Instructions message can indicate the barcode reader failed to trigger. For
example, if a board is already in the dispenser nest when Auto Program mode is turned on,
the dispenser will wait for the operator to take action.

If the Waiting for Instructions message is allowed to time out, the operator is presented with a
chance to select a program to run. Before running the newly selected program, Auto Program
mode is automatically canceled and the current board is ejected from the dispenser nest.
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ERROR_NO_READ

The ERROR_NO_READ program name displays in the Currently Selected Program field on
the main window when a barcode triggers the reader but the data is unsuccessfully read or
decoded.

Fails to Find Fiducials

If the dispenser cannot find the program fiducials, press ABORT in the Jog window to
terminate the program and cancel Auto Program.

Lost Label

A lost label condition could result if boards are fed into the system without a sufficient time
delay between boards. A delay is needed between the time the dispenser begins processing
the current board and the time the next board is allowed to trigger the barcode reader. A six (6)
second delay is generally long enough to allow dispenser gantry motion to start.

For example, if board B arrives at the barcode reader before the dispenser has completely
read the barcode file for board A, then the file for board A will be replaced with the file read for
board B.

Out-of-Sequence Condition

If the dispenser is powered off when a board arrives at the barcode reader, the dispenser will
not receive barcode data from that board. The dispenser will display a Waiting for Instructions
or Waiting for Info message and remain in a waiting status until the out-of-sequence condition
can be cleared.

For example, if board A has already past the barcode reader and is waiting to enter the empty
dispenser nest when you turn on the system and select Auto Program, then the barcode scan
was not triggered. Board A will enter the nest, the next board in sequence (board B) will pass
the barcode reader, and the dispenser will execute the program for board B on board A.

To clear an out-of-sequence condition:

1. Exit the Auto Program mode.
2. Remove all boards from the system.
3. You can now turn on Auto Program mode.

Calibration

To recalibrate the dispense weight for each board that enters the dispenser, add a Calibrate
Subop Weight at the beginning of the program.
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Barcode Scan Program Select

In effect as of FLOware software version 2.9.3P
PN 2050-0094

This feature allows the operator to scan a barcode (product code) with a handheld scanner to
configure which dispenser program will execute the next time a program is run by the
dispenser.

A product code to program id mapping file is maintained on the dispenser. This file contains a
list of product codes and their associated dispenser program identifiers. This mapping file
allows multiple product codes to be mapped to dispenser programs. This reduces the number
of required dispenser programs but requires maintenance of the mappings file.

There are two basic modes of operation:

« The dispenser executes the most recently selected program until that program is changed
by scanning a different product code.

+ The dispenser executes a program exactly once per scanned product code. This forces
the operator to scan a product code prior to running any product.

How to Use the Mappings File
To edit the mappings file:

1. Scan one of the Command Codes (pg 4.81).

Successful scan The handheld scanner emits a single high pitched beep.

Unsuccessful scan  The handheld scanner emits a low pitched buzz.

When a scan is successful, the dispenser has recognized the scanned product code and
opens a text editor on the FLOware screen allowing you to edit the mappings file.

2. Review Part Number Mappings File (pg 4.81).

Edit the mappings file as necessary per Editing the Mappings File (pg 4.82).

4. Save the file and close the editor. The new mappings are in effect immediately.
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Command Codes

Use graphical editor to edit part number mappings.

Use text editor to edit part number mappings.

Part Number Mappings File
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To configure a product code to program id mapping, the mappings file must be maintained.

The mappings file is a structured text file which contains program ids and their associated
product codes.

The mappings file contains dispenser program ids followed by 1 or more product codes
associated with that program id.

Example 1 - single dispenser program with multiple product codes:

dispensePrograml:

SD-S140B-022-VO01
SD-S180B-009-VO01
SD-S190B-001-20220-VO01

These mappings designate that when any of the three product codes (SD-S140B-022-
V01,SD-S180B-009-V01 and SD-S190B-001-20220-V01) are scanned, the dispenser

program dispensePrograml will be loaded and executed.

Example 2 - multiple dispenser programs each with multiple product codes:

productClassli4:

SD-S140B-001-20220-Vv01

SD-S140B-002-20220-V11
SD-S140B-003-20220-Vv41

productClassl8:
SD-S180B-009-VO01
SD-S180B-001-20220-VO01

productClass09:
SD-S090B-022-VvV01
SD-S090B-001-20220-V01
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Editing the Mappings File
There are two CQ Command Codes (pg 4.81). Each code starts a file editor on the proper
mappings file, but each starts a different text editor:

* NEdit is a graphical editor which most users will find intuitive to use

» VEditis a text based editor preferred by some

Tips & Tricks

SUGGESTION: Print your preferred command code and store it near (or on) the dispenser for

easy access.

Rules

» Dispenser program ids must end with a colon (;)

« Dispenser program ids must match the expression designated by the progid-patt
key in the configuration file. For details, refer to Testing & Validating Mappings and Config-

uration (pg 4.82).

* Product Codes are associated with the immediately preceding program id

*  Product Codes must match one of the expressions designated by the partno-patt
key in the configuration file. For details, refer to Testing & Validating Mappings and Config-

uration (pg 4.82).

¢ Comments and blank lines are allowed

Example - Mappings File:

Comments are prefixed with a hash (#).

#H
## blank lines are allowed

# recipe id

recipe 001:
# some product codes
SD-S140B-001-20220-Vv01
SD-S140B-002-20220-V11
SD-S140B-003-20220-V41

# another recipe id

recipe 010:
# some product codes
SD-S180B-001-20220-Vv01
SD-S170B-002-20220-V11
SD-S110B-003-20220-Vv41

B

g

uses
uses
uses

uses
uses
uses

## Product Code / Recipe ID Mappings
## Recipe Ids end with a colon
## Product codes are indented and associated with the preceding recipe id

recipe 001
recipe 001
recipe 001

recipe 010
recipe 010
recipe 010

Testing & Validating Mappings and Configuration
Refer to Periodic Operations - TEST Barcode Scan Program in the Dispenser Service Guide
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for details.
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Board Flip Control

In effect as of FLOware software version 2.8
The board flip software control feature enables the following process:

1. Equipment external to the dispenser presents a board to the dispenser conveyor.

2. The dispenser conveyor moves the board into the dispenser work area and begins pro-
gram execution.

The dispenser program stops when it encounters a Flip program line.

4. The dispenser conveyor reverses direction and returns the board to the entrance end of
the conveyor (or external equipment).

The external equipment flips the board and returns it to the dispenser.

6. The dispenser skips all programming up to and including the Flip program line, executes
the remainder of the program, and then releases the board normally to the exit end of the
conveyor.

Requirements

Board flip software control requires an additional conveyor relay and two additional SMEMA
lines. For further details about hardware and cabling, refer to the service document entitled
SMEMA Hardware & Cable.

Flip Program Line
To create a Flip program line, select an Operation of OPERATE and a SubOp of Flip.
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Flip Operations

If a program includes selections for pre-scan patterns and pre-scan probes, the dispenser will
pre-scan everything on the initial board side prior to executing the Flip program line. After the
board is flipped, the dispenser will again pre-scan everything on the new board side.
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Dynamic Load Program

In effect as of FLOware software version 2.9.3K

The Dynamic Load Program option allows a device instead of a user to select a program. It
simplifies the loading of FLOware software programs for most conveyorized scenarios by
automatically loading a program selected by a device that generates a program ID.

Examples:
A barcode reader is a device that generates program IDs, as is a wafer handling unit.

[For a conveyorized system with an upstream barcode reader and board flipper, refer instead
to Auto Mode (pg 4.76).]

Assumptions:

* FLOware control software Version 2.9.3K or later is installed on the system.

* The system is configured with a conveyor and other relevant hardware.

+ The system is configured for the Dynamic Load Program option (in a configuration file set
up at the factory).

* The system is not placed in Auto Mode. Dynamic Load Program and Auto Mode are mutu-
ally exclusive - implementing one rules out use of the other.

Process Flow
FLOware control software tests for the existence of a Dynamic Load Program file name at
various points in a run:

* immediately upon completion of a unit, or
» while waiting for unit delivery by the conveyor.

The current program remains selected from the time conveyor transport begins until the new
unit is completely processed. A dynamically loaded program is treated exactly as if selected by
a user except the user is not presented with the Mount dialog prior to calibration.

File Name Found

If the Dynamic Load Program file name is found and contains a valid program name,
the designated program is loaded and processing continues as if the user had
selected the new program and pressed the RUN button.

File Name Not Found

If the Dynamic Load Program file name is not found or does not contain a valid
program name, processing continues normally using the current program.
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Material Weigh Module

In effect as of FLOware software version 2.9.30
This software feature is intended for use with a precision weight scale.

Use the Material Weigh Module to monitor weights during a process by acquiring a weight
measurement at any time during a process and comparing it against a reference weight to
determine if quantities dispensed at the end of a process remain within tolerance.

This process monitoring tool is integral to a program and performs tests of process consis-
tency by weight. This process tool allows you to (1) change how frequently weight sampling
occurs and (2) edit the value of the tolerance range used when the module compares sample
weight(s) to a reference weight.

A process program must be running because weigh operations are triggered during the
process by the program.

Theory of Operation
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Numerous sample weight operations can occur in a program but for purposes of this expla-
nation, only two sample weights are used.

1. Start a program that includes the Material Weigh Module.

2. After the program dispenses material at the first component, a “monitoring” weight is dis-
pensed and weighed at the scale. This weight is saved as the reference weight in record
location 0.

3. After dispensing material at several more components, a “monitoring” weight is dispensed
and weighed at the scale. This weight is saved as the sample weight for record location
1.

4. After dispensing material at the remaining components, another “monitoring” weight is dis-
pensed and weighed at the scale. This weight is saved as the sample weight for record
location 2.

5. All sample weights are compared against the reference weight. If sample weights are
within tolerance, the program continues. If sample weights are outside tolerance, an error
message displays and the program pauses for operator action.
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Sample Program using Material Weigh Module
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The sample program shown here uses a single sample weigh operation. Values and
frequency of the sample weigh operation will vary in your programs due to different processes,
materials, and pumps.
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Priming shape

Reset operation

Reference weigh operation

Sample weigh operation

m OOl ® >

Compare weights operation

Priming Shape
(optional) - Increases program efficiency. Performing priming prior to Reset decreases
the weight difference between the reference weight and sample weight(s) using the
fewest program lines.

Reset
Clears weight values from all record locations.

Reference Weigh
The reference weight is assumed to be the current value of a dispense. The value for
the reference weight is always stored in record location 0.

Sample Weigh

The weight value captured at any time during a process run between the Reference
Weigh operation and Compare Weights operation. Each captured weight value is
stored in a separate record location.

Compare Weights Operation

Tests whether or not sample weights are within tolerance when compared to the refer-
ence weight. When a Compare operation is performed, all weights from Record 1
through Record n are compared against the reference weight. In the above sample
program, Record 1 is compared to Record 0.
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Editing Material Weigh Module Program

Tips & Tricks

You may change how frequently weight sampling occurs during a process run. You may also
change the value of the tolerance used when the Material Weigh Module compares sample

weight(s) to the reference weight.

Frequency of Weight Sampling

To change how often the weigh operation occurs, edit the program. The number of sample
weighs is controlled by the number of sample weigh operations in your program.

For example, the following is what the Sample Program using Material Weigh Module
(pg 4.86) would look like if you increased weight sampling frequency to occur after every two

dispense operations:

. Part
a Nurnber
A — 4 2 Weigh Dot 0
|| 3 Reset SubOp | Panel 5
B — ’///g/,Record 1]

775 it 1 0.0000 0.0000 [ Stundard Vakies N
C 6 Unit 2 1.2270 0.0000 o[, -
New —7— Record 1 N :

8 Unit 3 1.2270 2.1000 o W
New 9 Unit 3a 1.2500 2.3000 ' =
TN 19— Record 2 ThetaIO‘OO deg M
11 Unit 3b 1.1000 1.9000 Oblect
D___ | 12 Unit 4 0.0000 2.1000 Rota{ionlo‘oo deg M
(71— Record 3 .
E 14 compare Size » | 0,0000 in W
. ... .
A Priming shape
B Reset operation
C Reference weigh operations
D, New Sample weigh operation
E Compare weights operation

Rules for Sample Weigh Operations

RULE #1 - Use sample weigh operations anywhere in a program between the Reference
Weigh and Compare operations.
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N Number
2 HWeigh Dot 0
3 Reset SubOp |
4 Record 0
——5  unit 1 0.0000 0.0000 =y
6 Unit 2 1.2270 0.0000 or
7 Record 1 N
8 Unit 3 1.2270 2.1000 P
9 Unit 3a 1.2500 2.3000 ' =
10 Record 2 ThetaIO‘OO deg
11 Unit 3b 1.1000 1.9000 Object
12 Unit 4 0.0000 2.1000 Rotation | 0-00 deg
13 Record 3 .
14 compare Size A I 0,0000 in
—_—
C Reference weigh operations
E Compare weights operation
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RULE #2 - Each captured weight value is automatically stored in a separate record location.

Captured Weight Values are Stored in Record Locations

Record Location Captured Weight Value

Record 0
Record 1
Record 2
Record 3
Record 4
Record 5
Record 6
Record 7

3 3 3 3 3 3 3 >

NOTE: If you require additional record
locations, contact us.

Recommendation for Sample Weigh Operations

Maintain numeric sequence

Notice the numeric sequence of the sample weigh operations shown below. When
using multiple sample weigh operations, we recommend maintaining numeric
sequence as this lends clarity to future data analysis.

. Part
- Number
2 HWeigh Dot 0
3 Reset SubOp
4 Record 0
5 Unit 1 0.0000 0.0000 =y
6 Unit 2 1.2270 0.0000
/7/ Record 1
- 8 Unit 3 1.2270 2.1000 .
D /’ 9 Unit 3a 1.2500 2.3000
<‘“\l9— Record 2 ThetaIO‘OO !
11 Umit 3b 1.1000 1.9000 Object
2 Unit 4 0.0000 2.1000 Flataiia 0,00 ¢
13™~Record 3
14 Compare Size # | 0,0000
_____ [—"

D Sample weigh operation
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Tolerance for Weigh Samples

To change the allowable tolerance for the comparison function, open a shell and edit the
tolerance value in the appropriate file.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel.
Improper application of this information can lead to serious complications in FLOware Software
operations. Any non-GPD Global employee who uses this information beyond the stated appli-
cation specified by GPD Global Service Department personnel is in danger of causing personal
injury and invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

To edit the allowable tolerance value for the comparison function:

1.

2
3.
4

5.
6.

5/18/18

From the main menu bar, click on System Functions > Shell.
At the $ prompt, type cd /appl/etc/config/ and press Enter.
At the $ prompt, type 2050-0090.cfg

Edit the value for tolerance.

[DEFAULTI

log= lezwer ] = 10
logp=F i le=sapp lretos Doge2050-0090 . log
log-conzole=lalze

[ A050-00%0 1
tolerance=0.01

within this numbe

mote:  Lhis AUST be 0
o D= i gh=t i neou t =5000
L]
L

H]

u

it timeout a weigh | 1 tha ot become stable
"

]

i

k.

Save your change by pressing the ESC key, X for eXit, and Y to save all.

Reboot the system to implement the changed value.
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Editing Weigh Sample Parameters
To change the parameters for a weigh sample, edit the pertinent parameter(s) for the
(standard) shape used in your program. For example, if your program uses the Dot shape,
then for some pump types, you would change the OnTime value for the Dot shape.
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Weight Calibrated Shapes

In effect as of FLOware software version 2.9.1

This software feature is intended for use with a precision weight scale.

Why use Weight Calibrated Shapes?
Achieve the dispense pattern weight you want without performing trial-and-error program
adjustments. Use the Contour Mapping software routine to:

* reduce setup time,

+ program a complex dispense pattern consisting of lines, arcs, dots, etc., with as many fea-
tures as required,

* make adjustments to a dispense pattern while maintaining a desired weight, or

* adjust the weight with the same pattern.

During pattern setup, a base pump speed is defined and the desired weight for the dispensed
pattern is entered. The program is run and the system records pump starts, pump stops, and
the movement time between segments. These starts, stops, and delays are then duplicated at
the weight scale. The system adjusts pump speed to attain the desired weight.

Each dispense pattern used in a program can be calibrated to a specific weight or just to a
specific pattern. This feature greatly reduces setup time and allows users to (1) make adjust-
ments to the dispense pattern while maintaining the desired weight or (2) adjust the weight
with the same pattern.

For other weight scale features and parameters, refer to Scale Set Up within Software
(pg 3.129).

Theory of Operation
The Dispenser Editor (pg 5.24) presents a list of shapes for the currently selected program.
You need only enter weight calibration data on a shape-by-shape basis. At the next program
run, the system attempts to dispense the desired amount of material (by weight) for the given
shape(s):

1. When calibration is called for during the program run, the pump moves to the weight scale
and dispenses at the program-specified speed for the amount of time previously mea-
sured for the shape being calibrated.

2. After the initial weight of the shape is determined, pump speed is adjusted and the pump
once again dispenses material for the shape on the weight scale. If no suitable calibration
data is located, the pump speed is used unchanged from the program.

3. If further adjustments are required to fine tune the actual weight being dispensed, then cal-
ibration is tried again. A total of three calibration attempts are made before operator inter-
vention is required. If prompted, the operator is presented with these choices:

— Retry - calibration is tried, at most, three more times.

— Ignore - calibration is abandoned and the program continues using the previous cali-
bration values (if any).

— Cancel - the program is terminated.
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Guidelines for Shape Calibration

The Contour Mapping feature is only accessible when the dispenser is configured for the
weight scale option (and the correct password has been entered).

“Shape”. The term “shape” refers to a shape programmed via the FLOware software, NOT
the shape of the material being dispensed.

RULE: A shape must be created as a shape, not by using a program.

RULE: A shape must be fully executed by a program at least once before the shape can
be calibrated.

Shape ID. Because calibrated shapes are identified by both their program AND shape, cali-
brating a shape in one program does NOT calibrate the shape in another program.

RULE: A shape shared between programs has a separate and distinct calibration for each
of the programs.

Nested Shapes. Do not calibrate both a nested shape and one of its sub-shapes.
EXAMPLE: If shape A contains shapes B and C, calibrate only shape A. Even though it is
possible to do so, calibrating a nested shape and a sub-shape will generate undesirable
results.

RULE: Calibrate only the nested shape, not the sub-shape.

Weight Range. To achieve good results, keep a shape’s programmed weight reasonably
close in value to the desired calibrated weight.

EXAMPLE: If a shape is programmed to dispense 500 mg of material and you try to cali-
brate it to dispense 5 mg of material through pump speed adjustment, the results will be
disappointing.

Weight Time. Weight time cannot be set independently because weight calibration is specific
to shape elements.

RULE: The value for Weighing On Time must be zero (0).

Single Pump Speed. If multiple pump speeds are used to dispense a shape, weight calibra-
tion will not work.

RULE: Only shapes using a single pump speed will calibrate properly.
Pump. The Contour Mapping feature functions for pumps with encoder count capability.

EXAMPLE: Micro-Dot, PCD3H, PCD4H, and LX Auger pumps.
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Calibrating Weight Data

Once created and set up, a program can automatically calibrate one or more shapes during
program execution.

1 - Create a Program with Custom Shapes

1. Create shapes to represent desired pattern. For details, refer to Custom Shapes (pg 3.55).

2 - Generate Timing Values

The first time the program runs, the system generates timing values for each shape, so follow
these steps:

1. (Optional.) Use sample substrate for the first program run.

2. Select the program.

3. Run the program. Let the program and calibration sequence complete a full cycle.
4

Abort the program after it completes one full cycle.
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3 - Enter Weight Calibration Data

To enter weight calibration data for a shape:

1. Select SHPCAL in the main menu button bar to open the Contour Mapping Editor.

The name of the selected program displays in Selected Program. A list of all shapes in the
currently selected program also displays.

An absence of a list of shapes suggests the program needs to be run. Perform 2 - Gener-
ate Timing Values (pg 4.93).

= 3. 1
-
|

CE—
:
;
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Select (highlight) a shape in the list of shapes.

Check the Enable Calibration check box to activate weight calibration during program exe-
cution.

i 11

Hk:
B

Enter desired material weight (in mg) of the shape in Target Weight.

NOTE: The calibration routine can handle a minimum net weight of 0.001g. If the dis-
pensed sample weighs less than this amount, the system interprets a net weight of 0.0g.

Enter correct value for pump speed.

RULE: The pump speed in Contour Mapping must equal the pump speed used in Pro-
gram Detail or else incorrect data will result.

EXAMPLE 1: For Micro-Dot type pump, the value of MicroV must match Micro Valve Speed.

Figure 31: Match speed fields for Micro-Dot type pumps

Erm
& m.._
e
| I
- CEI.

L
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EXAMPLE 2: For PCD or LX Auger type pump, the value of PCD must match Auger Speed.

Figure 32: Match speed fields for PCD and LX type pumps

3 E

“EEEEEE @

{

Click SAVE to save the data.
Click CLOSE to close the window.

Run the program. Calibration of each shape occurs prior to program execution.

— If calibration results are within weight specification, your program is ready to for pro-
duction.

—  If calibration results are not within weight specification, select the RETRY button,
increase or decrease the Weight Compensation value, and run then the program
again.
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UV Wand Curing Light

In effect as of FLOware software version 2.9.1

When an optional UV curing light is integrated into the dispenser, UV wand control is managed
by the FLOware control software with the following customized SubOp controls created in the
SubType Editor (pg 5.103) using SubType 0. (For additional details, refer to SubOps &
SubTypes (pg 5.114).

UV Bulb Functioning

An input/output has been set up to detect the bulb ON state (i.e., not burned out). A
program that calls for UV operations will operate only if the bulb is in the ON state and
up to full light intensity. To check the UV bulb state before the lamp is to be used, use
an Operate SubOp of Lamp Lit.

This function may not be available with all UV control boxes.

UV Light ON/OFF (shutter open/closed)

The UV bulb is always in the ON state due to the warm-up period required by the bulb
to attain full light intensity. Light is emitted when the shutter is open. Control of the
shutter is available by using the Operate SubOps of UV ON and UV OFF.

UV Shutter Fault

The UV shutter fault is checked to confirm that the shutter has opened when called
for. This test should be run at the beginning of a program after UV ON has occurred.
To verify that UV shutter fault is checked, add an Operate SubOp of Shutter Open
after UV ON. A slight delay for checking can be added.

This function may not be available with all UV control boxes.

Safety Package

The UV bulb turns OFF when any dispenser window or shield is opened. Control of
the UV bulb shutter is linked directly into the standard, interlocked, dispenser safety
package.

To use the UV wand in a program:

1. Define the UV wand position using the Head 4 to Target (XY) base location.

2. To manage UV wand control in a program, add these program lines near the beginning of

your program:

a. Optional. To verify the UV wand is ready, add an Operate (pg 5.112) program line with
a SubOp of Lamp Lit.

b. To open the UV wand shutter, add another Operate (pg 5.112) program line, this time
with a SubOp of UV ON.

c. Optional. To verify the UV light shutter has opened, add another program line with a
SubOp of Shutter Open. A slight delay (between 0.5 second and 1 second) for check-
ing can be added by entering a value in the Operation Time field.

3. To close the UV wand shutter after your program is done running, add an Operate pro-
gram line with a SubOp of UV OFF near the end of your program.
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5

References

This chapter presents reference material from which you can obtain detailed information about
the various libraries, window content, and preprogramming primitive operations used by the
FLOware software.

» Libraries (pg 5.1)

*  Windows & Fields (pg 5.22)

+  Operations (Primitives) (pg 5.108)

*+ SubOps & SubTypes (pg 5.114)

* Legacy Controls & Operations (pg 5.120)

Libraries

5/18/18

Data is organized into a variety of libraries, each of which is discussed in this section. Each
library is accessible with the proper access rights via the Program Editor.

» Fixed Locations Library (pg 5.3) - define and edit fixed locations.

* Heads Library (pg 5.5) - add, modify, or delete a mount position from the list of mount posi-
tion types currently available.

+ Materials Library (pg 5.7) - add, modify, or delete a material from the list of materials cur-
rently available.

+ Material Defaults Library (pg 5.9) - define defaults for materials according to head mount
position.

* Needles Library (pg 5.11) - define a needle or change the characteristics of an existing
needle

+ Part Numbers Library (pg 5.12) - define individual cross reference records or change the
shape associated with an existing cross reference record.

+ Passwords & Access Rights Library (pg 5.13) - add or delete a user name, change access
rights for a user name, or change the password for a user name.

» Patterns Library (pg 5.16) to create or modify shapes to be used as patterns during fiducial
or bad mark pattern recognition by the (optional) automatic vision system to locate a prod-
uct and adjust for its orientation.

+ SubTypes Library (pg 5.18) to define and edit subtypes.
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Changes and Deletions

The process by which library records can be changed or deleted is the same for many of the
libraries; the required steps are listed below. When this is not the case, detailed instructions
are provided in each library-specific section along with the instructions on how to add records
to each library.

Edit a Library Record

To change parameters in a library record:

1. Open the Program Editor, click on Libraries, and select a library from the pull-down menu.
The editor window for the selected library will display.

2. Click the select button W by the name field, select the record to be changed, and click
ACCEPT.

3. Make desired changes. We strongly recommend you add text in the Description field to
indicate why this record is significant to your site (what does this record do and/or what is
its purpose).

4. Click APPLY to save the changes or click CLOSE to cancel.
Click CLOSE to exit the window.

Delete a Library Record
To delete a record from a library:

1. Open the Program Editor, click on Libraries, and select a library from the pull-down menu.
The editor window for the selected library will display.

2. Choose one of the following actions:
— Delete the Displayed Record
To delete the record displayed in the name field, click the DELETE button. Click OK on
the confirmation prompt that displays or click CANCEL to close the prompt without
deleting.

— Select and Delete Record(s)
« Single records - to select and delete a single record, click the select button W by
the name field, select the record to be deleted, and click ACCEPT.

* Multiple records - to select and delete multiple records, click the select button W
by the name field, use the <Ctrl> button to select as many records as you want to
delete, then click ACCEPT.
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Fixed Locations Library

5/18/18

Fixed locations are normally used in pick-&-place programs and are typically taught at the part
pick-up-point of a pallet or a feeder. Because they eliminate the need for height sensing at the
pick-up-point, fixed locations can also reduce program execution time.

A fixed location defines a location fixed in accordance with the dispenser table — it is a point
within the work area independent of board location, i.e., fixed locations remain unaffected by
program compensation adjustments made for board orientation.

The use of a fixed location enables pallets to be reset selectively. A fixed location is the
position of the first item on a pallet or a feeder and all device data points are measured from it.
A fixed location will often be taught at the center or corner of a pallet pocket. A pallet is
considered to be an array of pick up points; a multiple pallet is an array of pallets; and a
feeder, also based on pallets, is considered to be a 1 row by 1 column pallet.

Pallet size, spacing, and other parameters are defined when the fixed location is defined.
These types of parameters, along with the coordinates of the fixed location, can be changed
within a program using the Fixed Location Editor. Fixed location coordinates should not be
adjusted manually.

Fixed location values can and usually should be exported to permit reloading without the need
to re-teach points. The import of fixed location values requires special system privilege.

Locaion Specifice Framrer -

—Tﬂ-}\mﬁ ml__] Ganty A _] o Samet Inger

000 End Index

Name —_

Descrigtion -
Description — i ' 0.00 wn ot Aciust
. : 0,00 m b Y Adist
Coordinate %[0.00 000 nm  [SONEE
buttons —1 1] E-r.m 1 Muti i Count
& fields g -0 = 0.00 » [_‘ Mol ¥ Count — Features
[ % Count] 1 | 0.00 dag _finge T_l Wt R e
Location ¥ Court| 1 o0 s Opersta Time

Specifics — Taach| XSpace[o.0m l— Operate Doty [} Change Aequest
fields |-:-—
Teach| Y Space| 0,00 s 0,000 = Change Time [ Changed
- i A E:x

Option [ 4 No Pallot + Poquost Now - Use 1D Fichneials [0 Changeakiag
toggle wMultiLop - Mui Request . Mu Use 10 -
butions L Closs | Apply | Delste | |
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Add a Fixed Location
When creating a new fixed location, keep in mind that certain conditions that exist during
execution of the program using this new fixed location need to be in place while you teach the
fixed location coordinates. Also be aware that teaching accurate coordinates requires you to
install the same head (valve or tool) that will be used during program execution. Be sure to
install the head in the actual mount station position that will be used by the program.

To add a new fixed location:

1.

Open the Program Editor and click on Libraries > Fixed Locations. Fixed Location Editor
(pg 5.35) displays.

Create a fixed location record:

a. Enter a name in the Name field.

b. Type text in the Description box identifying the purpose for this fixed location.
c. Click APPLY now to save the new record name.

Teach the coordinates for the new fixed location record:

a. Install the valve or tool. To ensure accuracy and prevent equipment damage, use the
actual head and mount station position designated for use with this fixed location.

b. Use the coordinate buttons and fields to teach X,Y and Z coordinates.

Add additional parameter detail as needed:

a. If a pallet or array rotation needs to be defined, teach the angle coordinate by using
the Angle field TEACH button to teach the pallet pickup point farthest along the X axis
from the point already taught for the XYZ coordinates.

b. As needed, enter or teach the remaining Location Specifics fields.

c. Verify that the option toggle button applicable to the new fixed location is activated.

d. Enter values, as needed, in the Features fields.

Click APPLY again to save your additional input or CLOSE to exit the window without sav-
ing the parameter detail.

Click CLOSE to exit the Fixed Location Editor.

Remove the teaching tool from the mount position station.

Edit a Fixed Location
To change parameters for a fixed location, refer to Edit a Library Record (pg 5.2).

Delete a Fixed Location
To delete one or more fixed locations from the fixed locations library, refer to Delete a Library
Record (pg 5.2).

5/18/18
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Heads Library

The head library contains a set of predefined head records describing the properties and
defaults for the various valves and tools that might be mounted on the machine. You may
create and add new heads to the library or select an existing head and modify its character-
istics.

The head library is useful for eliminating operator setup mistakes by:

» associating parameters with a particular valve type.

* associating valve parameters with a program.

» enabling you to add, modify, or delete a mount position from the list of available mount
position types.

Head additions and modifications can be made at any time by accessing the Valve/Tool Editor
either directly through the Program Editor or indirectly through the materials or material
defaults libraries (the Mounts/Material Editor windows).

Clicking the selector button next to the Valve/Tool Name field opens the Select a Valve/Tool
window displaying a list of existing heads from which you can choose. Alternately, if you define
a new head name and click the APPLY button, the new name will be added to the heads list.

Only the operations and parameters that apply to the selected Type field will be active; those
that are not applicable to the currently selected head will appear faded.

Valve/Tool valverToe! Mame
Name ~ | NonE I;l_____._--—-':; | Dummy |
_ ——
Type _ 4 Deccdpses—
Description —j—1*
B I Lanw Material Sensor I Low Feservoir Sensor i Chvar Sermos
) -1 Petroct Sensor - Extra Senser A o Senser
Operations — | Has Standaf | Hes Shut OF i Has Jews
i Skip SrandOf Calbrasian  _i heep head shahss i Has Touch Probe
B X Ofget | 0000 in ¥ ;l'ser- 0,000 dm Z CI"S.!]| 0,000 in
Standefl[ . Standell [ - = PP
& Offagt] 0000 & W gt 00 & Sand Of1 2| 0,000 &
L - pPe— Valve [ . Stall
Spwad| 000 1 R | -0 1w 'Fu-,l 1,000 X
oL A —— Reloacd r
Parameters — Food Faig| 02000 /s hicc Fange| 1900 In/'s
hiravsive [ Micro Valve [T Micro Valve
Nty | © ctars Reeras | 0 cts oo | 1200000 ct
Hold Time | 0.000 3 Hold Center | 0,000 = "‘:,':::‘_f:_:"' 0.0 psi
Oipen Thme | 0000 5 Cipen Cenler | .00 5 5:;;:-' 0,000 g
Closa Apply Delote |
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Edit a Head

References

To add a new head to the head library:

1.

N o o kM DN

Open the Program Editor and click on Libraries > Head. The Valve/Tool Editor displays.
(You may also access the Valve/Tool Editor from either the Materials or Material Defaults
libraries.)

Enter a name in Valve/Tool Name.

Click on the Type button and make a selection from the drop down menu that appears.
If desired, type text in the Description box.

Activate each operation box applicable to the new head.

Enter values in the parameter fields applicable to the new head.

Click APPLY to save your input or CLOSE to exit the window without saving.

To change any of the characteristics for a head, refer to Edit a Library Record (pg 5.2).

Delete a Head
To delete one or more heads from the head library, refer to Delete a Library Record (pg 5.2).

5/18/18
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Materials Library

Use the materials library to make material parameter changes to a particular material record.
This single change will affect all programs using that material — this is more efficient than
making the same change repeatedly in every program that uses that material. If, however, the
change is applicable to all materials, we recommend making the change in the material
defaults library rather than repeating the step for every material record in the materials library.
Refer to Material Defaults Library (pg 5.9).

New materials can be added to the materials library by selecting an existing material and
modifying its characteristics. The materials library is represented by the Mounts/Material
Editor - MATERIAL window. (See Mounts/Material Editor (pg 5.59).) Clicking the selector
button next to the Material field opens a list of existing materials from which you can make a
selection.

Only the operations and parameters that apply to the selected material will be active; those
that are not applicable to the currently selected material will appear faded. If you enter a new
name and click the APPLY button, the newly created material will be added to the materials
list.

MATERIAL Vabw Seitings
Material Description Auger [L"
Speeg| 70
- 3 - Avger
Auger [
eterell ONE e [g.000 s |4
h { Mignume’T -
- Reverse i
Group | None Wi [
Shutoof | 000 s ¥
Color | None Meadle 25 o SnapOdZ | 0,00 ax "
Pinch [ i
Valve/Tool NONE |  Ganupa | Delay[ D000 s W
icro Vatve =20 —
Descrigtion Speed
2 Micro¥ ehve | 1000000 ct, | I
To provide for an unknown material or tool Accelpratign | 1 O
Pre SnapCfl ,— -
Delay 0.000 3 E
Post Delay| 0.000 5 "
hlaing NONE
500,00 we, |
I Auto Clean W Snag OF (oo
#ccclnrunm' 7000.0 nn/ [
| Manual Callbration W | Skip Calibeation
Feawre & rnspe:tDeiqr[:'.rJ.-: s
Clml Apply Deleta| /| Gapyl

Add a Material
To add a new material to the material library:

1. Open the Program Editor and click on Libraries > Material. The Mounts/Material Editor -
MATERIAL window displays.

2. If a material similar to the one you want to create already exists, click the select button W
by the Material field, select the existing material, and click ACCEPT.

If you are creating a completely new material, we recommend selecting the NONE mate-
rial name to use as a base.
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3. Enter values in the parameter fields applicable to the new material and activate each
applicable operation box.

We strongly recommend adding text in the Description field to indicate why this record is
significant to your site. The text should indicate what the record does and/or its purpose.

4. Click APPLY to save your input or CLOSE to exit the window without saving.

Edit a Material
To change any of the characteristics for a material, refer to Edit a Library Record (pg 5.2).

Delete a Material
To delete one or more materials from the material library, refer to Delete a Library Record

(Pg 5.2).
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Material Defaults Library

The material defaults library is the repository for the most commonly used material parameter
values. The default value for basically everything — needle size, valve speed, head type, etc.

— can be set here for each head position. The predefined values provided for you can be
changed to meet your needs.

NOTE: New records cannot be added to the material defaults library, nor can any of its
existing records be deleted. New material records must be added in the materials library.

When a particular value affects most of your materials, enter it in the materials default library.
For example, if your programs use primarily solder paste and adhesive materials and almost
always use the solder paste in head mount position 1 and the adhesive in head mount position
2, we recommend setting up these defaults in the material defaults library.

The values in the material defaults library are the default values for the materials library which,
in turn, contains the defaults for the Mounts window. This default hierarchy lends itself to an
efficient programming strategy:

+ Enter the most commonly used material parameter values in the material defaults
library,

» Enter values affecting only a particular material in the Materials Library (pg 5.7), and

» Enter values that affect only a specific program in the MOUNT (pg 3.70) window.

The material defaults library is represented by the Mounts/Material Editor - DEFAULTS

window.
DEFAULTS Vadve Seltings
Auger
Maseriat Description etfo.00 1 -
kaurt = 8 - Auger
L [[2_=] raneiselection Valves ReTfo 006 |4
Auger R
Beverse 0,005 = 4
Makerial NONE
hicroValve 0 stepe -
. Reverse | © "F
Group Blinimum
| Shut-off | -0 5 4
Colar]| Neadle 25 | = SnapOfZ|0.00 s | 4
- Finch
ValverTaal NONE |  Gantya -] Delay -7 ¢ 4
Micro Valve "y
Description M:nir‘:u oo M
. = o e -
‘ Acceleration | U <t S
Pre SnapCd .
i Delay 0,000 £ 4
Post Delay|0.000 s o
Pattern Name NONE Snap 0 ————
e \f:lgcny[ﬁ'""m Y
i | o Clean: Snap OF [ N
Acceleration | 10000 w4
1 Manual Calibetion 3 1 Skip Calibration
Feature ID Inspect Delay | 2,000 ¢
Close Apply Delata| 7| Copy

Clicking the Material button in this window opens a list of existing materials from which you
can make a selection. Only the operations and parameters that apply to the selected record
will be active and available for modification; those that are not applicable to the currently
selected record will appear faded.
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Edit a Material Parameter Default
To change any of the characteristics for a material default record, refer to Edit a Library
Record (pg 5.2) or refer to the following example.

5/18/18

IMPORTANT: The default value for basically everything — needle size, valve speed, head

type, etc. — can be set in the Material Defaults library for each head position with Mount Posi-
tion 6 acting as a default master for the material library, HOWEVER, the default values are only
used if the values in Valve/Tool Editor (pg 5.105) AND the Materials Library (pg 5.7) are set to
default (the default buttons are blue).

For Example - Changing Needle Size Default

The default size for valve needles can be changed to the most commonly used size. Poten-
tially, this saves the user from having to change the needle size every time a material is
selected.

To change the default needle size for a material:

1. From the Program Editor menu bar, click Libraries > Material Defaults. This action opens
the window for the Material Defaults Library (pg 5.9).

2. Select desired material by clicking MATERIAL, selecting a material from the list that dis-
plays, and then clicking ACCEPT.

3. Define the desired default needle size for each mount position:

a.

b.
c.
d.

Define the new needle size by clicking NEEDLE, selecting a size from the list that dis-
plays, and then clicking ACCEPT.

Click APPLY to save the change.

Select the next available MOUNT POSITION.

Repeat the steps above to update each available mount position with the new needle
size.

SUGGESTION: Change the default for each available mount positions (1 through 6)
to avoid future confusion.

4. Click CLOSE to exit the window.
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Needles Library

The needle library contains a set of predefined needle records. You may select existing needle
records or create and add new needle records to the needle library.

Any needle characteristic can be modified. Needle record additions and modifications can be
made at any time by accessing the Needle Editor either directly through the Program Editor or
indirectly through the materials or material defaults libraries (Mounts/Material Editor windows).

Needie |0 —3 Needein| 25 S| e s Needle Style
Type of Tip L TipeoiTe  Flat  —| Gmge|= Heedelewgn| 270w +—— Neadle Length
Dametr | 0.51 s Diameter| 0,25 w —— Needle Gauge
Outside I o I o : ]
Diameter P | Inside Diameter
~—— Description

Add a Needle
To add a new needle record to the needle library:

1. Open the Program Editor and click on Libraries > Needle. The Needle Editor displays.
(You may also access the Needle Editor from either the Materials or Material Defaults
libraries.)

2. Enter a name or number for Needle ID.

Make a selection from the drop down menus that appear when you click on the Needle
Style and Type of Tip buttons.

4. Enter values in the Gauge, Outside Diameter, and Inside Diameter fields.
If desired, type text in the Description box.

6. Click APPLY to save your input or CLOSE to exit the window without saving.

Edit a Needle
To change needle characteristics in a needle record, refer to Edit a Library Record (pg 5.2).

Delete a Needle
To delete one or more needle records, refer to Delete a Library Record (pg 5.2).
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Part Numbers Library

FLOware software part numbers are cross references that correlate a user’s pick-and-place
part numbers with dispenser operation types. These cross reference records are generally
created in bulk when converting pick-and-place data into dispenser import format by means of
a conversion program or by importing a cross reference table from a spreadsheet platform. On
the other hand, to create, edit, or delete an individual cross reference, use the Part Number
Editor.

If part number-to-operation type equivalence is needed, use the Part Number Editor to define
cross reference records or change the shape associated with an existing cross reference
record. From the Part Number Editor you can select an existing part number from a list and
change or delete it. You may also define a new part number, automatically adding the new
number to the list of part numbers.

For detailed descriptions of the elements used in the Part Number Editor window, refer to Part
Number Editor (pg 5.77).

| Part Number

Past Number | BMICORITXTRIS4MIZ "fﬁ Part Number

; Select button
Egucalert Shape ABR C2

Deserigton Des::ription

L —
|
- Delete button

i Delete
i Close Deaka —
| J =1 Select button

Add a Part Number
To create a new cross reference between a part number and a shape:

Open the Program Editor.

Click on Libraries > Part Numbers. The Part Number Editor displays.

Type a part number in the Part Number field.

Click on the Equivalent Shape button.

Select a shape from the Select a Shape window that displays and then click ACCEPT.
If desired, type text in the description field.

Click APPLY to save the entry and then click CLOSE to exit the window.

N o ok~ 0N =

Change a Part Number
To edit an existing part number, refer to Edit a Library Record (pg 5.2).

Delete a Part Number
To delete one or more part numbers, refer to Delete a Library Record (pg 5.2).
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Passwords & Access Rights Library

Access to various system features is controlled by unique, user-defined passwords that
protect unauthorized use of the access rights assigned to a user name. Use the Password
Editor to add or delete a user name, change the password for a user name, or change the
access rights assigned to a user name.

All available access rights are displayed on the Password Editor window. Any combination of
access rights can be assigned to any user name.

Whenever the dispenser is powered on, the default password in effect allows minimal access
(at the Operator level) to the system.

[ e e user Name List

Enter a Password
To enter a password:

1.

2. Enter a password and click OK.

Clear a Password

Ler Mame Arcess Rights _____._--—'—"'__._________.--—_"'_r- » User Name
Hactor _____q_____...-—*"" ——er|
Tl | perator -+ Password
"
Payaanrd | S ..1-"'";
Opermiional Areess
W Fead | Lhwe siefust
W Bu - Save Sudistmests
1 Aaclup _l Temach Vision PeBemis
I Restore Hackups nazpll Sotware Lindares L Arcess ng hits
1 SaVE Pragrams Purge Menagemest |
1 gty Librasies - Seie Classes
Syeteme Ao
1 Corlbrphe 1 FvatEm
I I:::rﬂ;u’ntlnn I Chande FAsS~TS
0K Apply Dhinlestar Help

From the main menu bar, click on Operations > Enter Password.

To cancel the current password and return the system to the operator access level, go to the
main menu bar and click on Operations > Clear Password.
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Change a Password
To change the password for a user name:

From the main menu bar, click Operations > Enter Password.

Change to a user name with access to the Change Passwords access right.
Open the Program Editor.

Click Libraries > Password. The Password Editor displays.

Select the desired User Name from the User Name list.

Click on the Password field.

Type a new password over the existing entry.

Click APPLY.

Click OK.

© © N o g~ 0w DN =

Add a User Name
To add a user name:

From the main menu bar, click Operations > Enter Password.

Change to a user name with access to the Change Passwords access right.

Open the Program Editor.

Click Libraries > Password. The Password Editor displays.

Type a new user name over the existing entry in the Name field.

Type a password over the existing entry in the Password field.

Click on each access right in the Access Rights panel pertinent to the new user name.
Click APPLY. The new user name will display in the User Name list.

Click OK.

© © N o g~ 0w DN =

Delete a User Name
To delete a user name:

From the main menu bar, click Operations > Enter Password.

Change to a user name with access to the Change Passwords access right.
Open the Program Editor.

Click on Libraries > Password. The Password Editor displays.

Select the desired User Name from the User Name list.

Click DELETE. The selected user name disappears from the User Name list.
Click OK.

N o ok~ DN =
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Change an Access Right
To change the access rights for a user name:

From the main menu bar, click Operations > Enter Password.

Change to a user name with access to the Change Passwords access right.

Open the Program Editor.

Click on Libraries > Password. The Password Editor displays.

Select the desired User Name from the User Name list.

Click each access right in the Access Rights panel pertinent to the selected user name.
Click APPLY.

Click OK.

© N o g A~ 0w DN =
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Patterns Library

Patterns are used to define fiducials and bad marks on dispensers equipped with automatic
vision. The pattern provides the automatic vision system with the parameters necessary to
locate a product-related image during pattern recognition and adjust for product orientation.
When a program run encounters pattern recognition requirements, the system software
searches for the pattern you select.

The user can teach, delete, or select and modify a pattern and store the results in the patterns
library for later use. Open teaching, along with unlimited image storage, allows the user to
customize any image for use as a pattern. The patterns library also contains a set of
predefined pattern records and associated information from the vision system.

E[im-ﬁl I_II,I'I ml '&_ Dalault <]  Canveral = |

Pattarn Mame Light Color  Camera

LT

%H

§|:. i‘I;

|4

L View

-

Pattern
L= Window

—

Fininr Joy Spevd [T L Im L T ] e e

Tran|  Tew|  Bew|  Duply|  Debeis| | Fo|

" ]

Restrictions
The following restrictions apply to the patterns library and Pattern Trainer window.

5/18/18

The patterns library is only accessible via the Pattern Trainer window when the dispenser
is configured for the Automatic Vision Alignment System option and the correct password
has been entered.

Pattern parameters are dependent on current conditions, search results, and desired
search speed. Therefore, adjusting camera alignment or lighting can affect existing pro-
gram patterns and may require changes be made to the patterns to accommodate the
hardware or condition changes.

When a manual camera (Optem Lens) is present, changing the zoom value can adversely
affect program results. Changing the zoom setting changes camera position in the Z axis.
It is suggested that you either use the same zoom setting throughout a program or delays
will result from the additional camera calibration operations.

The NONE pattern is protected and cannot be modified.
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*  SAVE vs. TRAINER buttons: The SAVE button may be used if the only changes made are
to the position of the Confusion Threshold and Acceptance Threshold sliders. If any addi-
tional pattern parameters are modified, you must click the TRAIN button instead.

» Only the sliders and buttons applicable to the selected Pattern will be active; those that do
not apply to the currently selected pattern will appear faded.

Select a Pattern
To select a pattern:

1. From the Program Editor menu bar, click on Libraries > Patterns. Pattern Trainer displays.

2. Either type a name in the Pattern Name field or select an existing pattern similar to the one
you want to create by clicking the button W next to the Pattern Name field and typing the
new name in the Pattern Name field.

NOTE: When teaching a new pattern, you must enter an original name.

Edit a Pattern
To change parameters for a pattern, refer to Edit a Library Record (pg 5.2).

Delete a Pattern
A pattern cannot be deleted if it is used anywhere in the control software.

To delete a pattern from the pattern library, refer to Delete a Library Record (pg 5.2).

Teach a Pattern
For details on how to teach a pattern, refer to Teaching a Pattern (pg 3.61).
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SubTypes Library

Subtypes define extensions of operations (shape primitives); that is, a subtype alters the
meaning of an operation. Subtypes are most commonly used to operate and test a specific I/O
(input/output) or to modify an operation.

CAUTION Care must be taken if subtypes are moved from one machine to another since sub-
types relate to both the hardware and software.

ATTENTION VORSICHT! ATTENZIONE PRECAUCION
Faire attention si les Vorsicht beim Prestare attenzione

Precaucién al mover

A unique set of subtypes is associated with each operation type. For example, the subtypes
Fixed and Optimize relate to the Partition operation; subtypes Circular, XMajor, XStagger,
YMajor, and YStagger relate to the Dot operation.

A subtype code is the key to each subtype. Subtypes without a valid subtype code are ignored
by the system. You may add and modify subtypes but not subtype codes. Some subtypes are
available for all machines and some apply only to unique features on a specific machine.

Operation ——————» Doerwion | OFERATE |
SubType Name —— SusType [ER0G PAUSE | SuTpe coce 10

SubType Code -

Pause for cpsrator action

Message Type ————————eep  Wessage Type  Dafault

Set (A3 O Mt Lisad = | S 110 Om Mot U -
Test b0 04 Mok LUsed = I Tt 1K0On Mok Usad -
St [45 O Mat Lisad =] St [0 O Mt Lsad =

Pattern ———————s Paiem| |

Pme| | Do)

The following references are available for further information about subtype codes and
operation types:

« Subtype codes are defined and correlated with operation types in the Subtype section of
the Import/Export Data Reference Guide.

*  Operation types are explained in Operations (pg 3.85).

+ Additional detail about each operation type is available from Operations (Primitives)
(pg 5.108).

Modify an Operation with a SubType

5/18/18

A subtype can be used to modify an operation. For example, rather than define a rectangle
operation by a corner, a subtype can be used to define a rectangle operation by its center.

Another application for subtypes is to create multiple subtypes that function the same but are
performed at different points in a program. Synonyms of a subtype can be created by using
the same subtype code and changing one or more of the variables associated with it: the
SubType name, Message, and/or Pattern.
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For instance, an existing subtype that pauses an operation to wait for an operator action and
displays a message can be used to create numerous other subtypes that also pause and wait
but display a different message. You need only modify the SubType name and Message Type.

In order to work properly, some subtypes may need specific detail parameters entered in the

program detail. For example, all blob conditions should be entered when a blob test subtype is
to be used. Examine the non-faded fields displayed in the Operate panel of the Program Detail
window and determine which fields require a value to be entered.

Operate or Test an /O with a SubType

5/18/18

Operating or testing a specific I/O (input/output) most commonly requires the use of a 3 in the
Subtype Code field. Using 3 allows you to change the state of an 1/O, test the condition of a
different 1/0, and then return the original I/O to its original state.

A pair of 1/0 control buttons, each with a drop down menu, is available for each stage of I/O
operation testing: start, test, and end.
o seeerew 0 |
Dperation  OPERATE |
SubiType | Bwls Tust L] T Code| 3 w—d— SubType Code
Deescription

Copesns wsai b shaop i aned Lest auit sensor]

Message Type  Default = |

Sat L0 -Od Hustl U] - St VO On Work Area 031 - | J_ Start operation IOs
IO controls Tem VO OF Work e 0 ~ | TesiOn  Metleed <1 | Test operation I/Os
Setl00f [ WorkArea b0l =]  Smso0n _ Meatssd  -| |- End operation 1i0s

Panin

Duse|  Aptr|  Doles|

When testing an 1/O, you may also use

the Program Detail window fields of -

Retries?and Operation Time in Q L.E..l @ [;] -
conjunction with each other to maximize s s pess
the number of retries and minimize the % GFERATE | vewTeds [ MiemBer | * E;';'lgir.am
amount of time that passes before the | FhomE | Feeieecion  Operate o windaw
operation continues after either passing . ] [Findtine
or failing the test. -

For a focus on function, enter the

number of retries you want in Retries @ o in R4 — Retries
and then enter an Operation Time value _ Sl
that accommodates that number of i .
retries. g — )
When focusing on optimization, set the woh| 5w x| s
Operate Time to a small value and then weak| S *
enter a number of retries in Retries that A il -
minimizes the amount of time the system w00 cosin | = — Operation
will have to wait for test failure to occur.  “wer  cumen o= Time
rafure 10
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Add a SubType

You may either create a new subtype from the starting point or by editing a similar, existing
subtype.

To add a new subtype:

1. Open the Program Editor and click on Libraries > SubTypes. SubType Editor displays.

Qperation p OPERECN  OFERATE |
SubType | st rRce ravss |) /| SuType Gese 10 =——L— SubType Code
[lesrngman
rauss for oparater actien
Description ——
Messnge Type  Defaalt - | - Message Type
St 50 O Mok Usad - o ) On Bt Ulmaed - | ]_ Btaﬂ ope-ration ”Us
o contrals*li TEMUDOf _ MotUsed Testion  MstUsed -~ | | - Test operation I'0s
SV Of _ Nollsed = SetioOn _ WotUsed | | ]~ End operation iOs
Pattern ——-—--""_'JMI !

B =B B

2. Create a subtype record:

a. Click the Operation button, select an applicable operation from the drop down menu,
and click ACCEPT.

b. Type a label in the SubType field.

c. Enter avalue in SubType Code. Only valid entries allow a subtype to be saved. For a
listing of Operate subtype codes and their definitions, refer to SubType Editor
(pg 5.103).

d. Type text in the Description box identifying the purpose for this subtype.

If applicable, make a selection from the Message Type button drop down menu.

If applicable, make a selection from the drop down menu for each 1/O control button.
If applicable, click the Pattern button, select a pattern, and click ACCEPT.

Click APPLY to save your input or DONE to exit the window without saving.

Click DONE to exit the SubType Editor.

N o o ko
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Edit a SubType
To change parameters for a subtype:

1. Open the Program Editor and click on Libraries > SubTypes. SubType Editor displays.

2. Click the Operation button, select the operation associated with the subtype to be modi-
fied, and click ACCEPT.

3. Click the select button W by the SubType field, select the subtype you want to change,
and then click ACCEPT.

4. Make desired changes.
5. Click APPLY to save the changes or DONE to cancel.
6. Click DONE to exit the SubType Editor.

Delete a SubType
To delete a subtype from the subtype library:

1. Open the Program Editor and click on Libraries > SubTypes. SubTypes Editor displays.

2. From the Operation drop down menu, select the operation associated with the subtype to
be deleted.

3. Click the select button WF by the SubType field, select the subtype to be deleted, and then
click ACCEPT.

4. Click the DELETE button. To delete the subtype, click OK on the confirmation prompt that
displays, or click CANCEL to close the prompt without deleting.

5. Click DONE to exit the SubType Editor.
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Windows & Fields

The FLOware software windows are each dedicated to displaying specific types of infor-
mation. The purpose for each window is described in this section along with definitions for all
fields and controls contained within the window. Instructions on how to access each window
are also included.

+ Check/Set Base Locations (pg 5.23)
+ Dispenser Editor (pg 5.24)

« Data Converter (pg 5.25)

« Data Export (pg 5.26)

« Data Import (pg 5.28)

«  Enter Operator Instructions (pg 5.29)
+ Export (pg 5.30)

* Fiducials & Bad Marks (pg 5.33)

» File Selection (pg 5.34)

» Fixed Location Editor (pg 5.35)

* Import (pg 5.37)

* Interim Report Generation (pg 5.40)
+ loView (pg 5.42)

+ Jog (pg 5.44)

» Live Program Adjustment (pg 5.46)
» Live Video Parameters (pg 5.48)

+  Main Control (pg 5.49)

+  Material Expiration (pg 5.54)

+  Miscellaneous Program Settings (pg 5.55)
*  Mounts Table (pg 5.57)

*  Mounts/Material Editor (pg 5.59)

* Needle Editor (pg 5.66)

+ Offline Operations (pg 5.67)

*  Optimize Current Program (pg 5.69)
*  Option Settings (pg 5.70)

+  Part Number Editor (pg 5.77)

+ Password Editor (pg 5.78)

+ Pattern Trainer (pg 5.81)

»  Print Selected Program (pg 5.85)

*  Program Detail (pg 5.86)

*  Program Editor (pg 5.94)

+  Select List (pg 5.98)

» Set Pressure/Temperature (pg 5.99)
+ Set Shape Reference Point (pg 5.100)
+ SubBoard Editor (pg 5.101)

+ SubType Editor (pg 5.103)

+  Valve/Tool Editor (pg 5.105)

* View Notes (pg 5.107)
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Check/Set Base Locations

Scrodling list of
base locations

Toggle
controls

Instructions

Command
buttons

Check/Set Base Locations enables you to teach, verify, and modify base locations. It is used
to establish ALL base locations and positions around the work area used for automatic adjust-

ments, e.g., the purge and refresh operations.

TIP: To access Check/Set Base Locations, go to the main menu bar and click on Configu-

ration > Base Locations.
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Table 31: Check/Set Base Locations window

— Coordinates

Alignment
cross hairs

Element Description

scrolling list

Alphabetic listing of all available base locations.

toggle controls

5.

Down/Up toggle controls for the Touch Probe and Valve/Tool mount positions 1 through

instructions

Basic instructions for teaching a base location.

coordinates

erence point.

A display of current camera coordinates. These coordinates are relative to the active ref-

alignment cross hairs Guides for precise alignment.
XY, Z Teaches the XYZ coordinates.
Z ONLY Teaches the Z coordinate.
SAVE Saves changes made to this window.
DONE Exits this window.
MOVE CAMERA Moves the camera to the XY and Z location for the SafetyZ base location.
MOVE GANTRY Moves the gantry to the XY and Z location for the selected base location.
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Dispenser Editor

References

TIP: To access Dispenser Editor, go to the main menu bar and click on SHPCAL.
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Table 32: Dispenser Editor window

Element

Description

Selected Program

Displays name of currently selected program.

list of shapes

List of all available shapes for currently selected program. Any values saved in the Dis-
penser Editor window are applied to the highlighted shape.

Enable Calibration

default = not enabled

Enabled - If check box is enabled, the highlighted shape in the selected program
becomes a candidate for calibration. Calibration is performed and pump speed is
adjusted during execution of the shape.

Not enabled - If check box is not enabled, no calibration is performed and no adjust-
ment is made to pump speed.

Target Weight Value (mg) entered by user as the desired weight of the selected shape.
PCD The label and units for this field change depending on pump type.
MicroV Pump base speed used in shape. This value must match the Weight Time value
entered during material setup.
[Pump adjustment factor by which the calculated calibration factor may be adjusted.]
Pump Prime Amount of time the pump is primed prior to calibration.

Wt. Compensation

An independent adjustment factor by which the calculated calibration factor may be
adjusted. This is implemented as an offset to Target Weight.

Calibration Tolerance

Percentage of Target Weight by which the calibration may be imprecise and still con-
sidered allowable.

Example: An entry of 50% is stored as 50, not 0.5.

Calibration Factor

Scaling factor applied to pump speed at run time.

Compensated Factor

Amount of adjustment.

Measured Valve On Time

Total pump on time (s) for this shape. Total pump times are collected every time the
program runs, whether pump speeds are adjusted or not.

SAVE

Saves calibration factors to the currently displayed shapes.

CLOSE

Closes the window. Any changes not saved with the SAVE button will be lost.
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The data converter is used to import data from various external sources after converting it to a
specific format that meets dispenser requirements.

TIP: To access Data Converter, go to the main menu bar and click on Ultilities > Import/Export

> Convert.

Incoming

- Dupléc
Data Type |=’G'e“‘°'“c ’7_| Skip I Replace _IShapes

Source File I j
Component/Feeder |; ¥
File (optional) :

ale:

Convert | Exit |

Table 33: Data Converter window

Element

Description

Incoming Data Type

The type of machine (typically a pick-and-place unit) that produced the data.

Source File

Location of the main data.

Component/Feeder File

Defines the feeder location and the type of component that each feeder processes; used

only for some incoming data types.

Skip Ignores any duplicate programs/shapes.
Replace Replaces any old program/shape with the new duplicate.
Shapes Includes or excludes shapes from the conversion.
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Data Export
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SUGGESTION: Use the newer Export (pg 5.30) window rather than the Data Export window.

Use the Data Export window to export data to a new dispenser file, a network, or a floppy disk.

TIP: To open Data Export, go to the main menu bar and click on Utilities > Import/Export >

Export.
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Table 34: Data Export window

Element

Description

File

Allows exit from export; provides an alternate button to start the export.

Export File Name

The name and path of the export data file.

Format File Name

The name and path of the file that defines the format parameters under which the export
file will be exported.

Options

Any combination of options may be selected. To quickly select all options, click on Export
Everything. To export all fields, click on Export ALL FIELDS.

Program Defaults

Not valid for FLOware software versions 2.4 and above.
Provides the ultimate parameter values for Program Detail lines when there is no other
way to determine the values.

Needles

5/18/18

Inside and outside diameters, and other parameters for standard needle gauges.
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Table 34: Data Export window (Continued)

Element

Description

Material Defaults

Provides the ultimate parameter values for mounted values/tools when there is no other
way to determine the values.

Vision Patterns

Patterns from the vision system and associated information.

Locations Basic positions for each gantry.

Base Info Machine definition and summary information by gantry about the machine.
Sub Types Defines extension to shape primitives.

Mgmnt Info Detailed information by gantry about each machine run.

Cross Reference

Connects a shape with a part number by providing an OpType for known part numbers.

Fixed Locs Locations of pallets or other points around the work area but outside of the nest.
Notes A table of operator notes.

Error Log List of messages selected by message class.

Dot Sizes Not currently used. Diameter (mm) of desired dots.

Valves/Tools

Properties and defaults for various heads that may be mounted on the machine.

Universal Opts

General options independent of installed hardware.

Shapes

Shape name.

Programs

Dispenser program names.

Export Everything

Equivalent to clicking all of the above Options.

Export ALL FIELDS

Generates a new Format File (exform file) containing all fields for all options. A format file
exporting all fields will be created.

Programs/Shapes to
Export

A list of program/shape names to export if any of the following options are selected:
Shapes, Programs, Export Everything. Use Enter Program/Shape Name to enter pro-
gram/shape names here.

Delete Selection

Clears items from the Program/Shapes to Export panel.

Enter Program/Shape Enter the name of a program/shape to be selected either with the keyboard or by drag-

Name ging the name from some other list. Press ENTER to move the selection to the Program/
Shapes to Export panel. This process can be repeated for multiple program/shape
names.

EXPORT Executes the export of selected file(s).
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SUGGESTION: Use the newer Import (pg 5.37) window rather than the Data Import window.

Data Import provides the means for importing dispenser programs and operating information
from various external sources.

TIP: To access Data Import, go to the main menu bar and click on Utilities > Import/Export >

Import.
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Table 35: Data Import window

Element Description
File Opens drop-down menu with the choices of Do Import and Exit. Do Import imports the
selected data the same as the BEGIN IMPORT button does. Exit closes the Data Import
window.
File to Import The file (in dispenser format) to be imported.
... button Opens a file selection window for use in selecting the file to be imported.

Skip Duplicates

Replaces any old program/shape with the new updates.

DELETE SELECTION

Use to delete selected programs/shapes from the list panel.

Names

Limits the import to the programs/shapes shown in the list panel.

BEGIN IMPORT

Imports the selected data.
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Enter Operator Instructions

Text intended for display in the Operator Instructions panel of the Mounts Table for the
currently selected program can be entered, modified, and deleted using Enter Operator

Instructions.

TIP: To access Enter Operator Instructions, open Program Editor and click on OPERATOR
INSTRUCTIONS.

[

a

4|

Cancel| Delste|

Table 36: Enter Operator Instructions window

Element

Description
text panel Text entered here displays in the Operator Instructions panel of the Mounts Table for the
currently selected program.
OK Saves changes and exits this window.
CANCEL Exits this window without saving changes.
DELETE Deletes all displayed text.
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Use the Export window to export data to a new dispenser file, a network, or a floppy disk.

SUGGESTION: Beginning with FLOware software version 2.6, use the Export window instead
of the Data Export (pg 5.26) window. Export is faster, more flexible, and has more selection
options for expanded data export results.

TIP: To access Export, click on Utilities > New Export from the menu bar in the main window.
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Table 37: Export window
Element Description

Export File The name and path of the export data file.

Format File The name and path of the file that defines the format parameters under which the export
file will be exported.

Tree Not currently available.

Name Activates a list of names from which to choose.

All Exports everything in the file corresponding to the ALL button. For example, when the
ALL button (next to Programs) is activated, as shown above, all records in the programs
file are exported.

Shapes Properties for shapes located in the shapes library.

Materials Properties and defaults for materials located in the materials library.

Valves/Tools

Properties for various heads that may be mounted on the machine.

Vision Patterns

Patterns from the vision system and associated information.

Needles

Inside and outside diameters, and other parameters for standard needle gauges.

Cross Reference

Connects a shape with a part number by providing an OpType for known part numbers.

Programs
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Dispenser program names.
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Table 37: Export window (Continued)

Element

Description

Program Classes

Shape Classes

Vision Classes

Activating the NAME button for Program Classes, Shape Classes, and Vision Classes
will export the programs, shapes, and vision patterns for the class names selected in the
Class Filter window; i.e., the objects of the selected class names are exported.

Activating the ALL button for Program Classes, Shape Classes, and Vision Classes will
export the names of the classes selected in Class Filter.

Management Info

Detailed information by gantry about each machine run.

Operator Notes

A table of operator notes.

Material Defaults

Provides the ultimate parameter values for mounted valves/tools when there is no other
way to determine the values.

Fixed Locations

Locations of pallets or other points around the work area but outside of the nest.

Universal Options

General options independent of installed hardware.

Sub Types Defines extensions to shape primitives.
Error Log List of messages selected by message class.
Base Info Machine definition and summary information by gantry about the machine.

Base Locations

Basic positions for each gantry.

SELECT ALL TABLES Any combination of options may be selected. To quickly select all options, click on
SELECT ALL TABLES.

SELECT ALL TREES Not currently active.

RESET Resets the Export window to its default display of a single selection: ALL programs.

FORCE ALL FIELDS

Generates a new format file containing all fields for all options.

EXPORT Executes the export of selected file(s).
EDIT NAMES Invokes a window listing the names of all currently selected files for export.
DONE Exits the window.
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Internal Tables

An additional button, INTERNALS, is available only at the super user access level. The
Internals tear-off menu that displays when the INTERNALS button is clicked lets you make
multiple selections from other tables.
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These additional tables fall into the following basic categories:

Table 38: Export window - Internal Tables

Table Category
Passwords Provides the user with access to the export of all passwords.
Permanent Info Cannot be changed. Can be exported but not imported.

Auto increment

Calibration Semi-temporary data related to current process/setup.
Scratch

Retention

Transfer
Offline

Material Dots Not yet implemented.

Variations
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Used to teach the fiducials for a fixed location. Displays the current coordinates at which the

gantry is positioned.

TIP: To access Fiducials & Bad Marks, open Program Editor and click on Fixed Locations, and

then from the resulting Fixed Location Editor click the FIDUCIALS button.
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Table 39: Fiducials & Bad Marks window

Element Description
Fiducial n Current coordinates for designated fiducial.
X, Y
Bad Mark Current coordinates for designated bad mark.
X, Y
TEACH Teaches the X and Y coordinates for the fiducial or bad mark.
MOVE TO Moves the gantry IMMEDIATELY to the coordinates designated in the X and Y fields.
Pattern Name of a pattern, up to 24 characters long.
Used Indicates whether or not the associated pattern is used.
Window Not currently functional. Primarily used to prevent false positives by masking objects
similar to the pattern for which you are searching.
Used Not currently functional. Indicates whether or not the associated window is used.
XY Not currently functional. X, Y size of the search window.
TEACH Not currently functional. Teaches the window area (X, Y).
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File Selection

A file selection window serves to retrieve or send file data by providing a means to find a
particular file and its path.

TIP: There are numerous file selection windows; the window titles may vary.

Filter Filter
Directories
Directories Files
A log i ,
Bl JHLOog. ESt . Files
v/ . Hfonts CHresources ‘__..--""
r/backup .Hresources.b
r/tmp .dstrt
Jkshre
¢ |-licenses ]
et | __ Selection
Selection T
| /dos/d “~ | _ Filter button
oKk | Fitter | Cancel|

Table 40: File Selection window

Element Description

Filter Enter a partial path in this field to limit the directories (folders) and files displayed. Wild
cards may be used.

Directories Directory results of a filtered search are displayed here for selection.

Files File results of a filtered search are displayed here for selection.

Selection Upon clicking the OK button, the file and path displayed in the Selection field will be
entered in the file definition field of the window from whence you just came.

FILTER Refreshes the Directories panel to display only those directories included within the
scope of the path you typed in the Filter field.

5/18/18

FLOware Software Guide 5.34



GPD Global®

References

Fixed Location Editor

Use the Fixed Location Editor to define and edit fixed locations (locations fixed in accordance
with the work table like pallets and feeders).

TIP: To access Fixed Location Editor, open the Program Editor and click on Libraries > Fixed

Locations.
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Table 41: Fixed Location Editor window
Element Description

Name

Name of the fixed location. may be up to 12 alphanumeric characters long.

Location Number

Type code. The system automatically generates this code; it cannot be altered.

Gantry

Indicates the gantry used. Choices are gantry A, B, or C only or any gantry.

Description

Comment and description field of up to 250 characters. Text will print fully on printouts.
The 40 characters entered up to the first hard return entered will display on some win-
dow lists.

LOCATION SPECIFIC FIELDS

X The absolute coordinates (mm) for this location; the distance from work area origin.

Y

Start Z Start and end absolute Z coordinate for this location.

End Z

X Count Whole number of pallet elements in the X and Y directions.

Y Count

Angle Pallet (array) rotation for this location. When teaching with the Angle TEACH button, jog

to the pallet pickup point farthest along the X axis from the point already taught for the
X,Y coordinates.

Operate Time

5/18/18

Operate time (ms).
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Table 41: Fixed Location Editor window (Continued)

Element Description
X Space Distance (mm) between pallet entries in the X and Y directions.
Y Space
Operate Delay Delay (ms).
Change Time Time (ms) to wait for a new pallet before asking operator.

OPTION TOGGLE BUTTONS
Only a single option toggle button can be active at any one time.

No pallet Recycle without stopping when pallet run is done.

Request New Ask operator for a new pallet when pallet run is done.

Use I/O Use CHANGE 1/Os when pallet run is done.

Multi Loop Recycle across multi-pallets.

Multi Request Ask operator for a new multi-pallet when all pallet runs are done.
Multi Use I/O Use CHANGE 1/Os for a new multi-pallet when all pallets are done.

FEATURE FIELDS

Start Index Start and end pallet indices. Pallet starts at Start Index and ends when End Index is
End Index exceeded, regardless of X Count and Y Count.

Multi X Adjust Adjustment distances to move from one multi-pallet to the next.

Multi Y Adjust

Multi X Count The number of multi-pallets in the X and Y direction.

Multi Y Count

Multi Max Index Total number of multi-pallets for this pallet. This value is set internally.

Change Request Work area output number requesting a pallet change.

Changed Work area output acknowledging change of a pallet.

Change Acknowledge | Work area input acknowledging pallet change request.

Changed Flag Work area input indicating a pallet was changed.
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Data Import provides the means for importing dispenser programs and operating information
from various external sources.

SUGGESTION: Beginning with FLOware software version 2.6, use the Import window instead
of the Data Import (pg 5.28) window. Import is faster, more flexible, and has more selection
options for expanded data import results.

TIP: To access Import, click on Utilities > New Import from the menu bar in the main window.

i

Hame A8

L

W W

wr
W

i
P ¢

Select All Tables |

IMPORT SELECTION

Export File  dos/a/gpdprogs

Format Flle |hﬂ;fw1n

Mame All

Shapes v
hiaterialz
ValvesTools

Wision Patterns
MHeadles it
Cross Reference

b

bl

4+  Programs
w Program Classes
-+ 4Shape Classes

- Wislon Classes

Al
« hianagement Info

- Oparator MNotas
- haterial Drefaults
w Fied Locations

AN
wr SubTypes

- Error Lag
-+ Base Info

+~ Base Locations

Vi
L/

~ Uiniversal Options

_| Update Duplicate | Replace Duplicate
Auxiliary Records Programs & Shapes

Reset |

Edit-Mamnes

Import

|

Table 42: Import window

Element

Description

Export File

The name and path of the file created by the export program.

Format File

The name and path of the file that defines the format parameters under which the
exported file will be exported.

Name

Activates a list of names from which to choose.

All

Imports everything in the file corresponding to the ALL button. For example, when the
ALL button (next to Programs) is activated, as shown above, all records in the programs
file are imported.

Shapes

Properties for shapes located in the shapes library.

Materials

Properties and defaults for materials located in the materials library.

Valves/Tools

Properties for various heads that may be mounted on the machine.

Vision Patterns

Patterns from the vision system and associated information.

Needles

Inside and outside diameters, and other parameters for standard needle gauges.

Cross Reference

Connects a shape with a part number by providing an OpType for known part numbers.

Programs
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Dispenser program names.
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Table 42: Import window (Continued)

Element

Description

Program Classes

Shape Classes

Vision Classes

Activating the NAME button for Program Classes, Shape Classes, and Vision Classes
will import the programs, shapes, and vision patterns for the class names selected in the
Class Filter window; i.e., the objects of the selected class names are imported.

Activating the ALL button for Program Classes, Shape Classes, and Vision Classes will
import the names of the classes selected in Class Filter.

Management Info

Detailed information by gantry about each machine run.

Operator Notes

A table of operator notes.

Material Defaults

Provides the ultimate parameter values for mounted valves/tools when there is no other
way to determine the values.

Fixed Locations

Locations of pallets or other points around the work area but outside of the nest.

Universal Options

General options independent of installed hardware.

Sub Types Defines extensions to shape primitives.
Error Log List of messages selected by message class.
Base Info Machine definition and summary information by gantry about the machine.

Base Locations

Basic positions for each gantry.

SELECT ALL TABLES Any combination of options may be selected. To quickly select all options, click on
SELECT ALL TABLES.
RESET Resets the Import window to its default display of a single selection: ALL programs.

Update Duplicate
Auxiliary Records

Updates any existing records with new updated version. If this option is not selected,
duplicates will be ignored.

Replace Duplicate Pro-

grams & Shapes

Deletes and replaces existing programs/shapes with new updated version. If this option
is not selected, duplicates will be ignored.

IMPORT

Executes the import of selected file(s).

EDIT NAMES Invokes a window listing the names of all currently selected files for import.
DONE Exits the window.
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Internal Tables
An additional button, INTERNALS, is available only at the super user access level. The
Internals tear-off menu that displays when the INTERNALS button is clicked lets you make
multiple selections from other tables.
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These additional tables fall into the following basic categories:

Table 43: Import window - Internal Tables

References

Table Category
Passwords Provides the user with access to the import of all passwords.
Calibration
Scratch
Retention Semi-temporary data related to current process/setup.
Transfer
Offline

Material Dots

Variations

Not yet implemented.
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Interim Report Generation

Reports can be generated for each run of a process (when the job accounting feature is set to
collect the data) using the Interim Report Generation window.

This window is also used to purge the same information.

TIP: To access Interim Report Generation, go to the main menu bar and click on Utilities >
Management Info > Show Job Info.
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Table 44: Interim Report Generation window

Element

Description

Program Name

reporting

Enter the name of a single program for which a report is to be generated or
leave blank if the report is to include all programs as selected by other con-
ditions.

purging

Enter the name of a single program for which a data is to be deleted, or
leave blank if all programs selected by other conditions are to be deleted.

Operator Name

reporting

Enter the name of a single operator for which a report is to be generated or
leave blank if the report is to include all operators as selected by other con-
ditions.

purging

Enter the name of a single operator for which data is to be deleted, or
leave blank if data for all operators selected by other conditions are to be
deleted.

Report this many days
back

5/18/18

reporting

Limits report to a particular time frame. For example, to include only opera-
tions that occurred during the last ten days, enter 10 in this field. The other
alternative is to enter a zero in this field and include a date in the Earliest

date on report field.

purging

To delete data more than 10 days old, enter 10 in this field.
Alternatively, enter a zero in this field and include a date in the Earliest
date on report field.
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Table 44: Interim Report Generation window (Continued)

Element Description

Earliest date on report reporting Enter the earliest date for which data is to be reported; this option requires
a zero be entered in the Report this many days back field. If the Report
this many days back field is not zero, the Year, Month, and Day fields
are ignored.

purging Enter the earliest date for which data is NOT to be deleted. If Year, Month,
and Day are all blank, all available data will be deleted. If these fields are
not blank, these fields are ignored.

Print to Disk The report is placed on a floppy disk in printer format. The floppy disk must contain a
newly formatted disk before you click OK on the Interim Report Generation window. The
name acctpmt is assigned to the disk file.

Data to Disk The report is placed on a floppy disk in a format suitable for use with a spreadsheet. The
floppy disk drive must contain a newly formatted disk before you click OK on the Interim
Report Generation window. The name acctdata is assigned to the disk file.

Print to Printer The report is sent directly to an attached printer. A printer must be connected to the dis-
penser; otherwise, do not use this option.
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The IO Viewer is a tool to help determine if a device I/O (input or output) is wired properly and
receiving the correct voltage.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION

Le contenu de cette

WARNUNG

Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA

Domain
Machine
Class
MName
Table 45: loView window
Element Description
Domain
Used to operate the I/O system on a different, networked machine.
Machine
Class A term to define a type of data defining a collection of programs, shapes, or vision pat-
terns that share the same characteristics. A class of programs, shapes, or vision pat-
terns is typically selected for display.
Name The label assigned to each /O number.
Refresh I/O Information Loads I/Os for viewing in the loView window.
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Table 45: loView window (Continued)

Element Description
Load Extra I/0 Definitions Not currently used.
Local I/0O Only Not currently used.
Exit Closes the loView window.
Input How the selected 1/O is configured.
Output
In/Out Denoted as a dynamic I/O in configuration files.
On The current state of the selected I/O.
Off
Wide Value Displays the value of a pseudo /0.
speed sliders (located on 10 by Class window) change the rate of refresh display and the reaction
time between command and I/O response.

5/18/18 FLOware Software Guide 5.43



GPD Global®

Jog

References

Jog provides the means to manually move the X, Y, and Z axes of the gantry using the
trackball and keyboard in order to position the camera, teach program coordinates, align offset
points, and reposition the gantry when necessary.

Jog will automatically display during various procedures.

TIP: To manually open a Jog window, go to the main button bar and click JOG. The JOG
button is also available on other various windows.
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Table 46: Jog window

Element

Description

coordinates

A display of the current coordinates for the camera. These coordinates are relative to the
active reference point.

alignment cross hairs

Guides for precise alignment.

CAMERA LENS &

LIGHTING CONTROLS

Camera x

Camera location for this camera.

Camera Gain

Vision system gain; gain to how the vision system sees the camera image.

Camera Offset

Vision system offset; offset to how the vision system sees the camera image.

Zoom Focal length for programmable focus lens camera.
Focus Focus for programmable focus lens camera.
f-stop f-stop for programmable focus lens camera.
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Table 46: Jog window (Continued)

Element Description

Light Level Level of camera light intensity. Only functional when the dispenser is configured with a
programmable focus lens camera.

Light Color Controls the light color. Used to enhance the field of view when vision is affected by sur-
face colors or textures. Only functional when the dispenser is configured with a program-
mable focus lens camera.

Choices available are typically Red or Blue for a dispenser configured with the Intensity
Control option, or between Ring Light Diffuser and Diffuse On Axis Light for a dispenser
configured with the Multi-Axis lllumination option.

SLIDERS

Pointer Jog Speed

Changes the overall operating speed of the cursor.

Keyboard Jog Speed

Changes the overall operating speed of keyboard controls.
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Live Program Adjustment

Live Program Adjustment is a program development tool used during a program run to tempo-
rarily adjust machine parameters for a designated valve mount station. For details, refer to
Tweaks for Valves/Tools (pg 3.119).

TIP: To access Live Program Adjustment, go to the main button bar and click TWEAKS.
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Table 47: Live Program Adjustment window

Element

Description

Position

Mount station location of the valve/tool for which parameters are to be adjusted.

On Time

The total amount of time a valve is on to dispense, delay time, or any other time value
required to perform an operation.

Valve Steps

Number of steps (encoder counts) for a Micro-Dot valve to dispense a dot.

Valve Prime

The time it takes to start valve operation before reaching Start Z (the Z location where
dispensing or other operation takes place); this is used to prime a valve.

Start Z Pause

In-position delay between attaining Start Z position (the Z location where dispensing or
other operation takes place) and the start of any motion associated with the operation.

Start Z

Distance above the board where dispensing or other operation is to take place for this
feature; negative to drill into a drill pad.

Approach Velocity

Speed of the motion from Settle Z (where the gantry settles before the operation) to Start
Z (the Z location where dispensing or other operation takes place).

Snap Off Z

Distance to move the valve/tool up during the snap-off action to prevent tailing.

Settle Z
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Distance above Start Z (the Z location where dispensing or other operation takes place)
where the gantry settles before the move to Start Z.
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Table 47: Live Program Adjustment window (Continued)

Element

Description

Fill Spacing

Defines the spacing between successive lines of fill for filled features such as circles and
rectangles.

Dispense Velocity

Speed of any motion required during an operation. For example, Z velocity while building
a pillar, or coordinated motion velocity while drawing a line.

Valve Off The distance prior to the end of a fill at which the valve is turned off to prevent possible
material dribble at the end of the operation. When applying this only to the last line or cir-
cle of a fill, make sure the length of the last line/circle allows this.

End Z Distance above Start Z (the Z location where dispensing or other operation takes place)

for the operation to end. This value is non-zero to create pillars or to dispense along an
angle to the plane of the board.

Valve Reverse

The amount of time the valve motor is on in the reverse direction to perform suck-back
action for an LX Auger Valve.

DONE Exits this window.

SAVE Save changes made to this window.

LOAD Loads the tweak settings (the Adjustable Parameters in the Live Program Adjustments
window) that were previously saved.

RESET Sets all tweaks (the Adjustable Parameters in the Live Program Adjustments window) to

100%.
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Live Video Parameters

Used to align Cognex cross-hair generator with video capture.

References

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION

Le contenu de cette

WARNUNG

Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA

The standard settings for systems using a WinTV video capture card or an NVidea VGA card
are a Shift X Offset of 14 and a Shift Y Offset of 2. Settings differ for systems with the older

VideoMail VGA cards.

The system must be rebooted before changes take effect.

TIP: To access Live Video Parameters, go to the main button bar, click Calibration > Live

Video Paramters.

DANGER: Any change REQUIRES
A recalibrating dispenser
and all recipes.
— Videa Pasition
640
J Jo |
Pan Offset
14
L
Shift X Offset
1
T3
Shift Y Offset
— Colors —dppeararce Parameters
63 63
I = |/ |
Red Gain Hue
63 63
I = |/ |
GreenGain Saturation
63 63
J = |/ |
Blue Gain Contrast
i Misc. Controls | 63
_I Cross Hair | | i
Brightness
OK | Cancel
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Main Control

The main control window displays when the system is ready to run and is the site where all
user interaction with FLOware control software begins. Whether or not all menu bar and button
bar choices are displayed depends upon the current access rights. All choices are displayed

here.
Menu Bar
Button Bar
- Status
Fun Contrals _
Cyele
Info
Program Editor lcons
(Edit Shapes) Counters
{Edit Programs)
Calculator Clack
Refresh: Fffobot S EEE00Y (MLRE, AfifAuger
Go Home:  $#Robon AL B3 LT 07
Jog: ‘FahfEEhiRobor d;
Select: LFFRLAT .""“"""""" ______
Ru: ¥l 2= T
Pause: {5
cml: mm ........................
Prb U F s (O 1 )

Run Mode:  Continuous
Inspection Mode:  Run
Inspection Delay: 100

Speed During Opestiorss. 100

ot bl T O i et) LB i i
Vision Display: % ComveyorOfiSendMone: 58 (Loader/Unlonder (15 load #8)
Alarm Off: #E {0 ConmyorOlSenddlone; 118 (08 Faljlead P28
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Table 48: Main Control window

Element

Description

MENU BAR

Operations Displays a drop-down menu of basic operations such as entering/clearing the password,
shutting down the system, rebooting, exiting the main control window, and displaying the
icons that appear along the bottom edge of the main control window.

Utilities Displays a drop-down menu of utility functions such as backups, imports/exports, instal-

lation of software updates, data management, and add/view notes.

Machine Controls

Displays a drop-down menu of manual machine controls.

Calibration Displays a drop-down menu of calibration choices including conveyor speed, conveyor
width, work area surface mapping, and D2A/A2D boards.
Configuration Displays a drop-down menu of configuration choices. Of particular interest is the option

settings choice; the other choices are not intended for typical customer use.

System Function

Displays a drop-down menu of various system functions which are not intended for typi-
cal customer use.

Help

The About choice displays the title and version number of the resident control software.

BUTTON BAR

SELECT

Enables you to choose a program to run. The dispenser will always run the currently
selected program.

RESTART

Functions the same as RUN except none of the setup parameters are changed.

RESTART will not prompt for the lifter pins to be repositioned, and, if pallets or feeders
are being used, the program will continue where it left off without resetting the pallets or
feeders (whereas RUN will start the program at the beginning of the pallet or feeder).

RUN

Starts the currently selected program in the current program mode after prompting you to
calibrate the valves/tools and load the product.

If pallets and feeders are used by the program, they are reset.

PAUSE

Stops the current operation at a convenient place in the program; e.g., gantry motion
may not stop immediately after you click on PAUSE. This is a non-destructive command;
the system will not stop in the middle of a dispense of any kind. Operations may be
resumed when convenient with the RUN button.

CANCEL

Ends program execution. Once a program is canceled, it can only be restarted from the
beginning with the normal RUN procedure. Occasionally, a program will not abort imme-
diately as the current operation has to execute fully.

REFRESH

Moves the gantry to the front of the machine where valves/tools can be refreshed conve-
niently.

GO HOME

Moves the gantry out of the way, usually to the left rear corner of the machine.

JOG

Enables manual control of the camera/gantry position.

MOUNT
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Executes a substrate fixturing routine. MOUNT applies to both stand-alone and conveyor
systems.
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Table 48: Main Control window (Continued)

Element

Description

TWEAKS

Can be used during a run to adjust machine parameters per valve mount station. All
listed parameters can be changed by a percentage based on the original program.

RUN CONTROLS

Current Selected Program

Name of the program currently selected.

Run Mode

Determines how the currently selected program will execute.

Continuous Program execution continues without pause except for required operator intervention.
This is typically the normal production pattern.

Board Processes a subboard on a panel without pause, except for required operator interven-
tion, and then prompts the operator before the next panel. The operator can either con-
tinue with the next subboard or skip it.

Step Processes a single program step and then prompts the operator to continue.

Loop Processes the same board repeatedly without pause except for required operation inter-

vention. This is typically used as a demonstration or test mode.

Inspection Mode

Determines how the currently selected program will be processed, either full or in one of
various inspections modes.

Run Program will execute as designed.

Dry Run Same as Run except no valve/tool operation or material dispensing occurs and no move-
ment below the board surface (trace cutting) is made.

Inspect The camera, not the valves/tools, moves to the coordinates of each program line, provid-
ing a visual inspection of the program. The gantry pauses for a specified time at each
location to allow inspection. To adjust pause duration, use the Inspection Delay slider.

Full Inspect Same as Inspect except the camera fully traces all moves, lines, arcs, fills, and dot

arrays. To adjust the speed, use the Speed During Operations sliders.

Inspection Delay

The length of time the camera will wait over a coordinate.

Speed During Opera-
tions

The speed at which the camera moves over fills, lines, arcs, and moves during a Full
Inspect. This is a relative speed, either slower or faster than the current setting.

Operation States

Operation State toggle boxes enable/disable the stated control over the camera, alarm,
conveyor, printer, etc.

Vision Display Displays the camera image whenever the camera is located over a significant feature.

Alarm Off Prevents the audible alarm from operating.

Printer On Activate to use a printer attached to dispenser parallel port. Various other print controls
throughout the system (such as Print Scale Values) can be set to print and then globally
controlled here with Printer On.

Conveyor Off Turns on the conveyor belt briefly in order to seat a board against the nest stop pin.

Stand Alone Prevents SMEMA communication (the conveyor ignores upstream and downstream sig-
nals) and requires manual product placement and removal.

Pass Through Causes the conveyor to pass all product through the dispenser without processing.

Auto Program
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Enables a device outside the dispenser (such as a matrix reader) to scan information
(such as barcode) from incoming product and dictate various instructions to the dis-
penser (such as which program to run, the number of boards to run before the next pro-
gram, etc.).
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Table 48: Main Control window (Continued)

Element

Description

Reset Valves

Provides a quick reset of the servo-drive model of Micro-Dot valve as required after a
valve change and if the valve was not connected prior to power up. (More recent stepper
drive models do not require a reset.)

Dot Inspect

Not currently functional; it has no effect on anything in either the On or Off state.

STATUS

Current Operator

Displays the name of the current user.

Program Displays the name of the program currently processing.

Board When in Inspect Mode, the name of the board the program is currently processing dis-
plays here.

Shape When in Inspect Mode, the name of the shape the program is currently processing dis-
plays here.

Info Displays information when a process is waiting, such as loading a program, operating

in pass-through mode, or waiting to release the exit board. When in Inspect Mode,
the operation being executed displays.

Pending Operation

Displays the pending operation when a pallet is a fixed location and the pallet needs
changing.

Monitor Displays the number of boards the program has completed processing along with the
grams of pressure exerted by the pressure pick-up tool, if that tools is installed.
Material When the Material Expiration feature is enabled, the Monitor field is present and displays

either the time remaining for the current material or an indication that the material is
expired. If the feature is disabled, the Monitor field is not present.

CYCLE INFO

Tracks cyclic aspects of a program run. All fields reset to zero when a program run is initiated.

Board Count

Number of boards processed through the dispenser during the current program run.
When pallets are present, the complete board is counted, not individual pallets.

Avg Board Time

The average time per board spent executing program commands. The initial board typi-
cally takes longer to run due to the calibration process that occurs at the beginning of a
program run.

Avg Cycle Time

The average time per board to complete a cycle includes Avg Board Time plus all other
events that occur within the cycle such as pausing for operator intervention, waiting for
upstream/downstream equipment, etc.

Boards per Hour

Number of boards processed during an hour based on the value of Avg Board Time.

Elapsed Time

Time elapsed since the current program run began.

COUNTERS

Ctr 1
Ctr 2
Ctr3

5/18/18

Counter values display only during a program run when counters are used in the active
program.

Various types of counters are available for adding to a program as an OPERATE line
with a SubOp. Counters can increment or decrement, test one counter against another,
or test a counter against a fixed value.

Counters are numbered and can be assigned any number from 1 to 32,767. Any counter
assigned a number less than 100 always starts at zero (0) with a program run and disap-
pears when the program run ends. Any counter assigned a number of 100 or greater
always starts with the value the last program left it with and keeps its value in the data-
base.
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Table 48: Main Control window (Continued)

Element Description
ICONS
Calculator Display a fully operational calculator. This is a standard X-Windows feature.
Program Editor: One of two variation of the Program Editor icon can display on the main control window.
Edit Shapes Icon appearance is related to which selection tool is active in the Program Detail window.
Edit Programs Typically, only a single Program Editor icon is displayed at a time.
Clock Displays the system date and time.
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Material Expiration

The Material Expiration features allows setting a material start date/time and a pot life. When
the combined start time and pot life has expired, messages are displayed indicating the
material has expired.

TIP: To access Material Expiration, go to the main menu bar and click Operations > Material
Expiration.

=] Material Expiry

Material Expiry Setup
Enter Start Date/Time and Pot Life

T Gegin Date/Time |2018—05—09 o800 ‘|
B Putlie | soow L Matewbpiy |

C — 11— wamn Time I 30,00 min Material Expiry Satup
Enter Start DateTime and Pot Life

Expires: 20153-05-09 16:02
A Begin Date/Time

0+ |
Paot Life 13.00 hr
‘Warn Time | b8 man

| Ok | Cancel | |

atarial Expiration Dizablad

Table 49: Material Expiration window

A | Expiration Period | Must be in this form: YYYY-MM-DD HH:MM
Starting Date and Time | | the date/time is entered incorrectly, the dialog will display 'Malformed Date/Time' in

area E.

B | Pot Life Pot Life is entered in hours; this may include fractional hours, e.g. 4.25
Examples: 1.5 is 1% hours

C |Warn Time Warning Time is entered in minutes; this may include fractional minutes. The number of
minutes before expiration when the system begins persistent notification about material
expiring.

D |Active/lnactive Enables/Disables the entire material expiration feature. If disabled, no messages are
displayed.

E |Message Area Displays expiration date/time or 'Invalid Data' messages.

F | Set NOW Sets the Starting Date/Time to 'Now'.

G | Accepts current data | Current data becomes immediately active.

H | Cancels data entry Discards all changes.
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Miscellaneous Program Settings

When building a program, use the Miscellaneous Program Settings for various purposes: to
refine the translation between vision system pixels and XY gantry motion (millimeters/inches);
to control device temperature; to control board rotation relative to bad mark count; and to set
device pressure values.

TIP: To access Miscellaneous Program Settings, open the Program Editor, select the name of
the program you wish to modify, and then click on the MISC PROGRAM SETTINGS button.

Vision Calibration Temperatures Other
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Tuning | 0 r Range & F & Range — “
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_| Post-Heat Heater On o

{—stop | 0.000 % A Post-Heat IT .
Light li Temperature |
Level | 10 % “ Post-Heat
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B | FF -
i Light on Dark e
Post-Heat PID -
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Work Area
) Range RF "
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Done Apply I

Teach ol s |
Vision| | Jog I Work Area Heater On

Table 50: Miscellaneous Program Settings window

Element Description

VISION CALIBRATION

Gain Camera gain (0-255) for dispensed or drilled dot calibration. A value of -1 disables
change.

Offset Camera offset (0-255) for dispensed or drilled dot calibration. A value of -1 disables
change.

Tuning Camera tuning (1-1000) for dispensed or drilled dot calibration.

Zoom Focal length (0.0 to 1.0) for an auto focus camera for dispensed or drilled dot calibration.

Focus Focus (0.0 to 1.0) for an auto focus camera for dispensed or drilled dot calibration.

f-stop f-stop (0.0 to 1.0) for an auto focus camera for dispensed or drilled dot calibration.

Light Level Level of camera light intensity for dot calibration. Only functional when machine is config-
ured for the Multi-Axis lllumination option.
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Table 50: Miscellaneous Program Settings window (Continued)

Element

Description

Light on Dark

ON = enables camera to see light dot on dark background for dot calibration.
OFF = enables camera to see dark dot on light background for dot calibration.

Light Color

Controls the light color for dot calibration. used to enhance fiducial or pattern identifica-
tion when vision is affected by surface colors or textures.

Choose a color (typically Red or Blue) when the system is configured with the Intensity
Control option, OR

Choose a lighting configuration (typically Ring Light or Diffuse On Axis Light) when the
system is configured with the Multi-Axis lllumination option.

TEACH VISION

Changes the settings on this screen to match the settings to which the camera is set.

ADJUST VISION

Adjusts the camera to the settings defined on this screen.

JOG

Opens a Jog screen.

Max Pixel Count

Maximum pixel count for calibration dot.

Min Pixel Count

Minimum pixel count for calibration dot.

Dot Volume

Volume of dot for calibration dot.

TEMPERATURES

Not yet functional. Temperature control is currently handled with CAL 9900 hardware.

Pre-Heat Heater On

Activates or deactivates temperature control for the pre-heat station.

Pre-Heat Temperature

Temperatures (degrees C) at which the pre-heat station is to be maintained.

Pre-Heat Range

Temperature range (degrees C) plus or minus adjacent to the specified pre-heat tem-
perature.

Pre-Heat PID

Activates or deactivates PID control at the pre-heat station.

blank button

Select a PID name.

Post-Heat Heater On

Activates or deactivates temperature control for the post-heat station.

Post-Heat Temperature

Temperatures (degrees C) at which the post-heat station is to be maintained.

Post-Heat Range

Temperatures range (degrees C) plus or minus adjacent to the specified post-heat tem-
perature.

Post-Heat PID

Activates or deactivates PID control at the post-heat station.

blank button

Select a PID name.

Work Area Heater On

Activates or deactivates temperature control for the work area.

Work Area Temperature

Temperatures (degrees C) at which the work area is to be maintained.

Work Area Range

Temperatures range (degrees C) plus or minus adjacent to the specified work area tem-
perature.

Work Area PID

Activates or deactivates PID control at the work area.

blank button

Select a PID name.

OTHER
Bad Mark Count If the bad mark count is exceeded, a request to rotate the board is issued.
Post Press Pressure (grams) for post-press pressure.

Post Press Range

Range (grams) for post-press pressure.

Post Press Time

Time (sec) for post-press pressure.
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Early in a program run, the Mounts Table displays to indicate to the operator which valves/
tools, materials, and needles to install for the program being run.

TIP: Mounts Table displays when either the RUN or MOUNT buttons are activated from the
main button bar.

Y

-.}1:'! R35: Prepare and Mount ltems Specified.
Mot Air afifrraticn
Pozition Toml\iahe HMaterial Meedis Pressure Mﬂmﬂ e
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OPERATOR INSTRUCTIONS
-
J.r
Continue Abaort
Table 51: Mounts Table window
Element Description
Tool/Valve Displays the name of the valve/tool to be mounted in the designated Mount Position.
Material Displays the name of the material to be dispensed. Up to 32 characters long.
Needle Displays the name of the needle to be used.

Air Pressure

The value for the valve syringe air pressure may be entered here. Pressure is automati-
cally regulated via the system for the MicroMax models, however, the DS Series models
require manual adjustment.

Skip Calibration

Determines omission of all calibration for this valve/tool (All), omits calibration only for
the rigid needle standoff (StandOff), or omits calibration only at the scale (Scale). When
the stale calibration time value expires, calibration will be forced.

Lot #

Enter up to 18 characters for Lot # if your work site uses job accounting; otherwise, this
field defaults to a blank. To collect this entry, the Job Accounting function must be turned
on; otherwise, it is only retained in this window display.

Type

Category
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Enter up to 18 characters for Type # and/or Category if your work site uses job account-
ing; otherwise, these fields default to the last values used for this program. To collect
these entries, the Job Accounting function must be turned on; otherwise, entries are only
retained in this window display.

FLOware Software Guide 5.57



GPD Global® References

Table 51: Mounts Table window (Continued)

Element Description

Select Feature ID Variation | Not currently function. Indicates whether to use a particular collection of feature IDs.

Select Feature IDs Indicates whether to use feature IDs.

Use Tweaks Indicates whether to use tweak values (set in the Live Program Adjust window) in place
of the program values.

Operator Instructions The optional text entered in Program Editor displays here. Displays instructions for the
operator to see during the initial step of a program run.

CONTINE Saves changes and continues the program run.

ABORT Closes this window without saving changes and terminates the program run.
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Mounts/Material Editor

There are three different versions of the Mounts/Material Editor window, each with a different
purpose and a unique access path. Parameter definitions remain the same across all three
versions of the editor, although not all fields are active in all three windows.

*  Mounts/Material Editor - MOUNT is used to define head location and the type of material
at the program level. For details, refer to MOUNT (pg 3.70).

* Mounts/Material Editor - MATERIAL is the Materials Library (pg 5.7).

* Mounts/Material Editor - DEFAULTS is the Material Defaults Library (pg 5.9).

Details about the default hierarchy beyond the general concept shown in Figure 33 are
discussed in Mounts & Material Defaults (pg 3.93).

TIP: To open these windows, use the following guide:.

Table 52: Guide to Opening the Mounts/Material Editor Windows

v‘::::::_ of To Open the Window
MOUNT From Program Editor, select program, then click VALVE/TOOL MOUNTS button.
MATERIAL From Program Editor, click Libraries > Material.
DEFAULTS From Program Editor, click Libraries > Material Defaults.

Figure 33: General concept of default hierarchy for Mounts/Material Editors

root default level
library level

program level
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g
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Table 53: Mounts/Material Editor windows

Element

Description

MATERIAL DESCRIPTION

Mount Position

Mount location for this valve/tool. If this information is omitted, the first mount location is
automatically assigned.

Panel Selection

A pull down menu of choices, each of which will display a different set of fields in the
right-hand side of the window: Valves, Process Defaults, Warning Limits, Scale Parame-
ters, Temperatures, Calibration Dot, X-Y Calibration, and Observation.

For details, refer to the subsequent Panel Selection subsections in this table.

Material Name of the material to be dispensed. May be up to 32 characters long. If present, this
name must match the name of the material in the Materials library; if it does not match,
the program will be rejected.

Group Group of the material; copied from the Materials library. May be up to 32 characters long.

Color Color of the material; copied from the Materials library. May be up to 32 characters long.

Needle Gauge of the needle used with this valve.

Valve/Tool Name of the valve/tool to mount. May be up to 18 characters long. This name must
match the tool/valve name in the Heads library; if it does not match, the program will be
rejected.

Gantry Gantry identification code for use with multi-gantry systems.

Description Optional comment field of up to 250 characters.

Pattern Name

Name of the pattern used with this valve/tool. This name can be up to 24 characters
long.

Auto Clean

Activates or deactivates automatic needle cleaning at the material level, making the Auto
Clean setting the default in every program using the current material.

When Auto Clean is activated and the system is configured with a needle cleaner device,
a needle can be cleaned online automatically as part of a program run.

When Auto Clean is deactivated, the system will stop when appropriate and wait for the
operator to clean the needle before continuing with normal operations.

Manual Calibration

Activates or deactivates a forced manual calibration. When this field is deactivated, the
camera is not used to find the calibration dot; this is particularly useful for use with clear
materials.

Skip Calibration

Controls omission of all calibration for this valve/tool; enables/disables the ability to
choose calibration at the start of a program.

Feature ID

Not yet functional. Name of a feature, up to 12 characters long. This field is used to
describe the record as part of a discernible feature on the board.

Inspect Delay

Minimum time (ms) for operation during inspection.

COPY

The Copy button is only active for certain selectable panels and allows, for example,
copying data from the XY Calibration selectable panel to the Observation selectable
panel.

For the Mounts/Material Editor - MOUNT window, the Copy button allows copying the
entire controls panel from one mount location to another.

SELECTABLE PA

NEL - VALVE SETTINGS

Auger Speed

Percent of velocity for variable speed auger valve.

Auger Idle
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Total time delay; the time between turning off an auger valve and starting the reverse
suck-back action. This field will not display if the system is configured for a non-contact
jetting pump rather than an auger valve.
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Table 53: Mounts/Material Editor windows (Continued)

Element

Description

Auger Reverse

Total time the auger valve will run in reverse to suckback material. This only applies to
the LX Auger Valve and other valves with similar control. This field will not display if the
system is configured for a non-contact jetting pump.

NCM Close Time

Total time delay; the time between closing and opening a non-contact jetting pump. All
fields using the seconds measurement unit change to 4 place values (0.0000 rather than
0.000).

NCM Open Time

Total time the non-contact jetting pump will remain open. This only applies to the
NCM5000 pump and other pumps with similar control. All fields using the seconds mea-
surement unit change to 4 places values (0.0000 rather than 0.000).

Micro Valve Reverse

Number of Micro-Dot valve suckback steps.

Minimum Shut-off

Minimum time (ms) after dispenser stops and before valve shut off is activated.NCM

Snap Off Z Distance (mm) to move the valve/tool up during snap off action to prevent tailing.
Pinch Delay Delay (ms) before operating a pinch tube.
Micro Valve Speed Micro-Dot valve speed (encoder uses steps per second).

Micro Valve Acceleration

Micro-Dot valve acceleration/change of velocity.

Pre SnapOff Delay

Time (ms) to delay after dispense but before beginning snap off.

Post Delay

Post operation delay (ms).

Snap Off Velocity

Snap off velocity (mm/sec).

Snap Off Acceleration

Snap off acceleration/change of velocity.

SELECTABLE PA

NEL - PROCESS DEFAULTS

Air Pressure

Value in kPa for syringe air pressure. Pressure is automatically regulated via the system
for MicroMax dispenser, but requires manual adjustment for DS Series dispensers.

Air Control

Determines the way air pressure is handled.
Auto - Air pressure turns on/off as operations dictate.
On - If the machine is equipped with automatic air pressure control, the valve air
pressure is set to the value of Air Pressure at the start of a program.
Off - If the machine is equipped with manual air controls, the value in Air Pressure is
informational only - it is displayed for the operator who must make a manual adjust-
ment to set the air pressure.

Minimum Air Time

Minimum time (ms) to apply air pressure to the valve. This suppresses the constant on/
off pressure to the valve.

Purge Time

Time (ms) to operate the valve for automatic purge.

Standard Acceleration

Speed (mm/sec/sec) at which the gantry moves for any operation with an acceleration
value not otherwise specified.

Dispense Pressure

Force (gm) applied to MV valve during dispense.

Idle Pressure

Force (gm) applied to MV valve when idle.

SELECTABLE PA

NEL - WARNING LIMITS

Operation Limit

Counts dots; limit for the number of operations (dots to dispense) before the operator is
warned (at product change) to refresh the material or replace the drill bit. Implies that
material is low or drill has become dull.

On Time Limit Limit (ms) of total valve on time before operator is warned (at product change) to refresh
the material.

Idle Limit Limit (ms) of valve/tool idle time before operator is warned of needed material purge.
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Table 53: Mounts/Material Editor windows (Continued)

Element

Description

Run Time Limit

Limit (ms) of elapsed run time before operator is warned to refresh the material.

Re-calibrate Operation
Limit

Number of (program) operations after which a valve is recalibrated with the scale. Weight
calibration is repeated after this number of operations have run.

Re-calibrate Board Count

Limit for number of boards to process before repeating weight calibration.

Re-calibrate Time

Elapsed time (ms) after which a valve is recalibrated with the scale. Weight calibration is
repeated after this time has elapsed.

Limit Override

Number of boards allowed after low material has been sensed.

SELECTABLE PA

NEL - SCALE PARAMETERS

Weighing On Time

Time (ms) for valve operation to perform a weight calibration.

Target Weight for On Time

Amount (grams) of material expected from Weighing On Time.

Tolerance for Weight

Tolerance (grams) within which Target Weight for On Time will not change Weighing On
Time and Dispense Velocity (for 1 or 2 part valves) values.

Scale Settle Time

Time (ms) allowed for the scale to settle after dispensing.

Maximum Scale Adjust

Maximum percent of weight variation allowed before operator is notified.

Maximum Scale Retry

Maximum number of consecutive re-weighing (weight calibration retries) before opera-
tion notification.

Multiple Dot Count

Not currently functional. Maximum number of dots to dispense before repeating weight
calibration.

On Times from Program

Time (ms) obtained from the [uniquely defined] program.
On = obtains the On times from the first six active program lines.
Off = the On times will be used as they are entered.

Skip Weighing

Activates (Y) or deactivates (N) precision weighing for this valve/tool.

Scale Jog Z

Distance (mm) to jog above scale after dispensing.

SELECTABLE PA

NEL - TEMPERATURES

Material Temperature

Temperature (degrees C) at which the material (tube or reservoir) is to be maintained.

Material Temp Range

Temperature (degrees C) range plus or minus adjacent to the specified material tem-
perature.

Material Heater On

Determines whether or not the temperature control is used.

Material PID Name

PID name for material temperature control.

Needle Temperature

Temperature (degrees C) at which the needle is to be maintained.

Needle Temp Range

Temperature (degrees C) range plus or minus adjacent to the specified needle tempera-
ture.

Needle Heater On

Determines whether or not the needle temperature control is used.

Needle PID Name

PID name for needle temperature control.

SELECTABLE PA

NEL - CALIBRATION DOT PARAMETERS

On Time

Main control of dispensed volume; value of the total time (ms) a valve is on to dispense a
dot during calibration.

Approach Velocity
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The speed (mm/sec) at which the Z axis moves from Settle Z (where the gantry settles
before calibration) to Start Z (the Z location where dispensing or other operation takes
place) during the calibration.
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Table 53: Mounts/Material Editor windows (Continued)

Element Description
Valve Prime Time (ms) to start valve operation before reaching Start Z (the Z location where dispens-
ing or another operation takes place) during calibration; this is used to prime a valve prior
to reaching target.
Start Z Distance (mm) above the board where dispensing or other operation is to take place
during calibration; a negative value will drill into a drill pad.
SnapOff Z Height above Start Z to move the valve after a dispense is complete and during snap-off

action to prevent tailing.

Move Velocity

Speed (mm/sec) at which the system moves the gantry during calibration operations.

Dot on Chip

Indicates whether a material dot is to be placed on a chip rather than on paper.

Settle Z

Distance (mm) above Start Z (the Z location where dispensing or other operation takes
place) where the gantry settles before the move to Start Z.

Snap Off Velocity

Speed (mm/sec) at which snap off action occurs to prevent tailing.

Snap Off Acceleration

Acceleration (mm/sec/sec) of motion during snap off action to prevent tailing. Typically
faster than standard acceleration to emphasize snapping motion.

Post Delay

Delay time (ms) after the valve/tool has turned off and reach Snap Off Z (snap off height).
Used to assist in material-to-needle separation for stringy materials.

Micro Valve Steps

Number of encoder steps for a Micro-Dot valve to dispense a calibration dot.

Micro Valve Speed

The speed at which the Micro-Dot valve turns to dispense the calibration dot in cts/s.

Micro Valve Reverse

Number of reverse steps for a Micro-Dot valve to perform suckback action.

End Z

End Z distance for calibration dot.

Pre Snap Delay

Time (ms) to delay after dispense and before beginning snap off of calibration dot.

SELECTABLE PA

NEL - X-Y CALIBRATION

Gain

Camera gain (0-255) for dispensed or drilled dot calibration. A value of -1 disables
change.

Offset Camera offset (0-255) for dispensed or drilled dot calibration. A value of -1 disables
change.

Tuning Camera tuning (1-1000) for dispensed or drilled dot calibration.

Zoom Focal length (0.0 to 1.0) for a programmable focus lens camera for dispensed or drilled
dot calibration.

Focus Focus (0.0 to 1.0) for a programmable focus lens camera for dispensed or drilled dot cal-
ibration.

f-stop f-stop (0.0 to 1.0) for a programmable focus lens camera for dispensed or drilled dot cal-
ibration.

Light Level Level of camera light intensity for dot calibration. Only functional when machine is config-

ured for the Multi-Axis lllumination option.

Light on Dark

5/18/18

On - Enables camera to see light dot on dark background for dot calibration.
Off - Enables camera to see dark dot on light background for dot calibration.
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Table 53: Mounts/Material Editor windows (Continued)

Element

Description

Light Color

Controls the light color for dot calibration. Used to enhance fiducial or pattern identifica-
tion when vision is affected by surface colors or textures.

Choose a color (typically Red or Blue) when the system is configured with the Intensity
Control option.

OR

Choose a lighting configuration (typically Ring Light or Diffuse On Axis Light) when the
system is configured with the Multi-Axis lllumination option.

JOG

Opens a Jog window.

TEACH VISION

Adjusts the camera to the settings defined on this screen.

ADJUST VISION

Changes the settings on this screen to match the settings to which the camera is set.

Max Pixel Count

Maximum pixel count for dot calibration.

Min Pixel Count

Minimum pixel count for dot calibration.

Dot Volume

Volume of dot for dispensed dot calibration.

Backlight

On - Visually enhances the calibration dot for the camera. Turns off the camera light and
turns on the calibration station backlight while the camera is looking at the calibration
dot.

Off - Not used.

SELECTABLE PA

NEL - OBSERVATION

Gain Camera gain (0-255) for fiducial and dot inspection on the board. A value of -1 disables
change.

Offset Camera offset (0-255) for dot inspection on the board. A value of -1 disables change.

Tuning Camera tuning (1-1000) for dot inspection on the board.

Zoom Focal length (0.0 to 1.0) for a programmable focus camera for dot/fiducial inspection.

Focus Focus (0.0 to 1.0) for a programmable focus camera for dot inspection on the board.

f-stop f-stop (0.0 to 1.0) for a programmable focus camera for dot inspection on the board.

Light Level Level of camera light intensity for dot inspection. Only functional when machine is config-

ured for the Multi-Axis lllumination option.

Light on Dark

On - Enables camera to see light dot on dark background for dot inspection on the
board.
Off - Enables camera to see dark dot on light background for dot inspection on the
board.

Light Color

Controls the light color for dot inspection. Used to enhance fiducial or pattern identifica-
tion when vision is affected by surface colors or textures.

Choose a color (typically Red or Blue) when the system is configured with the Intensity
Control option.

OR

Choose a lighting configuration (typically Ring Light or Diffuse On Axis Light) when the
system is configured with the Multi-Axis lllumination option.

JOG

Opens a Jog window.

TEACH VISION

Adjusts the camera to the settings defined on this screen.

ADJUST VISION

Changes the settings on this screen to match the settings to which the camera is set.

Max Pixel Count
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Maximum pixel count for dot inspection.
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Table 53: Mounts/Material Editor windows (Continued)

Element Description
Min Pixel Count Minimum pixel count for dot inspection.
Dot Volume Volume of dot for dispensed dot inspection.
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Use the Needle Editor to define a needle or change the characteristics of an existing needle.

Clicking the button next to the Needle ID field opens the Select a Needle window from which
you can choose an existing needle. Alternately, if you define a new needle ID and click the
APPLY button, the new ID will be added to the list of needles.

TIP: To access Needle Editor, open the Program Editor and click on Libraries > Needle.

Needle |D ——& NeedielD | 25 Fieetle Stye Steel | Needle Style
Type of Tip —Ls Type o Tip Flat o] Gouge|z | Mesdielength| 1270w <—— Needle Length
e utsice Diameter | 0,51 we Inside Dinmeter | 0,25 as —— Needle Gauﬂe
Outside — " *
Diameter Description ™~ Inside Diameter
-—

—— Description

Apply Cloga Dialistas

Table 54: Needle Editor window

Element Description
Needle ID Name of the needle. May be up to 12 characters long.
Needle Style Drop down menu of needle styles (Steel, Plastic, One Piece, Tapered Plastic, Teflon
Lined, Vacuum Cup, and Flat Surface).
Type of Tip Drop down menu of needle tip styles (Flat, Conical, Round Tool, and Square Tool).

Gauge

Gauge of the needle.

Needle Length

Length (mm) of the needle.

Outside Diameter

Outside diameter (mm) of the needle.

Inside Diameter

Inside diameter (mm) of the needle.

Description Optional comment field of up to 250 characters. Text displays only in the Needle Editor
window but prints in full for printouts.

APPLY Applies and saves entries to the currently displayed needle ID.

CLOSE Closes the window. Any changes not saved with the APPLY button will be lost.

DELETE Deletes the currently displayed needle ID and removes it from the needle ID list.
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Offline Operations

When the dispenser is offline (not running a process), various operations may be performed
independently from the program using the Offline Operations window:

* purging a valve

* cleaning a needle

» filling a syringe

* weighing dispensed material

TIP: To access Offline Operations, go to the main menu bar and click Machine Controls >
Offline Operations.
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Table 55: Offline Operations window

Element

Description

Mount Position

Mount location for this valve/tool.

Suppress Calibration

Indicates whether calibration operations are to be suppressed.

Valve Dictates which valve will be used during the offline operation. May be up to 18 characters
long.

Material Name of the material dispensed during the offline operation. May be up to 32 characters
long.

Program Not currently functional. Program from which to obtain scale on-times for automatic entry

in the Weight On Time(s) fields.

Expected Weight

The weight expected from the given On Times.

Purge On Time

On Time for offline purging. If value is 0, purging is under operator control.

Syringe On Time

On Time for offline syringe filling. If value is 0O, filling is under operator control. (The
SyringeFill value must be set to true in the configuration options file for this field to be
functional.)

Weight On Time(s)

5/18/18

On Time(s) to weigh a dispensed shot offline.
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Table 55: Offline Operations window (Continued)

Element

Description

Weight On Times from
Program

Not currently functional. Indicates whether On Time(s) are obtained from the program
selected by the Program field.

WEIGH

Weighs Dispensed Material for a Specific On-Time Value - the scale is zeroed, the gantry
moves forward, the specified amount of material is dispensed and weighed, the needle is
cleaned, and the weighing results are displayed in a window.

PURGE

Purges the Needle - the gantry moves forward to the purge cup, the needle is purged,
and the needle is cleaned. Purging ends when the specified purge time has elapsed or
when, provided Purge On Time equals zero, the operator manually stops it by clicking
DONE on the Information prompt.

SYRINGE

Fills the Syringe - the gantry moves forward, the operator is prompted to mount a
syringe, the gantry moves to the syringe fill station and fills the syringe, and then the nee-
dle is cleaned. Syringe filling ends when the specified fill time has elapsed or when, pro-
vided Syringe On Time equals zero, the operator manually stops it.

CLEAN

Cleans the Needle - the gantry moves forward, the specified needle is cleaned at the
needle cleaner or prompts the operator to clean the needle, and then the gantry moves
to the safety location. This button is only functional if the dispenser is configured for nee-
dle cleaner hardware.
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Optimize Current Program

The Optimize feature reorganizes the current program to minimize execution time. Typically,
Optimize is used on programs originally optimized for pick-and-place machines. Optimize is
not intended for use on programs containing drawing-type operations such as move and arc.

TIP: To access Optimize Current Program, open the Program Editor and click on Utilities >

Optimize.

Choose optimization options
then click OK.
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Table 56: Optimize Current Program window

Element

Description

Point to Point

Optimizes the program to go from one location to the next closest point.

Fixed Divisions

Optimizes the program by dividing the board into sections. The user enters the desired
number of sections per board in the Number of Divisions field.

Floating Square

Optimizes the program by performing all program functions within a defined square area
before moving to a new square area to perform the functions required in it.

The order in which square areas are processed is determined by which new area is clos-
est to the ending point of the just completed area. In other words, after completing the
first square, the square closest to the last point of the first square is the one that is pro-
cessed next. This pattern continues until all squares are processed.

The user defines the size of the floating area in the Size of Square field.

5/18/18
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Option Settings

Use the Editor to define and edit fixed locations (locations fixed in accordance with the work
table like pallets and feeders).

Upon closing the Option Settings window by clicking OK, you will be prompted to reboot the
machine in order for changes to become effective. Clicking CANCEL will erase any changes
made making rebooting the machine unnecessary; the Reboot message will not display

TIP: To access Option Settings window, go to the main menu bar and click Configuration >
Option Settings.

General Calibration Operation Log Classes

Conveyor Options
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Table 57: Option Settings window

Element

Description

GENERAL

System Move Velocity

Velocity default = 400.0 mm/sec

Provides a default velocity for any dispenser gantry move (X,Y, and Z) not otherwise
defined. This does not normally need changing; slow moves can cause time-outs and
fast moves can cause gantry movement to be unpredictable.

X Probe Offset
Y Probe Offset

X Probe Offset default = 4 mm
Y Probe Offset default = -4 mm

The X and Y distances to offset an etch head from the center of the touch pad to cali-
brate the drill position. These values should be chosen so the probe touches the calibra-
tion station itself, entirely missing the touch pad. The default values are normally
sufficient; they seldom, if ever, need changing.

Low Z Limit

default = Off

If a board is missing, a surface sense may move the gantry Z axis low enough to dam-
age fixtures. If an appropriate Z coordinate is taught when teaching the Base Location for
the probe, this coordinate can be used as a lower limit for Z axis movement. Set this
parameter as On only after teaching such a coordinate.

Etch Clearance

default = 10.0 mm

Specifies the distance to lift the etch head above the board to prevent dragging. Smaller
values speed the use of the etch head but may cause unwanted contact with the board.

Touch Offset

default = 0.0 mm

If TouchOffset has a positive value, motion of the Z axis during touch-off is fast until the
probe is this distance above touch-pad elevation. If it is 0.0, motion during touch-off is
slow starting at the safety location.

Work Area Vac Delay

default =-1 ms

The work area vacuum delay determines how hold-down vacuum is handled on a
machine with no conveyor. It has a value of -1 to suppress use of work area vacuum;
otherwise, it is a delay introduced between operating the crowders and turning the vac-
uum on.

Test Temp Ready

default = Off

If this parameter is On, temperature ready signals are tested before every board and the
process is suspended until all temperatures are within range.

Always Load Mixer

default = On

If Always Load Mixer is On, the mixer valve is always reloaded whenever it is turned Off.
If it is Off, the valve is reloaded only when purging/filling and at the end of a board.

Time Interval Time interval to repeat dot size inspection (sec).

Max Chip Index Max Chip Index default = 1

Drill Spacing Drill Spacing default =5 mm
Applies to dispensing on a chip or drilling holes in a chip on the calibration station. Max
Chip Index is the number of dots to dispense or holes to drill. Drill Spacing is the distance
between dots or holes.
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Table 57: Option Settings window (Continued)

Element

Description

Paper Advances

default =1

Paper Advances is the number of steps the calibration station test paper is advanced
each time an advance is made. The value is normally 1, but if the dispensed material
spreads on the paper, several advances may be required to clear the paper area for the
next dispense.

CALIBRATION

Purge Interval when Idle

default =0 ms

Limit of tool/valve idle time before the operator is warned of needed material purge. If
this parameter is non-zero, the value is the time between purges when the dispenser is
idle.

Post-Purge Delay

default =0 ms

This parameter allows a delay after every purge to prevent dripping. (It is temporarily in
Options; it will be moved later to the Materials file.)

Type of Needle Cleaner
Cleaning Velocity
Cleaning Increment
Cleaning Count

5/18/18

Type of Needle Cleaner default = 0
Cleaning Velocity default = 0.0 mm/sec
Cleaning Increment default = 0.0 mm
Cleaning Count default = 0

Cleaning Velocity provides the velocity for movement through any automatic needle
cleaner. This value is set to 0.0 if the machine has no automatic cleaner.

Type of Needle Cleaner is set to one of the following:
* 0 if there is no needle cleaner present, or
* 1-5 equal to the number of points needed if the machine has a needle cleaner
requiring no operator intervention.
* 6 to suppress cleaning altogether.

Standard Needle Cleaner

Needle clean points 1-5 are usable for an automatic needle cleaner if the machine is so
equipped. If Type of Needle Cleaner equals 1, the first needle clean point alone is used
with a 2 inch move in the X direction; if 2 or greater, the required number of needle clean
points are used to define a path through the needle cleaner.

~ continued ~

FLOware Software Guide 5.72



GPD Global®

References

Table 57: Option Settings window (Continued)

Element

Description

Type of Needle Cleaner
Cleaning Velocity
Cleaning Increment
Cleaning Count

~ continued ~

Multiple Standard Needle Cleaners

If the machine is equipped with multiple standard needle cleaners, the value of Type of
Needle Cleaner is set to 21 or 22 where the value 21 indicates a single point used with a
2 inch move in the X direction and a value of 22 indicates the use of two points. In these
configurations, special location points 1 and 2 define the needle cleaner used for Head 1,
points 3 and 4 the cleaner used for Head 2, and points 5 and 6 the cleaner used for Head
3. Setting Type of Needle Cleaner to 6 will suppress cleaning.

Scale- Integrated or Clamp Cleaner
If the machine is equipped with a scale-integrated or clamp cleaner, values of Cleaning
Increment must be set to the increment between successive dispenses and Cleaning
Count to the maximum increments before operator intervention. In this case, needle
clean special location point 4 is the first dispense point of the integrated cleaner and nee-
dle clean point 5 is the withdrawal point above the last dispense point of the integrated
cleaner. Type of Needle Cleaner is set to one of the following:

* 6 to suppress cleaning altogether.

* 11 if a scale-mounted type of cleaner is present. Cleaning Increment and Cleaning

Count must be set.

* 17 if a clamp type of cleaner is present. Cleaning Increment and Cleaning Count

must be set.

* 21-22 if multiple cleaners are present.

Scale Pre-Settle

Scale Post-Settle
Scale Prime

Reset Scale when Cali-
brating

Scale Pre-Settle default = 0 sec

Scale Post-Settle default = 0 sec

Scale Prime default = Off

Reset Scale when Calibrating default = Off

Scale Pre-Settle is the amount of time to allow after moving to the scale before dispens-
ing.

Scale Post-Settle is the amount of time to allow after dispensing on the scale before
attempting to read the scale.

Scale Prime is On to dispense material to prime the valve before weighing.

Reset Scale when Calibrating is On to use no adjustments when weighing; if Off, each
weighing starts with the defined values rather than the adjusted values from prior weigh-
ings.

Cup Location Count

Number of divisions around the circumference of the purge cup.

Cup Radius

Radius of the purge cup.

OPERATION

Job Accounting

default = Off

Jog Accounting is set to On to record details about each job run. Information includes
start/end times, operator, valve/tools, materials, program name, etc. If this is set to Off,
no information is recorded.

Note that this data must eventually be purged to prevent too much accumulation or filling
the computer hard drive.

Log Retention

5/18/18

default=0

Number of days logging information is to be retained. The default value is 0, for which
logging data is retained indefinitely.
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Table 57: Option Settings window (Continued)

Element

Description

Time Between Backup
Prompts

Time Between Backup
Reminder

Time Between Backup Prompts default = 0
Time Between Backup Reminders default = 0

Time Between Backup Prompts is the number of days between scheduled backups. The
default value of 0 equates to a setting of Off.

Time Between Backup Reminders is the number of days between the display of
reminder windows when a backup is overdue. The default value of 0 equates to a setting
of Off.

Mapping On default = Off
Mapping On is Off to boot the system in normal operating mode. Set Mapping On to On
and reboot to use DScal to map a glass plate (the system must be shutdown and
restarted for Mapping On to take effect). A message at startup will state Modified Servo
call for Mapping. After mapping is complete, set Mapping On back to Off and reboot the
system for normal operation.
White Dot default = Off
This applies only to mapping with DScal, not to normal operations. Set White Dot to Off
to map with DScal if the dot on the glass plate is black on a white background; set White
Dot to On if the dot is white on a black background.
X Dots X Dots default = 35
Y Dots Y Dots default = 35
There are several sizes of glass plates used for mapping with DScal. On each plate, the
physical size of the glass is 1 inch larger in length and height than the area of dots since
the dots start 1/2 inch in from the edge on all sides. The software needs to know the
number of dots to be scanned, not where the edge of the glass is located. Therefore,
count the number of dots:
* For an 18” x 18” glass plate, X Dots=35, Y Dots=35
* For an 21” x 21” glass plate, X Dots=41, Y Dots=41
* For an 27" x 27" glass plate, X Dots=53, Y Dots=53
Map Area default = 15000

Number of pixels in the area of the dot on the glass plate. 15000 is the default value for a
standard lens. If a 2x or greater programmable lens is used, this value must be
increased.

Stale Calibration

default = 480 minutes

Provides an expiration time for head calibration. Even if calibration is suppressed, it will
be performed if the last calibration is not within this time limit. The default (480 minutes =
8 hours) forces recalibration for a new shift.

Calibration Window

default =5 mm

Provides the size of a window of acceptance (mm) when calibrating a dispense or etch
valve/tool. If the valve/tool must be moved outside this window to find the dot or hole, the
operator is prompted to confirm the extent of movement. Other than causing an extra
operator prompt, this has no effect on operation.

Bull’s Eye

5/18/18

default = 0 mm

Determines the size of the flashing Bull's Eye figure that displays in the center of the Jog
and Pattern Trainer windows. A zero value in this field turns off the Bull's Eye function. A
non-zero value in this field defines the diameter of the flashing figure. After the first cali-
bration at the dot on the calibration station, the flashing figure will display in the specified
size in either the Jog window or the Pattern Trainer window.
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Table 57: Option Settings window (Continued)

Element

Description

Bull's Eye Shape

default =1, 2, or 3

Determines which figure (a circle, cross, or rectangle) will represent the Bull's Eye. A
zero value in this field turns off the Bull's Eye display. The following values determine
which figure will display:

1 =circle

2 = cross

3 =rectangle

LOG CLASSES

Log Classes A-Z

default =0

Log Classes is a set of selections for logging messages. Every message has a class (A-
Z) associated with it. A message is logged and saved only if its class is selected in Log
Classes. Note that a blank class is never logged.

Air or safety problem.

Calibration errors (e.g., cannot find pattern).

Debug messages (should never appear).

Operator errors (e.g., bad password).

I m gl O »

Hardware failure (e.g., no serial communication).

Information to operator (e.g., homing).

Maintenance (e.g., refresh material).

New names.

Operator instructions (e.g., clean a needle).

Program errors (e.g., missing shape definition).

Results (e.g., material weight).

System errors (e.g., missing files).

User messages (user defined).

Where multiple selects or multiple deletes are allowed.

Nl X| C| »w - T Ol Z| =

Post-press device.

B,F,GJLQTYV,
W, Y

Unassigned. These log classes can be used to flag messages for which the user has
manually changed the class in the resource file.

CAL DOT SIZES

Cal Dot Sizes

These fields contain the true (mm) sizes of the three calibration dots: A, B, and C used
during Dot Inspection (pg 3.105).

CONVEYOR OPTI

ONS

Wait for Board
Wait for Release

5/18/18

Wait for Board default = 10 seconds
Wait for Release default = 10 seconds

These may be set to very high values on a continuous line to wait indefinitely for a board
transfer without an operator present.

Wait for Board is the time the machine will wait for a board from upstream before
requesting operator intervention.

Wait for Release is the time the machine will wait to release a board to downstream
before requesting operator intervention.
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Table 57: Option Settings window (Continued)

Element

Description

Enter Dwell
Exit Dwell

Enter Dwell default = 0 ms
Exit Dwell default = 0 ms

Some machines have heaters at the entry and exit stations. To heat the product properly,
a dwell is required at these stations. Set Enter Dwell and Exit Dwell to a default time
needed on such a machine. Note: These parameters are available to the program.

Board Transit
Slow Transit

Board Transit default = 100.0 ms/in
Slow Transit default = 100.0 ms/in

If these values are too low, the boards may not move to the stop pins before the con-
veyor stops. If these values are too high, premature time outs may occur, in some cases
trapping a board in transit with a stop pin. To calculate these values, refer to the Calibra-
tion Conveyor Speeds portion of the Periodic Operations - CALIBRATION section in the
Dispenser Service Guide.

Board Transit is the time for a board to move one inch when the conveyor is running at
high speed; i.e., it is the transit timing for a board.

Slow Transit is the equivalent when a two-speed conveyor is running at low speed.

Slow Sensors

default = Off

Slow Sensors is normally set to Off unless the conveyor has adjustable intermediate-
position sensors used to slow the conveyor to prevent movement of mounted parts when
the board is stopped at a stop pin. The value of this parameter is ignored if a conveyor
and/or sensors are not configured.

Auto Width default = On
Auto Width determines whether to use the automatic width adjust feature on a convey-
orized machine. It is normally On, but may be set to Off is there is no automatic width
adjust on the machine or if the width adjust is not operational.

Max Conveyor Adj default = 30000 ms

The maximum time required to adjust the conveyor width from minimum to maximum
size. Used to computer time-out and hang-ups when adjusting the conveyor width auto-
matically.

Conveyor Clearance

default = 1.0 mm

The clearance allowed for the board motion when adjusting conveyor width. For exam-
ple, if this value is 1 mm and the board is 150 mm wide, the conveyor is adjusted to 151
mm.

Conveyor Calibrate

default = 38.1 mm

The conveyor width at calibration, hence the minimum width allowed for conveyor width
adjustment. If board width is less than this value (normally 0 when board width is not
specified), manual adjustment is required. The default value is 1.5 inches, the width of
the standard gauge block.

Vacuum Release Delay

default = 50 ms

The time delay between turning lifter vacuum off and dropping the lifter. Increase this
delay if the board is pulled down when the lifter drops.
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Part Number Editor

Use the Part Number Editor to define individual cross reference records or change the shape
associated with an existing cross reference record. The part number is a cross reference
connecting a shape with a known part number.

Clicking the button next to the Part Number field opens the Select a Part Number window from
which you can choose an existing part number. Alternately, if you define a new part number
and click the APPLY button, the new part number will be added to the list of part numbers.

TIP: To access Part Number Editor, open the Program Editor and click on Libraries > Part
Numbers.

Part Mumber

Pt Mumnbiar | MOOSOTXTR 154012

Equivaient Shage ABRC2)
—

Equivalent

Cescripns Shape button

1 — Description

Bl = BE4/4

Table 58: Part Number Editor window

Element Description
Part Number A part number may be up to 36 characters long.
Equivalent Shapes Opens the Select a Shape window from which you can choose an existing shape.
Description Optional comment field of up to 250 characters. Content in this field usually comes from
pick-and-place data. Comments are only viewable in the Part Number Editor window but
print in full for printouts.

5/18/18 FLOware Software Guide 5.77



GPD Global®

References

Password Editor

Use the Password Editor to add or delete a user name, change the password for a user name,
or change the access rights assigned to a user name.

TIP: To access Password Editor, open the Program Editor and click on Libraries > Passwords.

User Mame List

—
| User Name
Passwaord
'_,..--"
W Rend - Live Adust
= Ryun -1 Save Adstments
- Backup - Teach Viskan Pattems
) Save Programs - Punge Management nfa
I Madify Libianies - Select Classes
© yriem Acevrz
) Crfibrabe -l Gystem
1 Cordguration J Change Passwords
Table 59: Password Editor window
Element

Description

User Name List

All user names currently set up on the system are listed here. Highlighting a user name
in the list displays the access rights currently assigned to that user name.

User Name A user name may consist of 24 alphanumeric characters and spaces are allowed. Any
user name can have any combination of access rights assigned to it. The user names of
Master and Operator cannot be deleted or renamed.

Password

Passwords are case sensitive and may consist of up to 12 alphanumeric characters.
Spaces are allowed.

A password is not revealed when typed; each character/space is displayed as a *. The
number of passwords you create is limited only by the capabilities of the hardware. No
entry in this field makes it equivalent to Operator, allowing anyone to log in.

Access Rights

Any combination of access rights can be assigned to any user name.

Changing access rights requires you to enter the appropriate password with the following
exceptions: when the machine defaults to Operator upon start up and when the current
access rights are cleared.

Refer to the following section, Access Right Descriptions, for further details.
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Access Right Descriptions

All available access rights are displayed on the Password Editor window. Any combination of
access rights can be assigned to any user name.

Access rights are grouped into two categories: operation and system. Operational access
rights are typically assigned to users who perform normal machine operations. Conversely, it
is suggested that system access rights be reserved for use by technical or engineering staff on
an as needed basis only.
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Table 60: Password Editor window - Access Rights

Access Right

Allows Access to:

OPERATIONAL ACCESS RIGHTS

Read Basic login access and use of Program Editor to examine programs/shapes and perhaps
other tables, but does not allow table modification without additional access.

Run Homing the machine and running (executing) any program.

Backup Backup and Export execution without special access passwords.

Restore Backups

Restoring backups, import execution without special access passwords.

Save Programs

Editing and saving programs and shapes; optimizing programs.

Modify Libraries

Editing and saving Heads, Materials, and other libraries.

Live Adjust

Program modification/tweaking for the current run only.

Save Adjustments

Savings programs modified by tweaking during the current run.

Teach Vision Patterns

Teaching or changing vision patterns for fiducials or other purposes.

Install Software Updates

Installing software updates.

Purge Management Info

Purging current job accounting data.

Select Classes

5/18/18

Class filter thereby allowing expansion and restriction of the program or shape names
that display during program selection and in the Program Editor.

FLOware Software Guide 5.79



GPD Global® References

Table 60: Password Editor window - Access Rights (Continued)

Access Right Allows Access to:

SYSTEM ACCESS RIGHTS

Calibrate Calibration of various hardware features.

Configuration Changing configuration tables, such as the 10 and Options tables. Custom Controls
modification, and other optimal configuration.

System Access to system features from the system pull-down menu.

Change Passwords Altering any and all passwords for anyone. This access right allows full access to the
system.

5/18/18 FLOware Software Guide 5.80



GPD Global®

Pattern Trainer
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Patterns are used to define fiducial shapes for use by the Automatic Vision Alignment System
during pattern recognition. Use the Pattern Trainer to create a pattern or change the charac-
teristics of an existing pattern.

NOTE: The patterns library is only accessible when the dispenser is configured for the
Automatic Vision Alignment System option (and the correct password has been entered).

TIP: To access Pattern Trainer, open the Program Editor and click on Libraries > Patterns.
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Table 61: Pattern Trainer window

Element

Description

Pattern Name

A pattern name may consist of up to 24 alphanumeric characters. A list of patterns auto-
matically displays in alphabetic order.

Clicking the selector button next to the Pattern Name field opens the Select a Pattern
window which displays a list of existing patterns from which you can choose. Alterna-
tively, if you define a new pattern name and click the SAVE button, the new name will be
added to the pattern list.

Class Not yet functional. Use to select a class of vision patterns for display. Text field of up to
12 alphanumeric characters containing any text.

Light Color Use to select a color and type of illumination to enhance pattern identification when
vision is affected by surface colors or textures. The choices available from the pull down
menu are dependant upon whether or not the applicable illumination hardware is
installed on your machine.

Camera # Number of the camera to be selected.
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Table 61: Pattern Trainer window (Continued)

Element Description
Pattern Window The Camera View panel contains a Pattern Window within which the pattern is defined.
Everything displayed inside the Pattern Window is considered to be the pattern being
taught.

The size and shape of the view encompassed by the Pattern Window can be enlarged or
reduced by using the horizontal and vertical sliders. When the Pattern Trainer first
opens, both of these threshold sliders will be set to values for the previously loaded pat-
tern.

Pattern Window
is resizable

Sliders Sliders

Note the suggested MAXIMUM sliders positions shown in the following illustration.

NOTE: DO NOT exceed the maximum limit for pixel size by tweaking the
sliders beyond their maximum positions; doing so will cause the vision
system to abort. Tweaking can occur indirectly as the sliders work together
- moving one also repositions the other one.

MAXIMUM slider positions

|

Bull's Eye The diameter of the Bull's Eye that flashes in the center of the Pattern Trainer window
can be resized by changing the value of the Bull's Eye field in the Option Settings win-
dow.

CAL CAMERA Optimizes camera display parameters for current conditions.
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Table 61: Pattern Trainer window (Continued)

Element Description

Camera Gain Value by which the video signal is amplified. Camera gain and camera offset work
together to condition the video signal.

Afamily
of gains

AVPLFICATION

SIGNAL

If, for images with low contrast, you choose to set values manually with the sliders
instead of automatically with the CAL CAMERA slider, note that inappropriate values
could cause amplification of signal noise and obliterate detail in the image.

Camera Offset Value added to the video signal before amplification. Camera gain and camera offset
work together to condition the video signal.

If, for images with low contrast, you choose to set values manually with the sliders
instead of automatically with the CAL CAMERA slider, note that inappropriate values
could cause amplification of signal noise and obliterate detail in the image.

Afarrily
of gains ,,
SIGNAL ' SIGNAL
Confusion Threshold Value is dependent upon the video scene being used during pattern training. Affects

search speed.

REQUIREMENT: This value must always be greater than or equal to
Acceptance Threshold.

High range - tends to decrease search speed, but a high value may be necessary to
ensure the correct feature is found. Use a higher value if the trained pattern will appear in
multiple locations within the video scene.

Low range - tends to increase search speed under certain conditions. Use a lower value
if the trained pattern is unique within the video scene.

Acceptance Threshold The acceptance threshold is the shape score that a feature must equal or exceed to be
considered found by the pattern window. Affects search speed.

High range - tends to decrease search speed at the risk of not finding the pattern being
searched for because it is different than the trained pattern (due to image degradation).

Low range - tends to decrease search speed and you risk finding a similar scene rather
than the one you really wanted.

Zoom Camera zoom value for the automatic camera.

Focus Camera focus value for the automatic camera.
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Table 61: Pattern Trainer window (Continued)

Element Description

f-Stop Not yet functional. Camera f-stop value for automatic camera.

Light Level Controls the intensity of the light illuminating the camera field. A specific light level can
be defined here to enhance pattern identification. This function is only available for
machines equipped with the llluminator Intensity Control option.

CLOSE Closes the Pattern Trainer window without saving any changes.

TRAIN Teaches pattern using the camera’s current view and criteria.

TEST Initiates a search for the pattern currently selected in the Pattern Name field.

SAVE Saves the currently selected pattern and all other search criteria.

DISPLAY/LIVE

DISPLAY - displays the currently defined pattern in the video area.
LIVE - switches the video area from the generated displayed view back to the live cam-
era view.

DELETE Deletes the currently selected pattern and removes it from the patterns list.
EDGE Not yet functional. Cognex codes.
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Print Selected Program

The print options in Print Selected Program allow you to print the currently selected program,
optionally reducing detail with the use of one or more filters.

TIP: To access Print Selected Program, open the Program Editor and click on File > Print.

[T Peduced Header Info

[ Reduced kaount Info

I Beduced Egard Info

[~ Feduced ProgranyShape Info

ok ] Cacl]

Table 62: Print Selected Program window

Element Description
Reduced Header Info Prints program with minimally identifiable header detail.
Reduced Mount Info Prints program with minimally identifiable mount detail.
Reduced Board Info Prints program with minimally identifiable subboard detail.
Reduced Program/Shape | Prints program with minimally identifiable program/shape detail.
Info
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Program Detail

Program Detail enables the user to establish or modify operation parameters of any line for the

5/18/18

currently selected program.

References

TIP: To access Program Detail, open the Program Editor and click on EDIT DETAIL LINES.
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Table 63: Program Detail window

Element Description
ICONS
Cut Cut one program line.
Copy Copy one program line.
Icons Use these icons to insert a primitive operation below the currently highlighted program

line. The set of icons represent primitive operations: Line, Dot, Move, Arc, Rectangle,
Circle, Calibrate, Delay, Operate, Partition, Shape, None, and Setup.

Click an icon to insert that primitive operation below the currently highlighted program
line. The ShList icon brings up a list of all currently available (non-class filtered) shapes.

PROGRAM LINE

Program Name of the currently selected program.
Gantry Gantry identification code.
Partition Partition/Shape name, up to 12 characters long. This usually appears only on a Partition

or Shape record and is allowed to default on subsequent records. Embedded shapes
use this field to define the shape name.

program lines

The partition lines and shape lines that make up the program.

PROGRAM LINE

DETAIL

Comment

Any text, up to 72 characters long, describing this line for documentation purposes. Typi-
cally used when converting pick-and-place data to dispenser input format.

Operation

Name of the operation to perform for the current program line. May be up to 12 charac-
ters long, and may be the name of one of the primitive operations (DOT, LINE, RECTAN-
GLE, etc.) or it may be the name of a shape. (The shape must exist before running a
program using the shape.)

Valve/Tool n

Dictates which head will be used during the operation for the current program line. May
be up to 18 characters long. This usually appears only for a Partition record. A head
must be selected for each program line or else it will default to NONE. (This name should
match the name of the valve/tool in the Mounts library; if it does not, the program will not
run.)

Part Number

Optional part number up to 36 characters long. This field is usually filled in when convert-
ing pick-&-place data to dispenser input format. Import uses this field to determine the
operation type from the cross reference library.

FIND LINE

Allows a specific program line to be found within the current program by jogging to the
physical location associated with the program line.

Sub Op

List of sub operations from which to select. The choices displayed are dependent upon
the operation used in the Operation field.

Panel Selection

A pull down menu of choices, each of which will display a different set of fields in the
right-hand side of the window. Refer to the following definition tables for details about the
choices: Dispense, Extra Control, Array & Track, Operate, Vision, Blobs, and Service.

STANDARD VALUES

X Location where this operation is to occur relative to the board reference point.

Y

Theta Rotation (radians) of the fourth axis for this head.
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Table 63: Program Detail window (Continued)

Element

Description

Object Rotation

Rotation of a feature about (X, Y). Rotation is counterclockwise for a positive value. This
angle applies to the shape, line, rectangle, etc. defined by the Operation field.

NOTE: Rotation, rather than Object Rotation, should be used to rotate an
array because Rotation rotates the array, not the individual items within the

array.
Size X X-size of a line/rectangle or the start diameter of a circle.
Size Y Y-size of a line/rectangle or the start diameter of a circle.
| SizeY @ Start charrster
(5.1 . (5 | R—
Size X Sze X End dameter

Fill Spacing For filled features such as circles and rectangles, this field defines spacing between suc-
cessive lines of the fill in units of needle diameters. A typical value is 1.5 needle diame-
ters.

Fill Spacing Alternate value of Fill Spacing in millimeters rather than needle diameters.

Move Ctrl Most operations are performed in 3 stages:

On/Off Ctr FIRST stage - the gantry moves to the point (X, Y, Start Z + Settle Z) where the Z coordi-
nate is the distance to the board. It then moves vertically to a Z coordinate Start Z, turn-
ing the valve on and performing additional operations while moving.
SECOND stage - the gantry performs the function at the target point, such as filling a
rectangle or dispensing a dot.
THIRD stage - the gantry moves to a Z coordinate of Start Z + End Z + Snap Off Z at high
speed and acceleration, turning the valve off and performing additional operations while
moving.
To function continuously across several operations (e.g., when drawing a pattern), these
stages must be performed independently. Move Ctrl and On/Off Ctrl are integer controls
allowing the moves and on/off operations to be performed separately:
0 = Complete - perform all three stages. (this is the default).
1 = Start - perform first and second stages only.
2 = Middle - perform second and third stages only.
3 = End - perform second stage only.
4 = No Operation - for On/Off control, perform none of the stages.

Feature ID Any name up to 12 characters long associated with this program line. Typically, this is a

board location (C10, U15, R25, etc.). Describes a discernible feature on the board to
allow selection or rejection of program lines by Feature ID. A feature ID can be assigned
to any program line. Any program line without a feature ID (blank) will always run.

ENABLED/DISABLED

Toggle button indicates whether this detail line is to be used. Any program line can be
easily enabled and disabled.

FIND FEATURE

Allows a specific program line to be found within the current program by typing the name
of the Feature ID associated with the program line.

SELECTABLE PA

NEL - DISPENSE

Settle Z
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Distance above Start Z (the Z location where dispensing or other operation takes place)
where the gantry settles before the move to Start Z.
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Table 63: Program Detail window (Continued)

Element Description
Start Z Distance above the board where initial dispensing or other operation is to take place for
this feature; a negative value will drill into a drill pad.
End Z Final dispense height distance above/below Start Z (the Z location where dispensing or

other operation takes place) for a dot (pillar) or three dimensional coordinated motion.
This value is non-zero to create pillars or to dispense along an angle to the plane of the
board. Use a zero value if no motion is desired.

Approach Velocity

Speed at which the Z-axis moves from Settle Z (where the gantry settles before the oper-
ation) to Start Z (the Z location where dispensing or other operation takes place).

Dispense Velocity

Speed at which the gantry moves during any motion required during a constant dispense
operation (e.g., Z velocity while building a pillar, or coordinated motion velocity while
drawing a line).

Valve Prime

Used to start valve material flow prior to reaching the target. The time between turning
the valve on and reaching Start Z (target).

Start Z Pause

This allows for the creation of a puddle; it is a position pause/delay after reaching Start Z.
After this delay, the head moves at Dispense Velocity until the specified On Time has
elapsed. To be effective, Start Z Pause must be less than On Time.

On Time

The main control of dispensed volume. The total time a head remains on during dis-
pense, delay time, or any other time value required to perform an operation.

Valve Reverse

Number of encoder counts to dispense desired dot size with a Micro-Dot valve. If dis-
pensing any shape other than dots, enter a value based on the length of time required by
the program to dispense the shape. This value is ignored if the valve used is not a Micro-
Dot valve.

NCM Open Time

Total time the non-contact jetting pump will remain open. This field does not display if the
system is not configured for a non-contact jetting pump.

Micro Valve Steps

Number of encoder counts to dispense a dot with a Micro-Dot valve. If dispensing any
shape other than dots, enter a value based on the length of time required by the program
to dispense the shape.

Micro Valve Reverse

Reverses auger direction for the specified number of encoder counts. Used primarily to
relieve pressure built up inside the needle and hub and can also be used to pull material
back up into the needle.

This technique, commonly known as suck-back, is used to help prevent drip when using
low viscosity materials, help control dot repeatability by controlling the amount of residual
material on the tip, and it improves snap-off for some materials.

Valve Off

Distance before the end of a constant fill (line, circle, rectangle) where the dispenser
turns off. Used mainly with fluid materials to control drooling. When performing a fill, a
needle may dribble unwanted material at the end of the operation. To prevent this, the
valve is turned off Valve Off mm before the fill ends. When this applies only to the last
line or circle of the fill, make sure the length of the last line/circle allows this.

Snap Off Z
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Helps avoid material tailing. Distance to move the valve/tool up during the snap-off action
to prevent tailing. Height above End Z (after Start Z) to which the dispenser moves after
a dispense is complete.
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Table 63: Program Detail window (Continued)

Element

Description

SELECTABLE PANEL -

EXTRA CONTROL

Fill Width

The wall dimension (the width of each side) of a hollow rectangle. The pattern is covered

l
Fill Wicth

.T\
in increments of Fill Spacing needle diameters and motion is at vector speed Dispense

Velocity, and turning the vale off Valve Off needle diameters before completion of move-
ment for each line.

Fill Width applies only to spiral rectangle fill. It is ignored for serpentine rectangular fills.

5 = =

Corner/in Spiral Center/Out Spiral Serpentine

If Fill Width is 0, the entire rectangle is filled. Conversely, a hollow rectangle can be cre-
ated by specifying a non-zero Fill Width; spiral lines are drawn toward the center or away
from the center of the defined rectangle until pattern width reaches Fill Width.

Move Velocity

Speed at which the gantry moves between two consecutive points.

Micro Valve Speed

Micro-Dot valve velocity.

Reverse Dead Time

Allows a specified delay between stopping the auger and reversing its direction. Use this
action to wet to a surface with material prior to material suck-back.

NCM Close Time

Allows a specified delay between closing and opening a non-contact jetting pump. This
field does not display if the system is not configured for a non-contact jetting pump.

Pinch Delay Delay before operating a pinch tube; for additional process control. Used only when a
Pinch Tube style of dispense valve is mounted on the machine. Pinch Tube valves use a
rod that squeezes the body of the material feed tube shut to stop the flow of material.

Auger Speed Speed at which to operate a variable speed auger.

Pre Snap-off Delay

Time to delay after dispense but before beginning snap-off.

Post Delay

Post operation delay.

Snap Off Velocity

Snap-off velocity.

Snap Off Acceleration

Snap-off acceleration.

Micro Valve Acceleration

Micro-Dot valve acceleration.

Mixer Velocity

Speed at which to operate the mixer valve.

Scale Factor
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Scales a feature up or down by a particular percent. Applies especially to shapes; a
shape can be executed as a different size than it is defined.
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Table 63: Program Detail window (Continued)

Element

Description

SELECTABLE PANEL - ARRAY & TRACK

Rotation Angle through which the array is to be rotated, independent of Object Rotation. The
entire array is rotated as a unit about the point (X, Y).

NOTE: Object Rotation, rather than Rotation, should be used to rotate a
single item because Object Rotation rotates individual elements of the
array, not the array itself.

X Count default = 1 for a non-array

Y Count Number of array elements in the X and Y directions before rotation of the array.

X Space default=0

Y Space

Specifies the spacing between array elements in the X and Y directions before rotation of
the array. To jog to desired space in the XY direction, you can click TEACH SPACE.

TEACH SPACE

Calculates offsets for X Space and Y Space. Appears only when valid coordinates are
used in the X and Y fields of the Standard Values panel.

Needle Track default =N
Indicates whether to backtrack over last fill line.

Mixer Valve Velocity of mixer valve.

X Location where backtracking is to occur relative to the board reference point.

Y

Start Z Distance above the board where backtracking is to take place; a negative value indicates
drilling into a drill pad.

End Z Distance above Start Z (the Z location where backtracking takes place) for the operation
to end. This value is non-zero to create pillars or to dispense along an angle to the plane
of the board.

Velocity Speed at which the gantry moves from Start Z to End Z.

SELECTABLE PA

NEL - OPERATE

Max Repeat Number of times the system attempts to pick up the component at the current Z location.
Retries Number of times to retry a failed operation.

Skip Lines Number of program lines to skip forward (+) or backward (-).

Message Message number (-1 and greater) associated with this operation.

Flag Counter Number
Flag/Counter Value

Bit number (0-31) and value (0-1) to change or test bit flags. Used to test the status of
various conditions within a program/shape and, based on the test results, direct the con-
trol software to either continue or skip program detail lines.

Head Pressure

Operating pressure for this head.

Minimum Z Value
Maximum Z Value

Minimum and maximum Z coordinate values allowed (mm).

Operation Time

Operating time for this operation.

Blow Off Time

Blow-off time to release a part.

Pattern
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Name of a pattern, up to 24 characters long. This field is used when an OPERATE line
requires a vision pattern.
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Table 63: Program Detail window (Continued)

Element

Description

SELECTABLE PA

NEL - VISION

Camera Select

Camera number to be used in this operation.

Gain Camera gain (0-255). Use -1 to disable.

Offset Camera offset (0-255). Use -1 to disable.

Zoom Value (0.0 to 1.0) of focal length for an automatic focus camera for changes within the
program.

Focus Value (0.0 to 1.0) for focusing an automatic focus camera for changes within the pro-
gram.

f-stop Value (0.0 to 1.0) for f-stop on an automatic focus camera for changes within the pro-

gram.

Light on Dark

A'Y indicates use of a light dot on a dark background for dot inspection on the board. An
N indicates use of a dark dot on a light background.

Light Level

Level of lighting for changes within the program.

Light Color

Light color for changes within the program.

SELECTABLE PA

NEL - BLOBS

Blob Count

Number of blobs to be found by the vision system (0-50).

Low Gray Gray level pixel values (0-255) for low limit.

High Gray Gray level pixel values (0-255) for high limit.

Blob Ratio Minimum to maximum length ratio for blobs.

Min Area Minimum area (pixels) of blobs for blob search.

Max Area Maximum area (pixels) of blobs for blob search.

Window Height Used to determine the size of a search window for dot inspection. Establishing a narrow

Window Width area only slightly larger than the dot to be found is suggested. Refer to Dot Inspection
(pg 3.105).

Dot Volume Dispensed dot volume.

Target Size Desired blob (dot) size. Refer to Dot Inspection (pg 3.105).

Target Range

Desired tolerance value. Refer to Dot Inspection (pg 3.105).

SELECTABLE PA

NEL - SERVICE

Program Code

Internal use. Code to identify the program. The value is inherited from the @PRORAM or
@SHAPE record.

Program Flag

Internal use. Indicator used internally to select items.

Sequence Number

Internal use. Code to sequence the detail records. Records are re-sequenced automati-
cally as they are encountered.

PS Type Internal use.
Alternate PS Type Internal use.
MoPar Index Internal use.
Snap Mopar Internal use.
ST Code Internal use.
Ident Internal use.
Needle Inside Diameter Internal use.
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Table 63: Program Detail window (Continued)

Element Description

Head Type Internal use.

SELECTABLE PANEL - FUNCTIONS
Only functional when the dispenser is configured for Wedge configuration. Refer to custom Wedge project docu-
mentation.
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Program Editor

Program Editor provides access to the creation, modification, and selection of programs in
addition to the libraries and tools that directly affect program characteristics.

TIP: To access Program Editor, click on the Program Editor icon on the main control window.

Menu Bar

Board Information
Description

Fiducials, Bad Mark, Touch Span,
& Alignment Points
il | ¥

Program Selection Tools

Litiirics Heipr
| ——r——— | Options button
Board e &
! Class Filter| r/ - tear-off menu
= Class| versin| [ onems i
———— o i s
W 0.0000 I [ VS ey it 'Jm S
x 1 Lenghh| 0.0000 in | ated 0,000 in JW“ .
1’-§ m|o.mm s 0,000 in I_le
Search
= _ Sipia -
_ Pause o E
B Mark.
il W 1
: aEml
P 1 X] [o.000 10 ¥o.000 o
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Table 64: Program Editor window

Element

Description

MENU BAR

File Drop down menu of the following choices.
Print Prints the currently selected program with the option of reducing details by category if a
printer is attached.
Exit Closes the Program Editor and deletes the icon from the Main Control Panel.
Edit Drop down menu of the following choices.
Rename Program Enables a new name to be assigned to the currently selected program or shape.
Cut Not currently functional.
Copy Copies the currently selected program or shape.
Paste Not currently functional.
Convert Allows you to convert a shape to a program, a program to a shape, or a program to a
subboard.
Clear Not currently functional.

Refresh Program List

Use when the displayed list may not be accurate.

Libraries Drop down menu of the following choices that pertain to the machine configuration (only
the choices applicable to your machine will display).

Patterns Creates or modifies shapes to be used as patterns during fiducial or bad mark pattern
recognition by the (optional) automatic vision system to locate a product and adjust for its
orientation.

Materials Add, modify, or delete a material from the list of materials currently available.

Needle Define a needle or change the characteristics of an existing needle.

Part Numbers Define individual cross reference records or change the shape associated with an exist-
ing cross reference record.

Head Add, modify, or delete a mount position from the list of mount position types currently

available; e.g., auger, liquid dispense, trace cut, etc.

Fixed Locations

Define and edit fixed locations.

Password

Add or delete a user name, change access rights for a user name, or change the pass-
word for a user name.

Material Defaults

Define defaults for materials according to value/tool mount position.

SubTypes Define and edit subtypes.
Utilities Drop down menu of the following choice:
Optimize Reorganizes the current program to minimize execution time with either point-to-point,

fixed divisions (number of divisions), or a floating square (size of square).

PROGRAM SELECTION TOOLS

Edit Programs
Edit Shapes

Toggle controls which determine the type of programs (programs or shapes) displayed in
the Available ltems panel.

Class Filter

5/18/18

Use to select a class of program or shape for display. Expands or restricts the combina-
tion of programs or shapes displayed in the Available Items panel.
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Table 64: Program Editor window (Continued)

Element

Description

list of programs

Names of the currently available program or shape names as determined by the pro-
gram selection tools (Edit Programs, Edit Shapes, and Class Filter).

BOARD INFORMA

TION

Class

The Class Filter assigned to the current program is entered and displayed here.

Version

Applies to programs only. If a shape name cannot be found, the system looks for the
shape name with a version prefix.

Pre-scan Patterns

Requires a complete vision scan be performed before the program runs.

Pre-scan Probes

Requires a complete probe be performed before the program runs.

Point Search

Limits the search area for the vision system.

Skip if No Fiducial

If a fiducial is missing, rather than stopping for operator intervention, the program will
skip the board, subboard, or shape.

Pause on Bad Mark

Program will pause for operator intervention if a bad mark is detected.

Suppress Lifter

Suppresses lifter plate operations.

Suppress Hold-Down

Hold-down vacuum on the board will be suppressed.

Double Scan Performs a second fiducial search. (This option slows the fiducial scanning process.)
Atfter the standard process of looking for a fiducial and moving the gantry based on
search results is performed, a second fiducial search is performed and the gantry is
again moved if a position correction is deemed necessary by the second search.

Width Reference data required by SMEMA and used with

Length f the automatic adjust conveyor:

Thick Width - may be used to set the width of an auto-

Product ! matic conveyor.
Wicth
Length - used to improve conveyor operations.
'.:::o' Thick - may be used to adjust camera calibration.
Length o

Reference Point The system location (X,Y) of the board data origin

X (0,0) measured from the lower right corner of the

Y board. The default coordinates (0,0) can usually be

Product used unless converting data.
All data points on the product are measured from the
reference point. All values and defaults, except
(0,00 those defined as absolute, are referenced from this
Point s the point. If reference point values are zero, all X coordi-
MEHME m:eh qﬁﬂcmafm' nt (0.0) nates will be negative.
for thamachie. As necessary, i.e., when converting data, determine
reference point coordinates from product drawings
or by measuring the X and Y distances from the lower right hand corner of the product to
the reference point.

TEACH Teaches the X and Y coordinates for the reference point.

MOVE TO Moves the gantry IMMEDIATELY to the coordinates designated in the X and Y fields.

Taught Angle Angle at which the shape was taught.

5/18/18

FLOware Software Guide 5.96



GPD Global®

References

Table 64: Program Editor window (Continued)

Element

Description

FIND FIDUCIALS

Makes program adjustments for board orientation while moving the gantry to each fidu-
cial within the current program.

DESCRIPTION

Description

Optional text field of up to 250 characters long containing any descriptive information.

FIDUCIALS & BA

D MARKS

Fiducial n X, Y The use of these product orientation points is optional but recommended for accuracy.
Bad Mark X, Y Bad mark coordinates relative to the reference point.
MOVE TO Moves the gantry IMMEDIATELY to the coordinates designated in the X and Y fields.
Used Indicates whether or not the associated pattern is used.
Pattern Name of pattern up to 24 characters long for use with automatic vision. This name pro-

vides reference to the shape of the fiducial or bad mark.

Process if mark pres-

Determines how a bad mark is detected and used.

ent 0 = no bad mark indicators; process ignores mark if present.
1 = process if mark is present.
2 = process if mark is absent.
Window Not currently functional. Primarily used to prevent false positives by masking objects
similar to the pattern for which you are searching.
Used Not currently functional. Indicates whether or not the associated window is used.
X, Y Not currently functional. X, Y size of the search window.
TEACH Not currently functional. Teaches the window area (X, Y).

Touch Span X, Y

X and Y spacing for automatic touch probe operation.

Alignment Pt X, Y

Alignment point that aligns arrays with board edges.

COMMAND BUTTONS

ADD ITEM

Add a new program or shape.

DELETE ITEM

Delete the program or shape currently selected.

CLOSE EDITOR

Close the Program Editor to an icon.

EDIT DETAIL LINES

Modify, save, or delete program detail line(s).

VALVE/TOOL MOUNTS

Define the position and type of valve/tool, material, and needle gauge for each mount
position to be used in the current program (not applicable to shapes).

MODIFY SUB BOARDS

Define the location and orientation of each subboard in a program (not applicable to
shapes).

APPLY EDITS

Implements any changes currently displayed in the Program Editor window and any pro-
gram line modifications made in the Program Detail window.

MISC PROGRAM SET-
TINGS

Define program settings for various purposes, e.g., vision calibration, temperature, pres-
sure, or rotation relative to bad marks.

OPERATOR INSTRUC-
TIONS

Add, modify, or delete instructions associated with the currently selected program (not
applicable to shapes). These instructions display in the Mounts Table window.
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Select List

Select List is a basic window type that presents a list of items from which you can make a
selection. Select List is used by various features in the selection of a specific item. The
appearance and control buttons used on each select list window may vary somewhat but the
basic window function is the same.

E44; Salect an Operation

CAL1BRATE Foroes a calibraklon @aring a prosess

CIHCLE Duiwa @ eirele oF an arcay of elrelan

CLUT Hovan bhe gamkey in a skraight |iss

DELAY Dulaye processing for a specifisd msbar of willis
Ll Draws & dot or an arxay of dots

LIHE braws & lise or an artay of linea

HOVE Howea Ehi gantcy in a straight 1ins

e amy smbey for dalawlts

OFERATE fipwrates a irbure

FRARTITION Intreducas a program amd parkition dafaslts

HECT ALY Berawa & coctangle of am avvay of recbangles |
BETUP sala up pallets, stamdsffa, ale.

HHAPE Totreducas a

WOF0E B Fissnelon; & 080° ¥ 00107

A0402 B Fimsnslon: @060 K @010

BS0503 B Bisesnsion: 9. 060= K 0010

ASOBOE D Dimnsion: O 6E0= N 0050~

PTALEST i Eimenuion: & 680~ N O 050" i

e

[ARC Mot thon gantey i cirvmlag srn |

Aacapd Caneal Fimd

Table 65: Select List window

Element Description

scrolling list An alphabetic listing of all available items.

Selection Used to find a specified item. Type an item name in this field, press FIND, and if found,
the name will display in this field and the associated item will be selected in the scrolling
list.

ACCEPT Saves changes and exits this window.

CANCEL Exits this window without saving changes.

FIND Finds and selects the scrolling list item for the name typed into the Selection field.
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Set Pressure/Temperature

Set Pressure/Temperature is typically used for set up procedures when the system is
equipped to handle pressure and temperature control through the software instead of gauge
and switch hardware.

This window allows pressure and temperature values to be set independently from values in
the program. The operator can set these values when no program is running. The program
uses the value set in Air Pressure and the selection made from the drop down menu overrides
program actions.

Example:

+ ASSUMPTION 1: The program calls for 5.0 psi to turn off after a period of time.

+ ASSUMPTION 2: In the Set Pressure/Temperature window, Air Pressure is set to 8.0 psi
and ON is selected from the drop down menu.
* RESULTS: Air pressure will change to 8.0 psi and not turn off as defined in the program.

TIP: To access Set Pressure/Temperature, go to the main menu bar and click on Machine
Controls > Set Pressure/Temp.

Haterial Temp | ©

Heedle Temp |

Conwvey Temp |

1 2

Air PressureIO‘O p=i IO‘O psi

Program — | Program — |

Done |

Table 66: Set Pressure/Temperature window

Element

Description

Air Pressure

Syringe air pressure; the air pressure applied to the material syringe or FPC sensor (if
present).

Program

Drop down menu of program overrides. The override determines how and if the inde-
pendently set pressure and temperature values will affect the program.

* PROGRAM: the current program controls this feature.

» AUTO: used by older systems to toggle the manual syringe air pressure on/off.

» ON: syringe pressure is applied to the syringe.

» OFF: no syringe pressure is applied to the syringe.

Material Temp

Not currently functional. Temperature set point of the material heater.

Needle Temp

Not currently functional. Temperature set point of the needle heater.

Convey Temp

Not currently functional. Temperature set point of the conveyor rail heater.

APPLY Saves changes and exits this window.
DONE Exits this window without saving changes.
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Set Shape Reference Point

During the process of re-teaching a shape, the Set Shape Reference Point window is used to
tell the system the location of the reference point for the shape being re-taught.

TIP: The Set Shape Reference Point window will display automatically during the process of
re-teaching a shape, or you may choose to open it manually by selecting Edit Shapes in the
Program Editor and then clicking on the FIND FIDUCIALS button.

¥ ou must set the reference point — Relference
hofW point types
Calculated Center Set Singhe Point Fiued Locasion
I~ Calgulate Center Point -1 Set Reference Point - Uz Fhoed Location
FirstPoint | SetPoiut | | | |Nene J
Socond Poiut | Show Point
Show Poiut |

Crarue

Cancal| _Halp |

Table 67: Set Shape Reference Point window

Element

Description

CALCULATED

CENTER

Calculate Center
Point

Activates the Calculated Center type of reference point. Use when the shape is located on a
board and the shape reference point can be calculated at the center between two points.

FIRST POINT

Sets the first reference point to the current gantry position.

SECOND POINT

Sets the second reference point to the current gantry position and calculates a shape refer-
ence point at the center of a straight line between the first and second set points.

SHOW POINT

The gantry moves the camera to the center of the shape.

SET REFERENCE POINT

Set Reference Point

Activates the Set Reference Point type of reference point. Use when the shape is located on
a board and the shape reference point is a know point.

SET POINT

Sets the reference point to the current gantry position.

FIXED LOCAT

ION

Use Fixed Location

Not currently functional. Activates the Fixed Location type of reference point. Use when the
shape is located off the board at a fixed location (where coordinates are relative to gantry
position rather than board coordinates), such as a feeder or pallet.

selection field

Not currently functional. Select a fixed location or type in the name of an existing fixed loca-
tion.

SHOW POINT

Not currently functional. The gantry moves the camera to the fixed location.
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SubBoard Editor

Use the SubBoard Editor to define the location and orientation of each subboard in a program.

TIP: To access SubBoard Editor, open the Program Editor and click on MODIFY
SUBBOARDS.

References

Fhoesals Sub Board Infir
 Fidueind 1 Do Boards
3] 0.00 wn %[ 000w Taach
o Whed Palterm
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Table 68: SubBoard Editor window

Element

Description

FIDUGC CIALS

Fiducialn X, Y

Fiducial coordinates relative to the subboard reference point. Zero, one, two, or three
fiducials may be defined as needed.

These fiducials fields only apply to the first subboard in a program. Once created, a sin-
gle subboard program can be converted into a pallet program (a set of subboards).

Bad Mark Location

Bad mark coordinates relative to the subboard reference point.

TEACH Use to teach the (0,0) board location or bad mark location.
Used Indicates whether the associated subboard fiducial or bad mark is used.
Pattern Pattern name up to 24 characters long for use with automatic vision. This name provides

reference to the shape of the fiducial or bad mark.

Process if mark pres-

Determines how a subboard bad mark is detected and used.

ent 0 = no bad mark indicators; process ignores mark if present.
1 = process if mark is present.
2 = process if mark is absent.
Window Not currently functional. Primarily used to prevent false positives by masking objects
similar to the pattern for which you are searching.
Used Not currently functional. Indicates whether or not the associated window is used.
XY Not currently functional. X, Y size of the search window.
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Table 68: SubBoard Editor window (Continued)

Element

Description

TEACH

Not currently functional. Teaches the window area (X, Y).

SUB BOARD INFO

Defined Boards

The name and reference point coordinates for each subboard taught and named with the
tools in the SubBoard Specifics panel are displayed here.

SUB BOARD SPE

CIFICS

Name

Used only as a reference. Typically, subboard reference names correspond to a number
(First, Second, Third, etc.).

Feature Not currently functional.

X, Y Subboard reference point coordinates.

MOVE TO Moves the gantry to the reference point of the selected subboard.

TEACH Use to teach the subboard reference point location relative to the pallet reference point.
Angle Degrees of angle of the subboard position relative to the original orientation taught.

ARRAY DIMENSIONS

Span X, Y

Distance from same position board-to-board in X and Y directions.

Count X, Y

Number of subboards in X and Y directions.

Suppress Auto Height
Probe

Suppresses automatic probe operation on each board. If N, the elevation of every sub-
board is checked during processing. If Y, only the height of the first subboard in the pallet
is checked.
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SubType Editor
Use the SubType Editor to define and edit subtypes.

TIP: To access SubType Editor, open the Program Editor and click on Libraries >
SubTypes.

Operation o Uperation  OPERATE |
SubType Sudlipe | PROG PAUSE J SubType Coe | 10 — SubType Code
Description
Fause for operater actlen
Description —
hessage Type  Defanlt - | Message Type
SO0t NotUsed -] SetMiOn _ Notled | || |- Start operation I/Os
I'D controls Test WODE _ Motlsed - TestkDOn _ Motlsed } Test operation 1/0s
SO OF  MotUsed | SetMiOn _ Netlsed  ~| | T~ End operation /Os
attern | |
Pattern L —
D | Apply | Delats |
Table 69: SubType Editor window
Element Description
Operation Defines the operation to which this subtype applies.
SubType Name of the subtype. May be up to 12 alphanumeric characters long.
SubType Code A predefined code is automatically entered in this field when a selection is made from the

Operation button drop down menu.

Details for all operation subtype codes are located in the System Table Definitions: Sub-
Type section of the Import/Export Data Reference Guide. A summation is repeated here
for the commonly used Operate operation:

OPERATE Sub Type Codes Defined
0 - obsolete.
1 - operate probe.
2 - obsolete.
3 - operate I/O, skip for test success.
4 - halt program.
5 - operate pickup.
6 - perform place operation with pickup tool.
7 - test for missing/present part using test probe.
8 - test for presence of a dot using the vision system.
9 - suppress all auto-probe operations.
10 - pause for operator action.
11 - set a flag in current flag word.
12 - test a flag in current flag word.
13 - take a picture and begin analysis.
14 - advance pallet.

~ continued ~
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Table 69: SubType Editor window (Continued)

Element

Description

15 - clean needle.

16 - purge valve.

17 - adjust a lens.

18 - seat using a pressure foot.
19 - test using camera 2, pattern.
20 - turn air off.

Description

Comment and description field of up to 250 characters. Text will print fully on printouts.
The 40 characters entered up to the first hard return entered will display on some win-
dow lists.

Message Type

Code designating a user-defined message to be displayed when a Test I/O fails. Typi-
cally, Message Type is only used for SubType Code 3. Creating a user-defined message
requires editing the ds.user.msgs file. DO NOT proceed with this action unless you have
received specific instructions from GPD Global.

I/0 CONTROLS

These codes are for special I/O (input/output) operations and typically used with SubType Code 3.

I/O controls can be defined using Configuration > 1/0 Definitions. For work and head 1/O assignments, refer to
the details recorded in the Input/Output Listing section of Mechanical & Electrical Reference Documents located
in the dispenser documentation package.

START OPERATION /O

The upper set of Set I/O buttons shown in window:

Set 1/0 Off Set I/O Off = an I/O to turn OFF at the START of this operation.

Set /0 On Set 1/0 On = an I/O to turn ON at the START of this operation.
TEST OPERATION I/O The middle set of Test I/O buttons shown in window:

Test I/O Off Test I/O Off = an I/O to test for OFF.

Test I/O On Test I/O On = an I/O to test for ON.

If both Test I/0O Off and Test I/O On are zero, the operation delays for the amount of time
entered in the Operation Time field (on the Program Detail window) before executing the
lower set of Set I/O buttons.

END OPERATION 1/O

The lower set of Set I/0O buttons shown in window:

Set 1/0 Off Set I/O Off = an I/O to turn OFF at the END of this operation.
Set /0 On Set 1/0 On = an I/O to turn ON at the END of this operation.
Pattern name of a pattern used as part of the subtype function such as dot tests.
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Valve/Tool Editor

The Valve/Tool Editor is used to define the properties and defaults for a new head (valve or
tool) or change the characteristics of an exiting head.

TIP: To access Valve/Tool Editor, open the Program Editor and click on Libraries > Head.

Valve/Tool Vv Tool Name
Mame — 1 | NoNE T Doy |
Type —
Description —1—*
r § Low Maderal Sensor J Low Flesersoir Sensor i Cther Sensor
. I FiyBel Sarror I |Exirm Sanson I Ji Sansss
Dp’erahﬂnﬁ 1 J Hes Standol - Has Sra OF o Hes Jeers
I Skip Suand0f Calibrations I kap haad ataius i Wi Tonath Probe
o et 0,000 & ¥ Ozt [ 0.000 1 2 Ot | 0.000 &
Yava 0,000 ¥ Yahe 0, (i I'n'. el | Wil £
seerdl Famp | . Tstl "
Parameters — Faad Raam| -0 1rve | 0000 injs
M Vave R — hicre Vb )
Velosey e Rrversg o Ascearaan
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L Dper: Tine | 0,000 5 Open Certer | 0,000 5 m 000 g
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Table 70: Valve/Tool Editor window
Element Description
Valve/Tool Name Name of the valve or tool. May be up to 18 alphanumeric characters long.
Type Drop down menu of valve and tool types. The type determines how the head will oper-
ate.
VALVES: Dummy, Auger, Variable Auger, Drip-less, Syringe.
MORE VALVES: Needle, Single Part, Two Part, Micro Valve, Cartridge, MV50/400,
NCM.
TOOLS: Etch, Rout, Air Drill, Pickup, Other
Description Optional descriptive field of up to 250 characters. Text displays only in the Valve/Tool

Editor window but prints in full for printouts.

OPERATIONS

Low Material Sensor Indicates the presence of a low material sensor on the valve or tool.
Low Reservoir Sensor Indicates the presence of a material level detector on a the valve.
Other Sensor Indicates the presence of some other sensor on the valve or tool.
Retract Sensor Indicates the presence of a retract sensor.

Extra Sensor Indicates the presence of another sensor.

Jaw Sensor Indicates the presence of a sensor for jaw position.

Has Standoff Indicates the presence of a stand-off needle on the valve or tool.
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Table 70: Valve/Tool Editor window (Continued)

Element Description
Has Shut Off Indicates whether or not a valve uses a shutoff control.
Has Jaws Indicates the presence of centering jaws.

Skip StandOff Calibration

Indicates whether to calibrate this standoff or not.

Keep Head Status

Indicates whether head status (on time, dots dispersed, idle time, etc.) is to be retained
across programs.

Has Touch Probe

Indicates the presence of an integral touch probe on the valve or tool.

PARAMETERS

X Offset

X offset (mm) of the operating point of the valve or tool from the calibration teach tool.
This valve allows calibration with the calibration teach tool to be transferred to any valve
or tool.

Y Offset Y offset (mm) of the operating point of the valve or tool from the calibration teach tool.
This valve allows calibration with the calibration teach tool to be transferred to any valve
or tool.

Z Offset Z offset (mm) of the operating point of the valve or tool from the calibration teach tool.
This valve allows calibration with the calibration teach tool to be transferred to any valve
or tool.

Standoff X Offset X offset required to move a standoff needle from center during calibration. The value
depends on the position of the standoff foot.

Standoff Y Offset Y offset required to move a standoff needle from center during calibration. The value
depends on the position of the standoff foot.

Stand Off Z Z distance to calibrate the standoff needle.

Valve Speed Percent of full valve speed to run a variable speed valve.

Valve Ramp Acceleration (percent per millisecond) to ramp up/down a variable speed auger.

Stall Test Percent of full current at which a variable speed valve is considered stalled. Use this field

to prevent the variable speed valve from overheating.

Mixer Feed Rate

Value of mix rate, feed rate, etc. associated with this valve or tool.

Reload Mix Rate

Feed rate to move a mixer valve while reloading the valve.

Micro Valve Velocity

Speed (counts per millisecond) at which a Micro-Dot valve is run for purging or dispens-
ing lines or fills.

Micro Valve Reverse

Value (counts) to operate a Micro-Dot valve in reverse for suckback.

Micro Valve Acceleration

Acceleration (mm/sec/sec) for a Micro-Dot valve.

Hold Time

Not yet functional.

Hold Center

Not yet functional.

Air/Vacuum Pressure

Value of vacuum, pressure, air pressure, etc. associated with this valve/tool.

Open Time

Not yet functional.

Open Center

Not yet functional.

Seating Force

Optional pressure (kPa) used to seat a part with a pressure sensor.
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View Notes is where notes entered through the system text feature can be selected for
viewing or deletion.

TIP: To access View Notes, go to the main menu bar and click Utilities > Notes > View Notes.

User Notes
— & —
Jim Waloome to GPD's Dispanser Softwars )
Selection panel e

Display panel

Ok Dalate
Table 71: View Notes window
Element Description

selection panel

Note creation details are listed here chronologically. Selecting an entry here displays the
associated text in the display panel.

display panel Note text for the note selected in the selection panel is displayed here.
OK Saves changes and exits this window.
DELETE Deletes the selected note entry.
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Operations (Primitives)

A set of basic, preprogrammed operations is available in the dispenser control software. Each
of these primitive operations defines an often-used shape or action. This section presents an
explanation for each primitive operation.

* Arc (pg 5.108)

+ Calibrate (pg 5.108)
+ Circle (pg 5.109)

* Delay (pg 5.110)

* Dot (pg 5.111)

* Line (pg 5.112)

*  Move (pg 5.112)

*  None (pg 5.112)

*  Operate (pg 5.112)
«  Partition (pg 5.112)
* Rectangle (pg 5.113)
* Setup (pg 5.113)

+ Shape (pg 5.113)

NOTE: Definitions for fields mentioned in the description of each operation (primitive) can be
located here: Program Detail (pg 5.86).

NOTE: Each operation (primitive) has at least a couple SubOps or sub-operations associated
with it, and each sub-operation is bound to a specific subtype. For more details, refer to
SubOps & SubTypes (pg 5.114).

Arc
An arc operation will move the gantry in a circular arc according to the following sequence.
The center of the arc is at X and Y through Object Rotation starting at the current location.
1. The head moves at Move Velocity to Settle Z and X, Y at the first point of the arc.
2. The head moves downward at Approach Velocity to Start Z, turning on Valve Prime milli-
seconds before reaching Start Z if there is sufficient time to do so.
3. The head draws an arc as defined at Dispense Velocity, turning off the valve Valve Off dis-
tance before completion of movement.
4. The head moves to Snap Off Z above the product at a rate determined by Snap Off Veloc-
ity for the head.
Calibrate

A calibrate operation forces a calibration during a process as determined by SubOp values.
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Circle

5/18/18

A circle operation draws a circle or an array of circles according to the following sequence.
Any unspecified parameters are defaulted.

1. The head dispenses a ring from Start Diameter to End Diameter centered at X, Y.

Start charmater

Erd diarmeter

2. The head moves at Move Velocity to Settle Z and X, Y at the nearest point on the circle of
diameter Start Diameter centered at X, Y.

3. The head moves downward at Approach Velocity to Start Z, turning on Valve Prime milli-
seconds before reaching Start Z if there is sufficient time to do so.

4. The head draws a series of concentric circles of Fill Spacing needle-diameter increments
at Dispense Velocity to fill the ring to End Diameter, turning off the valve Valve Off distance
before completion of movement.

5. The head moves to Snap Off Z above the product at a rate determined by Snap Off Veloc-
ity for Head.
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A delay operation delays processing for a specified time span. Delay time is set in the
Operation Time field (in the Operate panel of Program Detail).

For example:

For a Dam and Fill application, use Delay to allow material to self-level prior to dispensing
the next layer.

For Underfill applications, use Delay to allow material to fill under the chip if Resumption
Points for Underfill - UltiPath™ (pg 4.62) are not used.

For further details about the following subops, refer to SubOps & SubTypes (pg 5.114).

Entry

Exit

Not currently functional. Delay override at Entry station.

Not currently functional. Delay override at Exit station.

Mark Delay

Used to mark the current time. Must be used in combination with Limit Delay.

Limit Delay

Used to limit delay at least On Time ms since last mark. Must be used in combination
with Mark Delay.

Using Limit Delay with Mark Delay

Limit Delay and Mark Delay can be used in combination. For example, these opera-
tions can be applied to underfill dispense to allow a dispense the time needed to wick
under a component while another action (needle clean, a second dispense, etc.)
occurs simultaneously. To achieve this result, program an underfill dispense, followed
by Mark Delay to start the timer, followed by Limit Delay to set the time span that is to
occur before the program continues with the next program line.

This combination of delay operations is limited to a single timer for use with a single
component size. When various component sizes and/or multiple timers are involved,
refer to Resumption Points for Underfill - UltiPath™ (pg 4.62).
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Dot

A dot operation moves a specified head to given coordinates and dispenses a dot or an array
of dots from the named head in one of the following scenarios. Any unspecified parameters
are defaulted.

* The head moves to (X, Y, Settle Z) at Move Velocity, then downward at Approach Velocity
to Start Z, turning on Valve Prime milliseconds before reaching Start Z if there is sufficient
time to do so. When the head reaches Start Z, it delays for the amount of time in On Time
or, if End Z is > zero, it dispenses as it approaches End Z at Dispense Velocity. The head
then moves to Snap Off Height for Head.

NOTE: Start Z is relative to the point at which the surface sensor obtains its reading; when
Start Z is zero the needle is positioned at the board surface. Also note that End Z is
relative to Start Z.

* If End Z equals zero, the system dispenses material at the Start Z position for the speci-
fied amount of time in seconds set in the On Time field.

WhenEnd Z=0
Quantity of material

dispensed is determined by
Start Z On Time and Valve Speed.

+ IfEnd Z is not equal to zero, the system turns on the valve, begins dispensing, waits for
Start Z Pause (even if it is zero), and then moves to End Z at Dispense Velocity before
shutting off the valve. On Time has no effect when End Z unequal to zero.

WhenEnd Z >0

Cusantity of material
dispensed is determined by
End Z, Valve Speed, and
Dispense Velocity.

EndZ |
Start Z

¢ A Micro-Dot valve works as described above unless End Z is zero, in which case the valve
is on for Valve Steps encoder counts. The head then moves to Snap Off Velocity for Head.
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Dot SubOps
For further details about the following subops, refer to SubOps & SubTypes (pg 5.114).

Subops for ordinary (major) or staggered arrays of dots are available for the DOT operation.

XMajor YMajor
nrm o {nn
XStagger Y Stagger

=

Line
A line operation draws a line or an array of lines. A line can be rotated with Object Rotation.
*)
Move
A move operation moves the gantry from point to point.
None
A none operation acts as a dummy entry and can be used to include comments.
Operate
An operate operation operates a fixture as determined by Head and SubOp. An operate
should only appear within a fixed partition.
Partition

A partition operation introduces a program and partition defaults in accordance with the guide-
lines listed below. It provides default values and defines sections of the program; partition may
appear anywhere within a program. It enables you to enter values only once and then edit
these values, which may be used in multiple occurrences, in only one place.

*  When sorting points for program optimization, each partition is optimized independently;
sorting is suppressed in a fixed partition.

» Parameters in a Partition program line are substituted for omitted fields with correspond-
ing names in all other program lines.

*  Omitted parameters in a Partition program line revert to system defaults.
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Rectangle

Setup

Shape
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A rectangle operation draws a rectangle or an array of rectangles in accordance with the
following sequence. Rectangle may have a hollow, concentric, or zigzag fill. Any unspecified
parameters are defaulted.

1. Dispenses rectangle of (Size X, Size Y) with lower left corner (if SubOp equals Corner) or
center (if SubOp is omitted or SubOp equals Center) at (X,Y).

| SizeY

)
Size X
2. If the SubOp is Center/in, Center/out, Corner/in, or Corner/out, the rectangle is drawn as
an inward or outward spiral; otherwise, the fill is zigzag.

3. If the SubOp indicates a spiral fill and if Fill Width is between zero and Size X/2, a hollow
rectangle is drawn with thickness of sides equal to Fill Width.

4. Anindividual rectangle can be rotated with Object Rotation. The point of rotation can be
changed by selecting one of the various rotation sub-operation choices.

5. If (X)Y) is the first corner, then the head first moves to (X,Y,Settle Z) at Move Velocity, then
downward at Approach Velocity to Start Z, turning on Valve Prime milliseconds before
reaching Start Z if there is sufficient time to do so.

6. The rectangle is drawn with a series of straight lines of roughly Fill Spacing increments at
Dispense Velocity, turning off the valve Valve Off distance before the end of each line.

7. The head then moves to Snap Off Z above the product at a rate determined by the Snap
Off Velocity for Head.

A setup operation sets up pallets, standoffs, etc. It allows a program to control various activ-
ities when the program is first started, such as resetting pallet parameters and some options. It
may also reset some fixed parameters or generate request for special operator actions.

Unless otherwise indicated by a SubOp definition (see below), setup lines are effective only if
a program is started by clicking the RUN button. If a program is started by clicking the
RESTART button, most setup operation lines are ignored. This allows a run to use former
pallet positions without requiring fresh pallets or feeders when a program is restarted.

Setup lines can occur anywhere in a program or shape. They are executed in the order in
which they appear in a program after the program is read but before any other operation
occurs. All setup lines are ignored after actual program execution starts.

& CAUTION: DO NOT USE - this feature is not currently functional.

A shape operation introduces a shape. It defines a particular shape for all following program
lines up to the next program or shape program line.
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SubOps & SubTypes

Each shape operation [Operations (Primitives) (pg 5.108)] has at least a couple SubOps
associated with it. Each of those SubOps is bound to a specific and unique Sub Type code.

SubOps are sub-operations; they modify the meaning of the operation. For example, the
Rectangle operation can be defined by a corner rather than its center by selecting a corner
SubOp rather than a center SubOp.

A specific Sub Type code is bound to each SubOp to define that SubOp. For example, the
Center SubOp for the Rectangle operation is always a Sub Type code of 0.

NOTE: Some Sub Type codes are available for all machines and some apply only to
unique features on a specific machine.

WARNING Care must be taken if subtypes are moved from one machine to another since sub-
types relate to both the hardware and software.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

As of software version 2.9, current subtype codes are as follows:

Table 72: SubTypes & SubOps by Operation

Operation SubOp Sub Type Code Description
Arc Relative or blank 0 Ordinary center/angle arc. Arc starts at last head position
with center of arc at X,Y and moves through an angle
Object Rotation.
3-Point 2 Allows arc to be defined with the three points of the arc.
Calibrate Head 0 Calibrate a single, named head.
All 1 Calibrate all defined heads.
Dot 3 Not yet implemented. Recalibrate dot.
Fiducials 2 Not yet implemented. Recalibrate fiducials.
Weight 4 Calibrate weight for named head.
Circle n/a n/a not applicable
Delay Absolute or blank 0 Delay for specified on time.
Mark 1 Mark current time.
Limit 2 Limit delay at least On Time ms since last mark.
Entry 3 Delay override at Entry station.
Exit 4 Delay override at Exit station.
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Table 72: SubTypes & SubOps by Operation (Continued)

Operation SubOp Sub Type Code Description
Dot XMajor 0 For array of ordinary dots only [see Dot (pg 5.111) sam-
ple].

YMajor 1 For array of ordinary dots only [see Dot (pg 5.111) sam-
ple].

XStagger 2 For array of staggered dots only [see Dot (pg 5.111)
sample].

YStagger 3 For array of staggered dots only [see Dot (pg 5.111)
sample].

Circular 4 Not currently functional; circular array.

Line Direct or blank 0 Start a line at first point by moving to the defined point
and dispensing a line defined by X, Y.

Fast 1 Start a line at the nearest point.

Move Relative or blank 0 Normal relative move. The head moves to coordinates
relative to the current board/subboard.

Special Locations 1-3 The head moves to Special Location 1, Special Location
2, or Special Location 3.

Incremental 4 Move incremental.

Tilt Minus 5 VCI move tilt minus.

Tilt Plus 6 VCI move tilt plus.

Calib Forwd 7 Tilts tilt fixture forward to calibrate.

Calib Rearwd 8 Tilts tilt fixture rearward to calibrate.

Operate Test 0 Operate 1/O controls. Used as on/off controls for devices
such as UV wand, etc.

Probe 1 Operate probe, finding product Z height at specified
coordinates. Tests the measured elevation against a set
of Z Probe Limits (pg 3.139). Reset Z coordinate.

--- 2 Obsolete.

--- 3 Function without an assigned name. Operate input/out-
put. Skip for success.

Halt 4 Halt and cancel the program.
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Table 72: SubTypes & SubOps by Operation (Continued)

Operation SubOp Sub Type Code Description
Operate Pick 5 Operate pickup head to perform part pickup; incremental
(continued) approach; skip for success.

The selected head is moved to position (X, Y), the piggy-
back dropped as needed, and the head moved to Settle
Z. The head is then moved to Start Z, Pickup control is
turned on, and after a delay of On Time, the head is
moved to End Z and Pickup_Sense is tested. If Pickup_-
Sense fails, this will be repeated up to X Count times
before declaring total failure. Total failure turns off Pickup
control and issues Message R26, allowing the operator
to continue or to abort. If the test is successful, Y Count
program lines are skipped.

Place 6 Perform part placement operation with pickup tool with
blow-off, pressure; skip for failure or success.

The selected head is moved to (X,Y), the piggyback is
dropped as needed, and the head moves to Settle Z.
The head then moves to Start Z, Pickup is turned off, and
after a delay of On Time, Release_Cltl is actuated. The
time used for blow is controlled by Valve Prime.
Release_Cltl is turned off, and then the head moves to

End Z.

Z Test 7 Test for missing/present part using test probe. Skip if in
range.

DotTest 8 Test for presence of a dot using the vision system; skip

for success.

Uses the result of a PICTURE operation to test for the
presence of X Count blobs. If the specified number of
blobs is present, the next Y Count program lines are
skipped; otherwise, all program lines are executed.

No Probe 9 Suppress all auto-probe operations.

Prog Pause 10 Pause program for operator action. Displays a program
pause message. Safety violations do not cancel the run,
allowing the operator access to the work area. The oper-
ator can continue the run or cancel it. Custom versions
of this function can be created with unique messages.

Set Flag 11 Set a flag in the current flag word. Each board has an
associated set of 31 status flags (hnumbered 1-31) that
can be set/reset to indicate status conditions on the
board. These flags are transported with the board on a
multi-gantry system. All flags have the initial value 0 for
the board at the first (A) gantry. Set Flag sets flag num-
ber (X Count) to on if X Count is less than 0 or to off if X
COunt is greater than 0. The flag can be tested subse-
quently with the Test Flag sub-operation.
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Table 72: SubTypes & SubOps by Operation (Continued)

Operation

SubOp

Sub Type Code

Description

Operate
(continued)

Test Flag

12

Test a flag in current flag word by testing the flag number
(X Count). If X Count is greater than or equal to 0 and
the addressed flag is off or if X Count is less than 0 and
the addressed flag is on, the next Y Count program lines
are skipped; otherwise, all program lines are executed. If
X Count equals 0, Y Count program lines are skipped
unconditionally.

Picture

13

Take a picture with the camera at (X,Y) and begins a
blob analysis. This operation is normally followed by a
Dot Test operation to determine whether an acceptable
number of blobs are present.

Parameters for the analysis are determined by the vision
pattern associated with the Picture operation:
Light On Dark ....Y/N: Y = light on dark
NumBlobs ......... 1-50: Max number blobs found
LowGray ........... 1-254: Detection level for 0
HighGray .......... 1-254: Detection level for 1
MinArea ............ Minimum blob area (pixels)
MaxArea ........... Maximum blob area (pixels)
BlobRatio .......... Less than 1.0: Measure of elonga-
tion

Advance Feed

14

Advance current pallet.

CIn Needle

15

Clean needle for current head.

Purge

16

Purge current head and then clean the needle.

Set Lens

17

Adjust lens by setting camera parameters:

» Gain to X Count if Use Camera Adjust is true and X
Count is between 0 and 255.

» Offset to Y Count if Use Camera Adjust is true and Y
Count is between 0 and 255.

» Focus to Fill Spacing if Fill Spacing is less than -1.

» Zoom to Scale Factor if Scale Factor is less than -1.

Press

18

Perform place operation with pickup tool by moving the
gantry down slowly until a pressure head registers the
pressure specified by the head. Pressure is maintained
for On Time seconds.

19

Function without an assigned name. Searches the cur-
rent field of view for a camera/lens/light/trained pattern.
Pattern name is the subop type. If the pattern is found,
the next Y Count lines are skipped; otherwise, all pro-
gram lines are executed. For a fixed upward looking
camera, Z will move where taught in Base Locations for
pattern training and searching

Air Off

20

Turn air off to current head.

21

Park head.

Mixer Reload

22

Reload the mixer valve.

Probe Setup

23

Initiate (VCI) probe operation.
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Table 72: SubTypes & SubOps by Operation (Continued)

Operation SubOp Sub Type Code Description
Operate Probe Part 24 Probe part without fixture rotation and save values.
(continued)
Probe Reset 25 Reset (VCI) probes.
Probe Skip 26 Probe tilted (VCI) part and skip lines.
Set Reject 27 Flag current board as Reject.
Index Probe 28 Index tilt part location.
Tilt Home 29 VCI home tilt fixture.
Tilt Forwd 30 VCI tilt forward.
Tilt Rearwd 31 VCI tilt rearward.
Mark Repeat 32 Mark start of repeat prior scan/probe.
Jump Repeat 33 Jump to repeat mark, prior scan/probe.
Inspection 34 Test for dot inspection needed; then inspect within
range.
Dot Size 35 Obsolete. Get dot size; does nothing with dot size.
Dot Inspect 36 Obsolete. Unconditional (without dot range set by cali-

bration mirror) dot inspect within range.

Flip 37 Flip and process second side of board.
Ctr Set 38 Set/Reset a counter.
CtrInc 39 Increment/Decrement a counter.
Ctr ValueLE 40 Test a counter less than or equal to a fixed value.
Ctr TestLE 41 Test a counter less than or equal to another counter.
Ctr Show 42 Select a counter to display.
CtrValueG 43 Test a counter greater than a fixed value.
Ctr TestG 44 Test a counter greater than another counter.
Resume Pt 50 Suspend program execution and resume it at a later
point in time.
Partition Optimize or omitted | 0 Partition can be optimized.
Fixed 1 Partition cannot be optimized.
Rectangle Center 0 Locate by center.
Corner 1 Locate by lower left corner.
Center/out 2 Center, spiral out.
Corner/out 3 Lower left corner, spiral out.
Center/in 4 Center, spiral in.
Corner/in 5 Lower left corner, spiral in.
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Table 72: SubTypes & SubOps by Operation (Continued)

Operation SubOp Sub Type Code Description
Setup Stand Off 0 Set a standoff. Moves the camera to the (X,Y) coordi-

or omitted nates of the setup line and asks the operator to place a
stand-off in that location. This feature should be used
sparingly since placements require significant operator
time.

Reset Pallets 1 Reset all pallets to start locations.

Raise Lifter 2 Raise lifter plate.

Lifter Down 3 Lower lifter plate.

Entry Delay 4 Set entry station delay.

Exit Delay 5 Set exit station delay.

Skip Calibration 6 Skip calibration.

Cancel MixLd 7 Cancel the AlwaysLoadMixer option.

No Stretch 8 Cancel fiducial stretch calculation.

Auto Purge 9 Valve purge during program run (inline applications).

--- 100-199 Reset specified pallet, alter pallet configuration 0-99.

--- 200-299 Alter pallet advance information 0-99.

shapename | XMajor 0 For array of ordinary shapes only.

XStagger 1 For array of staggered shapes only.

YMajor 2 For array of ordinary shapes only.

YStagger 3 For array of staggered shapes only.

--- 100-199 Ignore CoordX, CorrdY; use pallet coordinates 0-99.

--- 200-? For future use.
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Legacy Controls & Operations

This section includes all content related to the legacy Emergency Stop and Power Off controls
previously located on the front control panel of the dispense system.

Which Control Panel Does My System Use?

Use this chart to determine which version of controls your system uses:

This is the current version. It uses these con-
trols:

» Emergency Stop

* Power On

* Power Off

Ignore this Legacy Controls & Operations sec-
tion.

Which front panel is on your system?

This is the legacy version. It uses these con-
trols:

* Motion Stop

* Power On

» Emergency Stop

Use this Legacy Controls & Operations section
when directed here at pertinent points in this
document.

LEGACY

As of June 2017, these hardware and terminology changes went into effect:
» Emergency Stop was replaced with Power Off.
» Motion Stop was replaced with Emergency Stop.

Legacy Contents

+ Power On (pg 5.121)
+  Power Off (pg 5.121)
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Power Off

References

To power on the machine:

1.
2.
3.

Read all safety and operating instructions prior to operating the machine.
Verify the red Emergency Stop button is pulled out.

Turn on the machine by pressing the green Power On switch. The system will prompt you
to home the XYZ gantry when you turn on the power and the booting process has finished.
The system must complete the homing sequence before other operations are possible.
Refer to Home the System (pg 2.1).

Before powering off the machine, end any active program and perform a proper shutdown
described in the following procedure:

Prepare for Shutdown

Before you can perform the shutdown procedure, you must end any active program. It is also
recommended that you unload all product from the dispense area and remove and clean the
heads.

To prepare for shutdown:

1.

Shutdown

The machine can be left powered on as long as the safety system has not been bypassed,
however, GPD Global recommends that you power off equipment when it is not in use.

5/18/18

Stop program execution with one of these methods:
— If the Mount Board prompt is displayed, click ABORT, or
— Click CANCEL on the main button bar.

After the program has ended, remove all product from the dispense area. For details, refer
to Unload Product (pg 5.8).

Unload all heads (valves and tools):

a. Click REFRESH on the main button bar to move the gantry to the front of the machine
where you can access the heads.

b. Remove the heads. For details, refer to Mount Heads (pg 5.1).

c. Clean the heads. For details, refer to head cleaning instructions detailed in Valves
under CLEAN in the Periodic Operations section of the Dispense System Service
Guide.

To shutdown and power off the machine:

1.
2.

Perform the Prepare for Shutdown (pg 5.121) procedure.

From the main menu bar, click on Operations > Shutdown System. A shutdown verification
prompt displays.

Click YES to shutdown the system or CANCEL to abort the shutdown. Wait until a System
Stopped prompt displays.

Power off the machine by pressing the red Emergency Stop button.

Perform the Lock-Out (pg 5.122) procedure.
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Energy Isolation Procedures

Lock-Out
A CAUTION ACAUTION
uum:um Wear
ety protective
et gloves.
Jrotes et opveigny

To ensure energy isolation, lock-out the equipment:

Turn off customer-supplied Lock-Out switch.

Turn off main power switch.

Install a lock or tag per your facility energy isolation procedures.

Test if system will start by pressing the Power On switch.

o & D=

Test volt meter on known voltage source:
— Test for presence of electrical power at TB1 and TB2 or at EMI Filter inlet L1 or L2.
— Reconfirm volt meter on known voltage source.

Release Equipment from Lock-Out

MACAUTION A CAUTION
u:-m::um Wear
— protective
T gloves.
e s

To release equipment from customer-supplied Lock-Out switch:

Remove all tools, parts, and materials from the system.

Verify any and all work to ensure proper installation, polarity, connection.

Close all doors, covers, and shields.

Using facility-specific procedures, remove customer-supplied locks and/or tags.
Pull out the Emergency Stop button.

Ensure the power cord is connected.

Turn on main power switch, watching for electrical or other failure.

© N o g~ w0 DD =

Follow the Power On (pg 5.121) procedure.
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6 System Management

This chapter discusses various utilities requiring a top level password for access, account
management topics, the routine maintenance of performing various types of backups, and
how to boot the system.

*  Security (pg 6.1)
*  Account Management (pg 6.2)

« Administrative & Housekeeping (pg 6.5)
* Routine Backups (pg 6.13)

+ Troubleshooting (pg 6.28)

Security

Access to various system features is controlled by unique, user-defined passwords that
protect unauthorized use of the access rights assigned to a user name. Because any combi-
nation of access rights can be assigned to any user name, passwords are typically supplied by
the person who administers the system.

Whenever the dispenser is powered on, the default password in effect allows minimal access
(at the Operator level) to the system.

Passwords & Access Rights

Following are some of the advantages of using Passwords & Access Rights Library (pg 5.13):

* An administrator can set up different areas that various operators can use.

» Each operator can have customized functions.

* The system keeps track of who is logged in and their operations.

» Add or delete a user name, change access rights for a user name, or change the pass-
word for a user name.
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Account Management

Notes

Notes is a text facility available to all users. This feature can be used, for example, by an
operator to leave notes for the system engineer, technician, or the next shift.

Review Notes
Use the View Notes window to review and/or delete notes from the system by date or by
operator. Notes are displayed in the right hand panel of the View Notes window. The operator
who created the note and the date and time the note was created are listed in the left hand
panel.

Liser Notes
By Date/Operatar

D PV R X N T T | (.o o CGPD s Dispenser Software
Selection panel =

L]

Display panel -

oK | Delate

To view and/or delete a note:
1. From the main window menu bar, click Utilities > Notes > View Notes.

2. Click on the date/time/operator details of the note you wish to read or delete. The associ-
ated note text will display in the right hand panel.

To delete the selected note, click DELETE.

4. To exit the window and accept a deletion, click OK; otherwise, click CANCEL to exit with-
out changes.

Add Notes
The current user name, date, and time will be assigned automatically to each new note. Each
note may contain up to 2,000 characters.

To add a note:
1. From the main window menu bar, click Utilities > Notes > Add Notes. Notes displays.
2. Click inside the blank screen area and then type desired text.

3. Click OK to save the note or CANCEL to exit without saving it.
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Management Info

The dispenser system can be set up to collect data about each run of a process. Once data
has been collected, reports can be generated to disk or a printer.

Periodic data purges are also necessary to prevent filling the computer hard drive.

Job Accounting
The job accounting feature must be turned on in order for the system to collect record details
about each job run. There are two types of data that can be collected: job accounting data
(including start/end times, elapsed operation, elapsed idle times, material, material usage,
etc.) and error log information.

Items in the Operation pane
that apply to Job Accounting

...................... ]
irge Interval I 1| 4R JN
when Idle ; W ob Accounting ' e o

1 L
4-Furge Delay |} | 1 Days Log Retantion o a¢ ae
C > : -J Jd0 g
er i i JE R
—_'_J " Tirme Belwaen iF 4%

Ha Backup Reminders
J a7
slacity

To turn on job accounting:

1. From the main window menu bar, click on Configuration > Option Settings to access the
Option Settings window.

2. Turn on the Job Accounting used button located in the Operation pane.

Enter a value in Log Retention. This determines how many days error log information is
retained. If you do not enter a value, the default entry (0) will retain error log data indefi-
nitely, which could potentially cause a hard drive memory problem.

4. Click OK to accept changes; you will be prompted to reboot the machine to make the
changes take effect. Click CANCEL to erase any changes made, making a machine
reboot unnecessary.
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Report Generation
When the job accounting feature is turned on, it may be necessary to generate periodic
reports from the collected data. To generate a report of job accounting data:

1.

From the main window menu bar, click on Utilities > Management Info > Show Job Info.
The Interim Report Generation window displays.

Program MName I
{Blank for ALL programs) |-Fa”:’E T

Operator Mame :
(Blank for ALL operators) [iservice
Report this marny days back
i0 to use date below] o

“ear honth  Day

Earliest date an report "
(Unused if Tays Back’ |3 nonzera) | ELL | 3 15

“# Print to Disk + Data to Disk +~ Print to Printer

ok | Cancl|

Make the appropriate entries in the Program Name, Operator Name, Report This Many
Days, and Earliest Date fields to generate the desired report. For details about how to use
each field during the reporting process, refer to Interim Report Generation in the Windows
& Fields section of References.

Select only one of the output features: Print to Disk, Data to Disk, or Print to Printer.

After all sections are made, click OK to generate a report, or click CANCEL to exit without
generating a report.

Purge Accounting Data
Data continues to accumulate, so it must be purged occasionally or else the system may
become sluggish, particularly when powering on. Data may be selectively purged.
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Although purging is normally the job of the system engineer or administrator, the operator can
be authorized to perform this function.

To purge accounting data:

1.

From the main window menu bar, click on Utilities > Management Info > Show Job Info.
The Interim Report Generation window displays.

Enter or select the appropriate items to purge the obsolete data. For details about how to
use each field during the purge process, refer to Interim Report Generation in the Win-
dows & Fields section of References.

After all selections are made, click OK to purge the file, or click CANCEL to exit without
purging.
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Administrative & Housekeeping

Message Logs

Logging is an engineering tool that collects various types of system and user messages for
purpose of analyzing machine performance, process results, failure rates, etc. and exporting
the message logs to a spreadsheet.

Logging flags, also referred to as logging classes, determine which logging messages are
saved. A single class or any combination of classes can be selected when you set up the
system for log retention. The system will collect every instance of logging message for each
type of logging class selected.

After the system has collected logging data, the user retrieves the data from the dispenser via
an export file which, after some minor format modification, can be used for data analysis.

Set Up Logging

5/18/18

Prepare the dispenser to capture the logging data you want gathered:
1. From the main menu bar, click on Configuration > Option Settings to open Option Settings.
2. Turn on Job Accounting.

3. Enter avalue in Log Retention.
NOTE: To ensure logging files are purged periodically, it is strongly recommended that
you enter a value of 1 or 2 in order to limit collection to a one or two day period. Logging

data collection dramatically increases the size of data backups and exports. If Log
Retention is left as zero, logging files are never purged.
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4. From the following list of logging classes, select each class applicable to the types of data
you want to track.
RULE 1: The “I” logging class must be used in order for logging to be active.

RULE 2: Multiple logging classes may be selected.

Table 73: Logging Classes

Description Log Class
Air or safety problem A
Calibration errors Cc
Operator errors E
Hardware failure H
Information to operator |
Maintenance M
Operator instructions (0]
Program errors P
Results R
System errors S
User messages U

For further details about log classes, refer to Option Settings
in the Windows & Fields section of References.

5. Click OK to accept changes and close Option Settings.

6. For changes to take affect, perform a normal machine shutdown and then power on the
system. For details, refer to Power Off and Power On in the Basic Operations section of
the Dispenser Operator Guide.

7. When it is time to retrieve collected logging data, proceed with the following Retrieve Log-
ging Data procedure.

Retrieve Logging Data
To retrieve logging data captured by the dispenser, export the data to a file:

1. Atthe main menu bar, click on Utilities > Import/Export > Export. Data Export displays. For
more details about using export data, refer to Export Data in the Existing Programs section
of Operating Instructions.

At the Export File Name field, type in a file name.
Turn on the Error Log box.
Turn on the Export ALL FIELDS box.

Click the EXPORT button at the bottom of the window. A text file will be generated that can
be viewed in various Windows platforms.

o M 0D

6. Modify the format of the exported file using the following Format Logging Data for Analysis
procedure.
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Format Logging Data for Analysis
The exported file generated by the dispenser export process can be viewed as a text file on a
Windows system. The following is an example of how this information can be prepared in a
usable format for various analytical end uses. Also see Logging Custom Data (pg 6.8).

To format the exported logging data:
1. Using Microsoft Excel, open the logging data file exported during the preceding Retrieve
Logging Data procedure.

Before Deletion
Delete the SFORMAT cell so the header row will move into proper alignment with the data columns.

IGant RECID CurTime Program LogLy
029 152.9 128005 1 1 515: Live Cami
31030 1:05.0 1280Hs 1 I S15: Live Cami
3103 51:20.8 1280Hs 1 R C34: Z Touch
3103 51:23.2 1280HS 1 I S15: Live Cami
31033 51:39.0 128B0HS 1 R C34: Z Touch
31034 31:41.5 12BOHS 1 I S15: Live Cami
21035 51:57.3 1280HS 1 R C34: Z Touch
31036  51:59.9 1280HS 1 I 515: Live Cami
31037 52:15.8 1280Hs 1 R C34: Z Touch
31038  52:18.5 128B0HS 1 I s15: Live Cam

After Deletion

The header row is now properly aligned with the data columns.

BERRLOG IGant REeCID CurTima Frogranm LDgLE'-._-'E_'T
BERRLOG 1 31029 47:52.% 12B0HE 1 I =l5: Live Came
BERRLOG 1 31030 51:05.0 12B0HS 1 I S15: Live Came
BERRLOG 1 31031 51:20.8 12B0HS 1 R C34: Z Touch
AERRELOG 1 31032 91:23.2 1280HS 1 I g15: Live Came
BERRLOG 1 31033 51:39.0 12B0HS 1 R C34: Z Touch
BERRLOG 1 31034 51:41.5 12B0HS 1 I S515: Liwve Came
BAERRLOG 1 ENRVES 31:57.3 12B0HE 1 R C34: Z Touch
BERRLOG 1 31036 51:59.9 12B0Hs 1 I S15: Live Came
BERRLOG 1 31037 52:15.8 12B0Hs 1 R C34: Z Touch
BERRLOG 1 31038 52:18.5 128B0HE 1 I S15: Live Came

2. When presented with formatting choices, select Delimited and then Comma.

3. Locate the rows of information applicable to the error log and delete the single cell with
contents of “@Format” (refer to the illustration below). This deletion will allow the columns
of the header row to align properly with the data columns.

4. Save the results. The data is now ready for analysis. Use the Import/Export Data Refer-
ence Guide as an aid when analyzing the logging data.
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Logging Custom Data
In effect as of FLOware software version 2.5

You may customize the format file used to export desired data from the machine. The
following step-by-step procedure explains how to export both Probe data and Scale data; this
data is often needed in order to chart machine and/or process performance.

In summary, a single format file can be customized to gather the information for both the
Probe and the Scale functions because:

+ each time the program takes a probe reading, the X, Y, and Z-axis positions are recorded
and saved in the data base under the data base names ErrValue, ErrTarget, and ErrCor-
rection, respectively, and,

« similarly, each time a weighing function is performed, the actual weight, target weight, and
percentage of correction are saved in the data base under the same respective data base
names: ErrValue, ErrTarget, and ErrCorrection.

For a complete and detailed explanation of these functions, refer to the Import/Export Data
Reference Guide for FLOware Software.

Customize Export Format File

To customize the export format file to include both Probe and Scale data, proceed through all
of the following steps in the order listed:

Step 1 - Enable Log Classes

To enable the Log Class in the Option Settings Window:

1. From the main menu bar, click Configuration > Option Settings.

2. Select R and I in the Log Classes pane.
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3. Enter the desired number of days over which you wish to retain the log data in the Log
Retention field.
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Step 2 - Customize Format File

To customize a Format File:
1. From the main menu bar, click System Functions > Shell.
2. Atthe $ prompt, type vedit exform and press Enter.

3. Press Alt+F to display the file menu across the top of the Shell window.
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4. Click on Select File > Save_As as shown in the following image.

uffer switch...
Nex | buffer
Pre ious buffer

F4
Alt-T

rint...

Alt-P

nable edit restore
E it (saverabandon)

Alt-X

L
PFORMAT ,, *OFFLINE, IGant, MountLoc, Head, Hatlld, Program, WtUalue, WtOnTime, WtO

Jl

Wlass, PattDescr, PattCode. Cam Select, Camera
Head Tupe, OffsetX, OffsetY. OF £, StandOffX,
lebescr, HeedleCode, HeedleStyle, HeedleType, Gauw
scr, lGant, ReadlD, CtlID, SampleTime, Proportion
; NeedlelD, Pattern, FeaturelD, Color, MatGroup,
oc; Head, NeedlelD, Pattern, MatlID., FeaturelD, C
adfZ, Safetyd, SafetyY¥., SafetyZ, ParkX, Park¥, Pa
cword, PassType, DelPasswrd, Dspllogin, ServiceCl
Type, Xname, SubTypeDescr, SubTypeCode, HessageNo
wm, LoginNm, EndTime, StartTime, LotNo, LotType,
; SWWer, MachMame, LastBackup, LastInfo, LastPouw(
ant, FidHamel, FidHameZ, FidNamed, FidName4, FixD
, 3Type, Co, C1, 10, I1, Fo, F1, Bo, Bl
» LogClass, HsgText, CurTime, IGant, LogLevel, Er
atPIDname, PostHeatPIDname, WorkfAreaP IDname, Hod
pe, XrefDescr, Xref Type
» Hotelnfo
, HeedlelID, OnTime, StartZ, EndZ, Hovelel, Appro

isc earch indow wtor ser onfig

5. Save the file as /home/dispenser/probeform

6. Delete all lines except the RFORMATW@ERRLOG line.

7. From within the eFORMATQ@ERRLOG 1ine, delete all the data base names except
Program, Curtime, ErrValue, ErrTarget, and ErrCorrection. Use the following image as

a reference.

LINE: 1 COL: e
JFORMAT , PERRLOG. Program. CurTime, Errlalue, ErrTarget, ErrCorrection, g

8. Save your changes by pressing the ESC key, X for eXit, and Y to save all.

Step 3 - Restart Machine

Restart the machine.

Step 4 - Run program

Run your program(s) that uses the probes, or weight scale, or both. Logging data will be

generated.

Step 5 - Export Customized Data

To export your customized data:

1. From the main menu bar, click Utilities > New Export.
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System Management

Type the export file name in Export File using the correct file path for the type of media
you have available:

« /dos/a/ for floppy diskettes
« /dos/c/ for USB device

To use the custom format file you created, type probe form in the Format File field.

Select Error Log as the only data you wish to export.

Click on the Export button and view the data in a spread sheet at your desktop PC. Use
the following image as a reference.

5/18/18
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Installing & Upgrading Software

Installation of software on the dispenser, whether for upgrade or recovery purposes, is
detailed in documentation separate from this manual.

Software Upgrades
FLOware software, the system control software, can be upgraded incrementally from its
current version to more recent versions, one upgrade at a time.

A software upgrade is installed using the Utilities > Install Update function found in the main
window menu bar. The files needed to perform an upgrade are available from the GPD Global
Service Department.

NOTE: Detailed instructions for upgrading the control software are provided in software
version-specific editions of Upgrading FLOware Software (p/n 22100086).

Software Installation
The most current version of the system control software (FLOware software) and all other
system software needed to operate the dispenser are installed at the factory.

Should the software system become inoperable due to factors such as a corrupted hard drive,
the system software can be re-installed and data can be restored provided the necessary
backups are available.

NOTE: Detailed instructions for performing the recovery process are described in the
Dispenser Software Recovery (p/n 22100109CD.29) document.
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Routine Backups

5/18/18

as of FLOware Software ver 2.8 - 2.9i

« Backup Reminder (pg 6.14)

+  Data Backup (pg 6.15)

«  Application Backup (pg 6.18)
+  Full System Backup (pg 6.25)
+ FAQs (pg 6.27)

The importance of making routine backups can not be stressed enough. There is a saying
among computer users, “If you don’t do backups now, you will in the future.

WARNING GPD Global is NOT responsible for loss of configuration or programs if current

backup is not available.

ADVERTISSEMENT | ACHTUNG AVVERTENZA ADVERTENCIA
GPD Global n'est PAS | GPD Global haftet NICHT | La GPD Global Global | GPD Global NO

It is an inevitable reality that the primary hard disk will crash. Reasons underlying a system
failure can range from a simple hard disk mechanical failure, data corruption due to outside
causes such as electrical spikes or abnormal vibration, memory overload, to other causes that
may be related to an operating system malfunction or software glitch.

The good news is that the system is well equipped with a variety of methods that minimize
production down time as a consequence of a failure; thereby also alleviating panic for the
responsible engineers.

Table 74: Backup Types Described

Backup Type Description
Data Backup A data backup from any FLOware software LATER than ver. 1.5b:
(pg 6.15) « contains all essential configuration and calibration as well as all customer pro-
grams.

« can be restored on any version of software later than 1.5b.

A data backup from any FLOware software EARLIER than ver. 1.5b can be restored
only on the same machine at the same software level as the backup.

Application An application backup from any version of FLOware software contains all GPD
Backup (pg 6.18) | Global-supplied software in addition to all essential configuration and calibration
information. When an application backup is restored, the dispenser reverts to the
software level of the backup.

Full System A full system backup contains all dispenser software including the QNX operating
Backup (pg 6.25) | system, X-Windows system, Sybase data base, and all material from the application
backup.

To ensure uninterrupted operations, always perform a backup before and after a software
update in addition to periodic back ups. GPD recommends implementing the Backup
Reminder (pg 6.14) feature to automatically remind you to perform periodic backups.

Backups may be performed by whoever is responsible for this function at your facility, be that
an operator, engineer, or administrator.
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Backup Reminder

By recording the last time a backup was made, the backup reminder feature serves as a
repeating reminder to perform a backup. All backup types (Data Only, Application, and Full
System) will automatically reset the backup reminder feature; however, use of the export
feature has no affect on the backup reminder.

System Management

NOTE: The backup feature does not perform the backup for you; it only reminds you to do

SO.

EXAMPLE: If you enter a value of 2 in the Time Between Backup Prompts field and 14 in
the Time Between Backup Reminders field, then an initial reminder will display 14 days after
the last backup with subsequent reminders continuing to reappear every second day there-

after until a backup is performed.

Activate Backup Reminder
To activate the backup reminder feature:

5/18/18

1. From the main window, click Configuration > Option Settings.

2. In the Operations panel, enter a value in both fields: Time Between Backup Prompts and

Time Between Backup Reminders.
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4. As needed, perform regular backups. All backup choices will automatically reset the Time
Between Backup Reminders field. If you do not perform regular backups, the reminder
message will prompt you to do so.

FLOware Software Guide

6.14



GPD Global®

System Management

Data Backup

A data backup includes:

all machine configurations,
IO configuration,

Servo Files, and

System files

Additionally, all current data used by the machine is saved:

Programs Classes Management Info Error Log
Shapes Programs Notes Management Info
Materials Needles Fixed Locations Base Info
Material Defaults Vision Patterns Universal Options Base Locations
Heads Cross References SubTypes internals

A data backup excludes:

operating software such as FLOware operating software, X-Windows, SYBASE, and QNX
operating systems.

Data backups can be saved to floppy diskettes or a USB device.

Data Backup to USB
To create a data backup on a USB device:

5/18/18

1.
2.

Change the system password to an access right that permits access to Configuration.

From the main menu bar, click Utilities > Backup > Data Only. A prompt displays in the
GPD-Data Backup window:

GPD Global Dispenser Data Backup
Back up to USB Device? (Y/n) y

Press ENTER to use the default backup directory /dos/c/
Backup; Otherwise, enter the name of the desired directory:

Choose either the typical response of using the default Backup directory by pressing
Enter, or, if a different name is desired, enter it now; a directory with the new name will be
created automatically on the USB device.

Current Backups are:
The system lists all backups in the selected directory.

Enter a file name for this backup: filename
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4. Enter a file name avoiding the use of spaces, dots, and extensions. Name length is not
limited.

Do you really want to perform a Data Backup
To /dos/c/Backups/filename (Y/n) y

The system begins the backup. Ignore the following error (this information is for GPD
Global use only).

Pax: /etc/samba.setup : No such file or directory
Pax: /etc/start.tcpip : No such file or directory
The system finishes the backup with:

R S S 4

Remove the USB device

Remove all USB storage devices now.

Remove all USB storage devices now.

Remove all USB storage devices now.

5. Remove the USB device from the machine (or the system will continue repeating the
prompt). The following prompt displays:

Backup Complete
Bkset: DB connection
Done Press Enter to Continue

6. Press Enter to exit the Data Backup window.

5/18/18 FLOware Software Guide 6.16



GPD Global® System Management

Data Backup to Floppy Disk
To create a data backup on floppy disk(s):

1. Change the system password to an access right that permits access to Configuration.

2. From the main menu bar, click Utilities > Backup > Data Only. A prompt displays in the
GPD-Data Backup window:

GPD Global Dispenser Data Backup
Back up to USB Device? (Y/n) n

Do you really want to perform a Data Backup to /dev/fd0 (Y/
n)? vy

The machine begins preparing for the backup and leads to the following prompt:
Do you want a reloadable backup on QNX disks? (y/N) vy

A reloadable backup simply refers to a backup from which you can restore while at the
machine.

3. Ignore all error messages preceding the following information and prompt:
Total archive size is: 1924 k (size will vary)
Requiring about 1 disk(s).

Do you need to format some floppies now? (y/N) y

4. ALWAYS format the number of disks suggested by the machine. After formatting all disks,
the following prompt displays:

Vol: When drive light goes out insert disk 1 and press return

When the backup is complete, the following prompt displays; this prompt is for GPD
Global factory use only.

Do you want a non-reloadable backup on a DOS/Win disk? (y/N)
n (Non-reloadable backup is used only by GPD Global factory.)

Remove last backup disk
Write Protect all disks. Then press Enter to continue.

5. Press Enter to exit the Data Backup window.
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Application Backup

An application backup includes everything included in a Data backup plus the current version
of FLOware operating software. Application backups can be made on floppy diskettes, USB
devices, or on the primary hard disk /HDO of the machine.

Application Backup to USB (pg 6.18)

Application Backup to Floppy Disk (pg 6.20)

Application Backup to Slave Hard Drive: /hd1 (pg 6.22)
Application Backup to Primary Hard Drive: /hd0 (pg 6.23)

Application Backup to USB
To create an application backup on a USB device:

5/18/18

1.
2.

Change the system password to an access right that permits access to Configuration.

From the main menu bar, click Utilities > Backup > Application. A prompt displays in the
GPD-Data Backup window:

GPD Global Dispenser Application Backup
Back up to USB Device?(Y/n) vy

Press ENTER to use the default backup directory /dos/c/
Backup;

Otherwise, enter the name of the desired directory:

Choose either the typical response of using the default Backup directory by pressing
Enter, or, if a different name is desired, enter it now; a directory with the new name will be
created automatically on the USB device.

Current Backups are:
The system lists all backups in the selected directory.

Enter a file name for this backup: filename
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4. Enter a file name avoiding the use of spaces, dots, and extensions. Name length is not
limited.

Do you really want to perform an Application Backup
To /dos/c/Backups/filename (Y/n) y

The system begins the backup. Ignore the following error (this information is for GPD
Global use only).

Pax: /etc/samba.setup : No such file or directory
Pax: /etc/start.tcpip : No such file or directory
The system displays the following prompt to indicate the size of the backup:
Each dot is 10 seconds, 40 dots per line.

The system finishes the backup with:

R S S 4

Remove the USB device

Remove all USB storage devices now.
Remove all USB storage devices now.
Remove all USB storage devices now.

5. Remove the USB device from the machine (or the system will continue repeating the
prompt). The following prompt displays:

Backup Complete
Bkset: DB connection
Done Press Enter to Continue

6. Press Enter to exit the Application Backup window.
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Application Backup to Floppy Disk
A typical application backup will require the use of 10 floppy disks, making this medium incon-
venient for this backup process. It is recommended that Application Backups be created on
either a USB device or the hard disk.

To create an application backup on floppy disk(s):

1.
2.

5/18/18

Change the system password to an access right that permits access to Configuration.

From the main menu bar, click Utilities > Backup > Application. A prompt displays in the
GPD-Data Backup window:

GPD Global Dispenser Application Backup

Back up to USB Device? (Y/n) n

Back up to backup hard disk /hdl? (Y/n) n

Backup is currently scheduled for placement on floppy disks.
Do you want to back up to the hard drive hd0 instead? (y/N) n

Do you really want to perform an Application Backup to /dev/
fdo (Y/n)? y

The machine begins preparing for the backup and leads to the following prompt:
Do you want a reloadable backup on QNX disks? (y/N) vy

A reloadable backup simply refers to a backup from which you can restore while at the
machine.

Ignore all error messages preceding the following information and prompt:
FEach dot is 10 seconds, 40 dots per line. ...

Total archive size is: 44266 k (size will vary, however, most application
backups will be close to the value shown here.)

Requiring about 10 disk(s).

Do you need to format some floppies now? (y/N) vy
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4. ALWAYS format the number of disks suggested by the machine. After formatting all disks,
the following prompt displays:

Vol: When drive light goes out insert disk 1 and press return
When the backup is complete, the following prompt displays.
Remove last backup disk

Write Protect all disks. Then press Enter to continue.

5. Press Enter to exit the Data Backup window.
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Application Backup to Slave Hard Drive: /hd1
To create an application backup on /hd1, the system slave hard drive:

1. Change the system password to an access right that permits access to Configuration.
2. From the main menu bar, click Utilities > Backup > Application Backup.

In the GPD - Application Backup window, respond to the prompts as follows:
Back up to USB device? (Y/n) n
Back up to backup hard drive /hdl ?(Y/n) vy
Enter a file name for this backup: xxxxxx
4. Enter the backup file name using letters and numbers only; do not use spaces.

Do you really want to perform an Application Backup to /hdl/
Backups/xxxxxx (Y/n)? y

5. At this point, the backup process begins. Near the end of the process, expect to see the
following messages:

Building Setup Files, please wait...
Backing up: Application Backup
To: /hdl/Backups/xxxxxx

Each dot is 10 seconds, 40 dots per line.

Bakup Complete
Bkset: DB Connection
Done: Press ENTER to continue

6. Press Enter to complete the backup process and exit the Application Backup window.
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Application Backup to Primary Hard Drive: /hd0
To create an application backup on /hd0, the system primary hard drive:

1. Change the system password to an access right that permits access to Configuration.
2. From the main menu bar, click Utilities > Backup > Application Backup.

In the GPD - Application Backup window, respond to the prompts as follows:
Back up to USB device? (Y/n) n
Back up to back up hard drive /hdl 2 (Y/n) n

Application back up is currently scheduled for placement on
floppy disks.

Do you want to back to the hard drive hd0 instead? (Y/n) y
4. when the following prompts display:

Press ENTER to use the default backup directory;

Otherwise, enter the name of the desired directory:

choose either the typical response of using the default directory by pressing Enter, or, if a
different name is desired, enter it now; a directory with the new name will be created auto-
matically and used to store the application backup.

Current Backups are:

The system lists all backups in the selected directory.

Enter a file name for this backup: xxxxxx

5. Enter a file name avoiding the use of spaces, dots, and extensions. Name length is not
limited.

Do you really want to perform an Application Backup to /hd0/
Backups/xxxxxx (Y/n)? y
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At this point, the backup process begins. Near the end of the process, expect to see the
following messages:

Building Setup Files, please wait...
Backing up: Application Backup
To: /Backups/xxxxxx

Each dot is 10 seconds, 40 dots per line.

Bakup Complete
Bkset: DB Connection
Done: Press ENTER to continue

Press Enter to complete the backup process and exit the Application Backup window.
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Full System Backup

5/18/18

A full system backup is a comprehensive backup of all data and all operating software
including FLOware operating software, X-Windows, Sybase, and QNX.

This type of backup can only be made on the slave secondary hard disk /HD1.

To create a Full System Backup:

1. Change the system password to an access right that permits access to Configuration.
2. From the main menu bar, click Utilities > Backup > Full System.

3. Take action according to which window displays:
Table 75: Slave Drive Condition Indicated by Window

Window Displayed Action Required
GPD - Full System This window indicates that the Slave Drive has been recognized. Continue
Backup with the standard instructions.
GPD - Application This window is likely to indicate one of the conditions listed below; inspect and
Backup resolve problem(s) and restart the machine until the system recognizes the
Slave Drive and displays the GPD - Full System Backup window during this
operation.

* The Slave Drive/Backup Hard Drive is not present on your machine.

* The cable connections to the Backup Hard Drive are faulty (scenario A) - The
Primary Hard Drive is connected to the MASTER cable connector on the drive
end and the EIDE Port 1 of the CPU board. The drive is jumpered as a Master
drive. This is recognized by the computer as the PRIMARY MASTER Drive.

GPD - Application * The cable connections to the Backup Hard Drive are faulty (scenario B) - The
Backup (continued) CDRom is connected with a separate cable at the Master connector end while
the Slave Hard Drive is connected to the Slave connector end of the same
cable. The other end of this shared cable will be connected to EIDE Port 2 of
the CPU Board. The CDRom will be recognized as the SECONDARY MAS-
TER DRIVE and will be jumpered as a Master while the Slave hard drive will
be recognized as the SECONDARY SLAVE and must be jumpered as a Slave.
Refer to the jumper settings shown on the drive itself if there is any question as
to the proper jumper configuration.

* EIDE Port #2 is not enabled in the CMOS Setup configuration.
* EIDE Port #2 is faulty on the CPU board.
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GPD Global Dispenser System Backup
OK to erase backup hard drive /hdl ?(Y/n) vy

4. The primary hard drive is /hd0, and the slave hard drive is /hd1. A complete wipe of the
contents of the slave drive is necessary prior to performing a full system backup, so

answer Y.

Do you really want to perform a System Backup to /hdl (Y/n)?
Yy

5. Normally, the drive has already been partitioned and checked so this will not be neces-
sary. If, however, the Slave Drive is brand new, the system needs to mount a partition and
perform a surface check. After this operation is completed, the system ends the backup
session. You must then start the full system backup again from the beginning.

Typically the machine will prompt:
Erasing backup hard drive /hdl.
Wait..

Press ENTER to continue

6. Press Enter. At this point, the system prepares to perform the backup and displays the fol-
lowing:

Beginning Backup

If any error messages are reported, record them exactly as
they appear and contact GPD Global service personnel

Wait
Pax: /Backups : No such file or directory

The above error message is common. It will always display if there are no application
backups found on the master hard drive. If this prompt displays, ignore it.

The full system backup can last anywhere from 5 minutes to 20 minutes depending on the
amount of data and the speed of data transfer. A typical backup usually takes 7 to 8 min-
utes.

CAUTION: Do not attempt to end the procedure in any way until you receive the following mes-
sage:

Backup Complete Bkset: DB Connection Done : Press ENTER to
continue

7. Press ENTER to end the full system backup procedure and exit the window.
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FAQs

Which type of backup will return the system to operational status as quickly as
possible?
GPD Global dispensers use a redundant database system to protect data stored in the
database from corruption. This method tests the database integrity at each boot. In addition,
backup utilities are included on the machine for creating off-line backups:

* A data only backup creates an external backup (either on floppy disk or USB [if equipped])
of all the unique files on the machine.

* An application backup creates an internal backup (on the same partition from which the
dispenser operates or a separate internal hard drive) of the FLOware control software.

« Afull system backup creates a backup of all the files on the primary drive to the secondary
internal drive which can restore the dispenser to operation using the included restore util-

ity.

Does a “data” backup contain enough information to restore the system to opera-
tional status after the OS is installed?
A data backup includes the complete database and redundant files (i.e., all information
entered into the editor for customer applications and high level configuration) and the configu-
ration files (boot files, network configuration [if applicable], machine specific configuration,
unique servo configuration [tunes and contour map]).

Same question as above for the “application” backup.
An application backup includes all the FLOware control software required to operate the
dispenser.

What are the key differences between the “data” and “application” backups?
A data backup contains all the unique information required for customer application(s) while
an application backup contains the files necessary to access the FLOware control software.

Is the backup hard drive a separate physical drive or a partitioned drive?
The backup hard drive is a separate physical drive.

Will physically replacing the hard drive with a “mirror” hard drive completely
restore the system?
Backup tools not included with the dispenser are not supported nor recommended for use.
The dispenser uses a specialized operating system that is not compatible with many such
tools which results in backups which cannot be restored.

How do we mirror the main hard drive to a hard drive that will be kept off site?
An excellent way to create a “mirror” of the primary drive is to use the full system backup utility
included on the dispenser. If an external system backup is desired or required, use the full
system restore process to create a second primary drive. The second primary drive can then
be stored externally.
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Troubleshooting

Boot the System

The boot sequence initializes the computer, loads the operating system, and implements
FLOware software programming changes. Typically, users will use the following Boot with
Shutdown procedure as a normal step in some procedures, such as teaching base locations.
Only in special circumstances will a user be directed to use the Boot with Reboot procedure.

Boot with Shutdown
Some FLOware software programming functions, such as teaching base locations, require the
system to be booted before changes will take effect.

To boot the system:

1. From the main menu bar, click on Operations > Shutdown System. A shutdown verification
prompt displays. Click YES to shutdown the system, or CANCEL to abort the shutdown.
Wait until a System Stopped prompt displays, then power off the system per the normal
power off procedure.

2. Power on the system per the normal power on procedure. Wait until the system has com-
pleted the boot sequence before proceeding with regular operations.

Boot with Reboot
The Reboot function is intended for use only by GPD Global personnel. In special instances,
the GPD Global Service Department may direct a user on the usage of this feature in order to
accomplish a particular objective. Booting the system using the Reboot function requires a
special access right which in turn requires a knowledge of the intricacies and variables
involved in working at this level of the control software.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

To reboot the system:

1. Change the password to an access right that permits access to System.

2. From the main menu bar, click on Operations > Reboot. A boot verification prompt dis-
plays.

Click YES to boot the system, or CANCEL to abort the reboot.

4. Wait until the system has completed the boot sequence before proceeding.

Software Recovery

Installation of software on the dispenser for recovery purposes is detailed in documentation
separate from this manual. For details, refer to Software Installation (pg 6.12).
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Appendices

NOTE: This section provides information which, for the most part, should only be used while
under the direct guidance of GPD Global personnel.

*  Units of Measure (pg 7.1)

* Machine Controls (pg 7.4)

+ System Functions (pg 7.7)

* 10 Viewer (pg 7.8)

« VEdit in Shell Windows (pg 7.12)

+ Interfacility Communications (pg 7.15)
»  Screen Grabber (pg 7.16)

Units of Measure

Global Default for Units

Global default settings control whether the control software displays field value units-of-
measure using the English system or the metric system. If necessary, these default settings
can be changed.

Valid units of measure can be found at Unit Abbreviations (pg 7.2).

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

To change the units-of-measure global default settings from the English system to the metric
system or vice versa:

1. From the main window menu bar, click on Configuration > Dispenser Configuration
(pg 3.135). The GPD - Edit Configuration window will display.

2. Scroll down until you find the following text.

DisplayUnits = n

WeightUnits = n

TemperatureUnits = n
Change the DisplayUnits value as needed: 0 represents metric, 1 represents English.
DisplayUnits determines which system of units is used to display distances, speeds, accelera-

tions, and most other numeric values. If not set, WeightUnits and TemperatureUnits will revert
to the same setting as used for DisplayUnits.
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Unit Abbreviations

Units-of-measure used in value fields can be displayed using the English or metric system.
This can be changed on the fly during field value entry or globally by changing default settings.

Units of measure can be entered at the same time a value entry is made. The units entered
need not be the same as the units displayed. The entered value will be converted properly and
displayed automatically when the entry is applied.

If a more global change is needed to the system of units, the global default settings may be
altered - refer to Global Default for Units (pg 7.1). The default settings for weight units and
temperature units can be set independently of all other display units (distances, speeds, accel-
erations, and most other numeric values), but are usually set to match. Contact the GPD
Global Service Dept. for further details.

Abbreviations recognized by the system for valid units-of-measure are defined in the following
table.

Table 76: Recognized Units-of-Measure Abbreviations

Aspect Valid Units Description
Acceleration mm/s/s millimeters per second squared
cm/s/s centimeters per second squared
m/s/s meters per second squared
in/sls inches per second squared
ft/s/s feet per second squared
Angular Acceleration rev/s/s revolutions per second
rev/im/m squared revolutions per minute squared
Angular Velocity rom revolutions per minute
rps revolutions per second
Angle d degree
(Object Rotation) deg degree
r radian
rad radian
grad gradient
rev revolution
Area sq_mm square millimeter
sq_cm square centimeter
sq_in square inch
sq_ft square foot
c_mil cubic millimeter
Distance nm nanometer (x 10-9)
um micron (micrometer) (x 10-6)
mm millimeter (x 10-3)
cm centimeter (x 10-2)
dm decimeter (x 10-1) 0.001
mil inch
in inch
“ inch
ft foot
‘ foot
Flow ml/sec milliliter per second
ccl/sec cubic centimeter per second

* Applicable to mixer valve only
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Table 76: Recognized Units-of-Measure Abbreviations (Continued)

Aspect Valid Units Description
Force kg kilogram
mg milligram
g gram
oz ounce
Ib pound
Pressure kPa kilo Pascal
Pa Pascal
bar Bar
psi pounds per square inch
mb millibar
in inch of Hg
mm millimeter of Hg
atm atmosphere
n/sqm Newton per square meter
Temperature C Celsius
c Celsius
F Fahrenheit
f Fahrenheit
R Rankine
K Kelvin
Time ms millisecond
S second
us microsecond
ns nanosecond
m minute
h hour
d day
Velocity mm/s millimeter/second
cm/s centimeter/second
in/s inch/second
mil/s mil/second
dm/s decimeter per second
m/s meter per second
ft/s foot per second
rev/s * revolutions per second
ccls * cubic centimeter per second
cc* cubic centimeter per second
Volume cc cubic centimeter
ml milliliter
cu_in cubic inch
cu_ft cubic foot
fl_oz fluid ounce
| liter
qt quart
pt pint
Weight kg kilogram
mg milligram
g gram
oz ounce
Ib pound

* Applicable to mixer valve only
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Machine Controls
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Machine Controls allow you to exercise direct control over the dispenser by allowing you to
directly manipulate inputs and outputs. A drop-down menu of manual machine choices is
available by clicking on Machine Controls in the menu bar of the main window.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

A brief explanation of each machine control choice follows:

Custom Ctrls

Custom controls allow the user to directly manipulate various inputs and outputs for
some of the devices on the dispenser. Custom controls are typically used to activate a
mechanical operation; for example, to extend/retract a board stop, raise/lower a lifter
late, turn on/off the conveyor belt, etc. Note that the affected device will be activated
IMMEDIATELY when these controls are used.

The system must be configured to display the Custom Ctrls option on the Machine
Controls pull-down menu. The contents of the pull-down menu is likely to differ for
each machine since it can be customized for local use.

Lifter Controls

These controls move the lifter plate without damaging fixtures or confusing the
program as manual manipulation might. These functions may be performed when
adjusting lifter pins or during other setup operations. Note that the affected device will
be activated IMMEDIATELY when either of these controls is used.

Offline Operations

Displays a dialog allowing the operator to manually purge a valve. It also allows the
filling of a syringe with material or the weighing of a shot of material independently

from a program if the dispenser is equipped with a syringe fill station or a precision

scale.

Tilt Adjust

Provides an established operation sequence for purposes of adjusting the tilt position
of a Dual Rotation Fixture, one of the many optional mechanical fixtures available
from GPD Global. More at Tilt Adjust Fixture Controls (pg 3.125).

10 Viewer

Used as a maintenance or troubleshooting tool, this window allows you to manipulate
inputs and outputs directly. Because it affords a constant view of the state of any
selected set of machine inputs and the ability to control any selected machine outputs,
the 10 Viewer is usually only available to the machine administrator or programmer.
For details, refer to 10 Viewer (pg 7.8).
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View Pressure/Temp

This tear-off window displays the current air pressure, needle temperature and mate-
rial temperature for each head, as well as heater temperatures in the work area. This
window allows the operator to monitor these parameters continuously.

Use the View Pressure/Temp window when your dispenser is equipped to handle
pressure and temperature control through the software rather than with a gauge and
switch (typically located on the front control panel).

Set Pressure/Temp

This window is typically used for set up procedures when the system is equipped to
handle pressure and temperature control through the software instead of gauge and
switch hardware.

Set Pressure/Temperature (pg 5.99) allows pressure and temperature values to be
set independently from values in the program. The operator can set these values
when no program is running. The program uses the value set in Air Pressure and the
selection made from the drop down menu overrides program actions.

Example:

+ ASSUMPTION 1: The program calls for 5.0 psi to turn off after a period of time.

+ ASSUMPTION 2: In the Set Pressure/Temperature window, Air Pressure is set to
8.0 psi and ON is selected from the drop down menu.

* RESULTS: Air pressure will change to 8.0 psi and not turn off as defined in the
program.

LensAdjust

Provides programmable camera lens adjustment for any dispenser configured with
ClearVu Vision™. Use LensAdjust to adjust the focus controls while monitoring focus
results in the live video screen that displays alongside the focus controls panel. For
details, refer to Lens Focus (pg 3.76).

Clear Signal

The system is capable of generating a signal to be used remotely to indicate out-of-
range weight on the optional precision scale. This signal is intended to ring a bell in a
location perhaps 1,000 feet from the machine and is not cleared remotely; it must be
cleared by clicking on Machine Controls > Clear Signal.

MV50/400 Controls
Select from two choices for the optional MV50/400 Metering Valve:

+ MV50/400 Home activates the homing of the valve plungers; they home to their
upper-most position (linear stage).

+  MV50/400 Jog provides coarse manual control over the downward movement of
the valve plungers. Keep the lower left trackball button depressed until the valve
plungers move the cartridge valves down as far as desired. Downward movement
ceases as soon as you release the trackball button.
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Using Custom Controls
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Before proceeding, review the background information available here: Custom Ctrls (pg 7.4).

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION

Le contenu de cette

WARNUNG

Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA

To use Custom Citrls:

1. Enable the Custom Ctrls feature by reconfiguring the configuration file.

2. From the main menu bar, click on Machine Controls > Custom Ctrls.

Click on the dashed line at the top of the tear-off menu that displays and move it to a con-
venient place on the screen.

4. Most menu items are toggle controls - click them once to activate a device; click them
again to deactivate the same device. Click on the feature you wish to control - the device
will be activated immediately.

& WARNING: The affected device will be activated IMMEDIATELY when these controls are used.

5. When you are done using the Custom Ctrls feature, disable it in the configuration file.
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System Functions

System Functions provides tools for direct manipulation of the software systems that run the
dispenser. A drop-down menu of choices is available by clicking on System Functions in the
menu bar of the main window.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION WARNUNG ATTENZIONE ADVERTENCIA
Le contenu de cette Der Inhalt dieses Il contenuto NO SE RECOMIENDA

A brief explanation of each system function choice follows:

IsQL

SYBASE interactive SQL. Familiarity with an SQL language and the structure of the
data base is required. Used to edit the data base directly.

Shell

Initiates a Korn shell. Familiarity with UNIX-like systems and the structures of the
dispenser software is required. Used for any QNX activities.

Edit Any File

This can be used to edit any files accessible to the dispenser. Familiarity with VEdit
and the structure of the dispenser software is required to edit files here. For details,
refer to VEdit in Shell Windows (pg 7.12).

Show Common Area

Debug tool. Displays the data common to all currently running processes.

Edit sysinit
Edit .profile
Edit .xinitrc
Edit startup.sh
Edit . mwmrc

Starts a VEdit shell to edit the specified file. Familiarity with UNIX-like Edit profile
systems and the structure of the dispenser software is required. Note that any local
changes may be erased when a software update is installed.
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10 Viewer

The 10 Viewer may be used as a maintenance or troubleshooting tool to help determine if a
device input or output (I/0) is wired properly and receiving the correct voltage. You may force
an output device with 10 Viewer by clicking on the box next to the I/O label and observing the
results. An input cannot be forced, but you can flag a sensor and then observe the box next to
the 1/O label to see if it changes state, or you can observe if an I/O is reading a change of

5/18/18

condition.

You may select one or multiple I/Os or all I/Os for a device, turn each output on/off or flag an
input device, and then observe the results. For a list of inputs and outputs specific to your
machine, refer to the Input/Output Listing in the Mechanical & Electrical Reference Documents

section of the dispenser documentation package.

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and

invalidating their machine warranty.

ATTENTION WARNUNG

Le contenu de cette Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA

NOTE: Use care when working with IO Viewer functions. A device may respond immedi-
ately when the corresponding input or output is activated. Prior to activating an 1/O, be
sure you know which device it controls, and be sure to clear the area surrounding the
device to be tested in order to prevent equipment damage.

NOTE: A successful test with the 10 Viewer is not a guarantee that a device is configured
properly in the control software. Nor is a lack of visible state change viewed on the 10
Viewer a guarantee that a sensor has not changed state; the resulting flicker from a state

change may occur too quickly to be visible.

To use loView:

1. Change the system password to an access right with access to Configuration.

2. From the main menu bar, click Machine Controls > 10 Viewer. loView displays.
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3. Click on File > Refresh 1/O Information. All available 1/O classes display for the current
domain and machine.

4. Display the I/Os for a particular class by highlighting a selection in the Class pane. A list of
I/O names associated with that class displays in the Name pane.

For example, the StackLight class has been selected in the screen shown below at left,
resulting in all names associated with the StackLight class being listed in the Names pane.

5. Select either a single 1/0, multiple I/Os, or all 1/Os.

Table 77: Selecting I/Os

1/0 Quantity

Selection Instructions

one

1 - Highlight the name of the I/O you wish to select. For example, the StackLight I/O for
Green has been selected in the screen shown above at left.

2 - Click the trackball PopUp Menu button (lower right-hand button). A pop-up menu
displays like the one shown in the screen shown above at right.

3 - Click on the menu choice of Add to Class Window.

multiple

1 - Hold down the CTRL key while clicking the cursor on each 1/0 name you want to
select.

2 - Click the trackball PopUp Menu button (lower right-hand button). A pop-up menu
displays like the one shown in the screen shown above at right.

3 - Click on the menu choice of Add to Class Window.

all

1 - Click the trackball PopUp Menu button (lower right-hand button). A pop-up menu
displays like the one shown above at right.
2 - Click on the menu choice of Select All I/O.
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6. Note that the appearance of the 10 View By Class window and the types of 1/Os displayed
in the window may vary somewhat depending on the quantity and type of I/Os selected.
The samples shown below illustrate the selection results for a single 1/0, multiple I/Os, and
all I/Os. Also shown are the different types of I/Os. Each selected /O name appears as a
label with either a toggle box or a value field; the value field indicates a pseudo 1/O.

Single 1/0 selected - a single toggle box and label displays for the Green StackLight I/
0.

7. Pseudo I/Os are bits of memory used internally by the software; they are not physically
connected to an I/O board. A pseudo I/O may contain a value between 0 and 255.

Multiple 1/Os selected - a toggle box and label for each I/O selected for the WorkArea
class.

All 1/Os selected - the /O View By Class window expands to accommodate all 1/0Os
selected. Pseudo I/Os - display with a value field rather than a toggle box. The Violet,
Orange, Blue, AClear, and ASignal I/Os are all examples.

8. If desired, you can add additional I/Os to the I/O View By Class window from other
classes.
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9. Take action appropriate for each 1/O selected:

Table 78: Using I/Os

Type of Device or I/O

Action

Output devices

Click the 1/0 toggle box on and off while observing the response at the asso-
ciated device. For example, if you click the Green toggle box on and off, the
green status tower light should respond by turning on and off.

Input devices

Flag the sensor while observing the associated 1/0O toggle box for the state
changes. For example, manually block and unblock the sensor while observ-
ing the toggle box - the toggle box should change states.

Pseudo I/0

A pseudo I/O is the same as other types of I/Os except it is just memory in
the computer. Pseudo I/Os can be changed, read, or treated as both an input
or an output. To treat a pseudo I/O as an output, type a value in the associ-
ated value field. A pseudo I/O may contain a value between 0 and 255.

10. When you are done working with the IO Viewer, close it by clicking on File > Exit. All win-
dows subordinate to loView will also be closed.

NOTE: A successful test with the 10 Viewer is not a guarantee that a device is configured
properly in the control software.
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VEdit in Shell Windows

5/18/18

Occasionally, you may need to edit a file in a shell-style window environment. The file editing
utility provided for this function is VEDIT. As an example, you would use VEDIT to change the
global units-of- measure default setting by editing the appropriate character in the configu-

ration file.

Example of a file displayed in a shell-style window.

VEDIT QNX Ver. 3.22 11-26-96 Copyright (C) 1996 Greenview Data, Inc.

D359000 Series Application Configuration

Copyright 1996 (C) General Production Devices

PumpCfgVals = False

DisplayUnits = 1
eightUnits = 0

Temperaturelnits = 0
u 0 for metric, 1 for english; weight & temp revert to
DisplayUnits if absent

DisplayLen = 3
eightlen = 3

Places after the decimal point for English lengths and Metric weights

DispenserType = 0

=

WARNING The content of this section is NOT recommended for use by anyone besides GPD
Global personnel or those working under the direct guidance of GPD Global personnel. Improper
application of this information can lead to serious complications in FLOware Software operations.
Any non-GPD Global employee who uses this information beyond the stated application speci-
fied by GPD Global Service Department personnel is in danger of causing personal injury and
invalidating their machine warranty.

ATTENTION

Le contenu de cette

WARNUNG

Der Inhalt dieses

ATTENZIONE

Il contenuto

ADVERTENCIA
NO SE RECOMIENDA
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Navigation Controls

There are several ways within VEDIT to accomplish typical editing features. You can use key
stroke combinations, the mouse, or the menu. Here are some hints on how to move around in
a file during the edit process:

Search

Use the ARROW keys to move the cursor around the window. « Press the PAGE UP key

or PAGE DOWN key to view the previous or next window of text within the file.
Use the F1 key to display the help menu. Press the ESC key to exit the help menu.

To view the menu bar at the top of the window, press F10. To remove all menus, press the

CTRL and C keys.

To search a shell file for specific text, press the F2 key, enter the text you want to locate, and
press ENTER.

Press the F3 key for an additional search on the same text. This can be repeated until the end
of the file is reached.

To exit the search function, either press the ESC key twice or press the UP or DOWN arrow
key to move the cursor out of the selected text.

Copy Text

S

Put the cursor on the first line of the block to be moved.

Press F10 to display the menu.

Use the arrow keys to select Block > Set Line Marker. Press ENTER.
Use the arrow keys to find the end of the block that you want to move.

Press F10 to display the menu.

Use the arrow keys to select Edit > Copy to Scratchpad. Press ENTER.

Copy & Cut Text

1.

o o~ w0 DN

Paste Text

5/18/18

1.
2.
3.

Put the cursor on the first line of the block to be moved.

Press F10 to display the menu.

Use the arrow keys to select Block > Set Line Marker. Press ENTER.
Use the arrow keys to find the end of the block that you want to move.

Press F10 to display the main menu.

Use the arrow keys to move to Edit > Cut to Scratchpad. Press ENTER. Notice that all

highlighted text lines have been deleted.

Position the cursor on the line immediately following the place where text is to be inserted.

Press F10 to display the main menu.

Use the arrow keys to select Edit > Paste Scratchpad. Press ENTER. The previously

deleted lines will now be inserted.
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Copy & Paste Text Between Files

To copy text from file A and paste it into file B:

Copy text from file A:

Put the cursor on the first line of the block to be copied.
Press F9 to start a block.

Use the arrow keys to find the end of the block to be copied.
Press F9 to end the block.

Press the ALT + B keys and then the D key.

S

Enter an arbitrary file name and press ENTER.

Paste text into file B:

1. In the file B window, position the cursor on the line immediately following the place where
text is to be inserted.

2. Press the ALT + E keys and then the | (for Insert) key.
3. Enter the file name assigned during step 1.f and press ENTER.

Save Edit

Exit Edit

5/18/18

In addition to being able to save the file prior to exiting VEDIT, the file can be saved during the
editing process by selecting the File > Save and Continue menu selection.

There are several ways to end an edit session:

+ Type exit and press ENTER.
* Press the ALT and X keys simultaneously.
« Display the menu by pressing the F10 key. Then choose File > Exit, and press ENTER.

Using either of these methods to end an edit session will prompt you to either save the file

before exiting or to abandon any changes and exit. Answer YES to save the file before exiting
or answer NO to exit without saving.
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Interfacility Communications

5/18/18

Interfacility communications are addressed in a separate document in which procedural
details guide you in how to set up TCP/IP (Transmission Control Protocol/Internet Protocol)
communications between a GPD Global dispenser and a customer-supplied Windows or
UNIX PC to establish the necessary communication to transfer data between the two systems.
Request the following document from GPD Global:

TCP/IP Communications between Dispenser & Windows or UNIX PC (part no. 22100056M)
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Screen Grabber

Use a screen grab process to capture a FLOware software window as a file. You have the
option of capturing a specific window, the whole screen, or a select area of a window or
screen. Follow the procedure pertinent to the version of FLOware software installed on your
dispenser:

+ Screen Grabs (FLOware Software v 2.9+) (pg 7.17)
+ Screen Grabs (FLOware Software v 2.7-2.8) (pg 7.22)
+ Screen Grabs (FLOware Software v 2.6 & earlier) (pg 7.27).
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Screen Grabs (FLOware Software v 2.9+)

Screen grabs are performed by using a program named xv (X View). In addition to allowing
you to capture a window or the whole screen, it also allows you to do some basic operations
(cropping/scaling) on the captured image.

5/18/18

You may use the screen grab program at any time while the system is running; it should not
conflict with any of the basic operations.

1.

Prepare a medium on which to carry the images. This could be either a floppy disk
(already formatted for MSDOS) or a pen/flash drive with an MSDOS file system already on
it.

Load the medium. This entails either loading the floppy disk or inserting the pen/flash drive
into the USB slot.

Change password access to the Service level (password: ****).

At the bottom of the main control window, right-click on the sliver of blue background when
the cursor changes to an “X, and then select Screen Grabber from the Root Menu that dis-

plays.
Within several seconds you should see the splash screen for the program:

Position cursor inside the splash screen and then click the «bottom right trackball button»
to open the program control panel:

| |
®xv controls

o |[]
ey Dizplay 24/8 Bit algorithms
UNREGIETERED - -
wv Root Wwindows Image Size
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7.

8.

9.

10.

You'll notice that in the lower right corner of the control panel, just above the «Quit» button
is a button labeled «Grab»:

slors,

¥}

pird | it Grab
Ahout XY Quit

[+]

=

Clicking the «Grab» will open the Screen Grab Dialog:

Grakc after delay, Laft button grabs a window, Middle buttan
grabs a rectangular area. Right button cancels.

AuteGrabe after dolay, grabs the windaow the cursor is
potitioned in. Delay must bé nen-2ero

ity @ shcands Hide ¥V windaws
[ cab || autecrab | [ canan |

You will use each of the controls/parameters in this dialog differently depending on which
of the following scenarios you’re using:
Delay X Seconds

Setting this value to some number larger than zero has two effects: first, it enables the
AutoGrab button and, secondly, it causes a delay of that number of seconds between
the time you tell the program to begin the grab and the time when it actually does the
grab. This is very useful when capturing menus or other items which require some
action from the mouse.

Hide XV Windows
This tells xv to hide all of its windows prior to beginning the grab.

Grab

Begins a screen grab. Once you have pushed this button, clicking the «bottom left
trackball button» will select the window to grab. Optionally, clicking the «top right
trackball button» will allow you to grab an arbitrary portion of the screen by drawing a
rectangle around the area you want, or clicking the «bottom right trackball button»
cancels the screen grab.

AutoGrab

Begins a screen grab after the specified number of seconds. The window in which the
mouse resides when the time expires is grabbed. This is very handy for capturing
menus and other popup items.

Cancel
Cancels the screen grab.

After grabbing an image, that new image will appear in the window which initially held the
splash screen. All images may be viewed in that window.
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Grab a Sin

1

gl

2
3
4.
5

e Window
Click Grab button on the main control panel.

Click the Hide XV Windows check box.
Click the Grab button.
Click on the window you wish to grab.

Save the new image file.

Grab a Partial Window
1.

2
3.
4

Click the Grab button in the main control panel.
Click the Hide XV Windows check box.
Click the Grab button.

When the XV windows have disappeared, use the «middle button» to draw a rectangle

around the area you wish to grab.

a. When you release the button, XV will grab the region you defined.

b. If the region is not exactly what you wanted, simply repeat the procedure until you get
the desired area.

Save the new image file.

Grab Window & Menu
1.

5/18/18

2
3.
4

o

Click the Grab button in the main control panel.
Click the Hide XV Windows check box.
Click the Grab button.

Enter some number into the Delay X Seconds area. Typically, 3-5 seconds should be
enough.

Click AutoGrab

At this point you have the number of seconds you entered in which to select the window
with the menu in it and get the menu displayed by clicking and holding on the menu’s but-
ton. Simply hold the button (keeping the menu visible) until the screen grabber has
snapped the image and displays it in its main view window.

Save the new image file.
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Saving Image

1.

5/18/18

Click Save. A «File Dialog» will appear:

Format: | GIF |
Colors: | Full Color |
.inodes 4
Jastlogin |
.profile
veditkey
waditre E
Capal
1 bin
£ boot
£ cdo
£ dew
Cetc ||
£ home L
25 files | ]ssieied arn [ ] Normal size
save file: |fdosfcfgrah1.jpgl

Type in the path to your storage media, similar to this:

| %]
9files | ]ssieed an [ ] Normal size
save file: |fdosfcfgrah1.jpgl

The path should be one of the following depending upon the media in use:
— For floppy disk: /dos/a/
— For pen/flash drive: /dos/c/

Add the file name. If you are capturing more than one screen, it is a good idea to simply
number the files, e.g. sgrab1.jpg, sgrab2.jpg, etc.

You may specify the type of image file by adding the appropriate extension or by choosing
a file type from the Format menu. JPEG is probably your best choice.

PNG
PostScript
PEM/PGM/RPM (raw)
PBM/PGM/RPM (ascii)
11 Bitmap

®PM

BMP

Click the Ok button and your image will be saved.

HINT: Remember to use proper procedures when Removing USB (pg 2.9) from the
machine.
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Quitting XV
Find the XV Controls window and click the Quit button.

®v controls
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Screen Grabs (FLOware Software v 2.7-2.8)

Screen grabs are performed by using a program named xv (X View). In addition to allowing
you to capture a window or the whole screen, it also allows you to do some basic operations
(cropping/scaling) on the captured image.

You may use the screen grab program at any time while the system is running; it should not
conflict with any of the basic operations.

1. Prepare a medium on which to carry the images. This could be either a floppy disk
(already formatted for MSDOS) or a pen/flash drive with an MSDOS file system already on
it.

2. Load the medium. This entails either loading the floppy disk or inserting the pen/flash drive
into the USB slot.

Open the window that you want to capture.

4. Open the screen grabber software:

Position the cursor at the bottom of the screen until it turns into an X.
Click and hold down the <<bottom right trackball>> button.

Click on Utilities > Shell.

In the shell window that displays, type xv and press the Enter key.

Within several seconds you should see the splash screen for the program:

®oooTw

5. Position cursor inside the splash screen and then click the «bottom right trackball button»
to open the program control panel:

| |
®xv controls

ey Dizplay 24/8 Bit algorithms
UNREGIETERED - -
wv Root Wwindows Image Size

480x270 image. 2-hit mode. Got all B9 colors,
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6. You'll notice that in the lower right corner of the control panel, just above the «Quit» button

is a button labeled «Grab»:

slors,

¥}

pird | it Grab
op | About ¥y Quit

7. Clicking the «Grab» will open the Screen Grab Dialog:

Grakc after delay. Laft button grabs a window, Hiddle button
grabs a rectangular area. Right buttan cancels.

AuteGrabe after dalay, grabs the window the curser ic
positioned in. Delay must be nen-2ere

Dolay: [0 | seconds Hide ¥ windows
[ cab | [ autocran | [ cancer |

8. You will use each of the controls/parameters in this dialog differently depending on which

of the following scenarios you’re using:

Delay X Seconds

Setting this value to some number larger than zero has two effects: first, it enables the
AutoGrab button and, secondly, it causes a delay of that number of seconds between
the time you tell the program to begin the grab and the time when it actually does the
grab. This is very useful when capturing menus or other items which require some
action from the mouse.

Hide XV Windows
This tells xv to hide all of its windows prior to beginning the grab.

Grab

Begins a screen grab. Once you have pushed this button, clicking the «bottom left
trackball button» will select the window to grab. Optionally, clicking the «top right
trackball button» will allow you to grab an arbitrary portion of the screen by drawing a
rectangle around the area you want, or clicking the «bottom right trackball button»
cancels the screen grab.

AutoGrab

Begins a screen grab after the specified number of seconds. The window in which the
mouse resides when the time expires is grabbed. This is very handy for capturing
menus and other popup items.

Cancel
Cancels the screen grab.

After grabbing an image, that new image will appear in the window which initially held the
splash screen. All images may be viewed in that window.
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Grab a Sin

1

gl

2
3
4.
5

e Window
Click Grab button on the main control panel.

Click the Hide XV Windows check box.
Click the Grab button.
Click on the window you wish to grab.

Save the new image file.

Grab a Partial Window
1.

2
3.
4

Click the Grab button in the main control panel.
Click the Hide XV Windows check box.
Click the Grab button.

When the XV windows have disappeared, use the «middle button» to draw a rectangle

around the area you wish to grab.

a. When you release the button, XV will grab the region you defined.

b. If the region is not exactly what you wanted, simply repeat the procedure until you get
the desired area.

Save the new image file.

Grab Window & Menu
1.
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2
3.
4

o

Click the Grab button in the main control panel.
Click the Hide XV Windows check box.
Click the Grab button.

Enter some number into the Delay X Seconds area. Typically, 3-5 seconds should be
enough.

Click AutoGrab

At this point you have the number of seconds you entered in which to select the window
with the menu in it and get the menu displayed by clicking and holding on the menu’s but-
ton. Simply hold the button (keeping the menu visible) until the screen grabber has
snapped the image and displays it in its main view window.

Save the new image file.

FLOware Software Guide 7.24



GPD Global®

Saving Image

5/18/18

1.

Click Save. A «File Dialog» will appear:

Format: | GIF |
Colors: | Full Color |
.inodes 4
Jastlogin |
.profile
veditkey
waditre E
Capal
1 bin
£ boot
£ cdo
£ dew
Cetc ||
£ home L
25 files | ]ssieied arn [ ] Normal size
save file: |fdosfcfgrah1.jpgl

Type in the path to your storage media, similar to this:

| %]
9files | ]ssieed an [ ] Normal size
save file: |fdosfcfgrah1.jpgl

The path should be one of the following depending upon the media in use:
— For floppy disk: /dos/a/
— For pen/flash drive: /dos/c/

Add the file name. If you are capturing more than one screen, it is a good idea to simply
number the files, e.g. sgrab1.jpg, sgrab2.jpg, etc.

You may specify the type of image file by adding the appropriate extension or by choosing
a file type from the Format menu. JPEG is probably your best choice.

PostScript
PEM/PGM/PPM (ram)
PEM/PGM/PPM (ascii)
¥11 Bitmap

®PM

EMP

Click the Ok button and your image will be saved.

HINT: Remember to use proper procedures when Removing USB (pg 2.9) from the
machine.
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Quitting XV

1. Close the XV window by clicking on the <<Quit>> button.

2. To exit the shell, click on the shell window, type ex it and press the <<Enter>> key.

=v controls

|Glr|efslalo|ofels]a] o |
EIEN| | | | |
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Screen Grabs (FLOware Software v 2.6 & earlier)

You may use the screen grab program at any time while the system is running; it should not
conflict with any of the basic operations.

Capture Screen Grab
You must be at a password level of the software that allows access to System activities to
perform this procedure. To capture a screen grab:

1. Open the window that you want to capture in FLOware software.

2. Open the screen grabber software:
a. Position the cursor at the bottom of the screen until it turns into an X.
b. Click and hold down the right mouse button.
c. Click on Utilities > Grabber. X-Windows Screen Grabber appears.

3. Define desired Grabber criteria:

a. Inthe Input Option panel, click the screen area selection choice that best fits your
needs. Typically, Click on Window or Stretch Rectangle are used.

b. In the Output Format panel, click on BM/XPM3.

c. As needed: In the Output Options panel, verify or change the file name that is auto-
matically assigned by positioning the cursor in the To File field and then using the right
arrow key to scroll to the right until the file name displays. As of this writing, the file
path automatically assigned to grabbed files is /home/dispenser.

d. Click OK.

4. Choose one:
— If you selected Click on Window, position the eye cursor on the window to be cap-
tured.
— If you selected Stretch Rectangle, position the right angle cursor on the upper left cor-
ner of the area to be captured, hold the left mouse button down while using the track-
ball to position the cursor at the lower right hand corner of the area to be captured.

5. X-Windows Screen Grabber reappears for another grab. When you are done grabbing
screens, click DISMISS.

Convert Screen Grab
To convert the file format of the screen grab from . XWD to .GIF:

1. Open the Paint program:
a. Position the cursor at the bottom of the screen until the cursor arrow turns into an X.
b. Click and hold down the right mouse button.
c. Click on Utilities > Paint.
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4.

Select a screen grab file:

a. Click on File > Open.

b. Scroll down and highlight the file you created in the previous Capture Screen Grab
(pg 7.27) procedure. File names default to a prefix of scr# with a suffix of xwd.

c. Click BEST GUESS.

d. Click OK. The captured screen displays.

Convert the file:

a. Click on File > Save As.

b. Replace the suffix of the displayed file name by typing .gif over .xwd. For example, a
file name of scr1.xwd should be changed to scr1.gif.

c. Click on GIF FORMAT.

d. Click OK.

e. Click on File > Close.

Close the Paint program by clicking File > Quit.

Copy Screen Grab File to Floppy Diskette

5/18/18

1.

Open a Shell:

a. Position the cursor at the bottom of the screen until it turns into an X.
b. Click and hold down the right mouse button.

c. Click on Utilities > Shell.

Put a floppy diskette in drive a:
Copy GIF file onto the floppy diskette, type:

cp /home/dispenser/*.gif /dos/a

Verify files are on the floppy - type a lower case L to list files:
1 /dos/a

Remove GIF files from the hard drive:

rm /home/dispenser/*.gif

Remove original screen capture files from the hard drive:

rm /home/dispenser/*.xwd

To close the shell window, type:

exit

and press the ENTER key.
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Index

A

abbreviations. See Units of Measure
About 2.24, 3.24
accelerator keys. See User Interface
Acceptance Threshold 3.62
access rights 5.13-5.15
descriptions 5.79
overview 1.2
Password Editor 5.13, 5.78
passwords 2.20
security 6.1
typical for operator 3.23
typical for top level password 6.1
user name 2.20
account management. See managing data
ADD
ITEM 3.41
LINE 3.43
administrative topics 6.5
alarm controls 3.27
aligning
camera cross hairs 2.7
offset points 2.7
Alignment Points 3.40, 3.99, 4.3
application backup 6.18-6.24
APPLY EDITS 3.41
Approach Velocity 3.19
Arc 3.87,4.30-4.36, 5.108, 5.114
acceleration & deceleration 4.33
Editor 4.32
How to Program 4.30
icon 3.42
rotation 4.36
XY coordinates 4.34
areafill 4.17
arrays 3.99
rotation 3.97
subboard rules 4.42
arrow keys. See User Interface
auger valve, setting up 3.66
Auto
Calibration Limits 4.53
Grab 7.18, 7.23
Mode ?7-4.79
Program 3.28, 4.76-4.78
Purge 4.74
width, conveyor 3.123
automatic vision. See ClearVu Vision
Available Items 3.31
Avg
Board Time 3.29
Cycle Time 3.29
axis. See lighting
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B

backups
application 6.18-6.24
data 6.15-6.17
deleting 2.23
FAQs 6.27
full system 6.25-6.26
reminder 6.14
routine 6.13
types 6.13
BAD MARK X 4.3
bad marks 3.30, 3.38
inspection tool 3.104
pause on 3.35, 4.6
subboard 4.5, 4.39
teaching 4.3
using 3.38
barcode
Auto Mode 4.76
Barcode Scan Program Select 4.80
Dynamic Load Program 4.84
base locations 3.135, 3.146, 3.147-3.148, 5.23
batch. See stand-alone
Board
Also see subboards
average cycle time per 3.29
average time per 3.29
Count 3.29
dimension reference data 3.35
Dimensions 4.1
flip control 4.83
Information 3.34
level detect with touch span 3.40
number per hour 3.29
options 3.35, 4.6
orientation points 3.37
pass through state 3.27
per Hour 3.29
run pattern 3.25
skew 3.38
stretch and rotation, compensation for 3.37
vacuum 3.35
boot
system 6.28
with reboot 6.28
with shutdown 6.28
button
colors 2.15, 2.16
command 3.41
default 2.16, 3.88
default or used? 2.16
diamond 2.15
faded 2.20
item list 2.18
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main button bar 3.24
push 2.15
square 2.16
teaching coordinates 2.17
toggle 2.15
triangle 2.16, 2.18
used 2.15

buttons
... 222
ABOUT 2.24
ADD ITEM 3.41
ADD LINE 3.43
APPLY EDITS 3.41
AUTOGRAB 7.18, 7.23
BAD MARK X 4.3
CAMERA 3.61
CANCEL 3.24
CLASS FILTER 3.32
CLOSE EDITOR 3.41
DELETE ITEM 3.41
DELETE LINE 3.43
DISABLED 3.45
DISPLAY 3.63
DUP LINE 3.43
EDIT DETAIL LINES 3.41, 3.42
ENABLED 3.45
FIDUCIAL X 3.37, 4.2
FIDUCIALS 5.33
FILTER 2.22
FIND FEATURE 3.45
FIND FIDUCIALS 3.53
FIND LINE 3.44
FIRST POINT 3.54
FULL INSPECT 3.117
GO HOME 3.24
IMPORT 3.2
INCOMING DATA TYPE 3.4
INTERNALS 5.32, 5.39
JOG 3.24
LIGHT COLOR 3.61
LOAD 3.120
MISC PROGRAM SETTINGS 3.41
MODIFY SUB BOARDS 3.41, 4.43
MOUNT 3.24
MOVE CTRL 3.22
MOVE TO 2.17
ON/OFF CTRL 3.22, 3.45
OPERATION 3.85
OPERATOR INSTRUCTIONS 3.41
OPTIONS 3.35
PATTERN 4.2,4.3
PAUSE 3.24
REFRESH 3.24
RESET 3.120
RUN 3.25
SAVE (tweaks) 3.120
SECOND POINT 3.54
SELECT 3.25
SET POINT 3.53

5/18/18

SHOW POINT 3.54

TEACH 2.17, 3.25

TEACH COORDS 4.51
TEST 3.63

TRAIN 3.62

TWEAKS 3.25
VALVE/TOOL MOUNTS 3.41
WEIGH 3.130

Cc

CAD data 1.3, 3.52
Calculated Center 3.52
setting 3.54
calculator 3.28
Calibrate 3.87, 5.108, 5.114
icon 3.42
weight shapes 4.91
Calibration 3.24, 3.124-3.128
Also see vision
chip, using 3.82
conveyor speed 3.126
conveyor width 3.126
default vision 3.95
limits 4.53
tool 3.126, 3.127
calibration dot
fixed size 3.111
indexing at ceramic chip 4.70
setup parameters 3.70
size 3.107, 3.109
camera
adjusting thresholds 3.63
Also see Focus
Also see lighting
Also see vision
button 3.61
calibration 3.77
current coordinates 2.7
fixed 3.76
lens and lighting controls 2.8
light color 3.76
multiple 3.61
operation states 3.27
positioning. See Jogging Gantry
setting thresholds 3.62
types of lens focus 3.76
View 3.62
CANCEL 3.24
capture. See screen grabber
CENTER
/in 4.23,5.113, 5.118
/out 4.23,5.113, 5.118
Check/Set Base Locations 3.146, 5.23
Circle 3.87, 5.109, 5.114
How to Program 4.25
icon 3.42
class 4.1
FILTER 3.32
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filter 3.30, 3.31, 3.34
filter, assigning 3.33
filter, choices 3.33
filter, displaying by 3.32
classes 3.31, 3.34
logging, See logging
cleaning
Also see Needle Cleaner
path 3.142
Clear
Password 5.13
Signal 7.5
ClearVu Vision 3.77
1/0s 3.82
sequence of operation 3.78
clock 3.28
CLOSE EDITOR 3.41
color. See lighting
Comment 3.43
communications. See TCP/IP
Complete operation stage 3.45
complexity 3.50
Configuration 3.24, 3.135-3.149
backup reminder 6.14
communications 3.136
Dispenser 3.135
for monitoring details 3.138
inputs/outputs 3.82
needle cleaner 3.143
Servo 3.136
Confusion Threshold 3.62
continuous
dispensing path 3.22
moves 4.23, 4.29, 4.36
run pattern 3.25
valve or tool operations 3.45
Contour Mapping Editor 5.24
conventions, menu 2.13
Convert 3.4, 3.13
converting
data 1.3, 3.4-3.8
program 3.5, 3.13
program to subboard 4.38
conveyor
auto-width 3.123
board dimensions 3.35
emulating stand-alone unit 3.27, 3.118
Off 3.27,4.76, 4.78
operation states 3.27
speed calibration 3.24, 3.126
Stand Alone 3.27
width calibration 3.24, 3.126
coordinates
bad mark 3.38
buttons for teaching 2.17
fiducial 3.37
positive & negative 3.15
teaching. See Jogging Gantry
Copy 3.12
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icon 3.42
copying

program 3.12

text with VEdit 7.13
CORNER

/in 4.23,5.113, 5.118

/out 5.113, 5.118
Counters 3.29, 4.55-4.58
cross references 3.4

Also see Part Number
curing light. See UV wand
Cursor. See User Interface
Custom

Ctris7.4,7.6

data, logging 6.8

I/0 Definitions 3.135
Cut 3.87

icon 3.42
Cycle Info 3.29

D

Dark Field 3.76
Data
Also see managing data
backup 6.15-6.17
CAD 1.3, 3.52
Converter 1.3, 1.4, 3.4,5.25
Converting 3.4-3.8
Export 5.26
Exporting 1.3, 3.9-3.10
Import 5.28
Importing 3.1-3.3, 3.4
libraries 5.1
monitoring pressure 3.69
purging 6.4
Transfer Utilities 2.9
Transferring 1.3
date 3.28
default 3.88-3.95
Also see hierarchy
button 2.16, 3.88, 3.90
filter 2.22
illustrated 3.88-3.90
library, material defaults 3.93, 5.9
library, material parameters 3.93
material 3.93
Mount/Material Editor - MOUNT 3.71
mounts 3.93
needle size 5.10
operation state 3.27
password 2.20
program 3.81, 3.92
shape name 3.55
units of measure 7.1
vision calibration 3.95
Defined Boards 4.42
delay
icon 3.42
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inspection 3.26

operation 3.87, 5.110, 5.114
post 3.20

pre snap-off 3.20

DELETE

ITEM 3.41
LINE 3.43

Description 3.36, 3.54, 4.2
DISABLED 3.45

Dispense Velocity 3.19
Dispenser Configuration 3.135
dispensing

Also see parameters

Also see Programs

continuous motion 3.22

operations, illustrated samples 3.17
properties 3.49

use lines or move commands? 3.21

DISPLAY 3.63
documentation

Dot

about 1.4

Audience 1.4

Getting Started 2.1
Organization of 1.4
related documents 1.4

height 3.19

How to Program 4.7

icon 3.42

indexing calibration dot 4.70
Inspect 3.28, 3.116
operation 3.87, 5.111, 5.115
operation, illustrated 3.17

Double Scan 3.35
Dry Run 3.117

inspection pattern 3.26

DUP LINE 3.43
Dynamic Load Program 4.84

E

Edit 3.12, 3.28, 3.30

Any File 2.23, 7.7
Configuration 3.111
DETAIL LINES 3.41, 3.42
Programs 3.31

Shapes 3.31, 3.56

editing

file 2.23
with VEdit 7.7, 7.12

editor

Detail 5.86

file 2.24

Program 3.30, 5.94
Resource File 3.136
SubType 5.103
Valve/Tool 5.105

Elapsed Time 3.29
ENABLED 3.45
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End
operation stage 3.20, 3.22, 3.45
Point, 3-point arc 4.33
program execution 3.24
Z3.19, 3.21,4.24, 5111
Enter
Operator Instructions 5.29
Password 5.13
Exit 3.30
Main 3.23
expiration, material (pot life) 4.59
Export 5.30
exporting
data 1.3, 3.9-3.10
options 3.10

F

FAQs, routine backup 6.27
Feature ID 3.45, 3.49, 3.101-3.103
activating 3.102
assigning 3.101
finding 3.102
using 3.101
feeders 3.24
fiducial points 3.37-3.38
changing 3.14
compared to reference point 3.14
multiple 3.37
rules of use 3.37
teaching 4.2
three-point correction 3.38
FIDUCIAL X 3.37,4.2
FIDUCIALS 5.33
& Bad Marks 5.33
fields
active & inactive 2.10, 3.88
defined 5.22
faded items 2.20
overriding default 3.90
selectable panels of 2.12
File 3.30
Selection 5.34
files
editor 2.24
feeder 3.4
logging 3.136
selecting 2.21-2.22
selection windows 2.21
structure for exporting 3.9
structure for importing 3.1
Fill Spacing 3.44
filters
Also see class filter
defaults 2.22
file search 2.21
program print reduction 3.47
FIND
FEATURE 3.45, 3.102
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FIDUCIALS 3.53 header, program 4.1
LINE 3.44 heads
FIRST POINT 3.54 adding 5.6
fixed locations Also see tools
Editor 5.35 Also see valves
library 5.3 assigning needle cleaner 3.143
PICK SubOp 4.45 deleting 5.6
flags. See messages, logging editing 5.6
flipping board 4.83 library 5.5
flow rate. See scale offline defaults 3.95
FLOware software station position 3.70, 4.3
Data Transfer 1.3, 3.9 type 3.70, 4.4
Documentation 1.4 height sense. See touch probe
installing 6.12 help 2.24, 3.24
Performance 1.1 hierarchy
Programming 1.2 defaults 3.88
recovery 6.28 effects of overriding a default 3.90
restoring 1.4, 6.12 Mount/Material Editor (root, library, & program lev-
updating 6.12 els) 3.94
upgrading 6.12 programs & shapes 3.89
Using 3.1 Homing 2.1
Focus 3.62 Also see GO HOME
adjusting 3.62 housekeeping topics 6.5
Also see camera
consistent settings 3.79 |
lens 3.76, 3.83 e)
programmable 3.77 ClearVu Vision 3.82

warnings 3.80, 3.81, 3.83
format, for converting data 3.4, 3.5
f-stop 3.62, 3.76
Full

INSPECT 3.117

Inspect inspection pattern 3.26

Definitions 3.135

Definitions, Custom 3.135
pick-and-place 4.44

selecting single, multiple, or all 7.9
test with a subtype 5.19

using 7.11
system backup 6.25-6.26 View 5.42
Viewer 7.4,7.8
G icons
Gain 3.81 deleting Program Editor icon 3.30
gantry Edit Program 3.28
defining 3.70 Edit Shapes 3.28
entering code 2.4 main window 3.28
homing 2.1 primitive operations 3.42
identification code 3.43 Program Detail 3.42
jogging. See Jogging Gantry Program Editor 3.28
locating product in relation to 3.14 illumination, See lighting
motion, dampening during area fill 4.23 image
motion, dampening during circle 4.29 See barcode
motion, erratic 4.23 See patterns
MOVE CTRL 3.45 See screen grabber
moving. See Jogging Gantry See video
Global Units of Measure. See Units of Measure Import 3.2, 5.37
GO HOME 3.24 Import/Export 3.4
guide. See documentation importing
data 3.1-3.3, 3.4
H options 3.2
hard drive indexing calibration dots 4.70
primary 6.23 !nfo 3.29
slave 6.22 inline pass through 3.27

slave, condition indicated 6.25 inputs/outputs. See 1/0
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Inspecting

program development 3.117
Inspection

Delay 3.26

dot 3.28, 3.105-3.116

full 3.117

general 3.118

mode 3.26

pattern 3.26

process 3.104

sliders 3.26

with bad marks 3.104
Install Update 6.12
installing software. See FLOware software
instructions. See Operator Instructions
interfacility communications 7.15
Interim Report Generation. See Print
INTERNALS 5.32, 5.39
1ISQL 7.7

J

job accounting. See managing
Jog 5.44
button 3.24
Jogging Gantry
camera coordinates 2.7
controlling XYZ movement 2.8
cross hairs 2.7
fine tuning 2.8
GO HOME button 3.24
how to 2.7
JOG button 3.24
lens and lighting controls 2.8
MOVE TO 2.17
PAUSE button 3.24
reference point 2.7
REFRESH button 3.24
rules 2.7
speed 2.8
speed sliders 2.7, 2.8
TEACH button 2.17
Warnings 2.7, 2.8

K

Keyboard. See User Interface

L

Length 3.35, 4.1
lens
See camera
See Focus
See Jogging Gantry
LensAdjust 7.5
Libraries 3.31
deleting record 5.2
editing 5.2
Head 3.65, 3.66, 3.67, 5.5
Material 3.72, 3.80, 3.95, 5.7
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Material Defaults 5.9
material parameter 3.93
material parameter defaults 3.93
Needles 5.11
Part Number 5.12
Passwords & Access Rights 5.13
Patterns 3.61, 5.16
Shape 3.50
SubTypes 5.18
Lifter Controls 7.4
LIGHT COLOR 3.61
lighting
Also see camera
axis 3.61
color 3.61, 3.62, 3.74, 3.76
controls 3.73
controls. Also see Jogging Gantry
intensity 3.73
Level 3.62
low angle ring 3.76
offset 3.81
overhead, turning off 3.76
type 3.74
limit parameters 3.70
limits
calibration 4.53
Z probe 3.139
Line
choosing between a move and 3.21
How to Program 4.12
icon 3.42
operation 3.87, 5.112, 5.115
lines 3.21
angled 3.19
creating a series 3.21
creating program 4.4
puddled 3.19
lists 2.18
Live
Program Adjustment 3.25, 5.46
video 3.77
Video Parameters 3.62, 5.48
LOAD 3.120
logging
Also see messages, logging
custom data 6.8-6.11
Files 3.136
Loop run pattern 3.25

Machine Controls 3.24,7.4,7.8
main

button bar 3.24

control window 3.23, 5.49

menu bar 3.23

Resource File 3.136
maintenance, routine 6.5
managing
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Also see purge

data 6.2, 6.3

job accounting 6.3

system 6.1

View Notes 5.107, 6.2
manual. See documentation
manually teach a program 1.2
mapping calibration 3.24
material

adding 5.7

Also see parameters

Also see purge

defaults library 3.93, 5.9

deleting 5.8

editing 5.8

expiration 4.59

falling away from needle 3.20

flow rate 3.129
library 3.93, 5.7
parameters 3.72
pot life 4.59

preventing tailing 3.19, 3.20

preventing voids 3.19
selecting 4.3

separating from needle 3.20

type 3.70, 4.3

volume control 3.19

weight for scale 3.70

weight monitoring 4.85

weight volume 3.129
menu

bar, main 3.23

bar, Program Editor 3.30

configuration 3.135

conventions 2.13

item, selecting 2.4

option 2.13

pop-up 2.13

pull-down 2.13

tear-off 2.14
messages

custom user 3.104

homing status 2.1

info when process is waiting 3.29
info when program is active 3.29

logging 6.5

System Stopped 2.2
metric. See Units of Measure
Micro-Dot, setting up 3.65
MicroValve Steps 3.19
Mid Point, 3-point arc 4.33

Middle operation stage 3.20, 3.22, 3.45

Misc

PROGRAM SETTINGS 3.41, 3.81, 3.128

Resource File 3.136

Miscellaneous Program Settings 3.95, 5.55

modes
Inspection 3.26
operating 3.25

5/18/18

Run 3.25

MODIFY SUB BOARDS 3.41, 4.43

Monitor 3.29, 3.138
Temperature 3.136

monitoring
configuring 3.138
material pot life 4.59
material weights 4.85
pressure data 3.69
program details 3.138
temperature 3.141

MOTION STOP. See Legacy Controls & Operations

5.120
MOUNT 3.24
location, entering 2.4
mounting
product 3.24
USB device 2.9
Mounts Table 5.57
Mounts/Material Editor
DEFAULTS 3.93, 5.9, 5.59

MATERIAL 3.80, 3.93, 5.7, 5.59

MOUNT 3.70, 3.94, 5.59
MOVE

CTRL 3.22, 3.45

TO 2.17, 3.53
move

Also see continuous

choosing between Line and 3.21

commands 3.22
controls 3.45
icon 3.42
illustrated 3.18

operation 3.87, 5.112, 5.115

operation parameters 3.45
Velocity 3.19
moving

gantry. See Jogging Gantry
multiple segments in continuous path 3.21

multiple
fiducials 3.37

programs, sustaining across 3.133

Select 2.19
shapes 3.50
MV50/400 Controls 7.5

N

NCM
Close Time 5.61, 5.90
Open Time 5.61, 5.89
needle
adding 5.11
Also see material
Also see Needle Cleaner
Auto Purge 4.74
calibration 3.77
clean & purge 4.73
deleting 5.11
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distance 3.19
editing 5.11
Editor 5.66
gauge 3.70
height 3.19
library 5.11
path through time, illustrated 3.17
prime tip 3.19
purge, changing location 4.75
selecting 4.3
separating from material 3.20
size, changing default 5.10
speed of movement 3.19
Needle Cleaner 3.137
cleaning path 3.142
setup 3.142-3.149
network. See TCP/IP
new
Export 3.9
Import 3.2
No Operation 3.22, 3.45
None
icon 3.42
operation 3.87, 5.112
notes. See View Notes
Numeric Entry. See User Interface

(o)

Object Rotation. See rotation
offline
defaults 3.95
Operations 3.130, 5.67, 7.4
Offset
Lighting 3.81
points, aligning 2.7
On Time 3.19
ON/OFF CTRL 3.22, 3.45
online help 2.24
Operate
icon 3.42
operation 3.87, 5.112, 5.115
operating modes 3.25
Operation 3.43
button 3.85
shape 3.85
Time 4.65
operations 3.23, 5.108-5.113
Also see primitive operations
categories 3.85
Complete 3.45
dispensing, illustrated samples 3.17
End 3.20, 3.45
list of 3.87
Middle 3.20, 3.45
No Operation 3.45
pending 3.29
selecting 4.4
Shutdown System 6.28

5/18/18

stages 3.20, 3.45
Start 3.20, 3.45
subtypes 5.18
Operator
access level 5.13
Instructions 3.46
INSTRUCTIONS button 3.41
optimization
dispense patterns 1.1
fixed divisions 1.2
floating square 1.2
point-to-point 1.2
program 3.11
shape 3.11
Optimize Current Program 5.69
Option Settings 3.135, 5.70, 6.3
backup reminder 6.14
Cal Dot Sizes 3.109, 3.112
OPTIONS 3.35
orientation
Also see rotation
shapes versus subboards 3.50
subboards 4.5
origin
Also see work area origin
subboard 4.41
work area 3.14
overrides
shutting off valve early 3.21
using 3.90, 3.94

P

pallets 3.24, 3.29
Also see subboards
fixed locations 5.3
Panel Selection 2.12, 3.44, 3.45
panels
Available Items 3.31
selectable 5.60-5.64, 5.88-5.93
selecting 2.4, 2.12
panes. See window
parameters
Also see default
definitions 3.19
eliminate operator setup mistakes 5.5
inputs/outputs 3.82
interrelation to operation steps 3.17
limit 3.70
material 3.72, 3.73, 4.4, 5.7
material defaults 5.9
needle 5.11
needle cleaner 3.144
overview 3.17
part number 5.12
partition line 3.91
pattern 3.62, 5.16
place operation 4.50
process 3.70
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program line 4.5
subboard 4.5
teaching program 4.2
valve 3.71
vision 3.70
Part Number 3.43
adding 5.12
deleting 5.12
editing 5.12
Editor 5.77
library 5.12
partition
icon 3.42
line 3.90
name 3.43
operation 3.87, 5.112, 5.118
resumption points 4.64, 4.66, 4.77
shape 3.55
Pass Through 3.27
password system. See Access rights
Pattern
button 4.2, 4.3
Trainer 5.16, 5.81
patterns 5.16-5.17
as fiducial points 3.79
bad marks 3.38
defining fiducials 3.37
examining 3.63
Inspection mode 3.26
library 3.61, 5.16
name 3.61
new 3.61
optimizing 1.1
parameters 3.62, 5.16
pre-scan 3.35, 4.6, 4.52
Recognition 1.2
restrictions 5.16
Run mode 3.25
saving 3.64
shapes 1.2
teaching 3.61, 4.2
testing 3.63
training parameters 3.62
Pause
button 3.24
on Bad Mark 3.35, 4.6
Pending Operation 3.29
pick-and-place 3.4, 3.11, 3.15, 3.43
creating program for 4.44
shapes 4.51
Point
End 4.33
Mid 4.33
Search 3.35
Start 4.33
Post Delay 3.20
pot life. See material expiration
Power
Off 2.2

5/18/18

Off (legacy) 5.121
On21
On (legacy) 5.121
On & Homing 2.1
Pre Snap-Off Delay 3.20
precision, See touch span
Pre-scan 4.52
Patterns 3.35, 4.6
Probes 3.35, 4.6
pressure
monitoring data 3.69
sense tool 3.69
sense tool, setting up 3.67
set5.99, 7.5
view 7.5
primitive operations 3.85, 5.108-5.113
Also see operations
icons 3.42
in Default program 3.92
pre-programmed shapes 3.55
Print 3.30
Config Files 3.136
controls 3.27
generating reports 6.4
Interim Report Generation 5.40, 6.4
program 3.47
sample reports 3.47-3.48
Selected Program 3.47, 5.85
probe. See touch probe
process monitoring 4.85
Program
Detail 5.86
Detail, selectable panels 2.12, 5.86
Editor 3.30, 5.94
Editor, closing 3.41
Editor, versions (Programs,Shapes) 3.31
programmable focus. See ClearVu Vision
programming
arc 4.30
area fill 4.17
basics 3.16, 4.1
circle 4.25
complex programs with shapes 3.49
conveyor auto-width 3.123
dot 4.7
dot inspection 3.113
enhancements 4.52
high precision with touch span 3.40
limits 4.53
line 4.12
overview 1.2
partition line 3.90
pick-and-place 4.46
program line detail 3.43
program line subsets with Feature ID 3.45
program lines 3.43, 4.4
rectangle 4.17
successful 3.70
vision calibration, setup 3.81
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with counters 3.29

with Feature IDs 3.101

with pre-programmed shapes 3.55

with shapes 3.49

with subboards 4.37-4.43
Programs

adding 3.41

adjusting live 3.25

auto from scanned info 3.28

closing 3.30

converter 3.5

converting 3.4, 3.13

copying 3.12

creating 3.16, 3.30

creating basic 4.1

creating program lines 4.4

current 3.25

cyclic aspects 3.29

Default 3.81, 3.92

defaults 3.88

deleting 3.41

description 3.36, 4.2

detail records 3.42

Dynamic Load Program 4.84

editing detail lines 3.41, 3.42

ending 3.24

existing 3.1

exporting 3.9

gantry identification code 3.43

header 4.1

importing 3.1

instructions for operator 3.41, 3.46

isolating with classes 3.31, 3.34

Lines 3.43

modes 3.25

modifying 3.30

name 3.43, 4.1

optimizing 3.11

overview 1.2

partition line, using 3.90

pausing 3.24

pick-and-place 3.4

printing 3.47

reference point 3.50, 3.51

refining settings 3.41

refreshing 3.13

renaming 3.12

restarting 3.24

running 3.25

selecting 3.25, 3.30, 3.31

selection with barcode reader 4.76, 4.84

shapes 3.49

subboard 4.37-4.43

teaching 2.7

teaching manually 1.2

tweaking 3.25

updating 3.12
properties, dispensing 3.49
purge

5/18/18

accounting data 6.4

Auto, while system idle 4.74
changing location of 4.75
during program run 4.73
needle clean and 4.73
valve offline 7.4

R

reader, barcode
Auto Mode 4.76
Barcode Scan Program Select 4.80
Dynamic Load Program 4.84
reboot. See boot
records. See Data
recovery software 6.28
Rectangle
How to Program 4.17
icon 3.42
operation 3.87, 5.113, 5.118
subops 4.19
reference
board data 3.34
libraries 5.1
operations 5.108
SubOps 5.114
subtypes 5.114
windows & fields 5.22
reference point 3.36, 4.2
Also see Shapes, reference point
calculated center 3.52, 3.54
changing 3.14
compared to fiducial point 3.14
coordinates of active 2.7
frame of reference, illustrated 3.51
program 3.50
program vs. shape 3.50
shape 3.50, 3.52
single point 3.52, 3.53
teaching for shape 3.53
warnings 3.14, 3.36
work area origin 3.37
Refresh
button 3.24
Program 3.13
removable drive. See USB Port
Rename Program 3.12
reports. See Print
Reset
button 3.120
Valves 3.28
RESTART 3.23, 3.24
Restore
backup 6.12
USB Port 2.9
resumption points 4.62—4.69
rotation 3.96-3.98
arc 4.36
area fill 4.23
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array 3.97
circle 4.29
guidelines 3.96
Object 3.44, 3.96, 3.97
RECTANGLE 4.23
theta 3.98
routine backups. See backups
RUN 3.25
Controls 3.25
dry 3.117
inspection pattern 3.26
mode 3.25

S

SAVE 3.120
scale
Adjustment 3.137
calibration 3.24
flow rate 3.129
material weight 3.70, 3.129, 4.85
set up within program 3.132
set up within software 3.129-3.134
software, theory 3.129
scan
double 3.35
See also barcode
screen
grabber 7.16—7.28
vs. window 2.10
scroll bars. See User Interface
searching
Also see filters
with VEdit 7.13
SECOND POINT 3.54
security. See access rights
SELECT 3.25
List 2.18, 2.19, 3.86, 5.98
selectable panels 5.60-5.64, 5.88-5.93
selecting
Also see filters
files 2.21, 2.21-2.22
head 4.3
material 4.3
menu item 2.4
multiple items 2.19
needle 4.3
Operation 4.4
panels 2.4,2.12
sequence 3.49
Servo Configuration 3.136
Set
POINT 3.53
Pressure/Temp 5.99, 7.5
Shape Reference Point 3.53, 5.100
Settle Z 3.19
Setup
icon 3.42
operation 3.87, 5.113, 5.119

5/18/18

shapename 5.119
Shapes 3.49
assigning touch span boundaries 3.40
bad marks 3.38
complexity 3.50
converting to program 3.13
custom 3.55-3.60
defaults 3.88
Feature ID 3.49
guidelines 3.50
icon 3.42
library 3.50
name default 3.55
operation 3.85, 3.87, 5.113
optimizing 3.11
orientation 3.50
overview 1.2
partition line 3.55
pick operation 4.46
place operation 4.49
pre-programmed 3.55
reference point 3.50, 3.51
reference point types 3.52
reference point, changing 3.54
reference point, teaching 3.53
reference point, warning 3.54
sequence 3.49
touch probe action 3.50
version 3.30, 3.34, 4.1
vs. Subboards 3.49
weight calibrated 4.91
why use shapes? 3.49
ShList 3.85
icon 3.42
warnings 3.42
Show
Common Area 7.7
Job Info 6.4
POINT 3.54
shutdown
See boot
See Power Off
System 2.2
single
object rotation 3.97
Point 3.52
Point setting 3.53
Size
X 3.44
Y 3.44
Skip if No Fiducial 3.35, 4.6
slave. See hard drive
sliders. See User Interface
SMEMA 3.35
Snap Off
Acceleration 3.20
Velocity 3.20
Z3.20
software. See FLOware software
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spacing,fill 3.44
speed
Also see Jogging Gantry
Also see velocity
calibrating for conveyor 3.126
During Operations 3.26
stand-alone, emulating 3.27, 3.118
Standard
Acceleration 4.23, 4.29
Values 3.44
Start
operation stage 3.20, 3.22, 3.45
Point, 3-point arc 4.33
up . See Power On
Z3.19, 5111
Z Pause 3.19,4.24
states, operation 3.27
Status 3.29
Step run pattern 3.25
subboards
bad marks 3.39
convert from program 3.13
defining 4.5
modifying 3.41
touch span frequency 3.40
vs. shapes 3.49
warnings 4.5
SubOp 3.44, 5.114-5.119
3-Point Arc 4.31
counters 4.55
Delay 5.110
Dot 5.112
Flip 4.83
PICK 4.45
PLACE 4.45
RECTANGLE 4.19
SubTypes 5.18-5.21, 5.114-5.119
Editor 5.20, 5.103
library 5.18
multiple 5.18
Suppress
Auto Height Probe 4.5
Hold-Down 3.35, 4.6
Lifter 3.35, 4.6
suspending/resuming program execution 4.62
System
Functions 3.24, 7.7
management 6.1

T

Tab Key. See User Interface
TCP/IP
communications 7.15
Configuration 3.136
TEACH 2.17, 3.53
COORDS 4.51
Teaching
alignment points 4.3

bad marks 3.39, 4.3
cleaning path (needle cleaner) 3.146
coordinates with buttons 2.17
fiducial coordinates 3.37
fiducial points 4.2
fixed location 5.4
patterns 3.61, 4.2, 5.16
program coordinates. See Jogging Gantry
program parameters 4.2
program, manually 1.2
shape reference point 3.53
touch span parameters
warning 2.17
Temp PID 3.136
temperature
monitoring 3.136, 3.141
set5.99, 7.5
view 7.5
TEST 3.25, 3.63
testing
inspection mode 3.26
pattern 3.63
program development 3.117
Text
copy & cut7.13
copy & paste 7.14
copying 7.13
editor. See VEdit
Entry. See User Interface
pasting 7.13
Theta 3.44
Thick 3.35
thresholds 3.62, 3.63
Tilt Adjust 7.4
time 3.28
between backups, prompt 6.14
elapsed 3.29
tips & tricks 4.1
tools
Also see valves
calibration 3.126, 3.127
Etch, Rout, Drill, or Pickup 3.20
for program selection 3.31
Force Feedback 4.44
Pick 4.44
pressure sense 3.67, 3.69
tweaks 3.119
touch probe
action with shapes 3.50
height sense 4.52
limits 3.139
pre-scan 3.35
subboard, frequency for 4.40
touch span 3.30, 3.40, 4.3
pre-scan 4.52
Trackball. See User Interface
TRAIN 3.62
troubleshooting 6.28, 7.8
TWEAKS 3.25
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for valves, tools 3.119-3.122
warnings 3.119

U

underfill 4.62
Units of Measure 7.1
abbreviations 7.2
automatic conversion 2.5
entering 2.5
Global 2.6
global defaults 7.1
metric units 7.2
universal serial bus. See USB Port
Unmount USB 2.9
updating
program 3.12
software. See FLOware software
UPS (uninterrupted power supply) 2.1, 2.2
USB
application backup to 6.18
data backup to 6.15
port 2.9
User Interface 2.3
accelerator keys 2.4
arrow keys 2.4
Cursor 2.3, 2.8
Global Units of Measure 2.6
Keyboard 2.4, 2.7, 2.8
Numeric Entry 2.5
scroll bars 2.20
sliders 2.8, 2.20, 3.26, 3.62
Tab Key 2.5
Text Entry 2.5, 3.36, 3.43
Trackball 2.3, 2.7, 2.8
user name. See access rights
Utilities 3.23, 3.31
Backup 6.13, 6.23, 6.25
Import/Export 3.4
Install Update 6.12
Management Info 6.4
New Export 3.9
New Import 3.2
Notes 6.2
Optimize 3.11
Restore Backup 6.12
Unmount USB 2.9
uv
cure 4.97
wand 4.97

\'

values
affecting specific program 3.94
default 3.88
override 3.88
Valve
Off 3.19, 4.23
Prime 3.19

5/18/18

Valve/Tool 3.43
Editor 5.105
VALVE/TOOL MOUNTS 3.41, 4.3
valves
Also see heads
auger 3.66
defining parameters 3.41
flow rate 3.129
Micro-Dot 3.65
MV50/400 Controls 7.5
ON/OFF CTRL 3.45
parameters 3.71
reset 3.28
setting up 3.65
settings 3.70
turn on & off 3.22
tweaks 3.119
volume control 3.19
VEdit 2.21, 2.24,7.12
navigating 7.13
velocity
approach 3.19
arc 4.33
Dispense Velocity 3.19
optimize for fastest program 3.11
snhap off 3.20
snap off acceleration 3.20
system 3.19
Version 3.34, 4.1
changing 3.34
video, See Live Video Parameters
View
Notes 6.2
Pressure/Temp 7.5
vision
Also see camera
Also see ClearVu Vision
Also see lens
Also see lighting

automatic system 3.61, 3.77, 3.77-3.84

calibration 3.24, 3.128
Calibration panel 3.79
calibration, defaults 3.95
calibration, settings 3.81
calibration, verify 4.6
Display 3.27
limiting search area 3.35
parameters 3.70, 5.16
void, area fill 4.23
void, circle 4.29

w

WEIGH 3.130

weight
Also see material
calibrated shapes 4.91
for scale 3.70
monitoring 4.85
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Width 3.35
calibrating for conveyor 3.126
window
active & inactive 2.10
controls 5.22
faded items 2.20
file selection 2.21, 2.21-2.22
how to open each 5.22
lists 2.18
main control 3.23
moving 2.10
multiple select 2.19
panels,selectable 2.12
panes 2.11
resizing 2.10
select list 2.19
shell-style 2.24, 7.7
tear-off menus 2.14
vs. screens 2.10
window panels
Access Rights 5.14
Bad Marks 3.39
Blobs 3.107
Board Information 3.34
Camera View 3.62
Counters 3.29
Cycle Info 3.29
Defined Boards 4.42
Description 4.2
Fiducials 3.37
Misc Program Settings 3.81
Operation 6.3
Operation States 3.27
Program Line Detail 3.43
Program Lines 3.43
Run Controls 3.25
Selected Panel 3.45
Standard Values 3.44
Status 3.29
Vision 3.108
Vision Calibration 3.79, 3.108, 3.128
window titles
Arc Editor 4.32
Check/Set Base Locations 3.146, 5.23
Contour Mapping Editor 5.24
Data Converter 5.25
Data Export 5.26
Data Import 5.28
Edit Configuration 3.111
Enter Operator Instructions 5.29
Export 3.9, 5.30
Fiducials & Bad Marks 5.33
File Selection 5.34
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